WebEx Event Center
User's Guide
Copyright

© 1997-2013 Cisco and/or its affiliates. All rights reserved. WEBEX, CISCO, Cisco WebEx, the CISCO logo, and the Cisco WebEx logo are trademarks or registered trademarks of Cisco and/or its affiliated entities in the United States and other countries. Third-party trademarks are the property of their respective owners.

U.S. Government End User Purchasers. The Documentation and related Services qualify as "commercial items," as that term is defined at Federal Acquisition Regulation ("FAR") (48 C.F.R.) 2.101. Consistent with FAR 12.212 and DoD FAR Supp. 227.7202-1 through 227.7202-4, and notwithstanding any other FAR or other contractual clause to the contrary in any agreement into which the Agreement may be incorporated, Customer may provide to Government end user or, if the Agreement is direct, Government end user will acquire, the Services and Documentation with only those rights set forth in the Agreement. Use of either the Services or Documentation or both constitutes agreement by the Government that the Services and Documentation are commercial items and constitutes acceptance of the rights and restrictions herein.

Last updated: 08132013

www.webex.com
# Table of Contents

## Setting up and Preparing for an Event
- Setting up Event Center ................................................................. 1
  - System requirements for Event Center for Windows .......................... 2
  - Setting up Event Center for Windows ........................................... 2
- Preparing for an event .................................................................. 3
  - Checking your system for UCF Compatibility ................................. 3
  - About WebEx Connect .................................................................. 4
  - About sharing a remote computer ............................................... 4

## Planning an Event
- Getting started ........................................................................... 5
  - Adding security for your event .................................................... 6
- Defining your roles ...................................................................... 6
  - Tips for assigning responsibilities .............................................. 7
- Specifying whether the event is listed or unlisted ......................... 8
- Specifying registration options for attendees ............................... 8
  - Requesting attendees to register ................................................. 8
  - Requiring a registration ID for joining an event ........................... 9
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Requiring a registration password</td>
<td>9</td>
</tr>
<tr>
<td>Setting approval rules for registrants</td>
<td>10</td>
</tr>
<tr>
<td>Customizing the registration form</td>
<td>11</td>
</tr>
<tr>
<td>About the Add Text Box window</td>
<td>13</td>
</tr>
<tr>
<td>About the Add Check Boxes window</td>
<td>14</td>
</tr>
<tr>
<td>About the Add Option Buttons window</td>
<td>15</td>
</tr>
<tr>
<td>About the Add Drop-Down List window</td>
<td>16</td>
</tr>
<tr>
<td>About lead scores</td>
<td>17</td>
</tr>
<tr>
<td>About the Add From My Registration Questions/Survey Questions window</td>
<td>18</td>
</tr>
<tr>
<td>Specifying a destination Web page after registration</td>
<td>19</td>
</tr>
<tr>
<td>Inviting participants to your event</td>
<td>20</td>
</tr>
<tr>
<td>Creating an invitation list and inviting attendees to your event</td>
<td>20</td>
</tr>
<tr>
<td>Adding a new contact to your invitation list</td>
<td>21</td>
</tr>
<tr>
<td>Adding existing contacts to your invitation list</td>
<td>23</td>
</tr>
<tr>
<td>Importing a distribution list to your invitation list</td>
<td>24</td>
</tr>
<tr>
<td>Creating an invitation list and inviting panelists to your event</td>
<td>25</td>
</tr>
<tr>
<td>Editing an invitation list</td>
<td>26</td>
</tr>
<tr>
<td>Sending email messages to participants</td>
<td>28</td>
</tr>
<tr>
<td>About sending email messages to participants</td>
<td>28</td>
</tr>
<tr>
<td>About the Email Messages section</td>
<td>28</td>
</tr>
<tr>
<td>Including iCalendar attachments in email messages</td>
<td>31</td>
</tr>
<tr>
<td>Customizing email messages</td>
<td>31</td>
</tr>
<tr>
<td>Topic</td>
<td>Page</td>
</tr>
<tr>
<td>----------------------------------------------------------------------</td>
<td>------</td>
</tr>
<tr>
<td>About customizing email messages</td>
<td>31</td>
</tr>
<tr>
<td>About the Edit Event Email/Template Name: [template name] page</td>
<td>32</td>
</tr>
<tr>
<td>Customizing an email message for a specific event</td>
<td>33</td>
</tr>
<tr>
<td>Customizing an email message for future events</td>
<td>34</td>
</tr>
<tr>
<td>About variables in an email template</td>
<td>35</td>
</tr>
<tr>
<td>Selecting audio conference options</td>
<td>36</td>
</tr>
<tr>
<td>Setting up a teleconference for an event</td>
<td>39</td>
</tr>
<tr>
<td>Setting up an Integrated VoIP conference for an event</td>
<td>40</td>
</tr>
<tr>
<td>Setting up a dual-mode voice conference</td>
<td>41</td>
</tr>
<tr>
<td>Playing alerts when participants join or leave a teleconference</td>
<td>42</td>
</tr>
<tr>
<td>Sharing a presentation or document automatically</td>
<td>42</td>
</tr>
<tr>
<td>About the Add/Select Presentation page</td>
<td>44</td>
</tr>
<tr>
<td>Specifying basic information</td>
<td>45</td>
</tr>
<tr>
<td>Specifying an event type and topic</td>
<td>45</td>
</tr>
<tr>
<td>Automatically deleting an event after it ends</td>
<td>46</td>
</tr>
<tr>
<td>Using an event template during scheduling</td>
<td>46</td>
</tr>
<tr>
<td>Creating or editing an event template</td>
<td>47</td>
</tr>
<tr>
<td>Specifying an event password</td>
<td>48</td>
</tr>
<tr>
<td>Assigning your event to a program</td>
<td>48</td>
</tr>
<tr>
<td>Specifying tracking codes for a scheduled event</td>
<td>49</td>
</tr>
<tr>
<td>Reducing network bandwidth usage</td>
<td>49</td>
</tr>
<tr>
<td>Specifying date and time options</td>
<td>50</td>
</tr>
</tbody>
</table>
About specifying the event time, duration, and time zones ............................................. 50
Specifying the event time, duration, and time zones ......................................................... 51
Planning and selecting event time zones ........................................................................... 51
Allowing attendees to join the event and teleconference early ........................................ 54
Sending an email reminder to the host before the event ................................................. 55
Specifying event descriptions and options ........................................................................ 55
Specifying an event description .......................................................................................... 56
Formatting an event description .......................................................................................... 56
Adding an image to an event description ........................................................................... 56
Providing event material before an event ........................................................................... 57
About the Add Event Material page .................................................................................... 59
Specifying a destination URL after an event ...................................................................... 60
Preventing event attendees from sharing rich media files ............................................... 60
Requesting participants to check their rich media players ................................................ 61
Specifying whether to display attendee list to all participants ......................................... 61
Selecting video options ..................................................................................................... 62
Adding a post-event survey ............................................................................................... 62
About the Upload or Select Image window ....................................................................... 64
Specifying other options for attendees .............................................................................. 64
Allowing registrants to invite friends ............................................................................... 65
Specifying a maximum number of registrants .................................................................. 65
Specifying options for presenters & panelists ................................................................... 65
Allowing panelists to upload documents .................................................. 66

Scheduling, Editing, Canceling, and Starting an Event .............................. 67

Scheduling an event .............................................................................. 67
Starting an event .................................................................................. 68
About starting an event ........................................................................ 68
Starting an event from My WebEx ...................................................... 69
Editing a scheduled event ................................................................. 69
About editing a scheduled event ....................................................... 69
Editing a scheduled event from My WebEx ....................................... 70
Canceling a scheduled event .............................................................. 71
About canceling a scheduled event .................................................. 71
Canceling a scheduled event .............................................................. 71

Scheduling a MeetingPlace Personal Conference meeting ................... 73

About MeetingPlace Personal Conference meetings ............................ 74
Setting up a Personal Conference meeting or MeetingPlace Personal
Conference meeting ........................................................................ 74
Adding a scheduled Personal Conference meeting or MeetingPlace Personal
Conference meeting to your calendar program .................................. 75
Editing a Personal Conference meeting or MeetingPlace Personal Conference
meeting ............................................................................................. 76
Starting a MeetingPlace Personal Conference meeting .................... 78
Canceling a Personal Conference Meeting or MeetingPlace Personal
Conference meeting ........................................................................ 78
About the Personal Conference Meeting Information page (host) ....... 80
About the Personal Conference Meeting Information page (for attendees) .......... 81

Managing Programs ........................................................................................................... 83

About managing programs ............................................................................................... 83
Creating a program ........................................................................................................... 83

About creating a program ............................................................................................... 84
Creating a program ........................................................................................................... 84
Obtaining event, program, and recording URLs ............................................................... 85
About the Create a program page .................................................................................... 87
Adding live events to a program ....................................................................................... 89
Adding recorded events to a program ................................................................................ 90
Viewing, modifying, and deleting a program .................................................................... 90

Tracking Your Attendees .................................................................................................. 93

About tracking your attendees ......................................................................................... 93
Manually appending a source ID to your URL ................................................................. 94
Obtaining event, program, and recording URLs ............................................................... 94

Associating a source ID with a vendor ............................................................................ 97

Associating source IDs with vendors for an event ......................................................... 98
Associating source IDs with vendors for a program ....................................................... 99
Associating source IDs with vendors for an event recording ................................. 100

Managing Registration Requests ..................................................................................... 101

About managing registration requests ............................................................................ 101

Approving or rejecting registration requests ................................................................. 102
Sending email reminders to registrants ................................................................. 103

**Conducting a Practice Session** ............................................................................. 105
Setting up a practice session ................................................................................... 105
Starting a practice session ....................................................................................... 108
Ending your practice session ................................................................................... 109

**Joining an Event As a Panelist** ........................................................................... 111
About joining an event as a panelist ....................................................................... 111
   About the Panelist Entrance page ...................................................................... 112
Joining an event from an email invitation ............................................................... 112
Joining an event from a URL .................................................................................. 113
Obtaining event information .................................................................................... 113
Uploading files .......................................................................................................... 114

**Registering for an Event** ..................................................................................... 115
About registering for an event .................................................................................. 115
Registering for an event from your Event Center Web site ................................... 116
   About the Register for [Topic]/Register for Events page .................................. 117
   About the List of Events page ............................................................................ 118
Registering from an event URL ............................................................................... 118
Registering for multiple events in a program ......................................................... 119
   About registering for multiple events in a program .......................................... 119
Registering for events from the program URL ....................................................... 120
Registering for events from your Event Center Web site ...................................... 120
Obtaining information about an event ..............................................................121
Searching for an event ..................................................................................121
Obtaining event information before an event .................................................122
Viewing events in a different locale, language, or time zone .......................123
Changing the locale, language, or time zone for your site ..........................124

The Event Window..........................................................................................127
A quick tour of the Event window ................................................................127
Performing tasks on shared content .............................................................129
The menu bar .................................................................................................129
Using annotation tools on shared content ....................................................130
Sharing information .......................................................................................131
Changing views of shared content ...............................................................132
Working with panels ......................................................................................133
Managing panels .........................................................................................135
Minimizing panels .......................................................................................136
Expanding and collapsing panels ................................................................137
Restoring the panel layout ...........................................................................137
Accessing panel options ..............................................................................138
Resizing the content viewer and panels area ..............................................139
Accessing panels in full-screen view ............................................................140
Manipulating panels in full-screen view .......................................................141
Sharing in full-screen view .........................................................................142
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Synchronizing attendee displays</td>
<td>145</td>
</tr>
<tr>
<td>Viewing panel alerts</td>
<td>145</td>
</tr>
<tr>
<td><strong>Assigning Privileges During an Event</strong></td>
<td>149</td>
</tr>
<tr>
<td>About granting privileges to participants</td>
<td>149</td>
</tr>
<tr>
<td>Granting privileges to attendees and panelists</td>
<td>150</td>
</tr>
<tr>
<td>Granting privileges to attendees</td>
<td>150</td>
</tr>
<tr>
<td>Overview of attendee privileges</td>
<td>151</td>
</tr>
<tr>
<td>Granting privileges to panelists</td>
<td>152</td>
</tr>
<tr>
<td>Overview of panelist privileges</td>
<td>153</td>
</tr>
<tr>
<td><strong>Managing an Event</strong></td>
<td>155</td>
</tr>
<tr>
<td>Obtaining information about an event</td>
<td>156</td>
</tr>
<tr>
<td>Managing the Attendee List</td>
<td>156</td>
</tr>
<tr>
<td>Viewing the attendee list</td>
<td>158</td>
</tr>
<tr>
<td>Allowing panelists to view attendees’ company names</td>
<td>158</td>
</tr>
<tr>
<td>Inviting attendees to an event in progress</td>
<td>160</td>
</tr>
<tr>
<td>Inviting attendees by email to an event in progress</td>
<td>160</td>
</tr>
<tr>
<td>Inviting attendees by phone to an event in progress</td>
<td>160</td>
</tr>
<tr>
<td>Inviting attendees by WebEx Connect to an event in progress</td>
<td>161</td>
</tr>
<tr>
<td>Inviting attendees by instant messaging (IM) to an event in progress</td>
<td>163</td>
</tr>
<tr>
<td>Inviting participants by text message (SMS) to an event in progress</td>
<td>164</td>
</tr>
<tr>
<td>Creating a greeting message for attendees</td>
<td>164</td>
</tr>
<tr>
<td>Inviting attendees to a teleconference in progress</td>
<td>165</td>
</tr>
</tbody>
</table>
Reminding panelists to join an event in progress .................................................. 166
  Reminding panelists by email .............................................................................. 166
  Reminding panelists by WebEx Connect ................................................................. 167
  Reminding panelists by instant messaging (IM) ...................................................... 168
Tracking participant attention ..................................................................................... 169
  Checking participant attention in an event .............................................................. 170
  Turning on or off attention tracking in an event ..................................................... 170
  Granting attention tracking privilege .................................................................... 171
Designating a presenter .............................................................................................. 171
Designating a panelist ............................................................................................... 172
  About panelist roles and privileges ....................................................................... 172
Transferring the host role ......................................................................................... 173
  Transferring the host role ..................................................................................... 173
  Reclaiming the host role ....................................................................................... 174
Restricting access to an event ................................................................................... 174
Removing a participant from an event ...................................................................... 175
Ending an event ....................................................................................................... 175
  Leaving an event as the host .................................................................................. 176
  Ending an event .................................................................................................... 176

Managing Question-and-Answer Sessions ................................................................ 179
  Allowing participants to use Q & A ...................................................................... 180
  Setting privacy views in Q & A sessions ................................................................. 180
Managing questions on your Q & A panel ................................................................. 181
Working with the tabs on your Q & A panel .............................................................. 183
   Opening a tab ......................................................................................................... 183
   Closing a tab ......................................................................................................... 184
Assigning a question ............................................................................................... 185
Prioritizing questions ............................................................................................. 185
   Viewing prioritized questions ............................................................................... 186
Answering questions in a Q & A session ............................................................... 187
   Providing a public answer ..................................................................................... 188
   Answering a question privately ............................................................................ 188
   Dismissing a question ........................................................................................... 189
   Deferring a question ............................................................................................. 190
   Responding to questions answered verbally ....................................................... 190
Archiving Q & A sessions ..................................................................................... 191
   Saving a Q & A session ....................................................................................... 191
   Saving changes to a saved Q & A session ............................................................ 192
   Saving a copy of a previously saved Q & A session ............................................ 192
   Opening a Q & A file ............................................................................................ 193

Participating in a Question-and-Answer Session .................................................... 195
   Working with the tabs on your Q & A panel ......................................................... 195
   Asking a question in a Q & A session ................................................................. 196
   Checking the status of your questions ............................................................... 196
My Q & A tab .............................................................................................................197
Answering indicator .............................................................................................197

Using Teleconferencing .........................................................................................199

Joining or leaving a teleconference .....................................................................200
Inviting attendees to a teleconference in progress .............................................201
Muting and unmuting microphones in a teleconference ....................................202
  Muting participants' microphones automatically when they join an event ......202
  Muting and unmuting a specific participant's microphone .............................203
  Muting and unmuting all attendees' microphones simultaneously ..............204
  Muting and unmuting your microphone in a teleconference ......................205
Asking to speak in a teleconference ..................................................................205
Determining who is speaking in a teleconference ............................................206
Broadcasting audio streams to all attendees ......................................................206
  Starting an audio broadcast .............................................................................207
  Asking to speak during an audio broadcast ...................................................210
  Accepting an attendee's request to speak ......................................................210
  Controlling the audio on your computer .......................................................211
  Leaving audio broadcast ................................................................................212
  Joining audio broadcast ................................................................................212

Using Integrated VoIP Conferences .................................................................213

Starting or ending an integrated voice conference ............................................214
Joining or leaving an integrated VoIP conference .............................................215
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Speaking in an integrated VoIP conference</td>
<td>215</td>
</tr>
<tr>
<td>Muting and unmuting microphones in an integrated voice conference</td>
<td>216</td>
</tr>
<tr>
<td>Muting and unmuting participant microphones</td>
<td>217</td>
</tr>
<tr>
<td>Muting and unmuting your microphone</td>
<td>217</td>
</tr>
<tr>
<td>Setting integrated voice conference options</td>
<td>218</td>
</tr>
<tr>
<td><strong>Sharing Presentations, Documents, and Whiteboards</strong></td>
<td>219</td>
</tr>
<tr>
<td>Granting privileges to attendees</td>
<td>220</td>
</tr>
<tr>
<td>Content viewer tools</td>
<td>220</td>
</tr>
<tr>
<td>Changing views in a file or whiteboard</td>
<td>221</td>
</tr>
<tr>
<td>Using annotation tools...nested embedding</td>
<td>222</td>
</tr>
<tr>
<td>Sharing information</td>
<td>223</td>
</tr>
<tr>
<td>Sharing files</td>
<td>224</td>
</tr>
<tr>
<td>Sharing a file</td>
<td>224</td>
</tr>
<tr>
<td>Tips for sharing files</td>
<td>225</td>
</tr>
<tr>
<td>Choosing an import mode for presentation sharing</td>
<td>226</td>
</tr>
<tr>
<td>Closing shared files</td>
<td>227</td>
</tr>
<tr>
<td>Sharing a whiteboard</td>
<td>227</td>
</tr>
<tr>
<td>Starting whiteboard sharing</td>
<td>227</td>
</tr>
<tr>
<td>Closing a shared whiteboard</td>
<td>229</td>
</tr>
<tr>
<td>Navigating presentations, documents, or whiteboards</td>
<td>229</td>
</tr>
<tr>
<td>Navigating slides, pages, or whiteboards using the toolbar</td>
<td>229</td>
</tr>
<tr>
<td>Advancing pages or slides automatically</td>
<td>230</td>
</tr>
</tbody>
</table>
Animating and adding effects to shared slides ........................................231
Using keyboard shortcuts to control a presentation..................................232
Working with pages or slides ...................................................................233
Adding new pages to shared files or whiteboards ....................................234
Pasting images in slides, pages, or whiteboards .......................................234

Managing views of presentations, documents, or whiteboards ..............235
Zooming in or out ......................................................................................235
Controlling full-screen view .....................................................................236
Viewing thumbnails ..................................................................................237
Synchronizing all participant views ..........................................................238
Clearing annotations ................................................................................239
Clearing pointers ......................................................................................240
Renaming tabs ..........................................................................................241
Reordering tabs .........................................................................................241

Saving, opening, and printing presentations, documents, or whiteboards ....243
Saving a presentation, document, or whiteboard .......................................243
Opening a saved document, presentation, or whiteboard .........................244
Printing presentations, documents, or whiteboards ..................................245

Event participant .......................................................................................247
Displaying pages, slides, or whiteboards ..................................................247
Synchronizing your view of pages, slides, or whiteboards .........................248
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sharing Software</td>
<td>249</td>
</tr>
<tr>
<td>Sharing applications</td>
<td>249</td>
</tr>
<tr>
<td>Sharing several applications at once</td>
<td>250</td>
</tr>
<tr>
<td>Stopping application sharing for all participants</td>
<td>251</td>
</tr>
<tr>
<td>Starting application sharing</td>
<td>251</td>
</tr>
<tr>
<td><strong>Controlling views of shared software</strong></td>
<td>253</td>
</tr>
<tr>
<td>Pausing and resuming software sharing</td>
<td>254</td>
</tr>
<tr>
<td>Controlling full-screen view of shared software</td>
<td>255</td>
</tr>
<tr>
<td>Synchronizing views of shared software</td>
<td>256</td>
</tr>
<tr>
<td>Selecting a monitor to share</td>
<td>257</td>
</tr>
<tr>
<td>Controlling your view as an attendee</td>
<td>259</td>
</tr>
<tr>
<td>Closing your attendee sharing window</td>
<td>260</td>
</tr>
<tr>
<td>Switching your attendee view</td>
<td>261</td>
</tr>
<tr>
<td><strong>Annotating shared software</strong></td>
<td>263</td>
</tr>
<tr>
<td>Starting and stopping annotation</td>
<td>264</td>
</tr>
<tr>
<td>Using annotation tools</td>
<td>265</td>
</tr>
<tr>
<td>Letting an attendee annotate shared software</td>
<td>266</td>
</tr>
<tr>
<td>Requesting annotation control of shared software</td>
<td>267</td>
</tr>
<tr>
<td>Giving up annotation control</td>
<td>268</td>
</tr>
<tr>
<td>Stopping an attendee from annotating shared software</td>
<td>268</td>
</tr>
<tr>
<td>Saving an image of annotations on shared software</td>
<td>269</td>
</tr>
<tr>
<td>Sharing applications with detailed color (Windows)</td>
<td>270</td>
</tr>
<tr>
<td>xlv</td>
<td></td>
</tr>
<tr>
<td>Section</td>
<td>Page</td>
</tr>
<tr>
<td>------------------------------------------------------------------------</td>
<td>------</td>
</tr>
<tr>
<td>Sharing your desktop or applications with detailed color (Mac)</td>
<td>271</td>
</tr>
<tr>
<td>Tips for sharing software</td>
<td>272</td>
</tr>
<tr>
<td><strong>Sharing a Web browser</strong></td>
<td>275</td>
</tr>
<tr>
<td>Starting Web browser sharing</td>
<td>275</td>
</tr>
<tr>
<td>Stopping Web browser sharing</td>
<td>276</td>
</tr>
<tr>
<td><strong>Sharing your desktop</strong></td>
<td>277</td>
</tr>
<tr>
<td>Starting desktop sharing</td>
<td>277</td>
</tr>
<tr>
<td>Stopping desktop sharing</td>
<td>278</td>
</tr>
<tr>
<td><strong>Sharing Web Content</strong></td>
<td>281</td>
</tr>
<tr>
<td>About sharing Web content</td>
<td>281</td>
</tr>
<tr>
<td>Sharing Web content</td>
<td>282</td>
</tr>
<tr>
<td>Differences between sharing Web content and sharing a Web browser</td>
<td>282</td>
</tr>
<tr>
<td><strong>Sharing Multimedia on the Media Viewer Panel</strong></td>
<td>285</td>
</tr>
<tr>
<td>About sharing multimedia Web content on the Media Viewer panel</td>
<td>285</td>
</tr>
<tr>
<td>Sharing multimedia content in the media viewer</td>
<td>286</td>
</tr>
<tr>
<td><strong>Using Chat</strong></td>
<td>289</td>
</tr>
<tr>
<td>Sending chat messages</td>
<td>289</td>
</tr>
<tr>
<td>Sending chat messages to an attendee</td>
<td>290</td>
</tr>
<tr>
<td>Printing chat messages</td>
<td>291</td>
</tr>
<tr>
<td>Saving chat messages</td>
<td>292</td>
</tr>
<tr>
<td>Saving chat messages to a new file</td>
<td>292</td>
</tr>
</tbody>
</table>
Saving changes to a chat file.................................................................293
Creating a copy of previously saved chat messages...............................293
Opening a chat file during an event.......................................................293

Polling Attendees .............................................................................295

Preparing a poll questionnaire.............................................................295
Designating the role of polling coordinator..........................................296
Creating a poll questionnaire ...............................................................296
Displaying multiple poll questionnaires on Polling panel.......................298
Renaming and reordering poll tabs.......................................................301
Editing a questionnaire .....................................................................301
Displaying a timer during polling.......................................................303
Specifying options for poll results .....................................................303

Opening a poll...................................................................................304

Viewing and sharing poll results.........................................................305
Viewing poll results........................................................................306
Sharing poll results with participants................................................307

Saving and opening poll questionnaires and results............................307

Saving a poll questionnaire in an event.............................................308
Saving results of a poll..................................................................308
Saving results of all polls in one file................................................309

Opening a poll questionnaire file......................................................311
Using Feedback .......................................................... 313
  About using Feedback .................................................. 313
  Allowing participants to provide feedback .......................... 314
  Viewing a running tally of responses ................................ 314
  Providing feedback ...................................................... 315
  Removing feedback ...................................................... 316

Publishing a Recorded Event ........................................... 317
  Opening the My Event Recordings page .............................. 318
  Uploading a recording file .............................................. 319
  Publishing a recorded event ........................................... 319
  Deleting a published recording ....................................... 321
  Editing information about a recorded event ....................... 322
    About the My Event Recordings page ............................... 322
    About the Add/Edit Event Recording page ......................... 325
  How to access this page ............................................... 325
  What you can do here .................................................. 326
  Options on this page .................................................. 326
    About the Recording Information page ............................. 329
  Sending an email to share a recording .............................. 331
  Sending an email to vendors and tracking viewing of recording .......................... 332

Sending and Receiving Video ......................................... 335
  Minimum system requirements ....................................... 337
Locking focus on one participant.................................................................337
Switching between a list or thumbnail view of participants..........................338
Viewing everyone who is sending video.....................................................340
  Understanding the large video view.......................................................340
  Expanding the active speaker’s video display.........................................342
  Floating Icon Tray in Video Full Screen Mode .......................................342
Setting webcam options.............................................................................343
Managing video display during sharing......................................................344
  Controlling your self-view.......................................................................344
  Controlling video display........................................................................345
Obtaining video and audio data during an event.........................................346

Using My WebEx.........................................................................................349
  About My WebEx ..................................................................................350
  Obtaining a user account .......................................................................351
  Logging in to and out of the WebEx service site ....................................352
Using your list of meetings........................................................................352
  About your list of meetings .................................................................353
  Opening your meetings list .................................................................353
  Maintaining your scheduled meetings list .............................................355
  About the My WebEx Meetings page....................................................355
  About the My WebEx Meetings page - Daily tab.................................356
  About the My WebEx Meetings page - Weekly tab...............................358
Uploading a recording file ................................................................................................. 380
Editing information about a recording ........................................................................... 381
Sending an email to share a recording ........................................................................... 381
About the Add/Edit Recording page ................................................................................. 383
Playback control options ................................................................................................. 384
About the Recording Information page ............................................................................. 385
About the My WebEx Files > My Recordings page .............................................................. 387
About the My WebEx Files > My Recordings > Events page .............................................. 388
About the My WebEx Files > My Recordings > Miscellaneous page ................................. 390
Maintaining contact information ....................................................................................... 391
About maintaining contact information ........................................................................... 392
Opening your address book ............................................................................................... 392
Adding a contact to your address book ............................................................................ 393
About the New/Edit Contact page ................................................................................... 395
Importing contact information in a file to your address book ......................................... 396
About the Contact Information CSV template ................................................................... 397
Importing contact information from Outlook to your address book ............................... 399
Viewing and editing contact information in your address book ....................................... 400
Finding a contact in your personal address book ............................................................. 400
Creating a distribution list in your address book ............................................................. 401
Editing a distribution list in your address book ............................................................... 403
About the Add/Edit Distribution List page ....................................................................... 404
Deleting contact information in your address book .............................................. 405
Maintaining your user profile ........................................................................... 406
About maintaining your user profile ............................................................... 406
About the My WebEx Profile page ................................................................. 407
Editing your user profile .............................................................................. 413
Managing scheduling templates ...................................................................... 413
About managing scheduling templates .......................................................... 413
Managing scheduling templates ..................................................................... 414
Maintaining your Cisco Unified MeetingPlace Audio Conferencing accounts ...... 415
About maintaining Cisco Unified MeetingPlace audio conferencing account
numbers ........................................................................................................ 415
Resetting the profile PIN for your Cisco Unified MeetingPlace audio
conferencing account number ........................................................................ 415
About the Personal Conferencing page .......................................................... 416
Generating Reports ....................................................................................... 418
About generating reports .............................................................................. 418
Generating reports ...................................................................................... 420

Viewing Recorded Events ................................................................................ 423
About viewing a recorded event ..................................................................... 423
Viewing a recorded event ............................................................................. 423

Index ........................................................................................................... 425
Setting up and Preparing for an Event

<table>
<thead>
<tr>
<th>If you want to…</th>
<th>See…</th>
</tr>
</thead>
<tbody>
<tr>
<td>set up Event Center for Windows</td>
<td><em>Setting up Event Center for Windows</em> (on page 2)</td>
</tr>
<tr>
<td>make sure your system can handle UCF media files</td>
<td><em>Checking your system for UCF Compatibility</em> (on page 3)</td>
</tr>
<tr>
<td>get prepared for an event</td>
<td><em>Preparing for an event</em> (on page 3)</td>
</tr>
</tbody>
</table>

Setting up Event Center

To participate in an event, you must set up Event Center on your computer. Once you schedule, start, or join an event for the first time, your event service Web site starts the setup process. However, to save time, you can set up the application at any time before scheduling, starting, or joining an event.

<table>
<thead>
<tr>
<th>If you want to…</th>
<th>See…</th>
</tr>
</thead>
<tbody>
<tr>
<td>get an overview of system requirements</td>
<td><em>System requirements for Event Center for Windows</em> (on page 2)</td>
</tr>
<tr>
<td>set up Event Center for Windows</td>
<td><em>Setting up Event Center for Windows</em> (on page 2)</td>
</tr>
<tr>
<td>check your system for UCF compatibility</td>
<td><em>Checking your system for UCF Compatibility</em> (on page 3)</td>
</tr>
</tbody>
</table>
Chapter 1: Setting up and Preparing for an Event

System requirements for Event Center for Windows

You can find the system requirements and other information about compatible browsers and operating systems on the User Guides page for your service:

1. Log in to your WebEx Event Center site.
2. On the WebEx Event Center navigation bar, click Support > User Guides.
3. On the right side of the page, under Release Notes and FAQs, click the link for release notes.

Setting up Event Center for Windows

Before installing Event Center, ensure that your computer meets the minimum system requirements. For details, see System requirements for Event Center for Windows (on page 2).

If you are not using the Windows operating system, please refer to our FAQ, which includes information about setting up Event Center on other operating systems.

To go to the list of FAQs:

1. On your Event Center Web site, on the left navigation bar, click Support > User Guides.
2. On the User Guides page, under Release Notes and FAQs, click the link for FAQs (Frequently Asked Questions).

A list of questions displays, arranged by topic. Look for your information about your operating system under Minimum System Requirements.

To set up Event Center for Windows:

1. On the navigation bar, expand Set Up, and then click Event Manager.

   The Set Up page appears.

2. Click Set Up.

3. If a security dialog box appears, click Yes.

   Setup continues. A progress message box appears, indicating the progress of setup.

4. On the Setup Complete page, click OK.

   You can now start, schedule, or join an event.
Preparing for an event

To take advantage of the many features available in an event, check your system and then install some tools to extend event capabilities.

- Check your system for UCF compatibility (if you have presentations with animations, save them as .ucf so event attendees can view these effects) More... (on page 3)
- Set up and install Cisco WebEx Connect More... (on page 4)
- Share a remote computer, if this feature is available More... (on page 4)

Checking your system for UCF Compatibility

If you intend to play or view Universal Communications Format (UCF) media files during the event, either as a presenter or an attendee, you can verify that the following components are installed on your computer:

- Flash Player, for playing a Flash movie or interactive Flash files
- Windows Media Player for playing audio or video files

Checking your system is useful if you or another presenter plans to share a UCF multimedia presentation or standalone UCF media files.

To check your system for UCF compatibility:

1. On the navigation bar, do one of the following:
   - If you are a new event service user, click New User?.
   - If you are already an event service user, expand Set Up, then click Event Manager.
Chapter 1: Setting up and Preparing for an Event

2  Click **Verify your rich media players**.
3  Click the links to verify that the required players are installed on your computer.

**Note:** The option to check your system for required rich media players is available only if your
Event Center Web site includes the UCF option.

### About WebEx Connect

Use WebEx Connect, the instant messenger for business users to send secure instant
messages, invite or remind participants, and manage an event. Connect integrates with
Microsoft Outlook corporate directories and calendars, encrypts messages and scans
them for viruses, and offers quick access to business conferencing services from
WebEx.

**To download WebEx Connect:**

1  Log in to your Event Center Web site.
2  On the Event Center navigation bar, click **Support > Downloads**.
3  Scroll down to the section of the page describing WebEx Connect.
4  Click the link to learn more about this product and download it.

### About sharing a remote computer

Use remote computer sharing to show all event participants a remote computer.
Depending on how you set up the remote computer, you can show the entire desktop
or just specific applications. Use remote computer sharing to show attendees an
application or file that is available only on a remote computer.

Attendees can view your remote computer, including all your mouse movements, in a
sharing window on their screens.

You can share a remote computer during an event for which you are the presenter, if:

- You have installed the Access Anywhere Agent on the remote computer
- You logged in to your Event Center Web site before joining the event, if you are
  not the original event host

For information about setting up a computer so you can access it remotely, refer to the
Planning an Event

Planning is essential to delivering a successful online event. By taking the time to specify the details of an event, you can make your event as effective and engaging as possible for your attendees.

The Schedule an Event page on your Event Center Web site offers a variety of features that let you specify details for an online event according to your needs.

To access the Schedule an Event page:
1. Log in to your Event Center Web site.
2. On the left navigation bar, click Host an Event > Schedule an Event.

Getting started

These tasks can help you get started in planning your event:

- Define your roles. For details, see Defining your roles (on page 6).
- Determine whether to host a listed or an unlisted event. For details, see Specifying whether the event is listed or unlisted (on page 8).
- Determine registration options for attendees. For details, see Specifying registration options for attendees (on page 8).
- Create invitation lists for attendees and panelists. For details, see Inviting participants to your event (on page 20).
- Use the automated email management system to send out invitations, reminder, and other follow-up communications. For details, see Sending email messages to participants (on page 28).
• Set up audio options for the event. For details, see *Selecting audio conference options* (on page 36).

• Play a presentation while attendees wait for you to join the event. For details, see *Sharing a presentation or document automatically* (on page 42).

**Adding security for your event**

When you are scheduling or running an event, you can provide security for the event by doing *any* of the following:

• **Require a password**—If you specify a password, attendees must provide this password to join the event.

• **Make the event "unlisted"**—When scheduling an event, you can specify the event as *unlisted*. An unlisted event is not displayed on the List of Events page on your Event Center Web site. Attendees obtain complete information about the event from your invitation email message.

• **Require attendees to provide their registration IDs**—For either a listed or an unlisted event, you can request registration and require attendees to provide their registration IDs before joining the event. If you specify this option, each attendee receives a unique registration ID after you approve his or her registration request. For more information, see *Requiring a registration ID for joining an event* (on page 9).

• **Restrict access to the event**—Once all attendees have joined an event, you can prevent additional attendees from joining it by restricting access to the event. For details, see *Restricting access to an event* (on page 174).

**Tip:** Choose a level of security based on the event's purpose. For example, if you schedule an event to discuss your company picnic, you probably need to specify only a password for the event. However, if you schedule an event in which you will discuss sensitive financial data, you may want to make the event *unlisted*.

**Defining your roles**

Your event production team can be broken down into the following roles:
## Role Description

<table>
<thead>
<tr>
<th>Role</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>host</td>
<td>the participant who schedules, starts, manages, and ends the event and designates the presenter, panelists, and polling coordinator. The event host initially is the presenter. After the invited panelists join the event, the host can pass the presenter control to any of the panelists at any time during the event.</td>
</tr>
<tr>
<td>presenter</td>
<td>the participant, with the presenter control symbol 🎨, who is responsible for sharing and presenting information during the event.</td>
</tr>
<tr>
<td>panelist</td>
<td>a participant who is primarily responsible for assisting the presenter and participating in presentation. For more information, see About panelist roles and privileges (on page 172).</td>
</tr>
<tr>
<td>polling coordinator</td>
<td>the participant, with the 🖋️ symbol, who is responsible for preparing a poll questionnaire and conducting a poll during the event.</td>
</tr>
<tr>
<td>attendee</td>
<td>a participant who mainly listens or watches and does not present information during the event.</td>
</tr>
</tbody>
</table>

The following figure shows an example of the different roles in an event.

![Participants Example](image)

### Tips for assigning responsibilities

Create a document or storyboard that defines how you plan to produce the event.

**Example.** The document or storyboard can include the information for host, presenter, and panelist assignments, such as who will start and end the presentation, present slides, demonstrate software, handle the Q & A session, act as the poll coordinator, reply to chat messages, and so on.
Specifying whether the event is listed or unlisted

When scheduling an event, you can specify how the event is displayed on your Event Center Web site:

- **Listed**—The event appears on the List of Events page for anyone who visits your Event Center Web site. A listed event may or may not require registration.
- **Unlisted**—The event does not appear on the List of Events page on your Event Center Web site. Attendees receive an invitation email message that includes complete instructions about joining the event. An unlisted event may or may not require registration.

To make an event listed or unlisted:

On the Schedule an Event page, under Basic Information, select one of the following:

- Listed
- Unlisted

Specifying registration options for attendees

When scheduling an event, you can:

- Request attendees to register More... (on page 8)
- Require a registration ID for joining the event More... (on page 9)
- Requiring a registration password More... (on page 9)
- Setting approval rules for event registrants More... (on page 10)
- Customize the registration form More... (on page 11)
- Specify a destination Web page after registration More... (on page 19)

Requesting attendees to register

Whether your event is listed or unlisted, you can request attendees to register for your event.
Attendees receive an invitation email message that includes information about the event, including the registration password, if you specify one, and a link that they can click to register for the event.

To request registration for an event:

On the Schedule an Event page, select Required at Registration.

### Requiring a registration ID for joining an event

You can add security to your event by requiring that attendees provide their registration IDs to join the event.

Attendees receive an invitation email message that includes a link that they can click to register for the event. Once you approve an attendee’s registration request, the attendee receives a unique registration ID in a confirmation email message.

To require a registration ID for joining an event:

1. On the Schedule an Event page, at Registration, select Required.
2. In the Attendees & Registration section, select Yes at Registration ID required.

### Requiring a registration password

Specify a registration password only if you want to limit attendance to those whom you invite to register. The attendees that you invite receive an invitation email message, which contains the registration password and a link they can click to register for the event.
To specify a registration password for an event:

1. On the Schedule an Event page, at Registration, select Required.
2. In the Attendees & Registration section, select Yes at Registration password, and specify a password in the text box.

Setting approval rules for registrants

If you require approval for registration requests, you can set up approval rules to automatically approve or reject registrants using logical strings (For example, you can require that an attendee’s company name must contain the word WebEx.).

To set approval rules for registrants:

1. On the Schedule an Event page, go to the Attendees & Registration section.
2. At Approval required, select Yes.
3. Click Set up approval rules.
   The Approval Rules window appears.
4. See the following figure to learn how to set up rules.

   - Select a parameter from this drop-down list.
   - Select a logical string in this drop-down list.
   - Type the word or words that you want to include in the approval rule.
   - Select an action in this drop-down list.
   - To match the case of the text provided by a registrant to that of the text in 3, select Match case.

5. When you finish setting up a rule, click Add Rule.
   The approval rule appears in the Rules list.
Customizing the registration form

You can customize the registration form by adding or changing the questions.

A registration form contains these two types of questions:

- **Standard Questions**—Selecting the check box under the ✓ option indicates that it is an optional question on the registration form. Selecting the check box under the ☑ option indicates that it is a required question on the registration form.

- **My Custom Questions**—You can add text boxes, check boxes, option buttons, and drop-down lists to the registration form and customize the questions.

After you add a customized option to the registration form, you can edit it at any time. You can also reorganize the questions by using the up and down arrows.

To customize a registration form:

1. On the Schedule an Event page, go to the Attendees & Registration section, and then click the link at **Registration form**.

   The Customize Registration Questions page appears.

2. Under **Standard Options**, do the following:
   - For each option that you want to appear on the registration form, select the check box under ✓.
   - For each option for which you want to require attendees to provide information, select the check box under ☑.

3. Under **My Custom Questions**, add any of these types of questions:
   - **Text Box.**
     For details, see *About the Add Text Box window* (on page 13).
   - **Check Boxes.**
     For details, see *About the Add Check Boxes window* (on page 14).
   - **Option Buttons.**
     For details, see *About the Add Option Buttons window* (on page 15)
   - **Drop-Down List.**
     For details, see *About the Add Drop-Down List window* (on page 16).
4  To select questions you have previously saved, click My Registration Questions. For details, see About the Add From My Registration Questions/Survey Questions window (on page 18).

5  Optional. To reorganize your questions, click the up and down arrows in the Change Order column.

6  When you finish adding customized questions, click Save.

7  Click Close in the window that appears.

Displaying lead scores and company names on the Attendee List

During the event, you can have the Attendee List display these two types of information next to the name of each attendee:

- the attendee's response to the "Company" question on the registration form
- the attendee's total lead score based on his or her responses to the questions on the registration form

You can sort the Attendee List based on the scores or search for a company name and gain a better understanding of which attendees should be given priority during the event.
Important: If you want to display lead scores and company names on the Attendee List, you must do these two things on the registration form:

- Use the lead scoring option in the Add Check Boxes, Add Option Buttons, or Add Drop-Down List windows.
- Specify that the "Company" and all questions with assigned scores are required information—that is, select the symbol 🡈.

For more information, see Customizing the registration form (on page 11) and About lead scores (on page 17).

About the Add Text Box window

How to access this window

If you are creating or editing a post-event survey, do the following:

1. On the Schedule an Event or Edit Event page, go to the Event Description & Options section.
2. Do one of the following:
   - If this is the first time you create a post-event survey on your Event Center Web site, click Create post-event survey.
   - If you saved surveys as templates before, click Select survey. On the window that appears, click Create New Survey.
3. In the window that appears, click Text Box.

If you are creating or editing a registration form, do the following:

1. On the Schedule an Event or Edit Event page, go to the Attendees & Registration section.
2. Click the link next to Registration form.
3. In the window that appears, click Text Box.

What you can do in this window

Specify a text question that requires attendees to type information or answers in the text box provided on the survey or registration form.
Options in this window

<table>
<thead>
<tr>
<th>Use this option …</th>
<th>To …</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Text box label</strong></td>
<td>Compose a text question. A text box label can contain a maximum of 256 characters.</td>
</tr>
<tr>
<td><strong>Type</strong></td>
<td>Specify whether the text box contains a single line or multiple lines. If you select Multi-line, specify a number of lines in the Height box.</td>
</tr>
<tr>
<td><strong>Width</strong></td>
<td>Specify the width of the text box, in characters. The number that you specify determines how wide the text box appears on the survey or registration form but does not affect the number of characters that an attendee can type in the text box. A text box can contain a maximum of 256 characters.</td>
</tr>
<tr>
<td><strong>Height</strong></td>
<td>Specify the number of lines that the text box contains. To specify the number of lines, you must first select Multi-line next to Type. If you do not specify a number, Event Center uses the default height, which is one line.</td>
</tr>
</tbody>
</table>

About the Add Check Boxes window

How to access this window

If you are creating or editing a post-event survey, do the following:

1. On the Schedule an Event or Edit Event page, go to the Event Description & Options section.
2. Do one of the following:
   - If this is the first time you create a post-event survey on your Event Center Web site, click Create post-event survey.
   - If you saved surveys as templates before, click Select survey. On the window that appears, click Create New Survey.
3. In the window that appears, click Check Boxes.

If you are creating or editing a registration form, do the following:

1. On the Schedule an Event or Edit Event page, go to the Attendees & Registration section.
Chapter 2: Planning an Event

2 Click the link next to **Registration form**.

3 In the window that appears, click **Check Boxes**.

**What you can do in this window**
Specify questions that allow attendees to select multiple answers or choices on the survey or registration form. Each answer or choice appears next to a check box.

**Options in this window**

<table>
<thead>
<tr>
<th>Use this option …</th>
<th>To …</th>
</tr>
</thead>
</table>
| **Group label for check boxes** | Compose a question.  
**Note** If you are adding only one check box and do not want a group label, leave this box blank. |
| **Check box 1 to 9** | Compose the answers or choices, and specify which check boxes are selected or cleared by default on the survey or registration form.  
To add check boxes to the form, use the **Add** drop-down list. |
| **Score** | Specify a score for each response to the question. For more information, see *About lead scores* (on page 17). |

**About the Add Option Buttons window**

**How to access this window**
If you are creating or editing a post-event survey, do the following:

1 On the Schedule an Event or Edit Event page, go to the Event Description & Options section.

2 Do *one* of the following:
   - If this is the first time you create a post-event survey on your Event Center Web site, click **Create post-event survey**.
   - If you saved surveys as templates before, click **Select survey**. On the window that appears, click **Create New Survey**.

3 In the window that appears, click **Option Buttons**.
If you are creating or editing a registration form, do the following:

1. On the Schedule an Event or Edit Event page, go to the Attendees & Registration section.
2. Click the link next to Registration form.
3. In the window that appears, click Option Buttons.

**What you can do in this window**

Specify questions that allow attendees to select one single answer or choice on the survey or registration form. Each answer or choice appears next to an option button.

**Options in this window**

<table>
<thead>
<tr>
<th>Use this option …</th>
<th>To …</th>
</tr>
</thead>
<tbody>
<tr>
<td>Group label for option buttons</td>
<td>Compose a question.</td>
</tr>
<tr>
<td>Default choice</td>
<td>Specify which is the default answer or choice.</td>
</tr>
<tr>
<td>Choice 1 to 9</td>
<td>Compose the answers or choices.</td>
</tr>
<tr>
<td></td>
<td>To add option buttons, use the Add drop-down list.</td>
</tr>
<tr>
<td>Score</td>
<td>Specify a score for each response to the question. For more information, see About lead scores (on page 17).</td>
</tr>
</tbody>
</table>

**About the Add Drop-Down List window**

**How to access this window**

If you are creating or editing a post-event survey, do the following:

1. On the Schedule an Event or Edit Event page, go to the Event Description & Options section.
2. Do one of the following:
   - If this is the first time you create a post-event survey on your Event Center Web site, click Create post-event survey.
   - If you saved surveys as templates before, click Select survey. On the window that appears, click Create New Survey.
If you are creating or editing a registration form, do the following:

1. On the Schedule an Event or Edit Event page, go to the Attendees & Registration section.
2. Click the link next to Registration form.
3. In the window that appears, click Drop-Down List.

**What you can do in this window**

Specify questions that allow attendees to choose one single answer or choice on the survey or registration form. Each answer or choice appears in the drop-down list.

**Options in this window**

<table>
<thead>
<tr>
<th>Use this option ...</th>
<th>To ...</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Label for drop-down list box</strong></td>
<td>Compose a question.</td>
</tr>
<tr>
<td><strong>Default choice</strong></td>
<td>Specify which is the default answer or choice.</td>
</tr>
<tr>
<td><strong>Choice 1 to 9</strong></td>
<td>Compose the answers or choices. To add option buttons, use the Add drop-down list.</td>
</tr>
<tr>
<td><strong>Score</strong></td>
<td>Specify a score for each response to the question. For more information, see About lead scores (on page 17).</td>
</tr>
</tbody>
</table>

**About lead scores**

When customizing a survey or registration form, you can specify a score for each response to a question. Your site administrator can later generate a report that shows each attendee’s total score, so you can identify the most qualified leads from the scores as well as the other information you have gathered from the survey or registration form.

During the event, you can have the Attendee List display these two types of information next to the name of each attendee:

- the attendee’s response to the "Company" question on the registration form
the attendee's total lead score based on his or her responses to the questions on the registration form

You can sort the Attendee List based on the scores or search for a company name and gain a better understanding of which attendees should be given priority during the event.

Important: If you want to display lead scores and company names on the Attendee List, you must do these two things on the registration form:

- Use the lead scoring option in the Add Check Boxes, Add Option Buttons, or Add Drop-Down List windows.
- Specify that the "Company" and all questions with assigned scores are required information—that is, select the symbol .

For more information, see Customizing the registration form (on page 11) and About lead scores (on page 17).

About the Add From My Registration Questions/Survey Questions window

How to access this window

If you are creating or editing a post-event survey, do the following:

1. On the Schedule an Event or Edit Event page, go to the Event Description & Options section.
2. Do one of the following:
If this is the first time you create a post-event survey on your Event Center Web site, click **Create post-event survey**.

- If you saved surveys as templates before, click **Select survey**. On the window that appears, click **Create New Survey**.

3 In the window that appears, click **My Survey Questions**.

If you are creating or editing a registration form, do the following:

1 On the Schedule an Event or Edit Event page, go to the Attendees & Registration section.

2 Click the link next to **Registration form**.

3 In the window that appears, click **My Registration Questions**.

**What you can do in this window**

Select questions that you have previously saved, and then add them to this survey or registration form.

**Options in this window**

<table>
<thead>
<tr>
<th>Use this option ...</th>
<th>To ...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Check boxes</td>
<td>Select a question, and then click <strong>Add</strong> to add it to the current form.</td>
</tr>
<tr>
<td>Links for the questions</td>
<td>Edit a question, and then save it.</td>
</tr>
</tbody>
</table>

**Specifying a destination Web page after registration**

You can specify a destination Web page that displays once an attendee submits the registration form.

**To specify a destination URL:**

1 On the Schedule an Event page, go to the Attendees & Registration section.

2 At **Destination URL after registration**, type a URL in the text box.
Inviting participants to your event

To invite attendees and panelists to your event using the WebEx automated email system, do the following:

1. From the Schedule an Event page, create invitation lists.
   For details, see Creating an invitation list and inviting attendees to your event (on page 20) or Creating an invitation list and inviting panelists to your event (on page 25).
2. After you schedule the event, the Send Event Emails page displays immediately.
3. Select the recipients on the page, and click Send Now.

Note: Clicking Send Later takes you to the Event Information page, on which you can send invitation email messages at a later time.

Creating an invitation list and inviting attendees to your event

You can select contacts from an existing address book or add new contacts on your Event Center Web site.

If you have a large number of contacts in a distribution list, you can import the distribution list in the CSV (comma-separated/comma-delimited values) format.

To create an invitation list and invite attendees to your event:

1. On the Schedule an Event page, go to the Attendees & Registration section.
2. Click Create invitation list.
3. In the window that appears, add any of the following:
   - new attendees who are not already contacts in one of your address books. For details, see Adding a new contact to your invitation list (on page 21).
   - contacts and contact groups already in your address books on the Event Center Web site. For details, see Adding existing contacts to your invitation list (on page 23).
   - distribution list in the CSV format. For details, see Importing a distribution list to your invitation list (on page 24).
4 When you finish specifying options on the Schedule an Event page, click Schedule This Event.

5 On the Send Event Emails page, select the recipients, and then click Send Now.

### Send Event Emails

You have successfully scheduled your event.

**Send invitation emails to:**

- Host
- Panelists
- Attendees
- Vendors

[Send Now...]  [Send Later]

**Note:** Clicking Send Later takes you to the Event Information page, on which you can send invitation email messages at a later time.

6 Click OK and Continue on the messages that appear on your screen.

Each attendee that you invite receives an invitation email message, which includes a link that the attendee can click to obtain more information about the event and to join the event.

**Note:** Once you start the event, you can still invite more attendees. For details, see Inviting attendees to an event in progress.

### Adding a new contact to your invitation list

When scheduling an event, you can add a new contact to your invitation list—that is, an attendee who is not already a contact in one of your address books in My WebEx on the Event Center Web site. Once you specify information about a new contact, you can also add the contact to one of your address books.
To add a new contact to your event invitation list:

1. If you have not already done so, click **Create Invitation List** on the Schedule an Event page.
   
   For details, see *Creating an invitation list and inviting attendees to your event* (on page 20) and *Creating an invitation list and inviting panelists to your event* (on page 25).

2. Under New Attendee or New Panelist, provide information about the contact.
   
   For more information about the Time zone, Language, and Locale options, see *About time zones, languages, and locales* (on page 22).

3. Optional. To add the new contact to your Personal Contacts address book, select the **Add new attendee in my address book** or **Add new panelist in my address book** check box.

4. Optional. To add a new panelist as an alternate host, one who can start this event and act as the host, select the **Invite as alternate host** check box.

   **Note:** An alternate host must have an account on your site. In addition, only a panelist can be an alternate host.

5. Click **Add to Invitation List**.
   
   The contact displays under Attendees to Invite or Panelists to Invite.

6. Click **Invite**.

**Tip:**
- To view a list of the attendees or panelists you selected for an event, click **View invitation list** in the Attendees & Registration or Presenters & Panelists section.
- To delete a contact from an attendee or panelist invitation list, click **Edit invitation list** in the Attendees & Registration or Presenters & Panelists section. Select the contact, click **Delete**, and then click **OK**.

**About the time zone, language, and locale options**

*Host only*

For each attendee you plan to invite to your event, you can select a language, time zone, and locale in which your invitation displays text, dates, and times.

You can specify time zones, languages, and locales for an attendee when you are:
adding a new contact (A new contact is an attendee who is not already in one of your address books in My WebEx.)

editing an existing contact (The settings you specify here will replace the contact's original settings.)

**Important:**
- If you customize an email template, attendees will receive customized email messages in your language, rather than in the languages specified in attendee settings.
- If you do not customize an email template, attendees will receive email messages in the languages specified in attendee settings.
- For details about customizing email messages, see About customizing email messages (on page 31).

---

**Adding existing contacts to your invitation list**

When creating event invitation lists, you can select contacts in the following lists:

- **Personal Contacts**—Includes any individual contacts that you have added to your personal address book. If you use Microsoft Outlook, you can import the personal contacts that you keep in an Outlook address book or folder to this list of contacts.

- **Company Address Book**—Your organization's address book, which includes any contacts that your site administrator has added to it. If your organization uses a Microsoft Exchange Global Address List, your site administrator can import its contacts to this address book.

To add an existing contact to your event invitation list:

1. If you have not already done so, click Create Invitation List on the Schedule an Event page.

   For details, see Creating an invitation list and inviting attendees to your event (on page 20) or Creating an invitation list and inviting panelists to your event (on page 25).

2. In the Create Attendee Invitation List window or Create Panelist Invitation List window, click Select Contacts.

3. In the View drop-down list, select one of the following contact lists:
   - Personal Contacts
   - Company Address Book

   The contact list that you selected displays.
4 Select the check box for each individual contact or contact group that you want to add to your list of attendees or panelists.

When selecting contacts, you can do the following:

- In the Index, click a letter of the alphabet to display a list of contacts whose first names begin with that letter. For example, the name Susan Jones appears under S.
- To search for a contact in the list that you are currently viewing, type text that appears in either the contact's name or email address in the Search for box, and then click Search.

5 Do either or both of the following:

- Click Add Attendees or Add Panelists.
- Optional. To add a panelist from your existing contacts as an alternate host, select that contact and click Add as an alternate host.

**Note:** An alternate host must have an account on your site. In addition, only a panelist can be an alternate host.

The contacts that you selected display under Attendees to Invite or Panelists to Invite.

6 To add the selected contacts to your invitation list, click Invite.

Tip:

- To view a list of the attendees or panelists you selected for an event, click View invitation list in the Attendees & Registration or Presenters & Panelists section.
- To delete a contact from an attendee or panelist invitation list, click Edit invitation list in the Attendees & Registration or Presenters & Panelists section. Select the contact, click Delete, and then click OK.

### Importing a distribution list to your invitation list

Adding a large number of contacts to your invitation list is easy if you have them in a distribution list in the CSV (comma-separated/comma-delimited values) format.

To import a distribution list to your event invitation list:

1 If you have not already done so, open the Create Invitation List window from the Schedule an Event page.
For details, see *Creating an invitation list and inviting attendees to your event* (on page 20) or *Creating an invitation list and inviting panelists to your event* (on page 25).

2. Click **Import CSV Files**.

3. Follow the instructions on your screen to upload a distribution list.

4. When the system finishes importing all the contacts in the list, click **Close**.

## Creating an invitation list and inviting panelists to your event

You can select contacts from an existing address book or add new contacts on your Event Center Web site.

If you have a large number of contacts in a distribution list, you can import the distribution list in the CSV (comma-separated/comma-delimited values) format.

To create an invitation list and invite panelists to your event:

1. On the Schedule an Event page, go to the Presenters & Panelists section.

2. Click **Create invitation list**.

3. In the window that appears, add *any* of the following:
   - new attendees who are not already contacts in one of your address books. For details, see *Adding a new contact to your invitation list* (on page 21).
   - contacts and contact groups already in your address books on the Event Center Web site. For details, see *Adding existing contacts to your invitation list* (on page 23).
   - distribution list in the CSV format. For details, see *Importing a distribution list to your invitation list* (on page 24).

4. When you finish specifying options on the Schedule an Event page, click **Schedule This Event**.

5. On the Send Event Emails page, select the recipients and then click **Send Now**.
Chapter 2: Planning an Event

Send Event Emails

You have successfully scheduled your event.

Send invitation emails to:  
☐ Host  
☑ Panelists  
☑ Attendees  
☐ Vendors

6  Click OK and Continue on the messages that appear on your screen.
Each panelist that you invite receives an invitation email message, which includes a link that the panelist can click to obtain more information about the event and to join the event.

Editing an invitation list

When scheduling or editing an event, you can edit your invitation list for both attendees and panelists.

To edit an invitation list:

1  On the Schedule an Event or Edit Event page, go to the Attendees & Registration section or Presenters & Panelists section, as appropriate.

2  Click Edit invitation list.

3  Click the contact's name in the Name column.
Once you click the name of the contact, you can edit the contact information in the Edit Attendee or Edit Panelist section.

4. Make your changes.

5. Click Update Invitation List.
### Sending email messages to participants

<table>
<thead>
<tr>
<th>If you want to ...</th>
<th>See ...</th>
</tr>
</thead>
<tbody>
<tr>
<td>get an overview of sending email messages to your event participants</td>
<td>About sending email messages to participants (on page 28)</td>
</tr>
<tr>
<td>learn about the various email messages you can send or customize when scheduling or editing an event</td>
<td>About the Email Messages section (on page 28)</td>
</tr>
<tr>
<td>include iCalendar attachments in your email messages</td>
<td>Including iCalendar attachments in email messages (on page 31)</td>
</tr>
</tbody>
</table>

### About sending email messages to participants

When scheduling an event, you can choose from various types of participant email messages, such as registration status, reminders, and follow-ups, in the Email Messages section. The WebEx automated email system will send selected email messages at times you specify. For details, see About the Email Messages section (on page 28).

In addition, you can customize the templates by editing, rearranging, or deleting the content and variables—code text that Event Center uses to substitute for your specific event information. For details, see About customizing email messages (on page 31).

### About the Email Messages section

#### How to access this section

On the left navigation bar of your Event Center Web site, under Host an Event, click Schedule an Event, and then go to the Email Messages section.

#### What you can do in this section

Select or customize email messages that you want to send to event participants.

To customize an email message template, click the link for that email message. For example, click the Attendees link to customize the invitation email message to attendees.
To select a type of email message to participants, select the appropriate check box. For example, select the **Thank You for Attending** check box to send a follow-up email message after the event ends.

## Options in this section

<table>
<thead>
<tr>
<th>Using this option ...</th>
<th>You can do the following ...</th>
</tr>
</thead>
</table>
| **Email Format**       | Select **Plain Text** to send all email messages in plain text format.  
                         | Select **HTML** to send all email messages with the formatting you want, such as numbering, bullets, bold face, and italics. |
| **Invitation emails**  | Click the **Attendees** link to customize the invitation email message to attendees.  
                         | Click the **Panelists** link to customize the invitation email message to panelists.  
                         | **Note** For details, see *Customizing an email message for a specific event* (on page 33). |
| **Registration emails**| Select the check boxes to send notifications to registrants about their registration status.  
                         | **Pending**—Notifies that you have received the attendee’s registration and that it is pending approval.  
                         | **Approved**—Notifies that you have accepted the attendee’s registration. This email message contains a link the attendee can click to join the event.  
                         | **Rejected**—Notifies that you have declined the attendee’s registration request. The default email message does not contain a reason for rejection, so you may want to customize the message.  
                         | **Event In Progress**—Sends an email message to the attendees you invite after you start the event. Click this link to customize the email message.  
                         | **Note** To customize the email messages for **Pending**, **Approved**, **Rejected**, and **Event In Progress**, click the links. For details, see *Customizing an email message for a specific event* (on page 33). |
## Chapter 2: Planning an Event

<table>
<thead>
<tr>
<th>Using this option ...</th>
<th>You can do the following ...</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Event updated emails</strong></td>
<td>Customize the email messages that are sent to event participants about event updates. When you update your event, you can choose to send an event updates email to any of the following recipients (These options appear after you click Update This Event on the Edit Event page.):</td>
</tr>
<tr>
<td><strong>All Approved Registrants</strong></td>
<td>Sends an email message to only those whose registration has been approved</td>
</tr>
<tr>
<td><strong>All Attendees</strong></td>
<td>Sends an email message to all the attendees you invite using the WebEx email system</td>
</tr>
<tr>
<td><strong>All Panelists</strong></td>
<td>Sends an email message to all the panelists you invite using the WebEx email system</td>
</tr>
<tr>
<td><strong>Reminder emails</strong></td>
<td>Select the check boxes to send reminders to registrants at specific times.</td>
</tr>
<tr>
<td><strong>1st Reminder</strong></td>
<td>Sends an email message reminding registrants to join the event.</td>
</tr>
<tr>
<td><strong>2nd Reminder</strong></td>
<td>Sends a second email message reminding registrants to join the event.</td>
</tr>
<tr>
<td><strong>Note</strong></td>
<td>To customize the reminder email messages, click the links. For details, see Customizing an email message for a specific event (on page 33).</td>
</tr>
<tr>
<td><strong>Follow-up emails</strong></td>
<td>Select the check boxes to send follow-up email messages to attendees.</td>
</tr>
<tr>
<td><strong>Thank You for Attending</strong></td>
<td>Thanks an attendee for attending the event, and contains information about how the attendee can provide feedback on the event.</td>
</tr>
<tr>
<td><strong>Absentee Follow-Up Email</strong></td>
<td>Informs an absentee that the event has occurred, and provides the host's contact information. Event Center sends this message to each registrant who did not attend the event.</td>
</tr>
<tr>
<td><strong>Note</strong></td>
<td>To customize the follow-up email messages, click the links. For details, see Customizing an email message for a specific event (on page 33).</td>
</tr>
</tbody>
</table>
Including iCalendar attachments in email messages

To let invited participants add the scheduled event to their calendar programs, such as Microsoft Outlook, you can include an iCalendar item in your email messages, such as those for invitation, event updates, and registration confirmation.

To include iCalendar attachments in your email messages:

1. On the Schedule an Event page, go to **Email Messages**.
2. Select **Include iCalendar Attachments**.

Event Center includes an iCalendar attachment, in the .ics format, in your email messages. If a participant opens the .ics file, a meeting item opens. The participant can then save the meeting item in his or her calendar.

Customizing email messages

<table>
<thead>
<tr>
<th>If you want to ...</th>
<th>See ...</th>
</tr>
</thead>
<tbody>
<tr>
<td>get an overview of customizing email messages</td>
<td>About customizing email messages (on page 31)</td>
</tr>
<tr>
<td>customize an email message for an event that you are scheduling or editing</td>
<td>Customizing an email message for a specific event (on page 33)</td>
</tr>
<tr>
<td>customize an email message template for events that you may schedule in the future</td>
<td>Customizing an email message for future events (on page 34)</td>
</tr>
</tbody>
</table>

About customizing email messages

Event Center provides up to three templates for each type of email message. You can customize them on these two levels:

- event level—for a specific event that you are currently scheduling or editing. For details, see *Customizing an email message for a specific event*. (on page 33)
- host level—for all future events you will schedule. The changes you make on this level automatically apply to any future event that you schedule on your Event Center Web site. For details, see *Customizing an email message for future events* (on page 34).
About the Edit Event Email/Template Name: [template name] page

How to access this page

1. Do one of the following, as appropriate:
   - On the left navigation bar of your Event Center Web site, click Host an Event > Email Templates.
   - On the Schedule an Event or Edit Event page, go to the Email Messages section.

2. Select an email template that you want to customize, and then click Edit.

Options on this page

<table>
<thead>
<tr>
<th>Use this option ...</th>
<th>To ...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Email Template Name</td>
<td>Enter a different name for this template if it’s necessary. Available only if you are customizing the template for all future events.</td>
</tr>
<tr>
<td>From name</td>
<td>Enter the sender’s name. This name appears in the email message that participants receive.</td>
</tr>
<tr>
<td>From email</td>
<td>Enter the sender’s email address. This address appears in the email message that participants receive. By default, Event Center uses this variable, %SenderEmailAddress%, which retrieves the corresponding information from the mail server for your Event Center Web site. The default email address is <a href="mailto:messenger@webex.com">messenger@webex.com</a>.</td>
</tr>
<tr>
<td>Reply to email</td>
<td>Enter the email address to which you want all replies to this message to be sent. By default, Event Center uses this variable, %HostEmail%, which retrieves the corresponding information specified in your user profile. Note: To specify a different email address, delete the entire variable—the text and the percentage signs together, and then type the...</td>
</tr>
<tr>
<td>Use this option ...</td>
<td>To ...</td>
</tr>
<tr>
<td>---------------------</td>
<td>--------</td>
</tr>
<tr>
<td></td>
<td>new email address in the box.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Subject</th>
<th>Enter a subject that will appear in the subject line of the email message.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Header image</td>
<td>Click <strong>Add</strong> to add a header image in this email message. Available only in HTML templates.</td>
</tr>
<tr>
<td>Footer image</td>
<td>Click <strong>Add</strong> to add a footer image in this email message. Available only in HTML templates.</td>
</tr>
<tr>
<td>Revert to Default</td>
<td>Revert the template to the original state, which is set up by your site administrator.</td>
</tr>
<tr>
<td>Preview</td>
<td>Preview the email message in the text or HTML format that you selected.</td>
</tr>
<tr>
<td>Save</td>
<td>Save the changes you make.</td>
</tr>
</tbody>
</table>

**Tip:** WebEx recommends that you set up an email account that you can use exclusively for producing events. You can specify that address in the **Reply to email** box. For example, you can set up an account with the address `events@your_company.com`.

### Customizing an email message for a specific event

When you are scheduling or editing an event, you can customize an email message template for the specific event by editing, rearranging, or deleting the content and variables—code text that Event Center uses to substitute for your specific user or event information.
To customize an email message for an event:

1. On the Schedule an Event page or Edit Event page, in the Email Messages section, click the link for the email message that you want to customize.
   
   For more information, see About the Email Messages section (on page 28).

2. Select a template in the Select email message drop-down list, and then click Edit.

3. Make your changes on the Edit Event Email: [template name] page.
   
   For details, see About the Edit Event Email/Template Name: [template name] page (on page 32).

4. To save the changes you make, click Save > OK.

Customizing an email message for future events

You can customize email message templates for all future events you will schedule on your Event Center Web site. The changes you make on this level automatically apply to any future event that you schedule.

You customize an email message template by editing, rearranging, or deleting the content and variables—code text that Event Center uses to substitute for your specific user or event information.

Important: You can delete or rearrange variables, but never change the text in a variable. For example, in this variable, %ParticipantName%, do not change the text ParticipantName within the percentage signs. If you change it, Event Center cannot substitute the correct text from your user or event information.

To customize an email message template for future events:

1. On the left navigation bar of your Event Center Web site, click Host an Event > Email Templates.
2 Choose the type of email message you want to edit in the For: drop-down list, and then click one of the templates in the HTML or plain text section, depending on your need.

3 Click Edit.

4 Make your changes on the Template name: [template name] page. For details, see About the Edit Event Email/Template Name: [template name] page (on page 32).

5 To save the changes you make, click Save.

**Note:** To revert the email message to its original, default state, click Revert to Default.

### About variables in an email template

A variable is composed of text surrounded by two percentage signs. Each variable used in Event Center email templates is replaced in actual messages by corresponding information specified in an attendee’s registration data, in your user profile, on the Event Information page, and so on.

This table describes each of the variables and how you can use them.

<table>
<thead>
<tr>
<th>This variable</th>
<th>Is replaced by...</th>
</tr>
</thead>
<tbody>
<tr>
<td>%AttendeeName%</td>
<td>the first and last names that the attendee specified when registering for or joining the event</td>
</tr>
</tbody>
</table>
| %Disclaimer%          | This variable is replaced by the following text:

  IMPORTANT NOTICE: This WebEx service includes a feature that allows audio and any documents and other materials exchanged or viewed during the session to be recorded. By joining this session, you automatically consent to such recordings. If you do not consent to the recording, do not join the session. |
Chapter 2: Planning an Event

This variable is replaced by...

%DownloadInstruction%
This variable is replaced by the following instructions for downloading the Event Center application:
To join the event more quickly, you can set up the software that you need to join the event before it starts. Go to the URL above, then click Set Up.

%EmailFooter%
This variable is replaced by the following format:
http://www.webex.com

%EnrollmentID%
the registration ID for the attendee
Event Center automatically creates this ID for an attendee after you approve his or her registration request. If this event does not require registration, this variable is replaced by the following text:
This event does not require a registration ID.

Selecting audio conference options

To provide audio during an event, choose from these audio options on the Schedule an Event or Edit Event page:

<table>
<thead>
<tr>
<th>Audio options</th>
<th>Descriptions</th>
</tr>
</thead>
<tbody>
<tr>
<td>WebEx Teleconferencing Service</td>
<td>An integrated teleconference. Enter the number of callers that you expect to join the teleconference in the <strong>Estimated number of callers</strong> box. If you expect more than 125 callers for the teleconference, please contact your WebEx account manager to increase your audio conference capacity. Select one of these types of WebEx teleconferences:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Attendees call in</strong>—Attendees call a phone</td>
</tr>
</tbody>
</table>
Audio options | Descriptions
---|---
| number to join the teleconference and assume the charges for their calls. |
| **Attendees receive a call back** | Attendees provide their phone numbers once they join the event, and then receive call-backs at the phone numbers they provide. You or your organization assumes the charges for the calls. Recorded instructions guide the attendee through the process of connecting to the teleconference. |
| For more information, see *Setting up a teleconference for an event* (on page 39). |

Whether you select **Attendees call in** or **Attendees receive a call back**, you can select any of these options:

- **Allow access to teleconference via global call-in numbers** | Allows attendees in different countries to call in using WebEx international call-in numbers. A list of numbers—such as toll-free or local numbers—appears on attendees' screens once they join the event. For a list of toll-free calling restrictions by country, go to www.webex.com/pdf/tollfree_restrictions.pdf. The phone number displays in a message box on attendees’ screens once they join the event. When an attendee calls the phone number, recorded instructions guide the attendee through the process of entering a teleconference in the event. |

- **Broadcast audio stream to all attendees** | Provides one-way audio stream from a teleconference to attendees’ computers. Rather than connecting to a teleconference, attendees can listen to the audio portion of the event through their speakers or headsets. For more information, see *Broadcasting audio streams to all attendees* (on page 206). |

- **Mute upon entry for all participants** | Mutes participants’ telephones once they join the WebEx teleconference. Panelists can unmute their own phones. However, attendees need the host to unmute their phones. |

| Other teleconference service | A teleconference that a third-party service provides. Enter in the text box instructions for joining a teleconference. The instructions display in a message. |
### Audio options

<table>
<thead>
<tr>
<th>Descriptions</th>
</tr>
</thead>
<tbody>
<tr>
<td>box on attendees’ screens once they join the event. For more information, see <em>Setting up a teleconference for an event</em> (on page 39).</td>
</tr>
<tr>
<td>When you use a third-party service provider, you can select this option:</td>
</tr>
<tr>
<td><strong>Broadcast audio stream to all attendees</strong>—Provides one-way audio stream from a teleconference to attendees’ computers. Rather than connecting to a teleconference, attendees can listen to the audio portion of the event through their speakers or headsets. For more information, see <em>Using a third-party teleconference for audio broadcast</em> (on page 208).</td>
</tr>
<tr>
<td><strong>Note</strong> If more than 500 participants will attend your event, you can use either a third-party teleconferencing service or the WebEx Operator-Assisted Audio Conference Services. To learn more about the WebEx Operator-Assisted Audio Conference Services, contact your WebEx account manager.</td>
</tr>
<tr>
<td><strong>Cisco Unified MeetingPlace Audio Conferencing</strong></td>
</tr>
<tr>
<td>An integrated audio conference. If you select this option, choose the type of conference:</td>
</tr>
<tr>
<td>• <strong>Attendees call in</strong>: Select if you want customers to dial a number to join</td>
</tr>
<tr>
<td>• <strong>Attendees receive call back</strong>: Select if you want customers to type in a phone number and receive a call back from the conferencing service.</td>
</tr>
<tr>
<td>A participant must have a direct phone line to receive a call from the conferencing service. However, a participant without a direct phone line can join an audio conference by dialing a call-in number, which is always available in the meeting window.</td>
</tr>
<tr>
<td>Whichever option you choose, you can select any of these options:</td>
</tr>
<tr>
<td>• <strong>Broadcast audio stream to all attendees</strong>—Provides one-way audio stream from a teleconference to attendees’ computers. Rather than connecting to a teleconference, attendees can listen to the audio portion of the event through their speakers or headsets. For more information, see <em>Broadcasting audio streams to all attendees</em> (on page 206).</td>
</tr>
<tr>
<td>• <strong>Mute upon entry for all participants</strong>—Mutes participants’ telephones once they join the WebEx teleconference. Panelists can unmute their own</td>
</tr>
</tbody>
</table>
Audio options | Descriptions
--- | ---
| Integrated VoIP | A voice conference in which participants use computers with audio capability to communicate over the Internet rather than the telephone system. Integrated VoIP can be either half-duplex, which lets only one attendee speak at a time, or full-duplex, which allows up to two participants to speak at the same time.
For more information, see Setting up an Integrated VoIP conference for an event (on page 40). |
| No Teleconference | No teleconference is available in the event. To provide audio in the event, select Integrated VoIP. |

**Setting up a teleconference for an event**

Teleconferencing options may differ, depending on which options your organization uses.

To set up a teleconference:

1. On the Schedule an Event or Edit Event page, go to Teleconference.
2. Select one of the following options:
   - WebEx Teleconference Service.
     For the WebEx teleconference service, select one of the following:
     - Attendees call in
     - Attendees receive a call back
     Enter the number of estimated callers in the Estimated number of callers box.
   - Cisco Unified MeetingPlace Audio Conferencing.
For Cisco Unified MeetingPlace audio conferencing, select *one* of the following:

- Attendees call in
- Attendees receive a call back

- **Other teleconference service**—The event includes a teleconference that another service provides. Enter in the text box instructions for joining the teleconference. The instructions display in a message box once an attendee joins the event.

3. If you want to allow attendees in different countries to call in using WebEx international call-in numbers, select *Allow access to teleconference via global call-in numbers.*

4. If you want to provide one-way audio to attendees without requiring them to join your teleconference, select *Broadcast audio stream to all attendees.*

5. If you want to mute all participants’ telephones once they join the event, select *Mute upon entry for all participants.*

6. Click *Schedule This Event* or *Update.*

**Note:** Once you schedule the event, instructions for joining the teleconference display in the Join Teleconference dialog box once participants join the event.

---

**Setting up an Integrated VoIP conference for an event**

You can set up Integrated VoIP in addition to or as an alternative to a teleconference.

To set up an Integrated VoIP conference:

1. On the Schedule an Event or Edit Event page, go to *Teleconference.*

2. Select the *Integrated VoIP* check box.

3. Click *Schedule This Event* or *Update This Event.*

**Note:**
- If you set up an Integrated VoIP conference, you must start the conference before the other participants can start using it in the event.
Only participants whose computers meet the system requirements for Integrated VoIP can participate in the conference.

If you use WebEx Recorder to record the event and want to capture audio in the recording, ensure that the correct audio compression scheme is selected. For details, refer to the WebEx Recorder and Player User’s Guide, which is available on the User Guides page on your Event Center Web site.

System requirements for Integrated VoIP

To participate in an Integrated VoIP conference, you must ensure that your computer meets the following system requirements:

- a supported sound card
  
  For a list of supported sound cards, refer to the Frequently Asked Questions page on your Event Center Web site. You can access this page from your site's Support page.

- speakers or headphones

- microphone, if you want to speak during the conference

Tip: For better audio quality and greater convenience, use a computer headset with a high-quality microphone.

Setting up a dual-mode voice conference

You can set up a dual-mode voice conference for an event—that is, an audio conference that includes both a teleconference and an Integrated VoIP conference. In a dual-mode voice conference, participants can use either type of conference.

In a dual-mode voice conference, a participant can listen to audio using either a phone or speakers attached to his or her computer. To speak, a participant can use either a phone or microphone attached to his or her computer.

For details about setting up a teleconference and Integrated VoIP conference, see:

- Setting up a teleconference for an event (on page 39)
- Setting up an Integrated VoIP conference for an event (on page 40)
Chapter 2: Planning an Event

Playing alerts when participants join or leave a teleconference

When scheduling an event, you can specify the type of tone that plays in all participants’ phones once a participant joins or leaves the teleconference. This option is applicable only if you use integrated teleconference.

To specify sound alerts:

1. On the Schedule an Event or Edit Event page, go to Additional Event Options.
2. In the Entry and exit tone drop-down list, choose one of the following options:
   - **Beep**—A simple tone plays once a participant either joins or leaves the teleconference.
   - **Announce name**—Upon joining the teleconference, a participant must record his or her name, which is then played in the teleconference. The participant’s name is also played if he or she leaves the teleconference.
   - **No tone**—No alert plays in participants' phones once a participant joins or leaves the teleconference.

Sharing a presentation or document automatically

When scheduling an event, you can set up a Universal Communications Format (UCF) presentation that plays automatically for the participants while they wait for the event to start.

You can specify one of the following:

- A UCF presentation plays automatically in the content viewer once a participant joins the event. If the presentation contains multiple pages, you can also specify that it automatically advances its pages at a specified interval.
- A Web page appears once a participant joins the event. Participants can then browse Web pages while they wait for you to start the event.

**Important:**

The presentation or document that you select must:
- Be in the Universal Communications Format (UCF).
- Reside in your personal folders in the My WebEx area on your Event Center Web site. You can select a UCF file that already resides in your folders or upload a new file to your folders when scheduling an event.

To automatically share a file once an attendee joins an event:

1. On the Schedule an Event, go to Event Description & Options.
2. At UCF autoplay options, do one of the following:
   - In the text box, type the Web address or URL that you want to share automatically.
   - Locate and upload a UCF file by clicking Add and doing the following on the Add/Select Presentation page:
     - If the file resides in your personal folders on the Event Center Web site, select the file.
     - If the file does not yet reside in your personal folders on the Event Center Web site, click Browse, select the file, and then click Upload. Then select the file.
     - Click Done.
   For details, see About the Add/Select Presentation page (on page 44).
3. If you specify to show a UCF presentation, not a Web page, do one of the following:
   - To specify that the presentation starts automatically when a participant joins, select Start automatically.
   - To allow attendees to control viewing of the presentation, select Allow attendees to control file.
4. Optional. To specify that the presentation plays continuously during auto play, select Continuous play.
5. In the Advance page every drop-down list, select the length of intermittence in seconds between each slide.

Important:

If you share a UCF multimedia presentation that includes rich media files, such as audio or video files, do the following:
Chapter 2: Planning an Event

- Ensure that each media file is embedded in the presentation file or resides on a publicly accessible Web server. If the presentation contains a link to a media file that resides on your computer, participants cannot view that media file. For more information about creating UCF multimedia presentations, refer to the guide *Getting Started with WebEx Universal Communications Toolkit* by going to Support > User Guides on the left navigation bar of your Event Center Web site.

- Ensure that each media file is set to play automatically for participants. For more information about setting this option for a UCF media file, refer to the guide *Getting Started with WebEx Universal Communications Toolkit* by going to Support > User Guides on the left navigation bar of your Event Center Web site.

- Select *Allow attendees to control file* on the Schedule an Event page. If you do not select this option, the pages or slides in the document or presentation will advance automatically, which may prevent some participants from viewing the media files.

### About the Add/Select Presentation page

#### What you can do on this page

- Select a file already in your personal folders on the Event Center Web site to play automatically while participants wait for the event to start.

- Upload a new file to your personal folders on the Event Center Web site to play automatically while participants wait for the event to start.

#### Options on this page

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>File name box</td>
<td>Type the name of the file to upload to your folder.</td>
</tr>
<tr>
<td>Browse button</td>
<td>Click to select a UCF presentation or document that resides in your personal folders.</td>
</tr>
<tr>
<td>Upload button</td>
<td>Click to upload the specified file to your folder.</td>
</tr>
<tr>
<td>Select radio button</td>
<td>Select the button for the file to be added to the event.</td>
</tr>
<tr>
<td>Name button</td>
<td>Indicates the names of the files residing in your folder.</td>
</tr>
<tr>
<td>Description</td>
<td>Describes the folder or file.</td>
</tr>
<tr>
<td>Size</td>
<td>Indicates the size of the folder or file in kilobytes.</td>
</tr>
<tr>
<td>Done button</td>
<td>Click to add the specified file to your event and to have it play automatically while participants wait for the event to start.</td>
</tr>
</tbody>
</table>
Specifying basic information

<table>
<thead>
<tr>
<th>If you want to ...</th>
<th>See ...</th>
</tr>
</thead>
<tbody>
<tr>
<td>specify the event type and topic</td>
<td>Specifying an event type and topic (on page 45)</td>
</tr>
<tr>
<td>automatically delete the event after it</td>
<td>Automatically deleting an event after it ends (on page 46)</td>
</tr>
<tr>
<td>ends</td>
<td></td>
</tr>
<tr>
<td>copy event information from a pre-defined</td>
<td>Using an event template during scheduling (on page 46)</td>
</tr>
<tr>
<td>template to the Schedule an Event page</td>
<td></td>
</tr>
<tr>
<td>create or edit an event template</td>
<td>Creating or editing an event template (on page 47)</td>
</tr>
<tr>
<td>specify an event password</td>
<td>Specifying an event password (on page 48)</td>
</tr>
<tr>
<td>assign the event for a program</td>
<td>Assigning your event to a program (on page 48)</td>
</tr>
<tr>
<td>specify a tracking code</td>
<td>Specifying tracking codes for a scheduled event (on page 49)</td>
</tr>
<tr>
<td>reduce the network bandwidth consumption</td>
<td>Reducing network bandwidth usage (on page 49)</td>
</tr>
<tr>
<td>for joining the event</td>
<td></td>
</tr>
</tbody>
</table>

Specifying an event type and topic

When scheduling an event, you must specify the event type and topic.

To specify an event type and topic:

1. On the Schedule an Event or Edit Event page, choose an event type in the Event type drop-down list.
2. Type a topic for the event in the Event name text box.

Note:
- Your site administrator sets up the event type, which specifies what features are available during an event. If your site administrator specifies more than one event type, you must choose one in the drop-down list.
Automatically deleting an event after it ends

When scheduling an event, you can specify to automatically delete the event from My Meetings in My WebEx after the event ends.

Examples.

- You select the **Delete from My Meetings when completed** option, schedule the event for 10 a.m. to 11 a.m., and then start and end the event. The event will be removed from My Meetings in My WebEx at 11:01 a.m. or at the time you end the event, whichever comes later.

- You leave the **Delete from My Meetings when completed** check box cleared and schedule the event. Then you start and end the event. The event is always listed in My Meetings in My WebEx.

**Note:** Whether or not you select the **Delete from My Meetings when completed** option, you can always run reports from My WebEx to view information about your events. For more information, see *Generating reports* (on page 418).

Using an event template during scheduling

Event templates allow event hosts to shorten scheduling time and store their favorite settings. The **Event template** drop-down list lists the following templates:

- My templates—created by yourself and displayed only if you log in to your Event Center Web site.
Chapter 2: Planning an Event

- Standard templates—created by your site administrator and made available for the event hosts in your organization.
- System template—set up by your WebEx service; the name of the system template is displayed in brackets in the drop-down list.

If you choose to use a template, the information in the template, including the event name, description, password, teleconference options, registration options, customized registration questions, and email templates, is automatically copied to the Schedule an Event page. You can edit the information or options before scheduling the event.

**Note:** The participant list, panelist information, and registrant data are not copied to the Schedule an Event page.

**To choose an event template:**

On the Schedule an Event page or Edit Event page, in the Event template drop-down list, choose a template.

### Creating or editing an event template

You can create or edit a template from the Schedule an Event page. The templates you create or edit on this page will be included under My templates in the Event template drop-down list.

**Note:** Only the site administrator can edit or create the Standard templates. However, you can save a Standard template as a new template under My templates.

**To create an event template:**

1. Do one of the following as appropriate:
   - Specify the options on the Schedule an Event.
   - Choose a template in the Event template drop-down list.
2. Click Save as template on the bottom of the Schedule an Event page.
3. In the window that appears, type the name of the new template in the Template name text box.
4. Click Save.
To edit an existing event template:

1. In the **Event template** drop-down list, choose the template that you want to edit.

   **Note:** You can modify only the templates under *My templates*. Only the site administrator can edit the *Standard templates*.

2. Make your changes to the options in the template.

3. Click **Save as template** on the bottom of the Schedule an Event page.
   
   The **Template name** text box displays the name of the template you chose.

4. Click **Save**.

5. Click **OK** in the confirmation message box.

---

**Specifying an event password**

While scheduling an event, you can set a password that participants must provide to access or view information about the event.

To set an event password:

1. On the Schedule an Event or Edit Event page, go to **Basic Information**.

2. Type a password in the **Event password** box.

   **Note:** An event password cannot contain space or double quotation marks (""").

3. Type the password again in the **Confirm password** box.

---

**Assigning your event to a program**

If you want to add your event to a program on your Event Center Web site, you can do so when scheduling the event. Attendees can register for all the events in a program at one time.

To add an event to a program:

1. On the Schedule an Event or Edit Event page, go to **Basic Information**.

2. Choose a program in the **Program** drop-down list.
   
   A dialog box appears asking you to confirm adding this event to the program you just chose.
3 Click **OK** to add the event to the program list.

This event is grouped with the program you selected and can be viewed on the List of Events by Program page on your Event Center Web site.

To create a new program, click **Add a new Program**. For details, see *Creating a program* (on page 83).

### Specifying tracking codes for a scheduled event

Your site administrator can specify that the tracking code options appear on the Schedule an Event page. Tracking codes can identify your department, project, or other information that your organization wants to associate with your events. Tracking codes can be optional or required, depending on how your site administrator sets them up.

To specify tracking codes for a scheduled event:

1. On the Schedule an Event or Edit Event page, go to **Tracking codes**, and then select a code label in the box.
2. Do one of the following:
   - If a list of codes appear in the box, select a code from the list.
   - Type a code in the appropriate box.

**Tip:** If your site administrator has also specified that the same tracking code options appear in your user profile, you can edit your user profile to specify the tracking codes. The codes then appear automatically on the Schedule an Event page.

### Reducing network bandwidth usage

By selecting the option **Optimize bandwidth usage for attendees within the same network**, you can help reduce the network bandwidth consumption for joining the WebEx event.

**Example.** If you are expecting a large number of attendees, and many of them come from the same network with limited bandwidth, you may want to select the option.

**Note:**

Your site administrator determines which hosts have the privilege of reducing bandwidth usage for their attendees.

To reduce the network bandwidth consumption for joining your event:

1. On the Schedule an Event or Edit Event page, go to **Basic Information**.
2. At **Optimize bandwidth usage for attendees within the same network**, select **Yes**.

### Specifying date and time options

<table>
<thead>
<tr>
<th>If you want to ...</th>
<th>See ...</th>
</tr>
</thead>
<tbody>
<tr>
<td>get an overview of specifying the event time, duration, and time zones</td>
<td>About specifying the event time, duration, and time zones (on page 50)</td>
</tr>
<tr>
<td>specify the event time, duration, and time zones</td>
<td>Specifying the event time, duration, and time zones (on page 51)</td>
</tr>
<tr>
<td>allow attendees to join the event before it starts</td>
<td>Allowing attendees to join the event and teleconference early (on page 54)</td>
</tr>
<tr>
<td>send an email reminder to the host before the event</td>
<td>Sending an email reminder to the host before the event (on page 55)</td>
</tr>
</tbody>
</table>

### About specifying the event time, duration, and time zones

You can specify the time at which you want to start the event, the estimated event duration, and the time zones in which you want to view the event. The estimated duration gives participants an idea as to how much time they need to reserve from their own schedules.
Note:
- The estimated duration is for your planning purposes only. An event does not end automatically after the estimated duration that you specify.
- If you invite attendees to an event, their invitation email messages specify the event's starting time in the time zones that you specified. However, if attendees reside in a different time zone, they can choose to view the starting time in their time zones from the List of Events page on your Event Center Web site.

Specifying the event time, duration, and time zones

When setting up and scheduling an event, you must specify the event time, duration, and time zone.

1. On the Schedule an Event or Edit Event page, go to Date & Time.
2. Do the following:
   - Next to Start date, in the drop-down lists, specify the month, day, and year at which you want to start the event.
   - Next to Start time, in the drop-down lists, specify the time at which you want to start the event.
   - Next to Estimated duration, in the drop-down lists, specify the event duration in hours and minutes.
   - Next to Time zones, in the drop-down list, choose a time zone in which you want to view the event. To specify more time zones, click Display more time zones.

Planning and selecting event time zones

If your event participants are located in different geographical regions, Event Center makes it easy for you to select a suitable time across up to four time zones.
Chapter 2: Planning an Event

Click Plan event time zones to select a suitable time for your participants in different time zone.

The time zones you select will display on the scheduling page and, later, in invitation email messages.

To select time zones and a suitable starting time:

1. On the Schedule an Event or Edit Event page and at the Start time option, click Plan event time zones.
2. Add or select time zones.

This is the time zone your site administrator has designated for your Event Center Web site. To change it, do so at the Time zones option on the Schedule an Event or Edit Event page.

To add time zones, click +.
Chapter 2: Planning an Event

Use the drop-down list to select a time zone.

3 Optional. To save the time zones you selected here for future use, select **Save participants time zones**.

4 Click **Show Time**.

5 Select the most suitable time across the time zones you have selected.

6 Click **Select Time**.

About time zones in invitation email messages

Your invitation email messages include all the time zones, including the base time zone (your own time zone) you have selected when scheduling an event.

---

The time zones you have selected in the scheduling page display in invitation email messages. The first time zone is your base time zone.

If an attendee has a designated time zone in the contact information, the designated time zone will replace your base time zone in the attendee's invitation email message.

**Example.** You have specified these time zones: San Francisco (base time zone), Taipei, Honolulu, and London. Attendee Johnson has "New York" in his setting. Johnson will see this list of time zones in his invitation email message:

- New York
- Taipei
- Honolulu
- London
Chapter 2: Planning an Event

Note:

- Attendees who have user accounts can designate time zones, languages, and locales in their profiles on the Event Center Web site. For more information, see About maintaining your user profile (on page 406).

  If those attendees are already contacts in your address book on the site, you can add them to your event invitation list. Their language and time zone preferences will then display in their invitation email messages. For more information, see Adding existing contacts to your invitation list (on page 23).

- For attendees who are not yet contacts in your address book or do not have any pre-defined preferences on the Event Center Web site, you can designate a time zone, language, and locale for each of them when scheduling an event. For more information, see Adding a new contact to your invitation list (on page 21).

- You can change any attendees' information, including changing the time zone, language, or locale information, by editing the invitation list. For more information, see Editing an invitation list (on page 26).

Allowing attendees to join the event and teleconference early

When scheduling an event, you can choose to allow attendees to join the event and WebEx teleconference before the scheduled starting time. If attendees join an event before the starting time, you receive an email message notifying you that an attendee or panelist has joined your event.

Tip: You can set up a presentation to inform or entertain the participants while they wait for the event to start. For details, see Sharing a presentation or document automatically (on page 42).

To allow attendees to join the event and WebEx teleconference early:

1. On the Schedule an Event or Edit Event page, go to Date & Time.
2. Select the check box for Attendees can join X minutes before the scheduled start time, and then specify how early they can join the event.
3. Optional. To allow attendees to join the WebEx teleconference once they join the event, select the check box for Attendees can also connect to WebEx teleconference.

Note: You can set up a presentation to inform or entertain the participants while
4 Click **Schedule This Event** or **Update**.

### Sending an email reminder to the host before the event

You can send an email reminder to yourself, as the host, before the start of the event.

**To send an email reminder to the host:**

1. On the Schedule an Event or Edit Scheduled Event page, go to **Date & Time**.
2. In the drop-down list next to **Email reminder**, choose how early you want the email to be sent before the event starts.
   - If you do not want an email sent, select **None** in the drop-down list.

### Specifying event descriptions and options

<table>
<thead>
<tr>
<th>If you want to ...</th>
<th>See ...</th>
</tr>
</thead>
<tbody>
<tr>
<td>specify an event description</td>
<td><strong>Specifying an event description</strong> (on page 56)</td>
</tr>
<tr>
<td>format an event description in HTML</td>
<td><strong>Formatting an event description</strong> (on page 56)</td>
</tr>
<tr>
<td>upload an image that attendees can view from the Event Information page</td>
<td><strong>Adding an image to an event description</strong> (on page 56)</td>
</tr>
<tr>
<td>let participants download and cache files before the event starts</td>
<td><strong>Providing event material before an event</strong> (on page 57)</td>
</tr>
<tr>
<td>specify a destination Web page (URL) that attendees see after the event has ended</td>
<td><strong>Specifying a destination URL after an event</strong> (on page 60)</td>
</tr>
<tr>
<td>prevent attendees from sharing rich media files in the event</td>
<td><strong>Preventing event attendees from sharing rich media files</strong> (on page 60)</td>
</tr>
<tr>
<td>request participants to verify that rich media players are installed on their computers</td>
<td><strong>Requesting participants to check their rich media players</strong> (on page 61)</td>
</tr>
<tr>
<td>specify which participants can view the attendee list</td>
<td><strong>Specifying whether to display attendee list to all participants</strong> (on page 61)</td>
</tr>
<tr>
<td>include video in your event</td>
<td><strong>Selecting video options</strong> (on page 62)</td>
</tr>
<tr>
<td>add a post-event survey</td>
<td><strong>Adding a post-event survey</strong> (on page 62)</td>
</tr>
</tbody>
</table>
Specifying an event description

You can specify a description of the event, which attendees can view from the Event Information page before they join the event.

To specify a description of the event:

1. On the Schedule an Event or Edit Event page, go to **Event Description & Options**.
2. In the **Description** text box, type a description of the event.
   
   To format the description in HTML code, see *Formatting an event description* (on page 56).

Formatting an event description

You can format an event description using HTML (Hypertext Markup Language) code. The description can include links to Web pages or images that reside on a publicly accessible Web server on the Internet, such as the server on which your organization’s Web site resides.

If you use a Web page authoring program, you can create a formatted event description using that program and then copy its HTML code and paste it in the **Description** box.

**Tip:** After you format an event description and finish scheduling the event, you can verify whether it appears correctly on the Event Information page.

Adding an image to an event description

You can add a picture to an event description. The picture appears on the Event Information page, which attendees can view before the event starts.

The picture that you add must be a file that meets the following requirements:

- the GIF or JPEG format
- approximately 75 x 38 pixels
- less than 100 KB in size
To add a picture to an event description:

1. On the Schedule an Event or Edit Event page, go to Event Description & Options.
2. Next to Host image, click the link.
   The Upload Your Picture window appears.

3. Click Browse.
4. Select the file that you want to add to your event description.
5. Click Upload.
   Event Center imports your picture and adds it to the Event Information page for the event.

To replace a picture that you added to an event description:
Upload a different picture.
Event Center overwrites the original picture with the new one.

**Providing event material before an event**

When scheduling an event, you can add Universal Communications Format (UCF) files to the Event Information page, from which attendees can download and cache the files on their own computers before the event starts.
Providing event material ahead of time especially benefits attendees with a slower Internet connection because caching files can significantly reduce the loading time during an event.
To add event material to the Event Information page:

1. On the Schedule an Event or Edit Event page, go to Event Description & Options, and then next to Event material, click the link for uploading event material.

   The page that appears displays the files or folders stored in your personal folders in the My WebEx section of your Event Center Web site. For details, see About the Add Event Material page (on page 59).

2. If you have not uploaded the files to your personal folders, click Browse to select the file, and then click Upload.

   You can upload one file at a time.

3. Select the radio button next to the folder that contains the files you want to add to the Event Information page.

   The files in the selected folder appear.

4. Select the check boxes for the files you want to add to the Event Information page, and then click Add.

   The files you have added appear in the Event material section.

5. Optional. Type descriptions of the files in the Description text boxes.

About the Add Event Material page

What you can do on this page

- Select files already in your personal folders on the Event Center Web site to publish to the Event Information page.

- Upload new files to your personal folders on the Event Center Web site and then publish them to the Event Information page.

Attendees can download event material for review before the event starts.
Options on this page

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>File name box</td>
<td>Type the name of the file to upload to your folder.</td>
</tr>
<tr>
<td>Browse button</td>
<td>Click to select a UCF presentation or document that resides in your personal folders.</td>
</tr>
<tr>
<td>Upload button</td>
<td>Click to upload the specified file to your folder.</td>
</tr>
<tr>
<td>Select</td>
<td>Select the check box for the file to be added to the event.</td>
</tr>
<tr>
<td>Name</td>
<td>Indicates the names of the files residing in your folder.</td>
</tr>
<tr>
<td>Description</td>
<td>Describes the folder or file.</td>
</tr>
<tr>
<td>Size</td>
<td>Indicates the size of the folder or file in kilobytes.</td>
</tr>
<tr>
<td>Add button</td>
<td>Click to publish the specified file on the Event Information page on your Event Center Web site, making it available to attendees prior to the event starting time.</td>
</tr>
</tbody>
</table>

Specifying a destination URL after an event

When scheduling an event, you can specify a destination Web page or Web site that displays once the event ends.

To specify a destination URL:

1. On the Schedule an Event or Edit Event page, go to Event Description & Options.
2. Type a destination Web site address (URL) in the Destination URL after event box.

Preventing event attendees from sharing rich media files

Event Center, by default, allows attendees to share Universal Communications Format (UCF) files in an event. When scheduling an event, you can specify to turn off this function for the event.

To prevent attendees from sharing rich media files in the event:

1. On the Schedule an Event page, go to Event Description & Options > Other UCF options.
2 Select **Do not allow attendees to share rich media files for this event**, and then click **Schedule This Event**.

**Requesting participants to check their rich media players**

If you plan to show Universal Communications Format (UCF) multimedia presentations in the event, you can request participants to verify that rich media players are installed on their computers before they join the event. The invitation email messages to invited participants contain this request.

To request participants to verify their media players:

1. **On the Schedule an Event page, go to Event Description & Options > Other UCF options.**
2. **Select Request attendees to verify rich media players**, and then click **Schedule This Event**.

**Specifying whether to display attendee list to all participants**

When scheduling an event, you can specify which event participants can view the entire list of attendees during the event.

To specify who can view the attendee list:

1. **On the Schedule an Event or Edit Scheduled Event page, go to Event Description & Options.**
2. **Next to Attendee list viewing**, select one of the following:
   - **All**—Allows each event attendee to view a list of all attendees during the event.
   - **Host, presenter, and panelists only**—Allows only the event host, presenter, and panelists to view the entire list of attendees. Besides their own names, attendees can view only the names of the host, presenter, and panelists in the participant list.

**Tip:** Each time an attendee joins or leaves an event, the attendee list gets updated. Thus, for events with a large number of attendees, selecting **Host, presenter, and panelists only** can greatly improve the performance of the Event Center application for attendees during an event.
Selecting video options

You can choose to make video available during the event. Only the host and panelists can send and receive video. Attendees can only view video that is being sent.

**Note:** The video feature will only be available if it has been turned on by your site administrator.

To select video options:

1. On the Schedule an Event or Edit Event page, go to **Event Description & Options**.
2. In the **Video** section, select **Turn on video** to make video available during the event.
3. Select **View high-quality video** if would like high-quality video to be available during the event.
   - Video can be as high as 360p resolution (640x360). However, the quality of the video that participants can send and receive depends on each participant's webcam and computer capability, and network speed.
4. Select **View thumbnails** if would like display thumbnail views of those sending video.
5. Click **Schedule This Event** or **Update**.

Adding a post-event survey

When creating a survey, you can do the following:

- add text, multiple-answer, and single-answer questions
- add images
- save the survey as a template for future use

The survey that you add will display on attendees’ screens once the event ends.

To view survey results, you can generate an Event Center attendance report, attendee history report, or event recording report from the My WebEx Reports page in My WebEx. For details, see *Generating reports* (on page 418).
To create a post-event survey and add it to an event:

1. On the Schedule an Event or Edit Scheduled Event page, go to **Event Description & Options**.

2. Do *one* of the following:
   - If this is the first time you create a post-event survey on your Event Center Web site, click **Create post-event survey**.
   - If you saved surveys as templates before, click **Select survey**. On the window that appears, click **Create New Survey**.

3. Type a survey topic and introductory text.

4. Optional. Click **Add** to add a header or footer image.
   For detailed instructions, see *About the Upload or Select Image window* (on page 64).

5. To add survey questions, click **Text Box**, **Check Boxes**, **Option Buttons**, **Drop-Down List**, or **My Survey Questions**.
   For detailed instructions, see *About the Add Text Box window* (on page 13), *About the Add Check Boxes window* (on page 14), *About the Add Option Buttons window* (on page 15), and *About the Add Drop-Down List window* (on page 16).

6. Do *one* of the following:
   - To save the survey for this event, click **Save**.
   - To save the survey as a template for future use and also save it for this event, click **Save As Template**. Provide a template name for this survey or save it to an existing template, and then click **Save**.

7. Click **OK - Use This Survey**.

8. On the Schedule an Event or Edit Scheduled Event page and in the Post-event survey section, select one of these:
   - **Display survey in pop-up window**—Specifies that this survey will display in a separate window
   - **Display survey in main browser window (instead of destination URL)**—Specifies that this survey will display in the main window

**Note:** If you select **Display survey in main browser window (instead of destination URL)** and also specify a destination URL that displays after the event, the destination page will not display after the event.
About the Upload or Select Image window

How to access this window

If you are creating or editing a post-event survey, do the following:
In the Create Survey or Edit Survey: [survey topic] window, click Add next to Header image or Footer image.

If you are editing an email template, do the following:
In the Edit Event Email: [template name] window, click Add next to Header image or Footer image.

What you can do in this window

You can upload or select an image for the selected survey or email template.

Options in this window

<table>
<thead>
<tr>
<th>Use this option ...</th>
<th>To ...</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Upload New image..</strong></td>
<td>Upload a new image to your image library. From the image library, you can add images to the selected survey or email template.</td>
</tr>
<tr>
<td><strong>Add</strong></td>
<td>Add an image to the selected survey or email template. Ensure to select an image before you click Add.</td>
</tr>
<tr>
<td><strong>Trash</strong></td>
<td>Remove an image from the image library.</td>
</tr>
</tbody>
</table>

Specifying other options for attendees

<table>
<thead>
<tr>
<th>If you want to ...</th>
<th>See ...</th>
</tr>
</thead>
<tbody>
<tr>
<td>invite attendees to an event</td>
<td><em>Inviting participants to your event</em> (on page 20)</td>
</tr>
<tr>
<td>allow registrants to invite friends to the event</td>
<td><em>Allowing registrants to invite friends</em> (on page 65)</td>
</tr>
</tbody>
</table>
### Allowing registrants to invite friends

When scheduling an event, you can specify that registrants can invite their friends to your event.

**To allow registrants to invite friends:**

1. On the Schedule an Event or Edit Event page, go to **Attendees & Registration**.
2. Select the check box next to **Invite friends**.

### Specifying a maximum number of registrants

When scheduling an event, you can specify a maximum number of people who can register for your event. When the maximum number of registrants is reached, the last registrant receives a message that the maximum number of registrants has been met.

**To specify a maximum number of registrants:**

1. On the Schedule an Event page or Edit Event page, go to **Attendees & Registration**.
2. Type a number in the **Maximum number of registrants** box.

### Specifying options for presenters & panelists

<table>
<thead>
<tr>
<th>If you want to ...</th>
<th>See ...</th>
</tr>
</thead>
<tbody>
<tr>
<td>invite panelists to an event</td>
<td>[Creating an invitation list and inviting panelists to your event](on page 25)</td>
</tr>
<tr>
<td>allow panelists to upload files to your Event Information page</td>
<td>[Allowing panelists to upload documents](on page 66)</td>
</tr>
</tbody>
</table>
Allowing panelists to upload documents

When scheduling an event, you can specify that panelists can provide you with documents or presentations by uploading them from the Panelist Entrance page. The files uploaded by panelists appear on your Event Information page and your personal folders on your Event Center Web site. You can then download or organize the files before you start the event.

To allow panelists to upload documents:

1. On the Schedule an Event or Edit Event page, go to Presenters & Panelists.
2. Select the check box for Allow panelists to upload documents associated with the event.

Viewing or accessing the files uploaded by panelists

Before starting the event, you can view, download, or organize the files uploaded by panelists.

To view or access the files uploaded by panelists:

1. Log in to your Event Center Web site.
2. Go to either of the following pages:
   - the My WebEx Files page by going to My WebEx > My Files > Folders
   - the Event files section on the Event Information page
Scheduling, Editing, Canceling, and Starting an Event

To schedule, start, edit, or cancel your events, you must have a host account on your Event Center Web site.

<table>
<thead>
<tr>
<th>If you want to ...</th>
<th>See ...</th>
</tr>
</thead>
<tbody>
<tr>
<td>schedule an event</td>
<td>Scheduling an event (on page 67)</td>
</tr>
<tr>
<td>start an event</td>
<td>Starting an event (on page 68)</td>
</tr>
<tr>
<td>edit a scheduled event</td>
<td>Editing a scheduled event (on page 69)</td>
</tr>
<tr>
<td>cancel a scheduled event</td>
<td>Canceling a scheduled event (on page 71)</td>
</tr>
</tbody>
</table>

**Scheduling an event**

The Schedule an Event page on your Event Center Web site lets you plan and schedule an online event according to your needs.

For more information about specifying event details on the Schedule an Event page, see *Planning an Event* (on page 5).

To schedule an event:

1. Log in to your Event Center Web site.
2. On the navigation bar, click **Host an Event > Schedule an Event**.
   
   The Schedule an Event page appears.
Chapter 3: Scheduling, Editing, Canceling, and Starting an Event

3 Planning the event on the page, such as creating invitation lists, customizing the registration form, creating a post-event survey, and so on. For details, see *Planning an Event* (on page 5).

4 Once you finish specifying all the details on the Schedule an Event page, click **Schedule This Event**.

5 On the Send Event Emails page, select the recipients of the invitation email message, and then click **Send Now**.

**Note:** Clicking **Send Later** takes you to the Event Information page, on which you can send event updates email messages at a later time.

6 Click **OK** and **Continue** on the messages that appear on your screen.

The Event Information page appears. You also receive a confirmation email message that includes information about the scheduled event.

**Note:** The Event Information page displays the event addresses for attendees and panelists respectively. You can copy and paste the URLs in your own invitation email messages if you do not plan to use the WebEx automated email system.

---

**Starting an event**

<table>
<thead>
<tr>
<th>If you want to ...</th>
<th>See ...</th>
</tr>
</thead>
<tbody>
<tr>
<td>get an overview of starting an event</td>
<td><em>About starting an event</em> (on page 68)</td>
</tr>
<tr>
<td>start an event from your My WebEx page</td>
<td><em>Starting an event from My WebEx</em> (on page 69)</td>
</tr>
</tbody>
</table>

---

**About starting an event**

Events do not start automatically at scheduled times. Unless you specify that attendees can join before the host, you must first start an event before attendees can join it. For more information, see *Allowing attendees to join the event and teleconference early* (on page 54).
Once you schedule an event, you receive a confirmation email message that includes a link that you can click to start the event. You can also start the event from My WebEx on your Event Center Web site.

### Starting an event from My WebEx

You can start your event from the My WebEx page on your Event Center Web site.

**To start an event from the My WebEx page:**

1. Log in to your Event Center Web site.
2. Click **My WebEx > My Meetings**.
   
   The My WebEx Meetings page appears.
3. Find the event that you want to start, and then click **Start**.
   
   The Event window appears.

   If the event includes an integrated teleconference, the Join Teleconference dialog box appears. Follow the instructions in the dialog box to start the teleconference.

### Editing a scheduled event

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>get an overview of modifying a scheduled event</td>
<td><em>About editing a scheduled event</em> (on page 69)</td>
</tr>
<tr>
<td>modify a scheduled event from your My WebEx page</td>
<td><em>Editing a scheduled event from My WebEx</em> (on page 70)</td>
</tr>
</tbody>
</table>

**About editing a scheduled event**

Once you schedule an event, you can edit it at any time before you start it, including its starting time, topic, password, agenda, invitation lists, and many other options.

If you update any information about an event, including adding or removing attendees, you can choose to send attendees a new invitation email message that informs them that you have modified information about the event. Attendees whom you removed from the attendee list receive an email message informing them that the event was cancelled.
You can edit an event from the confirmation email message that you received after you scheduled the event, or from My WebEx on your Event Center Web site.

**Editing a scheduled event from My WebEx**

You can edit a scheduled event from My WebEx on your Event Center Web site and send event updates email messages to participants.

**To edit a scheduled event from My WebEx:**

1. Log in to your Event Center Web site.
2. Click **My WebEx > My Meetings**.
   
   The My WebEx Meetings page appears.
3. In the **Topic** column, click the topic for the event.
   
   The Event Information page appears.
4. Click **Edit Event**.
   
   The Edit Event page appears.
5. Make your changes.
   
   For details about the options on this page, see *Planning an Event* (on page 5).
6. To apply your changes to the event, click **Update This Event**.
7. On the Send Event Emails page, select the recipients of the event updates email message. If you added participants to your invitation list, you can also send them invitation email messages with the latest event information from this page.
8. Click **Send Now**, and then click **OK** and **Continue** on the messages that appear on your screen.

**Note:** Clicking **Send Later** takes you to the Event Information page, on which you can send event updates email messages at a later time.
Canceling a scheduled event

<table>
<thead>
<tr>
<th>If you want to ...</th>
<th>See ...</th>
</tr>
</thead>
<tbody>
<tr>
<td>get an overview of canceling a scheduled event</td>
<td>About canceling a scheduled event (on page 71)</td>
</tr>
<tr>
<td>cancel a scheduled event</td>
<td>Canceling a scheduled event (on page 71)</td>
</tr>
</tbody>
</table>

About canceling a scheduled event

You can cancel an event that you scheduled at any time. As you are canceling an event, you have the option of sending automatic cancellation email messages to the event participants.

Canceling a scheduled event

Cancel a scheduled event from My WebEx on your Event Center Web site.

To cancel an event you scheduled:

1. Log in to your Event Center Web site.
2. Click My WebEx > My Meetings.
   The My WebEx Meetings page appears.
3. In the Topic column, find the event you want to cancel, select the check box next to it, and then click Delete.
4. Click OK in the message box to confirm that you want to delete the event.
   A message box appears, allowing you to send email messages about this cancellation.
5. Do one of the following, as appropriate:
   - If you want to notify all invited participants, including attendees and panelists, click Yes.
     You also will receive a confirmation email message about this cancellation.
   - If you do not want to send a cancellation email message, click No.
   - If you do not want to cancel this event, click Cancel.
## Scheduling a MeetingPlace Personal Conference meeting

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Get an overview of MeetingPlace Personal Conference meetings</td>
<td><em>About MeetingPlace Personal Conference meetings</em> (on page 74)</td>
</tr>
<tr>
<td>Set up a MeetingPlace Personal Conference meeting</td>
<td><em>Setting up a Personal Conference meeting or MeetingPlace Personal Conference meeting</em> (on page 74)</td>
</tr>
<tr>
<td>Add a MeetingPlace Personal Conference meeting to your calendar</td>
<td><em>Adding a scheduled Personal Conference meeting or MeetingPlace Personal Conference meeting to your calendar program</em> (on page 75)</td>
</tr>
<tr>
<td>Make changes to the MeetingPlace Personal Conference meeting you have scheduled</td>
<td><em>Editing a Personal Conference meeting or MeetingPlace Personal Conference meeting</em> (on page 76)</td>
</tr>
<tr>
<td>Start your MeetingPlace Personal Conference meeting</td>
<td><em>Starting a MeetingPlace Personal Conference meeting</em> (on page 78)</td>
</tr>
<tr>
<td>Cancel your MeetingPlace Personal Conference meeting</td>
<td><em>Canceling a Personal Conference Meeting or MeetingPlace Personal Conference meeting</em> (on page 78)</td>
</tr>
</tbody>
</table>
About MeetingPlace Personal Conference meetings

A MeetingPlace Personal Conference meeting uses your Cisco Unified MeetingPlace audio conferencing account for the audio conference, and does not have an online portion for the meeting. MeetingPlace Personal Conference meetings are only available if your site supports Cisco Unified MeetingPlace audio conferencing and MeetingPlace Personal Conferencing.

Setting up a Personal Conference meeting or MeetingPlace Personal Conference meeting

To set up a Personal Conference meeting or MeetingPlace Personal Conference meeting:

1. Log in to your Event Center website.
2. On the left navigation bar, select Schedule an Event.
3. Select Advanced Scheduler.
   The Advanced Scheduler displays.
4. On the Required Information page, for Meeting type, select Personal Conference or MeetingPlace Personal Conference.
5. Enter the requested information.

**Note:** If you are scheduling a Personal Conference meeting, you do not need to specify a password. By default, the password is the attendee access code in your Personal Conference number account that is specified for this meeting. If you are scheduling a MeetingPlace Personal Conference, you do need to specify a password.

For an overview of this page and the information requested, select the Help button in the upper-right corner of the page.
Chapter 4: Scheduling a MeetingPlace Personal Conference meeting

6 Schedule your event now, or add more details.
   ▪ To schedule your event with these details, select **Schedule Event**
   ▪ To add more options, select **Next** or select another page in the scheduler. After you have added the details you need, select **Schedule Event**.

**Adding a scheduled Personal Conference meeting or MeetingPlace Personal Conference meeting to your calendar program**

Once you schedule a Personal Conference meeting or MeetingPlace Personal Conference meeting, you can add the Personal Conference meeting or MeetingPlace Personal Conference meeting to your calendar program, such as Microsoft Outlook. This option is applicable only if your calendar program supports the **iCalendar** standard, a common format for exchanging calendaring and scheduling information across the Internet.

To add a scheduled Personal Conference meeting or MeetingPlace Personal Conference meeting to your calendar

1 Choose either method:
   ▪ On the Personal Conference Meeting Scheduled page or the Personal Conference Meeting Information page, select **Add to My Calendar**.
   ▪ In the confirmation email message that you receive once you schedule or edit a Personal Conference meeting or MeetingPlace Personal Conference meeting, click the link to add the meeting to your calendar.

A meeting opens in your calendar program.
2. Select the option to accept the meeting request. For example, in Outlook, select **Accept** to add the Personal Conference event item to your calendar.

**Note:**
- If you cancel a Personal Conference meeting or MeetingPlace Personal Conference meeting, the Personal Conference Meeting Deleted confirmation page and the confirmation email message that you receive contains an option that lets you remove the meeting from your calendar program.
- If you invite participants to a Personal Conference meeting or MeetingPlace Personal Conference meeting, the invitation email message that they receive also contains an option to add the meeting to their calendar programs.

---

**Editing a Personal Conference meeting or MeetingPlace Personal Conference meeting**

Once you schedule a Personal Conference meeting or MeetingPlace Personal Conference meeting, you can make changes to it at any time before you start it—including its starting time, topic, agenda, attendee list, and so on.

If you update any information about the Personal Conference meeting or MeetingPlace Personal Conference meeting, including adding or removing attendees, you can choose to send attendees a new invitation email message containing the new details about the meeting. Attendees removed from the attendee list receive an email message letting them know that they are no longer asked to attend.

If you are logged in, you can edit the meeting details by clicking the link in the confirmation email message that you received after you scheduled the Personal Conference meeting or MeetingPlace Personal Conference meeting, or from your list of events in My WebEx.

**To edit Personal Conference meeting or MeetingPlace Personal Conference meeting from the confirmation email message:**

1. Open your confirmation email message, and then click the link to view your Personal Conference meeting information.

   The Personal Conference Meeting Information page appears.

2. Select **Edit**.

3. Make changes to the Personal Conference meeting details.

   For details about the information requested on any page, click the Help button in the upper-right corner of the page.

4. To save your changes to the meeting, select **Save**.
Chapter 4: Scheduling a MeetingPlace Personal Conference meeting

If you invited attendees, a message appears, asking you whether you want to send an updated email invitation to attendees.

5 If a message box appears, click the appropriate update option, and then select **OK**.

The Personal Conference Meeting Information page appears.

You receive a confirmation email message that includes information about the changes that you made to the meeting.

6 Optional. If you added the meeting to your calendar program, such as Microsoft Outlook, on the Event Updated page, select **Add to My Calendar**.

To edit a Personal Conference meeting or MeetingPlace Personal Conference meeting from your list of events on your Event Center Web site:

1 Log in to your Event Center website.

2 On the navigation bar, select **My WebEx**.

   The My Meetings page appears, showing a list of any events that you have scheduled. Personal Conference events have "Personal Conference" in the **Type** column.

3 In the list of events, under **Topic**, click the topic for the event. or click the **Display Info** link.

4 Select **Edit**.

5 Make changes to the Personal Conference meeting details.

   For details about the options on each page, click the Help button in the upper-right corner of the page.

6 Select **Save**.

   If you invited attendees, a message appears, asking you whether you want to send an updated email invitation to attendees.

7 If a message box appears, click the appropriate update option, and then click **OK**.

   If you select **Cancel** in the message box, the Personal Conference meeting is not updated.

8 Optional. If you added the meeting to your calendar program, such as Microsoft Outlook, in the confirmation email message, click the **Update My Calendar** link.
Starting a MeetingPlace Personal Conference meeting

Personal Conference events do not start automatically at scheduled times. You must start the audio portion of the Personal Conference first, and then you can start the online portion of the Personal Conference.

To start a MeetingPlace Personal Conference meeting:

Call the number listed in the confirmation email or on the Personal Conference Event Information page.

To access the MeetingPlace Personal Conference Meeting Information page:

1. Log in to your Event Center service site.
2. On the navigation bar, select **My WebEx**.
   - The My Meetings page appears, showing a list of any events that you have scheduled. Personal Conference meetings are listed as "Personal Conference" in the **Type** column.
3. In the list of events, select the **Topic** or **Display Info** link for your Personal Conference event.
   - The Personal Conference Event Information page displays.
4. If necessary, select the **More Info** link to display all the information about the event.

   Under **Audio conference**, look for the valid phone number or numbers to call for your MeetingPlace Personal Conference event, as well as other information you need to start the meeting. You may need to click the **Show detailed dial-in information** link.

Canceling a Personal Conference Meeting or MeetingPlace Personal Conference meeting

You can cancel any Personal Conference meeting or MeetingPlace Personal Conference meeting you have scheduled. Once you cancel a meeting, you can choose to send a cancellation email message to all attendees whom you invited to the meeting. The Personal Conference meeting is removed automatically from your list of events in My WebEx.
Chapter 4: Scheduling a MeetingPlace Personal Conference meeting

If you are logged in, you can cancel a Personal Conference meeting or MeetingPlace Personal Conference meeting from the confirmation email message that you received after you scheduled the meeting or from your list of events in My WebEx.

To cancel a Personal Conference meeting or MeetingPlace Personal Conference meeting from a confirmation email message:

1. Open your confirmation email message, and then click the link to view your Personal Conference meeting information.
   The Personal Conference Meeting Information page appears.

2. Select **Delete**.
   If you invited attendees, a message appears, asking you whether you want to send a cancellation email message to all attendees whom you invited to the event.

3. In the message box, click **Yes** or **No**, as appropriate.
   If you click **Cancel** in the message box, the meeting is not canceled.
   The Personal Conference Meeting Deleted page appears.

4. Optional. If you added the Personal Conference meeting to your calendar program, such as Microsoft Outlook, on the Personal Conference Meeting Deleted page, click **Remove From My Calendar** to remove the meeting from your calendar.

To cancel a Personal Conference meeting or MeetingPlace Personal Conference meeting on your Event Center website:

1. Log in to your Event Center website.

2. On the navigation bar, select **My WebEx**.
   The My Meetings page appears, showing a list of any events that you have scheduled. Personal Conference meetings are indicated by the words "Personal Conference" in the **Type** column.

3. In the list of events, under **Topic**, click the topic for your Personal Conference meeting.

4. Select **Delete**.
   If you invited attendees, a message appears, asking you whether you want to send a cancellation email message to all attendees whom you invited to the Personal Conference meeting or MeetingPlace Personal Conference meeting.

5. In the message box, click **Yes** or **No**, as appropriate.
   If you click **Cancel** in the message box, the meeting is not canceled.
Chapter 4: Scheduling a MeetingPlace Personal Conference meeting

You receive a cancellation confirmation email message.

6 Optional. If you added the Personal Conference meeting or MeetingPlace Personal Conference meeting to your calendar program, such as Microsoft Outlook, on the Personal Conference Meeting Deleted page, select **Remove From My Calendar** to remove the meeting from your calendar.

### About the Personal Conference Meeting Information page (host)

This page provides the details about the Personal Conference meeting or MeetingPlace Personal Conference meeting you have scheduled.

**What you can do on this page**

- Review the date, time, duration, and other helpful information about the Personal Conference event.
- Click the **More Info** link to view the meeting number, audio conference information, and meeting password. This information can help you start the audio portion of the Personal Conference event.
- Edit the details about the Personal Conference meeting or MeetingPlace Personal Conference meeting.
- Cancel the Personal Conference meeting or MeetingPlace Personal Conference meeting.
- Add the Personal Conference meeting or MeetingPlace Personal Conference meeting to your calendar, if you haven’t already done so.
- Start the online portion of the Personal Conference after the audio portion has started. (Does not apply to MeetingPlace Personal Conference meetings.)

<table>
<thead>
<tr>
<th>Select this button...</th>
<th>To...</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Edit</strong></td>
<td>Edit the details about the Personal Conference meeting or MeetingPlace Personal Conference meeting. For example, you can add attendees, change the Personal Conference number account for this event, or change the date, time, and duration.</td>
</tr>
<tr>
<td><strong>Delete</strong></td>
<td>Cancel the meeting.</td>
</tr>
<tr>
<td><strong>Add to My Calendar</strong></td>
<td>Add this Personal Conference meeting or MeetingPlace Personal Conference meeting to a calendar program, such as Microsoft</td>
</tr>
</tbody>
</table>
Chapter 4: Scheduling a MeetingPlace Personal Conference meeting

<table>
<thead>
<tr>
<th>Select this button…</th>
<th>To…</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Outlook.</td>
</tr>
<tr>
<td></td>
<td>To use this feature, your calendar program must conform with the iCalendar standard, a format used widely across the Internet for exchanging calendar information.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Go Back</th>
<th>Return to the event calendar.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start</td>
<td>Start the online portion of the Personal Conference meeting. This button is only available after you have started the audio portion of the Personal Conference meeting. (Does not apply to MeetingPlace Personal Conference meetings.)</td>
</tr>
</tbody>
</table>

About the Personal Conference Meeting Information page (for attendees)

This page provides the details about Personal Conference meeting or MeetingPlace Personal Conference meeting.

What you can do on this page

- Review the date, time, duration, and other helpful information about the Personal Conference meeting or MeetingPlace Personal Conference meeting.

- Click the More Info link to see the meeting number, audio conference information, and meeting password. This information can help you join the audio portion of the Personal Conference event or the MeetingPlace audio conference.

- Add the meeting to your calendar, if you haven’t already done so

- Join the online portion of the Personal Conference after the audio portion has started. (Does not apply to MeetingPlace Personal Conference meetings.)

Options on this page

<table>
<thead>
<tr>
<th>Click this button…</th>
<th>To…</th>
</tr>
</thead>
<tbody>
<tr>
<td>View Agenda</td>
<td>View Personal Conference meeting or MeetingPlace Personal Conference meeting agenda, if the host has provided it.</td>
</tr>
</tbody>
</table>
**Chapter 4: Scheduling a MeetingPlace Personal Conference meeting**

<table>
<thead>
<tr>
<th>Click this button...</th>
<th>To...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add to My Calendar</td>
<td>Add Personal Conference meeting or MeetingPlace Personal Conference meeting to a calendar program, such as <em>Microsoft Outlook</em>. To use this feature, your calendar program must conform with the iCalendar standard, a format used widely across the Internet for exchanging calendar information.</td>
</tr>
<tr>
<td>Go Back</td>
<td>Return to the event calendar.</td>
</tr>
<tr>
<td>Join</td>
<td>Once the audio portion of the Personal Conference meeting has started, you can select <strong>Join</strong> to join the online portion of the Personal Conference meeting. (Does not apply to MeetingPlace Personal Conference meetings.)</td>
</tr>
</tbody>
</table>
Managing Programs

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>get an overview of managing programs</td>
<td>About managing programs (on page 83)</td>
</tr>
<tr>
<td>create a program</td>
<td>Creating a program (on page 83)</td>
</tr>
</tbody>
</table>

About managing programs

*For hosts only*

Event Center allows you to group live or recorded events in a program for a specific project, product, or audience. A program allows attendees to conveniently register for all its events at one time. All the events in a program share the same registration form.

You can modify the programs you created on your Event Center Web site at any time.

Creating a program

<table>
<thead>
<tr>
<th>If you want to ...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>get an overview of creating a program</td>
<td>About creating a program (on page 84)</td>
</tr>
<tr>
<td>create a program</td>
<td>Creating a program (on page 84)</td>
</tr>
<tr>
<td>obtain the program Web address, or URL</td>
<td>Obtaining event, program, and recording URLs (on page 85)</td>
</tr>
<tr>
<td>add live events to a program</td>
<td>Adding live events to a program (on page 89)</td>
</tr>
</tbody>
</table>
### Chapter 5: Managing Programs

<table>
<thead>
<tr>
<th>If you want to ...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>add recorded events to a program</td>
<td>Adding recorded events to a program (on page 90)</td>
</tr>
<tr>
<td>view, modify, or delete a program</td>
<td>Viewing, modifying, and deleting a program (on page 90)</td>
</tr>
</tbody>
</table>

### About creating a program

You can create a program to group related events for a specific project, product, or audience. After you add events to a program, you can obtain the URL of the program from the program information page and invite participants to register for the associated events by sending them the URL.

### Creating a program

You can create a program to group your live or recorded events.

To create a program:

1. Do any of the following:
   - On the left navigation bar, click **Manage Programs > Create New Program**.
   - On the Schedule an Event page or Edit Event page, under **Event Time and Duration**, click **New program**.
     - The event that you are scheduling or editing is automatically added to this new program.
   - On the navigation bar, click **Manage Programs > List of Programs > New program**.
     - The Create a program page appears.

2. Specify the options on the page, and then click **Create program**.
   - For details about the options you can specify for a program, see **About the Create a program page** (on page 87).

3. If you created the new program from the Schedule an Event or Edit Event page, click **OK** in the message box, informing you that adding this event changes its registration options to be the same as those of the program.
   - This program displays on the Manage Programs page.
Obtaining event, program, and recording URLs

After you schedule an event, create a program, or upload a recording to your Event Center Web site, URLs, or event addresses, for the event, program, or recording display on the information page. You can invite attendees and panelists to an event or events in a program by sending them the appropriate URLs.

If you want to manually add a source ID for an event, a program, or an event recording, obtain the attendee URL and then publish the URL with the ID in your email messages. For more information, see Manually appending a source ID to your URL (on page 94).

To obtain an event URL:

Go to the Event Information page by using one of these methods:

- Go to My WebEx > My Meetings; then click the name of the event in the Topic column.
- Obtain it after you schedule an event.

To associate source IDs, use the event address for attendees.

To obtain a program URL:

1. On the left navigation bar of your Event Center Web site, click Manage Programs > List of Programs.
2. Go to the program page by clicking the name of the program in the Topic column. The URL is on the page.

To obtain a recording URL:
1. On the left navigation bar of your Event Center Web site, click **Host an Event > My Event Recordings**.
2 Go to the Recording Information page by clicking the name of the recording in the Topic column.

The URL is on the page.

---

**About the Create a program page**

**How to access this page**

Do *any* of the following:

- On the left navigation bar, click **Manage Programs > Create New Program**.
- On the Schedule an Event page or Edit Event page, under **Event Time and Duration**, click **New program**.
Chapter 5: Managing Programs

- The event that you are scheduling or editing is automatically added to this new program.
- On the navigation bar, click Manage Programs > List of Programs > New program.

What you can do on this page
- Specify the program details.
- Specify the registration options.
- Customize the program information page using the HTML code.

Options on this page

<table>
<thead>
<tr>
<th>Use this option ....</th>
<th>To ....</th>
</tr>
</thead>
<tbody>
<tr>
<td>Program name</td>
<td>Type the title of the program.</td>
</tr>
</tbody>
</table>
| Description         | Type a description for the program.  
                       **Note** You can format the description using the HTML code. |
| Expected registration | Specify the expected number of registrants. |
| Budget              | Specify the budget for the program. |
| Email               | Type the host's email address. |
| Program status      | Specify whether the program is Listed or Unlisted.  
                       A Listed program appears on the List of Events by Program page for anyone who visits your Event Center Web site.  
                       An Unlisted program does not appear on the List of Events by Program page. Attendees can view the upcoming events in the program if you send them the URL for the program. |
| Registration ID required | Specify whether attendees must register before they can join the events in the program. |
| Password required to register | Specify whether to require a password before an attendee can register for the events in the program. |
| Customize registration form | Customize the registration form by clicking Customize.  
                       The way you customize a program registration form is the same as you would an event registration form. For details, see  
                       **Note** All events in a program share the same registration form. |
Use this option .... | To .... 
---|--- 
Invite friends | Allow registrants to invite their friends to the events in the program. 
Destination URL after registration | Specify a Web address, or URL, that displays once an attendee finishes registering for an event in the program. 
Images | Upload photos that you want to show on the program information page. 
**Note** After uploading the images, you reference to those images from the Custom HTML Area section. 
Custom HTML Area | Format this area using the HTML code, including referencing to the images you upload in the Images section. 
Use the drop-down list to place this customized area above or below the title of the program.

---

**Adding live events to a program**

You can add events to a program from either of the following pages:

- the Schedule an Event page or Edit Event page
- the Manage Programs page

**To add a live event to a program when scheduling or editing the event:**

1. On the Schedule an Event page or Edit Event page, under Event Time and Duration, choose a program in the Program drop-down list.
2. Click OK in the message box, informing you that adding this event changes its registration options to be the same with those of the program.

**To add a live event to a program from the Manage Programs page:**

1. On the navigation bar, expand Manage Programs, and then click List of Programs.

   The Manage Programs page appears.
2. In the Topic column, click the title of the program to which you want to add an event.
3. Do one of the following:
   - If you have already scheduled the event that you want to add to the program, click the Add other events to this program link.
The window that appears lists the events you have scheduled.

Select the event that you want to add to the program, and then click Add. Click OK in the message box, informing you that adding this event changes its registration options to be the same with those of the program. Then click Continue.

- If you have not scheduled the event that you want to add to the program, click New event to schedule the event and add it to the program at the same time.

For details about scheduling an event, see Planning an Event (on page 5).

**Note:** All events in a program share the same registration form. Attendees can choose to register for all the events in a program at one time.

Adding recorded events to a program

If you have recorded events that you hosted, you can add them to a program.

To add a recorded event to a program:

1. On the navigation bar, expand Manage Programs, and then click List of Programs.
   The Manage Programs page appears.
2. In the Topic column, click the title of the program to which you want to add a recorded event.
3. Click the Add other recordings to this program link.
4. In the window that appears, select the recordings that you want to add to the program, and then click Add.
5. Click Continue in the window that appears.

Viewing, modifying, and deleting a program

Your Event Center Web site displays all the programs that you and the other hosts created on the Manage Programs page. You can view a program and add events or recordings to it at any time.
Note: You cannot modify or delete the programs the other hosts created.

To obtain information about a program:
1. On the navigation bar, expand Manage Programs, and then click List of Programs.
   The Manage Programs page appears.
2. In the Topic column, click the title of the program that you want to view.
   The program information page appears.

To modify a program:
1. On the navigation bar, expand Manage Programs, and then click List of Programs.
   The Manage Programs page appears.

   Note: The programs you created have check boxes next to them.

2. In the Topic column, click the title of the program that you want to modify.
3. Click Edit program.
   The Edit a program page appears.
4. Make your changes, and then click Update program.
   You receive an automatic email message about this update.

To delete a program you created:
1. On the navigation bar, expand Manage Programs, and then click List of Programs.
   The Manage Programs page appears.

   Note: The programs you created have check boxes next to them.

2. Select the check box for the program you want to delete.
3 Click **Delete**.

4 Click **OK** to confirm the deletion.

The Program Deleted page appears.
Tracking Your Attendees

<table>
<thead>
<tr>
<th>If you want to ...</th>
<th>See ...</th>
</tr>
</thead>
<tbody>
<tr>
<td>get an overview of how to use source IDs to track your attendees</td>
<td>About tracking your attendees (on page 93)</td>
</tr>
<tr>
<td>manually append a source ID to your event URL</td>
<td>Manually appending a source ID to your event URL (on page 94)</td>
</tr>
<tr>
<td>add a source ID for an email vendor from the Event Information page</td>
<td>Associating a source ID with a vendor (on page 97)</td>
</tr>
</tbody>
</table>

**About tracking your attendees**

Event Center allows you to gauge the effectiveness of the different methods you use to market your events by tracking from which sources attendees join or register for an event and view a recording.

To track your attendees, you add a source ID to the end of the URL in your email messages for:

- live events
- programs (Event Center captures source IDs for a program and each live event in the program.)
- event recordings

**Example.** You use vendors to promote your events. You can assign a source ID for each vendor that will send invitation or recording email messages for you. Event Center captures the source ID when an attendee clicks the URL link in the event, program, or recording email messages from a particular vendor.
You or your site administrator can then generate an attendance, a registration, or a recording report that shows each attendee’s source ID. You can compare and analyze which marketing method is more effective than another.

There are two ways of appending a source ID to an event, a program, or a recording URL:

- Manually append a source ID by adding &SourceId= to the event URL, and publish this new URL in your email messages.
- Associate a source ID with a vendor’s email address, if you use vendors to forward your email messages to potential attendees.

### Manually appending a source ID to your URL

You can manually append a source ID to your event, program, or recording URL. For details about obtaining such URLs, see *Obtaining event, program, and recording URLs* (on page 85).

To manually append a source ID to an event, a program, or a recording URL:

1. Obtain the attendee URL.
2. Add &SourceId=xxx at the end of the URL, and then publish it in your email message.

**Example.** An event URL with a source ID can be

```
https://[eventURL]&SourceId=CompanyWebsite or
https://[eventURL]&SourceId=anynumber
```

*Note:* You can specify up to 512 characters, in either letters or numbers, for a source ID.

### Obtaining event, program, and recording URLs

After you schedule an event, create a program, or upload a recording to your Event Center Web site, URLs, or event addresses, for the event, program, or recording display on the information page. You can invite attendees and panelists to an event or events in a program by sending them the appropriate URLs.
If you want to manually add a source ID for an event, a program, or an event recording, obtain the attendee URL and then publish the URL with the ID in your email messages. For more information, see *Manually appending a source ID to your URL* (on page 94).

To obtain an event URL:

Go to the Event Information page by using one of these methods:

- Go to **My WebEx > My Meetings**; then click the name of the event in the Topic column.
- Obtain it after you schedule an event.

To associate source IDs, use the event address for attendees.

To obtain a program URL:

1. On the left navigation bar of your Event Center Web site, click **Manage Programs > List of Programs**.
2 Go to the program page by clicking the name of the program in the Topic column. The URL is on the page.

<table>
<thead>
<tr>
<th>Event Program</th>
</tr>
</thead>
<tbody>
<tr>
<td>Creator:</td>
</tr>
<tr>
<td>Expected registration:</td>
</tr>
<tr>
<td>Budget:</td>
</tr>
<tr>
<td>Email:</td>
</tr>
<tr>
<td>Program URL:</td>
</tr>
<tr>
<td>Program status:</td>
</tr>
<tr>
<td>Registration ID required:</td>
</tr>
</tbody>
</table>

To obtain a recording URL:

1 On the left navigation bar of your Event Center Web site, click **Host an Event** > **My Event Recordings**.

2 Go to the Recording Information page by clicking the name of the recording in the Topic column. The URL is on the page.
Associating a source ID with a vendor

You can specify a source ID and then associate it with a vendor’s email address.
**Overview of associating a source ID with a vendor**

**programs**

**recordings**

### Associating source IDs with vendors for an event

Follow these steps:

To associate source IDs with vendor email addresses for an event:

1. Go to the Send Event Emails portion of the Event Information page by using one of these methods:
   - Go to *My WebEx > My Meetings*; click the name of the event in the Topic column; then click "Send Emails".
   - If you just finish scheduling an event, the Send Event Emails portion displays immediately.
2 Select **Vendors**.

3 Enter up to three vendors’ email addresses in the **Email address** boxes, and enter source IDs in the corresponding **Source ID** boxes.

4 Click **Send Now**.

   The vendors receive an invitation email message that they can forward to potential attendees. The email message includes an event URL with the source ID that you associated with a particular vendor. If an attendee clicks the link from the vendor’s email message, Event Center captures the source ID for the attendee.

**Associating source IDs with vendors for a program**

Follow these steps:

**To associate source IDs with vendor email addresses for a program:**

1 On the left navigation bar of your Event Center Web site, click **Manage Programs** > **List of Programs**.

2 Go to the program page by clicking the name of the program in the Topic column.

3 On the program page, click **Send to Vendor**.

4 Enter up to three vendors’ email addresses in the **Email address** boxes, and enter source IDs in the corresponding **Source ID** boxes.

5 Click **Send**.
The vendors receive an invitation email message that they can forward to potential attendees. The email message includes the program URL with the source ID that you associated with a particular vendor. If an attendee clicks the link from the vendor’s email message, Event Center captures the source ID for the attendee.

**Associating source IDs with vendors for an event recording**

Follow these steps:

**To associate source IDs with vendor email addresses for an event recording:**

1. On the left navigation bar of your Event Center Web site, click **Host an Event > My Event Recordings**.

2. Go to the Recording Information page by clicking the name of the recording in the Topic column.

3. On the Recording Information page, click **Send to Vendor**.

4. Enter up to three vendors’ email addresses in the **Email address** boxes, and enter source IDs in the corresponding **Source ID** boxes.

5. Click **Send**.

The vendors receive an invitation email message that they can forward to potential attendees. The email message includes the recording URL with the source ID that you associated with a particular vendor. If an attendee clicks the link from the vendor’s email message, Event Center captures the source ID for the attendee.
Managing Registration Requests

If you want to... | See...
---|---
get an overview of managing registration requests from attendees | About managing registration requests (on page 101)
manually approve or reject registration requests | Approving or rejecting registration requests (on page 102)
send email reminders to attendees whose registration has been approved | Sending email reminders to registrants (on page 103)

About managing registration requests

You can manage attendees’ registration requests by doing the following:

- Automatically approve registration requests by attendees. Your site administrator must set up this option for you.
- Manually approve or reject registration requests if you required approval when scheduling or editing the event.
- Send email messages to registrants about their registration status—that is, pending, approved, or rejected.
- Send reminder email messages to the attendees whose registration has been approved.
Chapter 7: Managing Registration Requests

Approving or rejecting registration requests

If you require approval for registration requests when scheduling or editing an event, you must review and manually approve or reject the requests.

For details about specifying approval rules for registration, see Setting approval rules for registrants (on page 10).

To approve or reject registration requests for an event:

1. Log in to your Event Center Web site.
2. Optional. To specify that attendees will receive registration status email messages once you process their requests, do so on the Schedule an Event or Edit Event page. For details, About sending email messages to participants (on page 28).
3. Click My WebEx > My Meetings.
   
   The My WebEx Meetings page appears. The page shows the number of requests that are pending (?), accepted (√), and rejected (×) for each scheduled event.
4. Find the event, and then click the link for one of the following:
   
   - **Requests Pending (?)**—Each pending request lists the registrant’s name, the registrant’s email address, and the date and time on which the registrant submitted the request.
   
   - **Requests Approved (√)**—Each accepted request lists the registrant’s name, the registrant’s email address, and the date and time on which the registrant submitted the request.
   
   - **Requests Rejected (×)**—Each rejected request lists the registrant’s name, the registrant’s email address, and the date and time on which the registrant submitted the request.
5. Optional. To review details about each registration, on the page that appears, click the link for the name of the registrant.
6. Select **Approved** or **Rejected** for each individual registrant or do one of the following, as appropriate:
   
   - To accept all requests for this event, click **Accept All**.
   
   - To make all requests pending for this event, click **Make All Pending**.
   
   - To reject all requests for this event, click **Reject All**.
7. Click **Update**.
The email message for approved registrants contains the registration ID, event password, if any, event number, and a link they can click to join the event.

**Sending email reminders to registrants**

You can send email reminders to attendees whose registration has been approved.

**To send email reminders to registrants:**

1. Log in to your Event Center Web site.
2. Click **My WebEx > My Meetings**.

   The My WebEx Meetings page appears. The page shows the number of requests that are pending, approved, and rejected for each scheduled event.

3. Find the event for which you want to send reminder email, and then click the link under the Requests Approved symbol.

4. On the page that appears, click **Send Email**.

5. In the message box that appears, click **OK**.

6. On the Email confirmed page that appears, click **OK**.

**Tip:** When scheduling or editing an event, you can also specify that approved registrants automatically receive email reminders at the date and time you specify.
Conducting a Practice Session

Practice sessions allow the host, presenter, and all other panelists to practice an event before starting it for all participants. In a sense, practice sessions are similar to working behind a curtain for dress rehearsals. Practice sessions are not visible to event attendees, and the event production team can perform all event functions in a practice session.

If a teleconference has been started in the main event when the host starts a practice session, the production team automatically enters a subconference, away from the main teleconference. Conversations in the subconference are private. Therefore, attendees outside the practice session cannot hear about the practice.

If an Integrated VoIP conference has been started in the main event when the host starts a practice session, the production team remains in the conference. Attendees outside the practice session cannot hear about the practice.

**Note:** The production team is composed of the host, presenter, and all other panelists.

Setting up a practice session

Before the host starts a practice session, all panelists should join the event. The host, presenter, and panelists should have all presentation material ready to share in the practice session.

**Tip:**
- Create a slide presentation for attendees to view while the production team is in a practice session.
Open the slide presentation and set it to autoplay before you start the practice session. If you do not have a presentation for attendees to view while a practice session is in progress, they see a message in their Event windows stating that the production team is in a practice session.

- Start the practice session early enough before the event so you can finish it before your event is scheduled to start.

The following table outlines what the production team and attendees can view once the host starts a practice session.

<table>
<thead>
<tr>
<th>Feature</th>
<th>Production Team</th>
<th>Attendees</th>
</tr>
</thead>
<tbody>
<tr>
<td>Participants panel</td>
<td>Can view the entire participants list.</td>
<td>The Panelists list appears grayed out and is unavailable.</td>
</tr>
<tr>
<td>Q &amp; A sessions</td>
<td>Can receive and answer questions sent by attendees.</td>
<td>Can send questions to the production team.</td>
</tr>
<tr>
<td>Chat</td>
<td>- Can send chat messages among team members.</td>
<td>- Cannot view chat messages within the practice session unless a production team member sends chat messages to All Attendees.</td>
</tr>
<tr>
<td></td>
<td>- Cannot receive chat messages sent by attendees.</td>
<td>- Cannot chat with the production team.</td>
</tr>
<tr>
<td></td>
<td>- Can send chat messages to attendees by selecting All Attendees in the Send to drop-down list.</td>
<td>- If the host grants chat privileges, an attendee can chat with other attendees by sending chat messages to All Attendees.</td>
</tr>
<tr>
<td>Document sharing</td>
<td>Cannot view documents, presentations, or applications that were opened before the host starts the practice session.</td>
<td>Can view documents, presentations, and Web content shared before the host starts the practice session.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Cannot view any.</td>
</tr>
</tbody>
</table>
### Chapter 8: Conducting a Practice Session

<table>
<thead>
<tr>
<th>Feature</th>
<th>Production Team</th>
<th>Attendees</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Application sharing or desktop sharing</strong></td>
<td>The host must stop any desktop or application sharing before starting the practice session.</td>
<td>Cannot view any desktop or applications shared during the practice session.</td>
</tr>
<tr>
<td></td>
<td>Any desktop or application shared within the practice session can be viewed only by the production team.</td>
<td></td>
</tr>
<tr>
<td><strong>Browser sharing</strong></td>
<td>The host must stop any browser sharing before starting the practice session.</td>
<td>Cannot view any shared browsers during the practice session.</td>
</tr>
<tr>
<td></td>
<td>Any browser shared within the practice session can be viewed only by the production team.</td>
<td></td>
</tr>
<tr>
<td><strong>Recording and playback</strong></td>
<td>Recording and playback is available to the production team.</td>
<td>Recording and playback is available to attendees, although attendees can record only the presentations outside the practice session.</td>
</tr>
<tr>
<td><strong>Polling</strong></td>
<td>The poll coordinator can open a poll that was created or loaded (but not opened) outside the practice session.</td>
<td>Can view a poll opened before the host starts the practice session.</td>
</tr>
<tr>
<td></td>
<td>Can prepare poll questionnaires, and test opening and closing the polls.</td>
<td>Cannot view any polls opened within the practice session.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>If, within the practice session, the poll coordinator closes the poll that the attendees are viewing, the poll closes for the attendees.</td>
</tr>
<tr>
<td><strong>Video</strong></td>
<td>Can view video within the practice session.</td>
<td>Cannot view video after the host starts a practice session.</td>
</tr>
<tr>
<td><strong>Teleconference</strong></td>
<td>Automatically enters a subconference. The audio conversations are private within the</td>
<td>Can join and stay in the main teleconference, but they cannot hear.</td>
</tr>
</tbody>
</table>
**Feature**

<table>
<thead>
<tr>
<th>Production Team</th>
<th>Attendees</th>
</tr>
</thead>
<tbody>
<tr>
<td>practice session.</td>
<td>conversations in the practice session.</td>
</tr>
</tbody>
</table>

**Integrated VoIP**

- The host can start an Integrated VoIP conference within the practice session.
- Can join an Integrated VoIP conference and speak within the practice session.
- Cannot hear the conversations in the practice session.

---

### Starting a practice session

Once the host starts a practice session, attendees who have joined the event cannot view any activities in the practice session.

**Note:**

- Only the host can start and end a practice session.
- If a host designates a panelist or presenter as an attendee during a practice session, the person is removed from the practice session.

To start a practice session:

1. Optional. Open the presentation that attendees can view while the production team is in a practice session. Set the presentation to automatically advance pages.

**Note:** Once the host starts a practice session, the production team cannot access the presentations or documents that the presenter opened in the Event window before starting the practice session. To use the same presentations or documents in the practice session, the presenter must open them again during the practice session.

2. In the Event window, on the **Event** menu, choose **Start Practice Session**.

   The practice session starts. The host, presenter, and panelists automatically join the practice session. Event attendees can view any presentation that the host or presenter opened before starting the practice session; they also see a message in the Event window that the production team is currently in a practice session.

3. Rehearse the event, such as opening presentations or preparing a poll questionnaire that the production team will use during the actual event.
Important: Before you end a practice session, ensure to close any shared documents, presentations, whiteboards, Web content, and opened poll that you do not want to share with attendees yet. If you do not close them, attendees can view them once you end the practice session.

Ending your practice session

When you finish your practice session, on the Event menu, choose End Practice Session.

The practice session ends. Event attendees can now view the activities in the Event window.

Important: Before you end a practice session, ensure to close any shared documents, presentations, whiteboards, Web content, and opened poll that you do not want to share with attendees yet. If you do not close them, attendees can view them once you end the practice session.
Joining an Event As a Panelist

<table>
<thead>
<tr>
<th>If you want to ...</th>
<th>See ...</th>
</tr>
</thead>
<tbody>
<tr>
<td>get an overview of joining an event</td>
<td>About joining an event as a panelist (on page 111)</td>
</tr>
<tr>
<td>join an event from your invitation email message</td>
<td>Joining an event from an email invitation (on page 112)</td>
</tr>
<tr>
<td>join an event from the URL for the panelist entrance</td>
<td>Joining an event from a URL (on page 113)</td>
</tr>
<tr>
<td>obtain event information</td>
<td>Obtaining event information (on page 113)</td>
</tr>
<tr>
<td>upload files for the host before the event starts</td>
<td>Uploading files (on page 114)</td>
</tr>
</tbody>
</table>

**Note:** The event host may choose to record the event.

### About joining an event as a panelist

*Panelists only*

If the host invites you to an event, you receive an invitation email message that contains a link you can click to join the event. Once you click the link, the Panelist Entrance page appears. On that page, provide the required information before you can join the event.

If you did not receive an invitation email message for an event, contact your host to obtain the URL for the Panelist Entrance page. Then join the event from the URL.
Chapter 9: Joining an Event As a Panelist

For more information, see About the Panelist Entrance page (on page 112).

**Note:** If you have not yet set up the Event Center application on your computer, you can do so before joining an event to avoid a delay. Otherwise, once you join an event, your Event Center Web site automatically sets up the application on your computer. For more information about setting up Event Center on your computer, see Setting up Event Center (on page 1).

### About the Panelist Entrance page

**Panelists only**

To access this page, in your invitation email message, click the link for joining the event.

Panelists join an event via the Panelist Entrance page. Before joining an event, you must provide required information on the page.

Provide the following information, as required, on the Panelist Entrance page, and then click **Submit**:

- **First name, last name, and email address**—The information you provide here must match what the host specifies when scheduling the event. Otherwise, you cannot join the event.
- **Panelist Password**—The invitation email message you receive from the host contains the panelist password, if any.

**Important:**

- Do not share the panelist password with event attendees. Attendees must join an event from a different "entrance." By not disclosing the panelist password, you can prevent attendees from entering the event as panelists.
- If a message appears informing you that you did not provide the matching information, verify it in your invitation email message or contact the host.

### Joining an event from an email invitation

**Panelists only**
If you receive an invitation email message for an event, you can join it from the email message. You can enter the event before the host starts it.

To join an event from an invitation email message:
1. Open the email message, and then click the appropriate link.
   The Panelist Entrance page appears.
2. Provide the required information, and then click **Submit**.
   For details, see *About the Panelist Entrance*. (on page 112)
   The Event Information page appears.
3. Click **Join**.
   The event window appears.
   If you are the first participant in the event, the host will join shortly.

**Joining an event from a URL**

*Panelists only*

If you did not receive an invitation email message for an event, contact the event host to obtain the URL for the Panelist Entrance page.

To join an event from the URL for the Panelist Entrance page:
1. Go to the URL that the host gave to you.
   The Panelist Entrance page appears.
2. Provide the required information, and then click **Submit**.
   For details, see *About the Panelist Entrance page* (on page 112).
   The Event Information page appears.
3. Click **Join**.
   The event window appears.
   If you are the first participant in the event, the host will join shortly.

**Obtaining event information**

*Panelists only*
From the Event Information page, you can obtain the event information, such as viewing other panelists’ information and event descriptions, and downloading event materials.

On this page, you can also upload the files you are going to use in the event so the host can view or organize them before the event starts. For details, see *Uploading files* (on page 114).

To access the Event Information page:

1. Do *one* of the following as appropriate:
   - Open the invitation email message you received, and then click the appropriate link.
   - Go to the URL that the host gave to you.

2. Provide the required information, and then click **Submit**. For details, see *About the Panelist Entrance page* (on page 112).

### Uploading files

*Panelists only*

Before the event starts, you can upload files that you are going to use in the event so the host can view or organize them.

**Note:** This option is available only if the host specifies it.

To upload files to the host:

1. On the Event Information page and in the **Event files** section, click **Upload**. For information about how to access the Event Information page, see *Obtaining event information* (on page 113).

2. In the Upload Event File window that appears, select the files you want to upload, and then click **OK**.

   The files you upload become available on your and the host’s Event Information pages respectively and in the host’s personal folder on the Event Center Web site.
10

Registering for an Event

<table>
<thead>
<tr>
<th>If you want to ...</th>
<th>See ...</th>
</tr>
</thead>
<tbody>
<tr>
<td>get an overview of registering for an event</td>
<td>About registering for an event (on page 115)</td>
</tr>
<tr>
<td>register from your Event Center Web site</td>
<td>Registering from your Event Center Web site (on page 116)</td>
</tr>
<tr>
<td>register from an event URL given by your host</td>
<td>Registering from an event URL (on page 118)</td>
</tr>
<tr>
<td>simultaneously register for multiple events in a program</td>
<td>Registering for multiple events in a program (on page 119)</td>
</tr>
<tr>
<td>obtain information about an event</td>
<td>Obtaining information about an event (on page 121)</td>
</tr>
<tr>
<td>change the time zone in which you want to view event times</td>
<td>Viewing events in a different locale, language, or time zone (on page 123)</td>
</tr>
</tbody>
</table>

About registering for an event

Attendees only

If the event to which you are invited requires registration, the invitation email message that you receive from the host contains a link you can click to register for the event.

If you did not receive an email invitation, you can register for the event from one of the following, depending on the type of event the host specified:

- your Event Center Web site.
- from the URL that the host gave to you.
If the host requires a password for registration, you must provide the password that the host gave to you in an invitation email message or via another method.

If the host requires that you provide your registration ID, you receive a unique registration ID in a registration confirmation email message. Then, you must provide the registration ID to join the event.

Registering for an event from your Event Center Web site

*Attendees only*

You can register for an event from the List of Events page on your Event Center Web site if the host specifies that it is displayed on the service Web site.

To register for an event from your Event Center Web site:

1. On the navigation bar, expand **Attend an Event**, and then click **List of Events**.
   
The List of Events page appears.

2. If the List of Events by Date page is not currently displayed, in the upper-right corner of the page, click **View Events by Date**.
   
   For more information, see *About the List of Events page* (on page 118).

3. In the list of events, locate the event for which you want to register.

4. Click **Register**.

5. If the Registration Password page appears, type the password that the event host gave to you in the **Registration password** box, and then click **Submit**.

6. On the Register for [Topic] page that appears, provide the required information.
   
   For details, see *About the Register for [Topic]/Register for Events page* (on page 117).

7. Click **Submit**.

   If the host approves your registration, you receive a confirmation email message containing instructions for joining the event.

**Important:** If the host approves your registration and requires that you provide your registration ID before you can join the event, you will receive the ID in the registration confirmation email message. Ensure that you keep the ID so that you can successfully join the event.
About the Register for [Topic]/Register for Events page

How to access the Register for [Topic] page

If you want to register for one event, fill out the registration form on this page.

Do one of the following, as appropriate:

- Click the appropriate link in your invitation email message, and then click Register.
- On the List of Events by Date page on your Event Center Web site, locate the event you want to join, and then click Register.
- On the Event Information page for the event you want to join, click Register.

How to access the Register for Events page

If you want to simultaneously register for multiple events in a program, fill out the registration form on this page.

Do one of the following, as appropriate:

- Go to the URL for the program that contains those events, select the events you want to register for, and then click Register.
- On the List of Events by Program page on your Event Center Web site, locate the program that contains those events, select the events you want to register for, and then click Register.

What you can do on the Register for [Topic]/Register for Events page

Provide information about yourself, and submit your answers to complete registration.

Options on this page

<table>
<thead>
<tr>
<th>Use this option ...</th>
<th>To ...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Text boxes, option buttons, drop-down lists, and check boxes for the questions</td>
<td>Provide your answers.</td>
</tr>
<tr>
<td></td>
<td>Note Questions with an asterisk are required.</td>
</tr>
<tr>
<td>Use this option ...</td>
<td>To ...</td>
</tr>
<tr>
<td>--------------------</td>
<td>--------</td>
</tr>
<tr>
<td>Remember me on this computer</td>
<td>Save your contact information, such as the name, email address, and title, for future use. You can remove your information stored on this computer by clicking <strong>Clear my information</strong>.</td>
</tr>
</tbody>
</table>

| Submit | Submit your answers, and complete your registration. |

### About the List of Events page

The List of Events page provides these three views:

- List of Events by Date page—events sorted by their dates
- List of Events by Program page—a list of programs (groups of related events)
- Event Recordings page—a list of recorded events that the event hosts have published on your Event Center Web site

### Accessing the List of Events page

On the left navigation bar, expand **Attend an Event**, and then click **List of Events**.

### Accessing different views of the List of Events page

In the upper-right corner of the List of Events page, you see two links.

**Example.** In this figure, the List of Events page is displaying a list of events by program. To access another view, click one of these two links.

### Registering from an event URL

*Attendees only*

You can register for an event from its URL if you received the URL from the host.
To register for an event from its URL:

1. Go to the URL that the host gave to you.
   The Event Information page appears.
2. Click **Register**.
3. If the Registration Password page appears, type the password that the event host gave to you in the **Registration password** box, and then click **Submit**.
4. On the Register for [Topic] page that appears, provide the required information.
   For details, see *About the Register for [Topic]/Register for Events page* (on page 117).
5. Click **Submit**.
   If the host approves your registration, you receive a confirmation email message containing instructions for joining the event.

**Important:** If the host approves your registration and requires that you provide your registration ID before you can join the event, you will receive the ID in the registration confirmation email message. Ensure that you keep the ID so that you can successfully join the event.

### Registering for multiple events in a program

<table>
<thead>
<tr>
<th>If you want to ...</th>
<th>See ...</th>
</tr>
</thead>
<tbody>
<tr>
<td>get an overview of registering for multiple events in a program</td>
<td><em>About registering for multiple events in a program</em> (on page 119)</td>
</tr>
<tr>
<td>simultaneously register for multiple events from the program URL</td>
<td><em>Registering from the program URL</em> (on page 120)</td>
</tr>
<tr>
<td>simultaneously register for multiple events from your Event Center Web site</td>
<td><em>Registering from your Event Center Web site</em> (on page 120)</td>
</tr>
</tbody>
</table>

### About registering for multiple events in a program

*Attendees only*
The event host can group related events in a program. Event Center allows you to simultaneously register for multiple events in a program.

Registering for events from the program URL

*Attendees only*

If the events to which you are invited are part of a program, and the host gave you the program URL, you can simultaneously register for multiple events from that URL.

To register for events from the program URL:

1. Go to the URL the host gave to you.
   
   The program information page appears.

2. Select the events for which you want to register, and then click Register.

3. If the Registration Password page appears, type the password that the host gave to you in the Registration password box, and then click Submit.
   
   The Register for Events page appears.

4. Provide the required information.
   
   For details, see About the Register for [Topic]/Register for Events page (on page 117).

5. Click Submit.

   If the host approves your registration, you receive a registration confirmation email message for each event you registered for. The message contains instructions for joining an event.

Registering for events from your Event Center Web site

*Attendees only*

If the events to which you are invited are part of a program, and the host has specified to display both the program and its events on your Event Center Web site, you can simultaneously register for multiple events from the service Web site.

To register for events from your Event Center Web site:

1. On the navigation bar, expand Attend an Event, and then click List of Events.
   
   The List of Events page appears.
2 If the List of Events by Program page is not currently displayed, in the upper-right corner of the page, click **View Events by Program**.

For more information, see *About the List of Events page* (on page 118).

3 Click the title of the program.

The program information page appears.

4 Select the events for which you want to register, and then click **Register**.

5 If the Registration Password page appears, type the password that the host gave to you in the **Registration password** box, and then click **Submit**.

The Register for Events page appears.

6 Provide the required information.

For details, see *About the Register for [Topic]/Register for Events page* (on page 117).

7 Click **Submit**.

If the host approves your registration, you receive a registration confirmation email message for each event you registered for. The message contains instructions for joining an event.

## Obtaining information about an event

<table>
<thead>
<tr>
<th>If you want to ...</th>
<th>See ...</th>
</tr>
</thead>
<tbody>
<tr>
<td>quickly find your event</td>
<td><em>Searching for an event</em> (on page 121)</td>
</tr>
<tr>
<td>obtain event information</td>
<td><em>Obtaining event information</em> (on page 122)</td>
</tr>
</tbody>
</table>

## Searching for an event

You can quickly find an event on your Event Center Web site by doing a search if the event host specifies that it is displayed on the Web site.

**To search for an event:**

1 On the left navigation bar of your Event Center Web site, expand **Attend an Event**, and then click **Search**.

2 On the page that appears, specify the date range.
3 Optional. In the Event text box, type complete or partial text of the event name.
4 Click Search.

Obtaining event information before an event

Attendees only
Before you join an event, you can view the following information about the event:

- event topic
- event date, time, and duration
- presenters’ names and information
- event description

Note: You can quickly find an event that you want to view or join by doing a search. For details, see Searching for an event (on page 121).

To obtain information about an event:

Do one of the following, as appropriate:

- Click the link in your invitation email message.
- On the List of Events by Date page on your Event Center Web site, click the link for the event.
  For more information about the List of Events page, see About the List of Events page (on page 118).
- Go to the URL that the host gave to you.

The Event Information page appears.
Viewing events in a different locale, language, or time zone

Your site administrator designates a locale, language, and time zone in which dates, times, and text display on your Event Center Web site. Anyone who visits the site can change the locale, language, or time zone by setting preferences on the Preferences page.

**Example.** You want to change the time zone for viewing events on the Event Center Web site because you are traveling and temporarily in another time zone.

Your preferences are saved as a cookie in the browser on your computer. If you have a user account and have logged in when changing the preferences, your preferences will be saved not only in the browser but also in your profile; your preferences will display on any browser or computer as long as you are logged in.

**The current locale, language, and time zone display in these places:**

- the List of Events by Date page
- the List of Events by Program page
- the Event Recordings page
- the Event Information page
- The page on which you can join an event
Changing the locale, language, or time zone for your site

At any time, you can change your Event Center site preferences, including the locale, language, and time zone.

To select a different locale, language, or time zone on your Event Center Web site:

1. Go to the Preferences page by using one of these methods:
   - In your invitation email message, click the link.
On the left navigation bar of the site, click Set Up > Preferences.

Select your preferences in the drop-down lists, and then click OK.

**Note:** If you have a user account, you can also set these preferences in your profile. For more information, see *About maintaining your user profile* (on page 406).
The Event window displays the content viewer on the left side, where you share documents, applications, desktops, and other items with attendees. The right side of the Event window contains panels, which you can display or hide as you need them.

This chapter gives you a quick overview of the Event window and the elements that compose it.

<table>
<thead>
<tr>
<th>If you want to ...</th>
<th>See ...</th>
</tr>
</thead>
<tbody>
<tr>
<td>learn about the Event window and the tools for sharing information</td>
<td>A quick tour of the Event window (on page 127)</td>
</tr>
<tr>
<td>learn how to work with shared content</td>
<td>Performing tasks on shared content (on page 129)</td>
</tr>
<tr>
<td>learn how to manipulate the panels</td>
<td>Working with panels (on page 133)</td>
</tr>
<tr>
<td>access panels while you are in full-screen view</td>
<td>Accessing panels in full-screen view (on page 140)</td>
</tr>
<tr>
<td>learn about the ways you can be alerted when a minimized or collapsed panel requires your attention</td>
<td>Viewing panel alerts (on page 145)</td>
</tr>
</tbody>
</table>

A quick tour of the Event window

The Event window provides the online environment where event participants interact.
In the Event window, you can share documents, presentations, desktops, and Web content, send chat messages, coordinate polls, and perform other event management tasks.

<table>
<thead>
<tr>
<th>Content Viewer</th>
<th>Tools</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Content Viewer" /></td>
<td>The tools on the content viewer toolbar allow you to share and perform actions on presentations, documents, and whiteboards.</td>
</tr>
</tbody>
</table>

**Annotation toolbar**—Select a drawing tool for directing attention onscreen, using pointers, a highlighter, or drawing a shape. *More*… (on page 130)

**Sharing toolbar**—Use these tools to share applications, documents, your desktop or a white board. *More*… (on page 131)

**Viewing toolbar**—Change to full-screen, rotate pages, zoom in or out using these tools. *More*… (on page 132)
Performing tasks on shared content

<table>
<thead>
<tr>
<th>If you want to ...</th>
<th>See ...</th>
</tr>
</thead>
<tbody>
<tr>
<td>learn about the menu bar</td>
<td>The menu bar (on page 129)</td>
</tr>
<tr>
<td>learn about the tools available in the content viewer</td>
<td>Sharing information (on page 131)</td>
</tr>
<tr>
<td>learn about the annotation tools</td>
<td>Using annotation tools on shared content (on page 130)</td>
</tr>
<tr>
<td>learn about the view tools</td>
<td>Changing views of shared content (on page 132)</td>
</tr>
</tbody>
</table>

The menu bar

The following table describes what you can do with each menu.

<table>
<thead>
<tr>
<th>Menu</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Event Center  (Mac only)</td>
<td>Provides commands for selecting communication tools and display preferences within the event.</td>
</tr>
<tr>
<td>File</td>
<td>Provides commands for saving, opening, or printing files during an event; and ending or leaving an event.</td>
</tr>
<tr>
<td>Edit</td>
<td>Provides commands for editing shared content in the content viewer.</td>
</tr>
<tr>
<td>Share</td>
<td>Provides commands for sharing documents, presentations, applications, Web browsers, desktops, multimedia Web content, and whiteboards.</td>
</tr>
</tbody>
</table>
Chapter 11: The Event Window

<table>
<thead>
<tr>
<th>Menu</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>View</td>
<td>Provides commands for displaying information in the content viewer on a host's, presenter's, or attendee's screen.</td>
</tr>
<tr>
<td>Communicate</td>
<td>Provides commands for setting up an audio conference.</td>
</tr>
<tr>
<td>Participant</td>
<td>Provides commands pertaining to participants, such as inviting a participant to an event, assigning roles and privileges, controlling participants' audio, and so on.</td>
</tr>
<tr>
<td>Event</td>
<td>Provides commands pertaining to the event, such as viewing event information and restricting access to the event.</td>
</tr>
<tr>
<td>Help</td>
<td>Provides information about the Event Center service.</td>
</tr>
</tbody>
</table>

Using annotation tools on shared content

In an online event, you can use annotation tools on shared content to annotate, highlight, explain, or point to information:

![Basic annotation tools](image)

<table>
<thead>
<tr>
<th>Annotation Tool</th>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pointer</td>
<td>![Pointer Icon]</td>
<td>Lets you point out text and graphics on shared content. The pointer displays an arrow with your name and annotation color. To display the laser pointer, which lets you point out text and graphics on shared content using a red “laser beam,” click the downward-pointing arrow. Clicking this button again turns off the pointer tool.</td>
</tr>
<tr>
<td>Text</td>
<td>![Text Icon]</td>
<td>Lets you type text on shared content. Attendees can view the text once you finish typing it and click your mouse in the content viewer, outside the text box. To change the font, on the Edit menu, choose Font. Clicking this button again turns off the text tool.</td>
</tr>
</tbody>
</table>
### Chapter 11: The Event Window

<table>
<thead>
<tr>
<th>Tool</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Line</td>
<td>Lets you draw lines and arrows on shared content. For more options, click the downward-pointing arrow. Clicking this button closes the Rectangle tool.</td>
</tr>
<tr>
<td>Rectangle</td>
<td>Lets you draw shapes, such as rectangles and ellipses on shared content. For more options, click the downward-pointing arrow. Clicking this button again closes the Rectangle tool.</td>
</tr>
<tr>
<td>Highlighter</td>
<td>Lets you highlight text and other elements in shared content. For more options, click the downward-pointing arrow. Clicking this button again closes the Highlighter tool.</td>
</tr>
<tr>
<td>Drawing Color</td>
<td>Displays the Annotation Color palette, on which you can select a color to annotate shared content. Clicking this button again closes the Annotation Color palette.</td>
</tr>
<tr>
<td>Eraser</td>
<td>Erases text and annotations or clears pointers on shared content. To erase a single annotation, click it in the viewer. For more options, click the downward-pointing arrow. Clicking this button again turns off the eraser tool.</td>
</tr>
</tbody>
</table>

### Sharing information

You can open a document, whiteboard, desktop, or application to share by clicking the sharing icons in the upper left corner.

#### Sharing tools for Windows

![Sharing tools for Windows]

#### Sharing tools for the Mac

![Sharing tools for the Mac]

<table>
<thead>
<tr>
<th>Sharing Tool</th>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Share Document</td>
<td>![icon]</td>
<td>Share a document or presentation that resides on your computer. Participants view the shared document or presentation in their content viewers.</td>
</tr>
</tbody>
</table>
Chapter 11: The Event Window

### Sharing Tool

<table>
<thead>
<tr>
<th>Sharing Tool</th>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Share Application</td>
<td><img src="image" alt="Share Application Icon" /></td>
<td>Share any application on your computer with meeting attendees. Attendees can view the shared application in a sharing window on attendees' screens.</td>
</tr>
<tr>
<td>Share Desktop</td>
<td><img src="image" alt="Share Desktop Icon" /></td>
<td>Share your computer desktop* with meeting attendees, including any applications, windows, and file directories that are currently open. Attendees can view the shared desktop in a sharing window on attendees' screens</td>
</tr>
<tr>
<td>Share Whiteboard</td>
<td><img src="image" alt="Share Whiteboard Icon" /></td>
<td>Share a whiteboard on which you can draw and write. Attendees can view a shared whiteboard in their content viewers.</td>
</tr>
</tbody>
</table>

**Note:** Click Share on the Menu bar to see more options for sharing information in an event.

### Changing views of shared content

You can switch views in the content viewer by clicking the viewing icons in the bottom left corner of the content viewer:

![View tools](image)

<table>
<thead>
<tr>
<th>Tool</th>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Standard View/</td>
<td><img src="image" alt="Standard View Icon" /></td>
<td>Clicking Standard View displays the shared content as you would normally view it.</td>
</tr>
<tr>
<td>View Thumbnails</td>
<td><img src="image" alt="View Thumbnails Icon" /></td>
<td>To display thumbnails, or miniatures, of shared pages, slides, or whiteboards to the side of the content, click View Thumbnails. This tool helps you locate a page or slide quickly.</td>
</tr>
<tr>
<td>Full-Screen View</td>
<td><img src="image" alt="Full-Screen View Icon" /></td>
<td>Displays shared content in a full-screen view. Helps you to ensure that participants can view all activity on your screen. Also helps to prevent participants from viewing or using other applications on their screens during a presentation.</td>
</tr>
</tbody>
</table>
Click ESC to return to the content viewer.

<table>
<thead>
<tr>
<th>Rotate page</th>
<th>For documents in landscape orientation, you can rotate the pages to the left or right so they appear correctly in the content viewer.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Zoom In/</td>
<td>Lets you display shared content at various magnifications. Click this button, and then click the page, slide, or whiteboard to change its magnification. For more magnification options, click the downward-pointing arrow.</td>
</tr>
<tr>
<td>Zoom Out</td>
<td></td>
</tr>
<tr>
<td>Synchronize</td>
<td>For presenters, synchronizes all participants’ displays with your display. Helps to ensure that all participants are viewing the same page or slide, at the same magnification, as in your display.</td>
</tr>
<tr>
<td>Displays for All</td>
<td></td>
</tr>
</tbody>
</table>

**Working with panels**

Your service determines which panels display initially.

**For Windows**
For Windows

1. To restore panel layout, minimize all panels, or manage panels, click this button and choose a command from the menu.
2. Click these icons to restore or minimize the panels. More… (on page 136)
3. In this example, the Q & A panel is collapsed. More… (on page 137)
4. Use these icons to collapse or expand a panel. More… (on page 137)
5. Use this icon to minimize the panels on the icon tray. More… (on page 136)

Note: To access panel options, right-click in the panel title bar. More… (on page 138)

Note for Windows users: In sharing mode, you can have one or more panels "float" on top of the shared document, presentation, Web browser, or other shared item. See Accessing panels in full-screen view (on page 140).

For the Mac
Managing panels

You can determine which panels are displayed in the event window, and in which order they will be displayed:

To manage the display of panels:

1. Click this button.

   for Windows

   for the Mac
Choose **Manage Panels** from the menu.

- Use the **Add** or **Remove** buttons to specify which panels should display in your event window.
- Use the **Move Up** or **Move Down** buttons to specify the order of the panel display.
- Click the **Reset** button to restore the panel view to the default layout.
- Clear the check box beside **Allow participants to change the sequence of panels** if you want to permit attendees to manage their own display of panels.

### Minimizing panels

Minimizing a panel causes the panel to disappear from the display and reappear as an icon on the icon tray.

**To minimize or close a panel (for Windows):**

Click the **Minimize** icon on the title bar of the panel you want to minimize.

**To restore a minimized panel (for Windows):**
To minimize or restore a panel (for the Mac):

On the bottom of the panels, you see a tray holding icons of the displayed panels. Click its icon to minimize or restore the panel. The icon of a minimized panel appears grayed on the tray.

Expanding and collapsing panels

When you collapse a panel, the body of the panel disappears, leaving just the title bar visible. When you expand the panel, it reappears in its full form.

To collapse or expand a panel:

Restoring the panel layout

If you have closed, minimized, or expanded or collapsed panels, you can restore the display to the layout

- you specified in the Manage Panels dialog box.
- that existed when you first joined the event (if you did not specify a layout via the Manage Panels dialog box)

To restore the panel layout:

1. Click this button.
2 Choose **Restore Layout**.

**Accessing panel options**

Each panel provides a menu of commands related to the panel. Expanding and minimizing are two common commands for all the panels.

Depending on what operating system you are using, access the commands for a panel by following these steps:

- **Windows**—Right-click the panel title bar to see a menu of commands related to the panel.
- **Mac**—Select **ctrl** and then click to see a menu of commands related to the panel.

<table>
<thead>
<tr>
<th>Panel</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Participants</td>
<td><strong>Sound Alerts</strong>: Lets you choose a sound to play when a participant:</td>
</tr>
<tr>
<td></td>
<td>- joins the event</td>
</tr>
<tr>
<td></td>
<td>- leaves the event</td>
</tr>
<tr>
<td></td>
<td>- clicks the <strong>Ask for Mic</strong> button on the <strong>Participants panel</strong>.</td>
</tr>
<tr>
<td></td>
<td><strong>Attendee Privileges</strong>: Available for only the event host. Displays the Attendee Privileges dialog box. For details about these privileges, see <strong>Granting privileges to attendees (on page 150)</strong>.</td>
</tr>
<tr>
<td>Chat</td>
<td><strong>Sound Alerts</strong>: Lets you choose the kinds of chat messages for which you want a sound to play. Select a sound from the drop-down list or click <strong>Browse</strong> to find a sound in a different location on your computer.</td>
</tr>
<tr>
<td></td>
<td><strong>Attendee Privileges</strong>: Available for only the event host. Displays the Attendee Privileges dialog box. For details about these privileges, see <strong>Granting privileges to attendees (on page 150)</strong>.</td>
</tr>
</tbody>
</table>
### Panel Options

#### Media Viewer
- **Share Multimedia:** Available for only the presenter. Lets you share multimedia Web content in the media viewer on this panel.
- **Stop Multimedia Sharing:** Available for the presenter, who has started sharing multimedia content.

#### Q & A
- **Attendee Options:** For privacy, lets you show or hide names of attendees who send questions, names of panelists who send answers, or time stamps for each question and answer, when questions and answers are published on attendees’ Q & A panels.

### Resizing the content viewer and panels area

You can control the size of the content viewer by making the panel area narrower or wider.

**To change the size of the content viewer and panels:**

Click the dividing line between the content viewer and the panels.

- Drag the line to the left to make the area devoted to the panels wider.
- Drag the line to the right to make the content viewer larger.
Accessing panels in full-screen view

If you are viewing a document in full-screen mode, or remotely controlling a shared application, or desktop, the Event window appears as a full-screen sharing window. In a sharing window, you access panels from the Event Controls Panel.

<table>
<thead>
<tr>
<th>Control</th>
<th>Descriptions</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.png" alt="Icon" /></td>
<td>Displays icons for working with attendees</td>
</tr>
<tr>
<td><img src="image2.png" alt="Icon" /></td>
<td>Displays a maximum of 4 icons. You can open any remaining panels from this menu.</td>
</tr>
<tr>
<td><img src="image3.png" alt="Icon" /></td>
<td>Stops sharing and returns to the Event window</td>
</tr>
<tr>
<td><img src="image4.png" alt="Icon" /></td>
<td>Provides access to event controls and panels that are not displayed on the Event Controls Panel.</td>
</tr>
<tr>
<td><img src="image5.png" alt="Icon" /></td>
<td>Opens the Participants panel</td>
</tr>
<tr>
<td><img src="image6.png" alt="Icon" /></td>
<td>Opens the Chat panel</td>
</tr>
<tr>
<td><img src="image7.png" alt="Icon" /></td>
<td>Opens the Q &amp; A panel</td>
</tr>
<tr>
<td><img src="image8.png" alt="Icon" /></td>
<td>Opens the Annotation Tools panel</td>
</tr>
<tr>
<td><img src="image9.png" alt="Icon" /></td>
<td>Opens the Polling panel</td>
</tr>
<tr>
<td><img src="image10.png" alt="Icon" /></td>
<td>Opens the Video panel</td>
</tr>
<tr>
<td><img src="image11.png" alt="Icon" /></td>
<td>Opens the Recorder panel</td>
</tr>
</tbody>
</table>
Tip:

- **Windows**: To clear space on your desktop, you can drag the Event Controls Panel to the top, left, or right to dock it on the edge of the window. To undock the icon tray and float it again, simply drag it away from the edge of the window.
- **Mac**: To clear space on your desktop, you can drag the Event Controls Panel and dock it anywhere on your desktop.

**Manipulating panels in full-screen view**

*For Windows users only*

You can open and float panels on the window, redock floating panels, and resize floating panels to meet your viewing requirements.

**To open a panel when your view is full-screen mode:**

Click its icon on the Event Controls Panel. For example, to open the Chat panel, click the Chat icon.

- If the Event Controls Panel is docked on the edge of the window, the panel appears and “floats” on top of the shared document, presentation, or other shared item.
- If the Event Controls Panel is floating on top of the window, the panel appears and is docked to the Event Controls Panel.

**To float a panel:**

Click the float icon.

**To resize a floating panel:**

Grab any corner and drag the panel to the required size.
To dock a floating panel onto the Event Controls Panel, do either of these:

- click the slanted arrow on the right side of the panel title bar
- drag and drop the panel onto the Event Controls Panel or another docked panel.

**Note:** The Event Controls Panel must be in floating mode before you can dock panels on it.

To open and float all panels during full screen mode:

On the Select Panel menu, choose Float All Panels.

All panels display, even those you had minimized previously.

### Sharing in full-screen view

*Host and Presenter only*

In full-screen view, you have access to sharing options from the Event Controls Panel.

- **Share Document**—select a document that you already have open or open a new document. *More...* (on page 143)
Chapter 11: The Event Window

- **Share Application** - select an application that you already have open or open a new application. *More...* (on page 143)

- **Share Desktop** - your attendees can see your desktop, and you can proceed to show or demonstrate content.

- **Share Whiteboard** - select a whiteboard that you already have open or start a new whiteboard. *More...* (on page 144)

- **Share Web Content** - select a Web site that you already have open or specify a URL to share the content of another Web site. *More...* (on page 144)

- **Share Web Browser** - your default browser opens; your attendees can see it, and you can proceed to browse the Web

- **Share Remote Computer** - select a remote computer and an application on that computer that you want to share. To share a computer in an event, you must have already set it up for remote access.

**If you are sharing a document**

If you have already opened several documents, you can switch sharing from one document to another, or you can open a document that is currently closed.

- Select **Share Document** and choose an open document from the list.

- Select **Share Document** > **Share Document...** to open a new document.

**If you are sharing an application**

If you have already opened several applications, you can switch sharing from one application to another, or you can open an application that is currently closed.
If you are sharing a whiteboard

If you have already opened started several whiteboards, you can switch sharing from one whiteboard to another, or you can start another whiteboard.

- Select Share Whiteboard and choose another whiteboard from the list.
- Select Share Document > Share a New Whiteboard to start a new whiteboard.

If you are sharing Web content

If you have already set up one or more Web sites for content viewing, you can switch sharing from one to another, or you can specify a URL to share the content of another Web site.
Chapter 11: The Event Window

Synchronizing attendee displays

To resize the display of participants to match your display:

1. Click this button on the Event Controls Panel.

2. On the menu, choose View > Synchronize for All.

All attendee displays now match your display.

Viewing panel alerts

If a panel you collapsed or minimized requires your attention, the icon representing the panel blinks for a few seconds and changes color to get your attention to a change.

Here are some reasons for seeing alerts:

- A participant arrives or leaves an event.
- A Raise Hand or Request Phone indicator appears on the Participants panel.
- An attendee sends a question using the Q & A panel.
- An attendee sends a chat message.
- A poll closes.
- Poll answers are received.

Choose Share Web Content > a Web site URL listed on the menu.

Choose Share Web Content > Share New Web Content... to open another Web site.
**Example.** A participant clicks the Request Phone icon in your event, and you do not have the Participants panel open. This table shows you different ways you can be alerted.

<table>
<thead>
<tr>
<th>Participants panel alerts</th>
<th>Ways to see alerts</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="Image1.png" alt="Image" /></td>
<td>panel is minimized on an icon tray</td>
</tr>
<tr>
<td><img src="Image2.png" alt="Image" /></td>
<td>panel is collapsed</td>
</tr>
<tr>
<td><img src="Image3.png" alt="Image" /></td>
<td>panel is minimized in a full-screen view</td>
</tr>
<tr>
<td><img src="Image4.png" alt="Image" /></td>
<td>panel is collapsed in a full-screen view</td>
</tr>
<tr>
<td><img src="Image5.png" alt="Image" /></td>
<td>panel is floating and collapsed in a full-screen view</td>
</tr>
</tbody>
</table>
The panel remains in the alert status until you open the panel.
Assigning Privileges During an Event

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>get an overview of privileges</td>
<td>About granting privileges to participants (on page 149)</td>
</tr>
<tr>
<td>assign particular privileges to attendees or panelists</td>
<td>Granting privileges to attendees and panelists (on page 150)</td>
</tr>
<tr>
<td>review specific details about each attendee privilege</td>
<td>Overview of attendee privileges (on page 151)</td>
</tr>
<tr>
<td>review specific details about each panelist privilege</td>
<td>Overview of panelist privileges (on page 153)</td>
</tr>
</tbody>
</table>

About granting privileges to participants

Once the event starts, participants automatically receive default privileges that allow them to perform activities during the event. You, as the event host, can grant additional privileges to participants.

For example, you can allow participants to do the following event activities:

- saving, printing, or annotating shared content in the content viewer
- viewing thumbnails of pages, slides, or whiteboards in the content viewer
- viewing any page, slide, or whiteboard of the current content the presenter is sharing in the content viewer
viewing any document, presentation, or whiteboard in the content viewer, regardless of the current content that the presenter is sharing

- chatting with specific participants

- recording the event

For information about which privileges participants receive by default, see *Overview of attendee privileges* (on page 151) and *Overview of panelist privileges* (on page 153).

---

### Granting privileges to attendees and panelists

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>grant privileges to or remove privileges from attendees</td>
<td><em>Granting privileges to attendees</em> (on page 150)</td>
</tr>
<tr>
<td>grant privileges to or remove privileges from panelists</td>
<td><em>Granting privileges to panelists</em> (on page 152)</td>
</tr>
</tbody>
</table>

### Granting privileges to attendees

You can grant privileges to or remove privileges from attendees during an event.

**To assign attendee privileges during an event:**

1. In the Event window, on the Participant menu, click **Assign privileges to > Attendees**.

   The Attendee Privileges dialog box appears.

2. Do *any* of the following:

   - To grant a privilege to all attendees, select its check box.
   - To grant all privileges to attendees, select the **All attendee privileges** check box.
   - To remove a privilege from all attendees, clear its check box.

   For descriptions of each option in the Attendee Privileges dialog box, see *Overview of attendee privileges* (on page 151).

3. Click **Assign**.
Overview of attendee privileges

To access the Attendee Privileges dialog box, in the Event window, on the Participant menu, click Assign privileges to > Attendees.

The following table describes each option in the Attendee Privileges dialog box.

<table>
<thead>
<tr>
<th>Under this area ...</th>
<th>Use these options to allow attendees to ...</th>
</tr>
</thead>
</table>
| **Document**        | ▪ **Save**—Save any shared documents, presentations, or whiteboards that appear in the content viewer.  
                      ▪ **Print**—Print any shared documents, presentations, or whiteboards that appear in the content viewer.  
                      ▪ **Annotate**—Annotate any shared documents, presentations, or whiteboards that appear in the content viewer, using the annotation tools. |
| **View**            | ▪ **Attendee list**—View the names of all other attendees on the Participants panel. If this option is unavailable, it means you have specified during scheduling that attendees can view only the names of the event host and the panelists on the Participants panel.  
                      ▪ **Thumbnails**—Display miniatures of any pages, slides, or whiteboards that appear in the content viewer, regardless of the current content the presenter is sharing in the content viewer.  
                      ▪ **Any page**—View and navigate between the pages or slides of the current document or presentation that the presenter is sharing in the content viewer.  
                      ▪ **Any document**—View and navigate between any document, presentation, or whiteboard that appears in the content viewer.  
                      ▪ **Number of attendees**—View the total number of attendees on the Participants panel. |
| **Event**           | ▪ **Record the event**—Record all interactions during an event using WebEx Recorder and play back recordings at any time. |
Chapter 12: Assigning Privileges During an Event

<table>
<thead>
<tr>
<th>Under this area ...</th>
<th>Use these options to allow attendees to ...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Communications</td>
<td>To let attendees chat with the following persons privately, select Private chat with.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Host</strong>—Chat privately with only the event host. If an attendee sends a chat message to the host, it appears on only the host's Chat panel.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Presenter</strong>—Chat privately with only the presenter. If an attendee sends a chat message to the presenter, it appears on only the presenter's Chat panel.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Panelists</strong>—Chat privately with any panelist or all panelists.</td>
</tr>
<tr>
<td></td>
<td>• <strong>All attendees</strong>—Chat with <em>either</em> of the following:</td>
</tr>
<tr>
<td></td>
<td>□ <strong>All Attendees</strong>, excluding the event host and panelists</td>
</tr>
<tr>
<td></td>
<td>□ <strong>All Participants</strong>, including the event host and panelists, if you also selected all the other check boxes under Communications</td>
</tr>
<tr>
<td></td>
<td>If you want to grant the teleconferencing privilege to attendees without having to approve their requests, select <em>Automatically approve teleconferencing requests</em>.</td>
</tr>
<tr>
<td>All Attendee Privileges</td>
<td>Have all the attendee privileges.</td>
</tr>
</tbody>
</table>

Granting privileges to panelists

You can grant privileges to or remove privileges from panelists during an event.

**To assign panelist privileges during an event:**

1. In the Event window, on the **Participant** menu, click Assign privileges to > Panelists.

   The Panelist Privileges dialog box appears.

2. Do *any* of the following:
   - To grant a privilege to all panelists, select its check box.
   - To grant all privileges to panelists, select the All panelist privileges check box.
   - To remove a privilege from all panelists, clear its check box.

For descriptions of each option in the Panelist Privileges dialog box, see *Overview of panelist privileges* (on page 153).
3 Click Assign.

### Overview of panelist privileges

To access the Panelist Privileges dialog box, in the Event window, on the Participant menu, click Assign privileges to > Panelists.

The following table describes each option in the Panelist Privileges dialog box.

<table>
<thead>
<tr>
<th>Under this area ...</th>
<th>Use these options to allow panelists to ...</th>
</tr>
</thead>
</table>
| **Document**        | • **Save**—Save any shared documents, presentations, or whiteboards that appear in the content viewer.  
                      • **Print**—Print any shared documents, presentations, or whiteboards that appear in the content viewer.  
                      • **Annotate**—Annotate any shared documents, presentations, or whiteboards that appear in the content viewer, using the annotation tools, and use pointers on shared documents, presentations, and whiteboards. |
| **View**            | • **Attendee list**—View all attendees’ names on the Participants panel.  
                      • **Thumbnails**—Display miniatures of any pages, slides, or whiteboards that appear in the content viewer, regardless of the current content the presenter is sharing in the content viewer.  
                      • **Any page**—View and navigate between the pages or slides of the current document or presentation that the presenter is sharing in the content viewer.  
                      • **Any document**—View and navigate between any document, presentation, or whiteboard that appears in the content viewer. |
| **Event**           | • **Record the event**—Record all interactions during the event using WebEx Recorder and play back recordings at any time.  
                      • **Share documents**—Share presentations or documents during the event. |
<table>
<thead>
<tr>
<th>Under this area ...</th>
<th>Use these options to allow panelists to ...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Communications</td>
<td>• <strong>Private chat with</strong>—To chat with the following persons privately:</td>
</tr>
<tr>
<td></td>
<td>Host: Chat privately with only the event host. If a panelist sends a chat message to the host, it appears on only the host's <strong>Chat</strong> panel.</td>
</tr>
<tr>
<td></td>
<td>Presenter: Chat privately with only the presenter. If a panelist sends a chat message to the presenter, it appears on only the presenter’s <strong>Chat</strong> panel.</td>
</tr>
<tr>
<td></td>
<td>Panelists: Chat privately with any other panelist or all panelists.</td>
</tr>
<tr>
<td></td>
<td>• <strong>All attendees</strong>: Chat with one of these groups:</td>
</tr>
<tr>
<td></td>
<td>□ All Attendees, excluding the event host and panelists</td>
</tr>
<tr>
<td></td>
<td>□ All Participants, including the event host and panelists, if you also selected all the other check boxes under <strong>Private chat with</strong>.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Attention Tracking</strong>—View attention indicator and learn which attendee is not paying attention during the event.</td>
</tr>
<tr>
<td>All Panelist Privileges</td>
<td>Have all the panelist privileges.</td>
</tr>
</tbody>
</table>
As the event host, you run the event using the features provided by Event Center. For example, you can:

- Manage the Attendee List More... (on page 156)
- Invite additional attendees to the event More... (on page 160)
- Remind the panelists who were invited but have not yet joined the event More... (on page 166)
- Tell which participants are not paying attention in the event More... (on page 169)
- Designate a presenter More... (on page 171)
- Designate panelists More... (on page 172)
- Transfer the host role to a panelist; reclaim the host role later More... (on page 173)
- Control access to an event More... (on page 174)
- Remove a participant from the event More... (on page 175)
- End the event More... (on page 175)

Note:
- A host must be an authorized user—that is, the host must have a user account.
- After an event starts, the host is initially the presenter. The host can then designate a panelist as the presenter.
Chapter 13: Managing an Event

Obtaining information about an event

During an event, you can obtain the following information about the event. If necessary, you can instruct attendees about how to obtain this information:

- event topic
- location, or URL, of your Event Center Web site
- event number
- teleconferencing information
- current host
- current presenter
- current user—that is, the attendee's name
- current number of participants

To obtain information about an event in progress:

In the Event window, on the Event menu, choose Information.

Managing the Attendee List

Host only

The Attendee List shows not only the names of the attendees in the event but also their:

- Lead scores—The Score column displays each attendee's total lead score based on the attendee's response to the questions on the registration form.
- Company names—The Company column displays each attendee’s company name based on the attendee’s response to the Company question on the registration form.

Lead scores and company names can help you identify which attendees should be given priority in the event. For example, these two features can help you and the panelists to set priorities for the questions attendees ask during the event.

Important: If you want to display lead scores and company names on the Attendee List, you must do these two things on the registration form:
- Use the lead scoring option in the Add Check Boxes, Add Option Buttons, or Add Drop-
Down List windows.

- Specify that the "Company" and all questions with assigned scores are required information—that is, select the symbol $\mathbb{R}$.

For more information, see *Customizing the registration form* (on page 11) and *About lead scores* (on page 17).

This figure gives an overview of how you can manage the Attendee List.

---

1. To search for an attendee's name or company name, enter all or a portion of the text and then click **Find**.
2. Use this button to hide or display the Score column.
3. Use this button to hide or display the Company column.
To sort the Attendee List by score, click the column name.

To alphabetically sort the Attendee List by company name, click the column heading.

To alphabetically sort the Attendee List by attendee name, click the column heading.

For events using Audio Broadcast only. If an attendee requests to speak in a teleconference, select the attendee’s name and then click Allow. After the attendee joins the teleconference, you can mute or unmute his or her microphone.

To promote an attendee as a panelist, select the attendee’s name and then click Make Panelist.

To remove an attendee from the event, select the attendee’s name and then click Expel.

Viewing the attendee list

Typically, only the host, presenter, and other panelists, instead of all participants, can see the attendee list in an event. When scheduling an event, you determine who can view the attendee list. For more information, see Specifying whether to display attendee list to all participants (on page 61).

To view the Attendee List:

On the Participants panel, click View all attendees.

The Attendee List dialog box appears.

Allowing panelists to view attendees' company names

Host only
Panelists cannot view attendees' company names unless you grant them the privilege to do so.

To grant a panelist the privilege to view attendees' company names:

1. On the Participants panel, right-click the panelist's name and then choose Privileges.

2. In the Panelist Privileges dialog box, select Company name and then click Assign.
Inviting attendees to an event in progress

After you start an event, the Quick Start tab in your Event window allows you to use email, a phone, or instant messaging (IM) to invite additional attendees to the event.

During an event, you can also create a greeting message for attendees when they first join the event.

Inviting attendees by email to an event in progress

During an event, you can send your invitation email message using one of the following delivery methods:

- WebEx email system
- your default local email program

An invitation email message you send from the event contains information pertaining to the event. You do not need to type the information yourself.

Each person that you invite receives an invitation email message that includes information about the event—including the password, if any—and a link that the attendee can click to join the event.

To invite additional attendees by email, after you start your event:

1. In your content viewer, select the Quick Start tab and click Invite and Remind.
2. Select the Email tab.
3. Do one of the following, as appropriate:
   - Enter the email addresses of the attendees, and then click Send.
   - If you want to use your local default email program, such as Microsoft Outlook or IBM Lotus Notes, select your local email, and then send the email message as usual.

Inviting attendees by phone to an event in progress

During an event, you can extend your event invitation with just a phone. You can call and verbally instruct attendees on how to join your online event.
To invite an attendee to your event in progress by phone:

1. In your content viewer, select the **Quick Start** tab and click **Invite and Remind**.
2. Select the **Phone** tab, and then enter the required information.
3. Verbally give the attendee the instructions on how to join the event.

After following the instructions on the screen, the attendee joins the event.

### Inviting attendees by WebEx Connect to an event in progress

After starting an event, you can use the WebEx Connect integration to invite additional attendees and remind panelists of attending the event. When you click the IM option on the QuickStart tab, a WebEx Connect window appears, allowing you to send instant messages (IMs) to your contacts.

The IM automatically includes the event topic, starting time, and a link for joining the event.

Before using WebEx Connect, ensure all of the following:

- You have WebEx Connect installed and running on your computer.
- You are logged in to WebEx Connect.
- The attendees or panelist who receive your IMs have WebEx Connect or other IM applications installed, such as AIM (AOL Instant Messenger), GoogleTalk, or Jabber.
- The attendees or panelists who receive your IMs are logged in to their IM programs.

If your contact is not online when you try to send him or her an IM, WebEx Connect automatically switches the method of sending the message to email. The email message will still contain the event topic, starting time, and a link for joining the event.

### Note:

- WebEx Connect is a productivity tool you can use to send instant messages, make video and voice calls, share files on your desktop, manage meetings, and communicate more efficiently within and outside your company.
- If you do not have WebEx Connect and want to learn more about it, go to the [Cisco WebEx Connect Web site](http://www.webex.com/go/wc).
- To download WebEx Connect, go to the [Cisco WebEx Connect Web site](http://www.webex.com/go/wc).
To send an invitation IM using WebEx Connect:

1. In your content viewer, select the **Quick Start** tab and click **Invite and Remind**.
2. Select the **IM** tab and click **Invite**.
3. Open the Invite More window in Connect by using one of these methods:
   - In the content viewer of the Event window, under **Quick Start > Invite Participants**, click .
   - On the Participants panel, click the downward-pointing arrow on the button, and then choose **Invite by IM**.
4. In the Invite More window that appears, enter the contact’s screen name or email address:
   - Type the attendee’s Connect screen name or email address in the box.
   - WebEx Connect integrates with your Microsoft Outlook Global Address List. Click to obtain and enter the attendee’s email address from Microsoft Outlook.
5 Ensure that you select the check boxes next to the names of the attendees you want to invite.

6 Click **Invite**.

The attendee receives the IM. The attendee receives an email message if he or she is not logged in.

The following shows an example of the invitation IM.

**Inviting attendees by instant messaging (IM) to an event in progress**

If you use an IM program other than WebEx Connect, copy and paste the link for joining the event and send the IM to the attendee you want to invite.

**To send an invitation IM using a program other than WebEx Connect:**

1 In your content viewer, select the **Quick Start** tab and click **Invite and Remind**.

2 Select the **IM** tab.
Inviting participants by text message (SMS) to an event in progress

You can invite participants by text message (SMS) to an event in progress. This feature must be enabled by your site administrator.

To invite a participant by text message from the event:
1. In your content viewer, select the Quick Start tab and click Invite and Remind.
2. Select the SMS tab.
3. Enter a phone number in the Invitee Mobile Number box.
4. Click Send.

The participant receives a text message, which includes:
- A number the participant can call to join the event
- The account code
- Event topic
- Event start time
- The host name
- A reply code to receive a call from the event.

Creating a greeting message for attendees

During an event, you can create a message and display it to attendees once they join the event. You can write your own message or edit the default text.

Example. In your message, you can welcome the attendee to the event and provide important information or special instructions about the event.

To create a greeting message during an event:
1. In the Event window, on the Event menu, choose Welcome Message.
   The Create an Attendee Greeting window appears.
2 Select **Display this message when attendees join the event** to have the message displayed on attendees’ screens when they join the event.

3 Edit the message in the **Message** box.

4 Click **OK**.

**Inviting attendees to a teleconference in progress**

You can invite attendees to only the audio portion of the event by having them join a teleconference.

**Example.** You are hosting a large all-hands company event online. One of the executives prefer listening in to the event because he is on the road. You provide his phone number in the Invite by Phone dialog box. When he receives a call back at the phone number you provided, he can join the teleconference in the event by following the instructions in the voice message.

**Important:** To use this option, you must set up a call-back teleconference when scheduling the event.

To invite attendees to only a teleconference in an event:

1 In your content viewer, select the **Quick Start** tab and click **Invite and Remind**.
2 Select the **Phone** tab.

3 Enter the attendee’s name and phone number, including the area code.

4 Ensure that the country or region code is correct. To select a different country code, click the down arrow in the Phone Number field.

5 Click **Call**.

   The teleconferencing service calls the attendee. The **Conference** button becomes available for you to call another attendee.

---

**Reminding panelists to join an event in progress**

After you start an event, the **Quick Start** tab in your Event window allows you to use email, a phone, or instant messaging (IM) to remind the invited panelists who have not yet joined the event.

**Reminding panelists by email**

To remind the invited panelists to join an event in progress, you can send reminder email messages using one of the following delivery options:

- WebEx email system
- your default local email program, if you use Microsoft Outlook or IBM Lotus Notes

A reminder email message you send from the event contains information pertaining to that event, including the password, if any, and a link that the panelist can click to join the event. You do not need to type the information yourself.

To remind panelists by email, after you start your event:

1 In your content viewer, select the **Quick Start** tab and click **Invite and Remind**.

2 Select the **Email** tab.

3 Do one of the following, as appropriate:
   - Enter the email addresses of the attendees, and then click **Send**.
   - If you want to use your local default email program, such as Microsoft Outlook or IBM Lotus Notes, select your local email, and then send the email message as usual.
Reminding panelists by WebEx Connect

After starting an event, you can use the WebEx Connect integration to invite additional attendees and remind panelists of attending the event. When you click the IM option on the QuickStart tab, a WebEx Connect window appears, allowing you to send instant messages (IMs) to your contacts.

The IM automatically includes the event topic, starting time, and a link for joining the event.

Before using WebEx Connect, ensure all of the following:

- You have WebEx Connect installed and running on your computer.
- You are logged in to WebEx Connect.
- The attendees or panelist who receive your IMs have WebEx Connect or other IM applications installed, such as AIM (AOL Instant Messenger), GoogleTalk, or Jabber.
- The attendees or panelists who receive your IMs are logged in to their IM programs.

If your contact is not online when you try to send him or her an IM, WebEx Connect automatically switches the method of sending the message to email. The email message will still contain the event topic, starting time, and a link for joining the event.

Note:

- WebEx Connect is a productivity tool you can use to send instant messages, make video and voice calls, share files on your desktop, manage meetings, and communicate more efficiently within and outside your company.
- If you do not have WebEx Connect and want to learn more about it, go to the Cisco WebEx Connect Web site (http://www.webex.com/go/wc).
- To download WebEx Connect, go to the Cisco WebEx Connect Web site (http://www.webex.com/go/wc).

To send your panelists a reminder IM using WebEx Connect:

1. In your content viewer, select the Quick Start tab and click Invite and Remind.
2. Select the IM tab and click Invite.
In the window that appears, the names of the panelists you invited display automatically.

3. Ensure that you select the check boxes for the names of the panelists you want to remind.
4. Click Send.

**Reminding panelists by instant messaging (IM)**

If you use an IM program other than WebEx Connect, you can copy and paste the link for joining the event and send the IM to the invited panelists who are not yet in the event.

To send a reminder IM using a program other than WebEx Connect:
1. In your content viewer, select the **Quick Start** tab and click **Invite and Remind**.
2. Select the **IM** tab.
3. Click **Copy**.
4. Paste the link in an IM window and then send it to the attendee.
Tracking participant attention

During your event, you can easily tell if attendees are no longer focused on your presentation. The attention indicator shows if an attendee has:

- Minimized the event window
- Brought another window, such as any kind of instant messaging (IM) window, in focus on top of the event window

### During an event, you can check:

#### Overall attentiveness

The left side of the bar graph indicates the percentage of attendees who are paying attention; the right side indicates the percentage of attendees who are not paying attention.

#### Individual attentiveness

If an attendee is not paying attention, an exclamation mark appears next to the name of the attendee.
Chapter 13: Managing an Event

After an event ends, you can generate reports to obtain data about individual attentiveness. A report contains this information for each attendee:

- Attention-to-attendance ratio: Attentiveness based on how long the attendee was in the event
- Attention-to-duration ratio: Attentiveness based on the duration of the event

For details, see About generating reports (on page 418).

**Note:** The attention indicator is unavailable when the host and panelists are in a practice session.

Checking participant attention in an event

During an event, you can easily check which attendees are not paying attention.

To check who is not paying attention in the event:

Look for the icon that appears next to the name of the attendee who is not paying attention.

To check overall attentiveness:

Click the icon on the toolbar of your Participants panel.

Turning on or off attention tracking in an event

*Host only*

You can turn on or off attention tracking in an event.

To turn on or off attention tracking in an event (Windows):

1. On the Event menu, choose Options.
2. On the **Communications** tab, select **Attention tracking**.

To turn on or off attention tracking in an event (Mac):
1. On the **Event Center** menu, select **Preferences**.
2. Select the **Tools** button.
3. Select **Attention tracking**.
4. Select **OK**.

**Note:** If the Attention tracking option is unavailable, contact your site administrator.

---

**Granting attention tracking privilege**

*Host only*

By default, all panelists in an event have the privilege to view the attention indicator. You can remove the privilege from them or grant the privilege to them at any time during the event.

To remove or grant the attention tracking privilege:
1. On the **Participant** menu, choose **Assign Privileges To > Panelists**.
2. If you use the Mac, select the **Communications** tab.
3. Check or uncheck **Attention Tracking**, as appropriate.

---

**Designating a presenter**

As the host, you are initially the presenter as well. During an event, you can designate any panelist as the presenter. You can also reassume the presenter role or change the presenter at any time.

**Important:** Changing the presenter discontinues any application, Web browser, or desktop sharing session currently in progress. However, any documents, presentations, or whiteboards that the current presenter is sharing remain in the content viewer of the Event window.
To designate a presenter:

1. On the Participants panel, select the name of the panelist whom you want to designate as the presenter.

2. Do either of the following:
   - On the Participants panel, click the Make presenter button.
   - On the Participant menu, choose Change Role to > Presenter.

The green presenter indicator appears to the left of the panelist’s name.

To reclaim the presenter role:

On the Participants panel, select your own name, and then click the Make presenter button.

**Note:** If the presenter leaves the event, the host becomes the presenter.

**Designating a panelist**

During an event, you can designate any attendee as a panelist. You can also change panelists at any time. For details about a panelist’s role, see *About panelist roles and privileges* (on page 172).

To designate a panelist:

1. On the Participants panel, click View all attendees.

   The Attendee List appears.

2. Select the name of the attendee whom you want to designate as a panelist, and then click Make Panelist.

   The attendee’s name appears in the panelists list.

**About panelist roles and privileges**

The host can designate any attendee as a panelist during an event. A panelist is a participant who is primarily responsible for assisting the presenter and participating in presentation. Any number of attendees can be panelists.

A panelist can do the following during an event:
participate in discussions to which other attendees listen
serve as a subject matter expert in a Q & A session
view and answer questions by attendees in a Q & A session
respond to public and private chat messages
participate in a practice session
annotate shared documents
annotate shared applications, Web browsers, and desktops, if the presenter grants annotation control to the panelist
become a polling coordinator to manage polls
view feedback
record an event
save chat messages to a file
download files that the presenter publishes

Transferring the host role

As the event host, you can transfer the host role—and control of the event—to a panelist at any time. This option is useful if you need to leave an event for any reason. You can reclaim the host role at any time.

To transfer the host role to a panelist:

1. Optional. If you plan to reclaim the host role later, write down the host key that is displayed on the Info tab in the Event window’s content viewer.

2. On the Participants panel and in the panelists list, select the name of the panelist to whom you want to transfer the host role.
3 On the Participant menu, click Change Role to > Host.

A confirmation message appears, in which you can verify that you want to transfer control of the event to the panelist whom you selected.

4 Click OK.

Reclaiming the host role

If you have transferred control of an event to a panelist, you can gain control of the event by reclaiming the host role.

To reclaim the host role:

1 On the Participants panel, select your own name.

2 On the Participant menu, choose Reclaim Host Role.

   The Reclaim Host Role dialog box appears.

3 Type the host key in the Host key box.

4 Click OK.

Tip:
- If you did not write down the host key before transferring the host role to another panelist, you can ask the current host to send you the host key in a private chat message. The host key appears on the current host’s Info tab in the content viewer.
- If you leave an event—whether intentionally or inadvertently—and then log back in to your Event Center Web site, you automatically become the event host once you rejoin the event. You can rejoin an event using your list of scheduled events under My WebEx.

Restricting access to an event

Once you start an event, you can restrict access to it at any time. This option prevents anyone from joining the event, including attendees whom you invited to the event but have not yet joined it.

To restrict access to an event:

In the Event window, on the Event menu, choose Restrict Access.

Attendees can no longer join the event.
To restore access to an event:

On the Event menu, choose Restore Access.

### Removing a participant from an event

You can remove a panelist or an attendee from an event at any time.

#### To remove an attendee from an event:

1. On the Participants panel, click **View all attendees**.
   The Attendee List dialog box appears.
2. Select the name of the attendee whom you want to remove, and then click **Expel**.
   A confirmation message appears.
3. Click **Yes**.
   The attendee is removed from the event.

#### To remove a panelist from an event:

1. On the Participants panel, and in the panelists list, select the name of the panelist whom you want to remove.
2. On the Participant menu, choose **Expel**.
   A confirmation message appears.
3. Click **Yes**.
   The panelist is removed from the event.

**Tip:** To prevent an expelled attendee from rejoining an event, you can restrict access to the event. For details, see *Restricting access to an event* (on page 174).

### Ending an event

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>leave an event as the host</td>
<td><em>Leaving an event as the host</em> (on page 176)</td>
</tr>
</tbody>
</table>
Chapter 13: Managing an Event

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>end an event for all participants</td>
<td>Ending an event (on page 176)</td>
</tr>
</tbody>
</table>

Leaving an event as the host

If you want to leave an event but do not want to end the event for all participants, you can transfer the host role to a panelist before leaving.

If you are participating in a call-back teleconference or an Internet phone conference, Event Center disconnects you from the conference once you leave the event.

To leave an event:

1. In the Event window, on the File menu, choose End Event.
   The End Event dialog box appears.
2. Select Leave this event without ending it.
3. In the New Host drop-down list, choose the panelist to whom you want to transfer the host role.
4. Click OK.
   If you have not yet saved annotated documents or presentations, poll questionnaire, poll results, or chat messages, Event Center asks you whether you want to save them before ending the event. Once you respond to the message, the Event window closes.

Ending an event

Once you end an event, the Event window closes for all participants. If the event includes an integrated teleconference or an Internet phone conference, the conference also ends.

To end an event:

1. In the Event window, on the File menu, choose End Event.
   The End Event dialog box appears.
2. Select End this event for all participants, and then click OK.
If you have not yet saved annotated documents or presentations, poll questionnaire, poll results, or chat messages, Event Center asks you whether you want to save them before ending the event. Once you respond to the message, the Event window closes.
Managing Question-and-Answer Sessions

Host only

During a question-and-answer (Q & A) session, you can respond to questions that attendees ask during the event. A Q & A session not only provides instant text messaging similar to that in Chat, but also does the following:

- Provides a more formal procedure for asking and answering questions in text format
- Automatically groups questions to help you manage the queue, such as quickly identifying questions that you have or have not answered
- Displays visual cues for the status of questions
- Lets you assign questions to the appropriate domain expert on your team
- Allows you to quickly send a standard response to questions for which you cannot or do not want to answer immediately

You can save the questions and answers in a Q & A session to either a text (.txt) file or a comma-separated/comma-delimited values (.csv) file for future reference.

Tip: If you use Q & A during an event, WebEx recommends that a panelist (the host or presenter) monitors the Q & A panel at all times during the event.
Allowing participants to use Q & A

_Host only_

To use Q & A during an event, ensure that the Q & A option is turned on. You can also turn it off at any time, if necessary.

To turn on or off Q & A during an event (Windows):

1. In the Event window, on the _Event_ menu, choose _Options_.
   An options dialog box appears.
2. On the _Communications_ tab, check or uncheck _Q & A_, as appropriate, and then select _OK_.

To turn on or off Q & A during an event (Mac):

1. In the Event window, on the _Event Center_ menu, select _Preferences_.
2. Select _Tools_.
3. Check or uncheck _Q & A_, and then select _OK_.

Setting privacy views in Q & A sessions

_Host only_

To protect the privacy of panelists and attendees during an event, you can hide or show the following information when questions and answers are published on attendees' Q & A panels:

- Names of attendees who send questions
- Names of panelists who send answers
- Time stamps for questions and answers respectively

**Note:** The names of attendees and panelists and time stamps are always visible on panelists’ Q & A panels.
To set privacy views:

1. Open the Attendee Options dialog by following one of these steps:
   - Windows: Right-click the title bar of your Q & A panel, and then choose Attendee Options.
   - Mac: Select ctrl, click, and then choose Attendee Options.

2. In the dialog box that appears, select any of the options that you want attendees to see, and then click OK.

Managing questions on your Q & A panel

The tabs and visual cues on your Q & A panel allow you to manage the questions you receive in the queue in the following ways:
Chapter 14: Managing Question-and-Answer Sessions

- Set a priority for any question you have received
- Identify the status of questions and answers—answered, unanswered, assigned, private, dismissed, or deferred—and address questions that need your attention.
- Assign questions to the appropriate expert on your team in the event.
- Get an idea of the interactions between the panelists and attendees who ask questions.

1. The auto-grouping of questions by tab make it easy for you to filter and answer questions.

Examples:
Follow up on the questions that are sent or assigned to you on the My Q & A panel.
View questions that have been given a priority status on the Prioritized tab; view only questions with a certain priority status on the Prioritized tab.

2. Visual cues, such as "deferred" and "private," tell you the status of a question.

3. A question appears bold if no panelist has answered it.
Right-click (Windows) or select ctrl and click (Mac) a question to:

- Assign it to a subject-matter expert, defer it, or dismiss it
- Assign a priority status
- Send a standard response if this question has been answered verbally

Working with the tabs on your Q & A panel

Your Q & A panel consists of five tabs. The All tab displays by default. The following table describes what each tab displays.

<table>
<thead>
<tr>
<th>Tab</th>
<th>Displays ...</th>
</tr>
</thead>
<tbody>
<tr>
<td>All</td>
<td>All questions and answers—unanswered, answered, private, deferred, and dismissed—in the queue</td>
</tr>
<tr>
<td>Unanswered</td>
<td>Questions that have not been answered by a panelist</td>
</tr>
<tr>
<td>Answered</td>
<td>Questions that have been answered by a panelist and answers</td>
</tr>
<tr>
<td>My Q &amp; A</td>
<td>Questions that</td>
</tr>
<tr>
<td></td>
<td>- attendees specifically send to you by your name</td>
</tr>
<tr>
<td></td>
<td>- other panelists assign to you</td>
</tr>
<tr>
<td></td>
<td>- attendees send to All Panelists and that you have answered</td>
</tr>
<tr>
<td></td>
<td>- attendees send to Host&amp;Presenter, Host, or Presenter, if you are the host or presenter</td>
</tr>
<tr>
<td>Prioritized</td>
<td>Questions that have been assigned a priority status</td>
</tr>
</tbody>
</table>

Opening a tab

When you open the Q & A panel, the All tab appears by default.

To open other tabs on the Q & A panel:

1. Depending on the operating system you are using, follow one of these steps:
Chapter 14: Managing Question-and-Answer Sessions

- Windows: Right-click the All tab.
- Mac: Select ctrl and then click the All tab.

2. Choose Open Tab > the tab you want to open.

3. If you want to open one more tab, right-click (Windows) or select ctrl and click (Mac) any of the open tab, and then choose Open Tab > the tab you want to open.

Displaying hidden tabs

The Q & A panel cannot display all open tabs at one time unless you expand the panels to the left.

To display a hidden tab on the Q & A panel:
Click the downward arrow, and then choose the tab you want to display.

Closing a tab

You can close all the tabs, except the All tab, on your Q & A panel.

To close a tab on the Q & A panel:
Click the X button on the tab you want to close.

*Note:* Closing a tab does not remove the information on the tab. You can view the information on that tab by opening it again. *More...* (on page 183)
Assigning a question

You can assign questions to yourself or another panelist. The questions appear on the designated panelists' My Q & A tab, with the text assigned next to them.

To assign a question:

From any of the tabs on which you received the question, right-click (Windows) or select ctrl and then click (Mac) the question, and then choose Assign to > the person you want to assign it to.

Note:
- To assign multiple questions at the same time, hold down the Ctrl key while selecting the questions.
- If an assigned question is answered, the text assigned still displays.
- The text assigned does not display on attendees' Q & A panels.

Prioritizing questions

You can set priorities—high, medium, or low—for any questions you have received on the Q & A panel. Your prioritized questions display on the Prioritized tab.

To set a priority for a question:
Chapter 14: Managing Question-and-Answer Sessions

Right-click (Windows) or select **ctrl** and then click (Mac) the question, and then choose **Priority** > **High**, **Medium**, or **Low**.

**Fast track**
After you set a priority for a question for the first time during an event, a column appears to the left of the Q & A panel showing rectangular icons.
Click the rectangular icon for the question you want to set priorities for, and then choose **High**, **Medium**, or **Low**.

**To remove the priority status from a question:**
Click the rectangular icon for the question, and then choose **Clear**.

**Viewing prioritized questions**

You view your prioritized questions on the **Prioritized** tab.

To view your prioritized questions:
1. Click the **Prioritized** tab.
2 Optional. To view only questions with a certain priority status, select the status at the "View priority" option.

If you do not want to view questions with a certain status, uncheck the appropriate check box.

Answering questions in a Q & A session

During a Q & A session, you can:

- Provide an answer to a question publicly. More… (on page 188)
- Provide an answer to a question privately. More… (on page 188)
- Defer a question. More… (on page 190)
- Dismiss a question. More… (on page 189)

Tip: You can respond to a question from any of the four tabs on which you receive the specific question. If a question shows as assigned on the All tab, you can check whether this question has been assigned to you on your My Q & A tab.

When a panelist is typing an answer to a question that no one else has responded to yet, an in-progress indicator displays under that question for all participants. This figure shows an example.

Alex Simpson - 03:40 pm
Q: (assigned) hello, I have a question.
This question is being answered...
Providing a public answer

Your answer to a question appears on all participants' Q & A panels, unless you choose to send your answer privately.

To provide a public answer during a Q & A session:

1. On your Q&A panel, select the question from any of the tabs on which you received the question.

   To select a question, click it once.
   To copy the question into the text box, right-click (Windows) or press ctrl and then click (Mac) your mouse, choose Copy, and then paste it in the text box.
   To clear the selection, right-click (Windows) or press ctrl and then click (Mac) the question, and then choose Deselect.

2. Type your answer in the text box.

   To edit your answer before sending it, highlight the text you want to edit and then right-click (Windows) or press ctrl and then click (Mac) the highlighted text. The menu that appears provides editing commands.

3. When you finish typing your answer, click Send.

   The answer appears on all panelists' and attendees' Q & A panels.

Answering a question privately

If you send your answer privately, these participants can see the private answer:

- the attendee who sent you the question
- all panelists

To answer a question privately:

1. On your Q&A panel, select the question from any of the tabs on which you received the question, and then click Send Privately.
Chapter 14: Managing Question-and-Answer Sessions

To select a question, click it once.

To copy the question into the text box, right-click (Windows) or press ctrl (Mac) your mouse, choose Copy, and then paste it in the text box.

To clear the selection, right-click (Windows) or press ctrl and then click (Mac) the question, and then choose Deselect.

2 In the dialog box that appears, type your answer in the text box.

3 If you want to save the answer you typed as the standard private answer for all panelists to use, click Save or Save as Default.

4 Click Send.

Dismissing a question

In a Q & A session, you can dismiss a question using a standard or customized answer. The standard answer reads: Thank you for your question. The information that you requested cannot be provided by any of the panelists.

If you dismiss a question, these participants can see the Dismiss answer:

- the attendee who sent the question
- all panelists

To dismiss a question during a Q & A session:

1 From any of the tabs where you received the question, right-click the question, and then choose Dismiss.

Tip for Windows users: To dismiss multiple questions at one time, hold down the Ctrl key while selecting the questions, right-click your mouse, and then choose Dismiss.

The Respond Privately dialog box appears, containing the standard Dismiss answer.

2 Optional. To customize the standard answer, click Custom, and then edit the text in the text box.
3 Optional. To save your customized answer as the standard *Dismiss* answer for all panelists to use, click **Save** (Windows) or **Save as Default** (Mac).

4 Click **Send**.

5 Click **Yes** in the confirmation message box.

**Deferring a question**

In a Q & A session, you can defer a question using a standard or customized answer. The standard answer reads: *Thank you for your question. Your question was deferred but will remain in the queue. A panelist will answer your question at a later time.*

If you defer a question, the following participants can see the **Defer** answer:

- the attendee who sent the question
- all panelists

To defer a question during a Q & A session:

1 From any of the tabs where you received the question, right-click the question, and then choose **Defer**.

| Tip for Windows users: To defer multiple questions at one time, hold down the **Ctrl** key while selecting the questions, right-click your mouse, and then choose **Defer**. |

The Respond Privately dialog box appears, containing the standard **Defer** answer.

2 Optional. To customize the standard answer, click **Custom**, and then edit the text in the text box.

3 Optional. To save your customized answer as the standard **Defer** answer for all panelists to use, click **Save** (Windows) or **Save as Default** (Mac).

4 Click **Send**.

**Responding to questions answered verbally**

If a question has been answered verbally, you can send a standard response: *This question has been answered verbally.*

Follow these steps:
Archiving Q & A sessions

At any time during an event, you can save the questions and answers on the All tab on your Q & A panel to a .txt or .csv (comma-separated/comma-delimited values) file. If there are updates in the Q & A session, you can save them to the existing file.

Once you save a new Q & A session to a file, you can also save a copy to another file.

Saving a Q & A session

At any time during an event, you can save the questions and answers on the All tab on your Q & A panel to a .txt or .csv file.

Note: Event Manager automatically saves Q & A sessions every two minutes to the WebEx folder in the My Documents folder on the host and presenter computers.

To save a Q & A session:

1  In the Event window, on the File menu, choose Save > Questions and Answers.
2  Choose a location at which to save the file.
3  Type a name for the file.
Chapter 14: Managing Question-and-Answer Sessions

4 In the **Save as type** box, select **Text Files (*.txt)** or **CSV** (comma-separated/comma-delimited values).

5 Click **Save**.

Event Manager saves the file at the location and format that you chose.

To review the content of an archived Q & A session, open the .txt file in a text editor or the .csv file in a spreadsheet program, such as Microsoft Excel.

**Saving changes to a saved Q & A session**

If you have previously saved a Q & A session, and there are additional changes in the Q & A session, you can save the updates to the existing file.

To save changes in an existing Q & A file:

In the event window, on the **File** menu, choose **Save > Questions and Answers**.

Event Center saves the changes to the existing Q & A file.

**Note:** If there are no changes on the **All** tab on your Q & A panel, the Save option is unavailable.

**Saving a copy of a previously saved Q & A session**

If you have previously saved a Q & A session, and you want to save another copy of the session, you can do so by following these steps:

1 In the Event window, on the **File** menu, choose **Save As > Question and Answers**.

The Save Questions and Answers As dialog box appears.

2 Do **any or all** of the following:

   ▪ Type a new name for the file.
   ▪ Choose a new location at which to save the file.
   ▪ Choose a different format for the file.

3 Click **Save**.

Event Manager saves the file with any additional changes in the Q & A session.
Opening a Q & A file

The Q & A files that you saved during an event have either a .txt or .csv extension.

To view a .txt file, open it in a text editor, such as Notepad.

To view a .csv file, open it in a spreadsheet program, such as Microsoft Excel.
Participating in a Question-and-Answer Session

Question-and-Answer (Q & A) sessions during an event allow you to ask questions and receive answers using your Q & A panel, in a more formal way than Chat.

Your Q & A panel automatically groups questions and answers into these two tabs, which make it easy for you to check whether your questions have been answered:

- **All**—all questions and answers in a Q & A session during the event *More...* (on page 195)
- **My Q & A**—the questions you sent and the answers to your questions *More...* (on page 195)

**Note:** The host has to turn on the Q & A function in the event before you can use the Q & A panel.

**Working with the tabs on your Q & A panel**

Your Q & A panel provides two views of the question-and-answer queue: the **All** and **My Q & A** tabs. The **All** tab stays open all the time on your Q & A panel.

The **My Q & A** tab displays as soon as you send your first question using Q & A. You can close the **My Q & A** tab at any time.
To open the My Q & A tab:

Right-click (Windows) or select ctrl and then click (Mac) the All tab, and then choose Open Tab > My Q & A.

To close the My Q & A tab:

Right-click (Windows) or select ctrl and then click (Mac) the My Q & A tab, and then choose Close Tab.

**Note:** Closing the My Q & A tab does not cause you to lose the questions and answers on the tab. You can re-open it at any time.

---

**Asking a question in a Q & A session**

During an event, you can send your questions to all or specific panelists in a Q & A session.

**To ask a question in a Q & A session:**

1. Open the Q & A panel.
2. On the Q & A panel, type your question in the text box.
3. Optional. To edit your question, highlight the text you want to edit, and then right-click (Windows) or select ctrl and then click (Mac) to use the editing commands in the menu.
4. In the Ask drop-down list, select the recipient, and then click Send.

---

**Checking the status of your questions**

The auto-grouping of questions and answers and visual cues on attendees’ Q & A panels make it easy for you to check whether a panelist has responded to your question.

Always check the My Q & A tab to quickly find out whether your question has been answered. *More...* (on page 197)

When a panelist is answering your question, an indicator appears under the question. *More...* (on page 197)
Chapter 15: Participating in a Question-and-Answer Session

My Q & A tab

Your Q & A panel provides two views of the question-and-answer queue: the All and My Q & A tabs. Always check the My Q & A tab to quickly find out whether your question has been answered. This tab displays a list of the questions you sent and the answers, whether public or private, to those questions.

<table>
<thead>
<tr>
<th>Q&amp;A</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>All (3)</strong></td>
<td><strong>My Q&amp;A (2)</strong></td>
</tr>
</tbody>
</table>

**Jay Chow** - 10:46 am  
Q: I have a question.

**Janet Goodman** - 10:48 am  
A: yes, please send it to me.

**Jay Chow** - 10:58 am  
Q: How do I record the session?

**Felicity Wu** - 10:59 am  
A: [private] We will post the recording after the session ends.

1. The My Q & A tab displays the questions that you sent and the answers to those questions.

2. If a panelist answers your question privately, the text `private` appears next to the answer. No attendee can see this private answer, except yourself.

Answering indicator

When a panelist is typing an answer to a question, an in-progress indicator displays under that question. This figure shows an example.
Jay Chow - 01:54 pm

Q: I have a question.

This question is being answered...
An integrated teleconference can be either a call-in teleconference or call-back teleconference.

Your user role in a teleconference determines your level of participation. Whichever role you take, the following table describes the basic tasks associated with that role. For detailed instructions on a particular task, click “More” by the task description.

<table>
<thead>
<tr>
<th>Role</th>
<th>Task description:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Host</td>
<td>Start and manage a teleconference:</td>
</tr>
<tr>
<td></td>
<td>- join the conference [More…](on page 200)</td>
</tr>
<tr>
<td></td>
<td>- invite participants [More…](on page 165)</td>
</tr>
<tr>
<td></td>
<td>- use caller identification to start or join teleconferences [More…](on page 202)</td>
</tr>
<tr>
<td></td>
<td>- mute or unmute one or more microphones [More…](on page 202)</td>
</tr>
</tbody>
</table>
### Role

<table>
<thead>
<tr>
<th>Participants</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Task description:</strong></td>
</tr>
<tr>
<td>Participate in a teleconference:</td>
</tr>
</tbody>
</table>
| - Join, rejoin, or leave a conference  
  *More… (on page 200)* |
| - Mute or unmute your microphone  
  *More… (on page 205)* |
| - Ask to speak  
  *More… (on page 205)* |

**Note:** If you set up another type of teleconference, such as that of a third-party teleconferencing service, you must manage the conference using the options that service provides.

---

**Joining or leaving a teleconference**

Once you join an event, instructions for joining the teleconference automatically appear on your screen. The instructions differ, depending on whether the host set up a call-back teleconference or a call-in teleconference.

During an event, you can leave a teleconference without leaving the event. You can also rejoin the teleconference at any time.

Once you join a teleconference, the **Teleconference** indicator appears to the left of your name on the Participants panel.

**To join a call-back teleconference:**

In the Join Teleconference dialog box, provide your phone number. The automated system will call you and add you to the teleconference.

**Tips for joining a call-back teleconference:**

- Select the **Remember phone number on this computer** check box if you want this number to be entered automatically each time you join a teleconference.
If you are unable to join a call-back conference, you can dial the backup call-in number instead. To obtain the call-back number, see your invitation email message, if you received one; find it on the Info tab in the Event window; or find it by choosing Information on the Event menu.

To join a call-in teleconference:
In the Join Teleconference dialog box, dial the appropriate number to join the teleconference.

**Note for joining a call-in teleconference:** If the global call-in numbers option is available, a list of international phone numbers appears on the Join Teleconference dialog box. Dial the appropriate number for your location, and then click OK to close the dialog box. For a list of toll-free calling restrictions by country, see www.webex.com/pdf/tollfree_restrictions.pdf.

To display teleconference instructions during an event:
On the Communicate menu, choose Join Teleconference.

To rejoin a teleconference:
On the Communicate menu, choose Join Teleconference.

To leave a teleconference:
Hang up the phone; or choose Leave Teleconference on the Communicate menu.

**Inviting attendees to a teleconference in progress**

You can invite attendees to only the audio portion of the event by having them join a teleconference.

**Example.** You are hosting a large all-hands company event online. One of the executives prefer listening in to the event because he is on the road. You provide his phone number in the Invite by Phone dialog box. When he receives a call back at the phone number you provided, he can join the teleconference in the event by following the instructions in the voice message.

**Important:** To use this option, you must set up a call-back teleconference when scheduling the event.
To invite attendees to only a teleconference in an event:

1. In your content viewer, select the Quick Start tab and click Invite and Remind.
2. Select the Phone tab.
3. Enter the attendee’s name and phone number, including the area code.
4. Ensure that the country or region code is correct. To select a different country code, click the down arrow in the Phone Number field.
5. Click Call.

The teleconferencing service calls the attendee. The Conference button becomes available for you to call another attendee.

**Muting and unmuteing microphones in a teleconference**

The following table illustrates how to quickly mute and unmute microphones in a teleconference depending on your user role. For detailed instructions, click “More” by the task description.

<table>
<thead>
<tr>
<th>Role</th>
<th>Task description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Host</td>
<td>You can:</td>
</tr>
<tr>
<td></td>
<td>• Mute all attendees' microphones automatically when they join a meeting More… (on page 202)</td>
</tr>
<tr>
<td></td>
<td>• Mute or unmute a specific participant's microphone More… (on page 203)</td>
</tr>
<tr>
<td></td>
<td>• Mute or unmute all attendees' microphones simultaneously at any time during a meeting More… (on page 204)</td>
</tr>
<tr>
<td>Participant</td>
<td>Mute or unmute your own microphone at any time More… (on page 205)</td>
</tr>
</tbody>
</table>

**Muting participants' microphones automatically when they join an event**

*Host only*
In a teleconference, you can automatically mute all participants' microphones as they join the event. You can then allow specific participants to speak by unmuting their microphones.

**To mute all participants' microphones when they join the event:**

On the Participant menu, choose Mute on Entry.

Once a participant joins the event, the Muted indicator appears to the left of the participant's name. For example:

![Muted Indicator](image)

You can see the attendee list by clicking View all attendees on the Participants panel.

**Note:** Attendees for whom you have muted microphones can request to speak at any time during an event, by clicking Raise Hand on their Participant panels.

---

**Muting and unmuting a specific participant's microphone**

*Host only*

In a teleconference, you can mute or unmute a specific participant’s microphone, including the microphone for:

- An attendee
- The presenter
- Any panelist

**To mute or unmute a specific participant's microphone:**

1. On the Participants panel, select one or more participants for whom you want to mute or unmute microphones.
   
   To select multiple attendees, hold down the Ctrl key on your keyboard.

2. On the Participants panel, click Mute or Unmute to control each participant's microphone.
The indicator beside the attendee's name changes state when you mute or unmute the attendee's microphone.

**Note:** Attendees for whom you have muted microphones can request to speak at any time during an event, by clicking **Raise Hand** on their Participant panels.

---

**Muting and unmuting all attendees’ microphones simultaneously**

*Host only*

During a teleconference, you can mute or unmute all attendees' microphones simultaneously.

This option does not affect the host’s, the presenter’s, and any panelists’ microphones.

---

<table>
<thead>
<tr>
<th>To mute all attendees’ microphones</th>
<th>To unmute all attendees’ microphones</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Using your phone keys, press “##”</td>
<td>• Using your phone keys, press “99”</td>
</tr>
<tr>
<td>• On the <strong>Participant</strong> menu, choose <strong>Mute All</strong></td>
<td>• On the <strong>Participant</strong> menu, choose <strong>Unmute All</strong></td>
</tr>
</tbody>
</table>
Note: Attendees for whom you have muted microphones can request to speak at any time during an event, by clicking Raise Hand on their Participant panels.

Muting and unmuting your microphone in a teleconference

**Participant**

In a teleconference, you can mute or unmute your microphone at any time. However, if the host has muted your microphone, you cannot unmute it.

**To mute or unmute your microphone:**

On the Participants panel, select your name, and then click Mute or UnMute.

Asking to speak in a teleconference

**Participant**

If the host has muted your microphone during a teleconference, you can ask the host to unmute your microphone so that you can speak. You can cancel a request to speak at any time.

<table>
<thead>
<tr>
<th>To ask to speak</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>Click Raise Hand On the Participants’ panel</td>
<td>The Raised Hand indicator appears on the Participant panel for the host, presenter, and panelists.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>To cancel a request to speak</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>Click Lower Hand On the Participants’ panel</td>
<td>The Raised Hand indicator is removed from the Participant panel for the host, presenter, and panelists.</td>
</tr>
</tbody>
</table>
Determining who is speaking in a teleconference

Participant

During a teleconference, you can quickly determine which participants are speaking. When a participant speaks, the Teleconference indicator on the Participants panel animates. For example:

Broadcasting audio streams to all attendees

Audio broadcast allows the host, presenter, and other panelists to speak to attendees without requiring them to connect to a teleconference. Attendees can listen to the audio part of the event through their speakers or headsets.

Using audio broadcast can help reduce the cost of a large event because attendees do not need to connect to a teleconference.

During an audio broadcast, attendees must have the necessary audio capacity such as speakers or headsets to listen to the audio part of the event.

Your user role in an audio broadcast determines your level of participation. The following table describes the tasks you may want to perform in an audio broadcast. For detailed instructions, click "More" by a task description.
## Chapter 16: Using Teleconferencing

### Role

<table>
<thead>
<tr>
<th>Host</th>
<th>Task description:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start and manage a teleconference:</td>
<td></td>
</tr>
<tr>
<td>- Broadcast audio to all attendees in the event. [More…](on page 207)</td>
<td></td>
</tr>
<tr>
<td>- Accept an attendee’s request to speak. [More…](on page 210)</td>
<td></td>
</tr>
<tr>
<td>Attendee</td>
<td>Connect to an audio broadcast:</td>
</tr>
<tr>
<td>- Ask to join the teleconference so that you can speak. [More…](on page 210)</td>
<td></td>
</tr>
<tr>
<td>- Control the audio on your computer. [More…](on page 211)</td>
<td></td>
</tr>
<tr>
<td>- Leave audio broadcast. [More…](on page 212)</td>
<td></td>
</tr>
<tr>
<td>- Rejoin audio broadcast. [More…](on page 212)</td>
<td></td>
</tr>
</tbody>
</table>

### Starting an audio broadcast

*Host only*

You and the other panelists must join a teleconference first before you can use audio broadcast.
To broadcast audio stream in an event, you must select the audio broadcast option when scheduling the event. If you select the audio broadcast option when scheduling an event, Integrated VoIP becomes unavailable.

**Using a third-party teleconference for audio broadcast**

If you use a third-party teleconference provider, rather than the WebEx teleconferencing service, you must also connect your third-party teleconference bridge to the audio broadcast.

To connect your third-party teleconference bridge to audio broadcast:

Provide your teleconference account information in the Audio Broadcast Connection dialog box.

This table describes each option and text box in the Audio Broadcast Connection dialog box:

<table>
<thead>
<tr>
<th>Use this option or text box</th>
<th>To...</th>
</tr>
</thead>
</table>
| **Dial-in number**          | Enter the dial-in number for a teleconference.  
**Note:** The number cannot contain characters, such as - or ().
Use this option or text box | To…
---|---
Greeting bypass digit | Select the key or digit, if there is one, that you use to bypass the greeting when you call the dial-in number.
Pause before user ID | Specify the amount of time you have to wait before you are asked to enter your user ID. Note that if you choose to bypass the greeting, the wait is shorter. Depending on your teleconference service, a user ID could be called a pin number, conference ID, meeting number, or an access code.
User ID | Enter your user ID. If you are asked to press a key at the end of your user ID, ensure to include it. Depending on your teleconference service, a user ID could be called a pin number, conference ID, meeting number, or an access code.
Pause before user PIN | Specify the amount of time you have to wait from the time you finish entering the last key to the time you are asked to enter a second user ID, if there is one. Depending on your teleconference service, a pin could be called a pin number, user ID, conference ID, meeting number, or an access code.
User PIN | Enter your pin number—that is, the second user ID you are asked to enter, if there is one. Depending on your teleconference service, a pin could be called a pin number, user ID, conference ID, meeting number, or an access code.

**Tips for connecting a third-party teleconference to audio broadcast**

These are tips that can help you connect to audio broadcast more efficiently during an event:

- Do dry runs to understand the call flow. For example, take notes of what is the greeting bypass key and how long is the pause before you are asked to provide your access code.
- Start your event early, and connect to a teleconference early to ensure no delay in your event.
Chapter 16: Using Teleconferencing

Asking to speak during an audio broadcast

*Attendees only*

Once you join the event, audio broadcast starts automatically, and you will hear the audio part of the event. If necessary, you can request to join the teleconference to speak.

To request to join the teleconference to speak:

On your Participant’s panel, click **Request**.

- If your request is granted, instructions for joining the teleconference appear on your screen.
- If your request is denied, a message appears on your screen to that effect.

Accepting an attendee’s request to speak

During audio broadcast, attendees can listen to only the audio part of the event. If it is necessary, an attendee can request to join the teleconference and speak. After an attendee makes a request, an indicator appears to the left of the attendee’s name on the Participants panel and the Attendee List dialog box.

To grant the teleconferencing privilege to an attendee who makes a request:

Do either of the following:

- On your Participants panel, select the attendee’s name, and then click **Allow**.
- Click **View all attendees** on your Participants panel to open the Attendee List dialog box. In the dialog box, select the attendee’s name, and then click **Allow**.

The attendee then sees instructions for joining the teleconference on his or her screen.

The following figure shows an example of your Participants panel during audio broadcast. You can open the Attendee List dialog box by clicking **View all attendees**.
Automatically granting attendees the teleconferencing privilege

If you want to automatically grant the teleconferencing privilege to each attendee who makes a request, do the following:

1. On the Participant menu, click Assign Privileges To > Attendees.
2. Select Automatically approve teleconferencing requests, and then click Assign.

Attendees will receive instructions for joining the teleconference once they request to speak.

Controlling the audio on your computer

During an audio broadcast, you can use the Audio broadcast panel to pause, stop, or resume audio broadcast and to adjust the audio volume.

1. To pause or resume audio broadcast on your computer, click this button.
2. To stop audio broadcast on your computer, click this button.
To adjust the audio volume, use the volume slider.

**Leaving audio broadcast**

You can leave audio broadcast at any time.

**To leave audio broadcast:**

In the Event window, choose **Communicate > Leave Audio Broadcast.**

Your Audio broadcast panel closes.

**Joining audio broadcast**

If you closed your Audio Broadcasting panel for any reason, you can rejoin audio broadcast at any time.

**To join audio broadcast:**

In the Event window, choose **Communicate > Join Audio Broadcast.**

Your Audio Broadcast panel appears.
Using Integrated VoIP Conferences

During an event, you can join an integrated voice conference in which participants speak to each other using Voice over Internet Protocol (VoIP)—a technology that transmits voice calls over the Internet. Integrated voice conferences are useful if

- Participants are located a great distance away and do not want to incur long distance phone charges.
- The event is a presentation rather than a discussion and does not involve interaction among participants.

Your user role in an integrated voice conference determines your level of participation. Whichever role you take, the following table describes the basic tasks associated with that role. For detailed instructions on a particular task, click “More” by a task description.
### Role

<table>
<thead>
<tr>
<th>Role</th>
<th>Task description:</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>host</strong></td>
<td>Start and manage an integrated voice conference:</td>
</tr>
<tr>
<td></td>
<td>- set conference options &lt;More… (on page 218)</td>
</tr>
<tr>
<td></td>
<td>- start or end a conference &lt;More… (on page 214)</td>
</tr>
<tr>
<td></td>
<td>- mute or unmute participant microphones &lt;More… (on page 217)</td>
</tr>
<tr>
<td></td>
<td>- Mute or unmute your microphone &lt;More… (on page 217)</td>
</tr>
<tr>
<td><strong>participant</strong></td>
<td>Participate in an integrated voice conference:</td>
</tr>
<tr>
<td></td>
<td>- Join or leave a conference &lt;More… (on page 215)</td>
</tr>
<tr>
<td></td>
<td>- Mute or unmute your microphone &lt;More… (on page 217)</td>
</tr>
</tbody>
</table>

**Note:** For better audio quality and greater convenience, use a computer headset with a high-quality microphone, rather than speakers and a microphone.

### Starting or ending an integrated voice conference

Once a host and panelist starts an integrated voice conference, any participant whose computer has a supported sound card can join the conference.

A host and panelist can end an integrated voice conference at any time.

**To start or end an integrated voice conference:**

On the Audio menu, choose **Integrated Voice Conference > Start Conference** or **End Conference.**
**Note:** To start an integrated voice conference, you must have selected the integrated VoIP option when setting up your event. Otherwise, an integrated voice conference is unavailable during the event.

---

**Joining or leaving an integrated VoIP conference**

During an event, you can leave an integrated voice conference without leaving the event. You can also rejoin the conference at any time.

To join or leave an integrated voice conference, do one of the following:

- Click **Yes** to join the conference when the Join This Integrated Voice Conference message appears on your screen.
- On the **Audio** menu, choose **Integrated Voice Conference > Join Conference** or **Leave Conference** respectively.

To rejoin an integrated voice conference:

On the **Audio** menu, choose **Integrated Voice Conference > Join Conference**.

**Tip:** Before starting or joining an integrated voice conference, use the Audio Setup Wizard to fine-tune your computer's settings for integrated VoIP. For details, see *Setting integrated VoIP conference options* (on page 218).

---

**Speaking in an integrated VoIP conference**

If you are a current speaker, the method by which you speak depends on the speaker setup option that is currently selected for your event:

- **Desktop speakers (default):** If this option is selected, the following appears in the bottom-right corner of your Event window:

  ![Press CTRL to speak]

  Press the **Ctrl** key on your keyboard while speaking.Pressing this key mutes your speakers, thereby preventing your voice from echoing in the conference.
• **Headset:** If this option is selected, the following appears in the bottom-right corner of your Event window:

![Speak Now](image)

Simply speak into your microphone.

**Tip:** Before you join an integrated voice conference, you can use the Audio Setup Wizard to select your speaker setup. For details, see *Setting integrated VoIP conference options* (on page 218).

---

**Muting and unmuting microphones in an integrated voice conference**

The following table illustrates how to quickly mute and unmute microphones in a conference depending on your user role. If you want detailed instructions, click “More” by the task description.

<table>
<thead>
<tr>
<th>Role</th>
<th>Task description:</th>
</tr>
</thead>
<tbody>
<tr>
<td>host</td>
<td>You can:</td>
</tr>
<tr>
<td></td>
<td>• mute or unmute your own microphone at any time <em>More…</em> (on page 217)</td>
</tr>
<tr>
<td></td>
<td>• mute all participants’ microphones <em>More…</em> (on page 217)</td>
</tr>
<tr>
<td></td>
<td>• mute or unmute a specific participant’s microphone <em>More…</em> (on page 217)</td>
</tr>
<tr>
<td>participant</td>
<td>mute or unmute your own microphone at any time <em>More…</em> (on page 217)</td>
</tr>
</tbody>
</table>
Mutting and unmouting participant microphones

*Host and panelist only*

In an integrated voice conference, you can mute or unmute one or more participant microphones.

**To mute or unmute a specific participant’s microphone:**

1. On the Participants panel, select the participant for whom you want to mute or unmute the microphone.
2. Click Mute or Unmute to control the participant’s microphone.

The Muted or Unmuted indicator appears to the left of the participant’s name. For example:

![Wanda Bernstein](image)

The indicator beside the attendee’s name changes state when you mute or unmute the attendee’s microphone.

**Note:** If a participant is a current speaker in an integrated VoIP conference and you have not muted his or her microphone, that participant can mute or unmute his or her own microphone independently.

To mute or unmute an attendee’s microphone, click View all attendees on the Participants panel. Select the attendee’s name, and then click Mute or Unmute.

**To mute or unmute all participant microphones at time of joining:**

On the Participant menu, choose Mute on Entry.

**To mute or unmute all participants’ microphones during an event:**

On the Participant menu, choose Mute All or Unmute All, respectively.

Mutting and unmutting your microphone

If you are the current speaker in an integrated voice conference, you can mute or unmute your microphone at any time. However, if the host has muted your microphone, you cannot unmute it.
To mute or unmute your microphone:

1. On the Participants panel, select your name.
2. Click **Mute** or **Unmute**.

The indicator to the left of your name changes state.

---

**Setting integrated voice conference options**

- Use the Audio Setup Wizard to
  - specify your audio equipment and set optimal volume levels. You can specify whether you are using speakers and a separate microphone, or a headset with an integrated microphone
  - ensure that your microphone and speakers are set to their optimal volume levels.
- Use the Volume dialog box to adjust the volume for your speakers or microphone at any time.

To set integrated voice conference options:

On the **Audio** menu, choose one of these options, and follow the directions:

- Audio Setup Wizard
- Integrated Voice Conference > Volume
Your user role in an event determines your level of sharing. Whichever role you take, the following table describes the basic tasks associated with that role. For detailed instructions on a particular task, click “More” by the task description.

<table>
<thead>
<tr>
<th>Role</th>
<th>Task description:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Host</td>
<td>Start and control sharing a document or presentation</td>
</tr>
<tr>
<td></td>
<td>• learn about tools for sharing [More](on page 220)</td>
</tr>
<tr>
<td></td>
<td>• start sharing [More](on page 224)</td>
</tr>
<tr>
<td></td>
<td>• assigning sharing privileges to attendees [More](on page 229)</td>
</tr>
<tr>
<td></td>
<td>• save a document [More](on page 243)</td>
</tr>
<tr>
<td>Attendee</td>
<td>View and interact with shared documents and presentations</td>
</tr>
<tr>
<td></td>
<td>• display slides or pages [More](on page 243)</td>
</tr>
<tr>
<td></td>
<td>• use tools to annotate a document [More](on page 244)</td>
</tr>
<tr>
<td></td>
<td>• synchronize your view with the host [More](on page 248)</td>
</tr>
</tbody>
</table>
Granting privileges to attendees

You can grant privileges to or remove privileges from attendees during an event.

To assign attendee privileges during an event:

1. In the Event window, on the Participant menu, click Assign privileges to > Attendees.
   The Attendee Privileges dialog box appears.

2. Do any of the following:
   - To grant a privilege to all attendees, select its check box.
   - To grant all privileges to attendees, select the All attendee privileges check box.
   - To remove a privilege from all attendees, clear its check box.

   For descriptions of each option in the Attendee Privileges dialog box, see Overview of attendee privileges (on page 151).

3. Click Assign.

Content viewer tools

<table>
<thead>
<tr>
<th>Content Viewer</th>
<th>Tools</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Content Viewer" /></td>
<td>The tools on the content viewer toolbar allow you to share and perform actions on presentations, documents, and whiteboards.</td>
</tr>
</tbody>
</table>
Chapter 18: Sharing Presentations, Documents, and Whiteboards

### Content Viewer

<table>
<thead>
<tr>
<th>Tools</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Annotation toolbar</td>
<td>Select a drawing tool for directing attention onscreen, using pointers, a highlighter, or drawing a shape More…</td>
</tr>
<tr>
<td>Windows Sharing toolbar</td>
<td>Use these tools to share applications, documents, your desktop or a white board. More…</td>
</tr>
<tr>
<td>Mac Viewing toolbar</td>
<td>Change to full-screen, rotate pages, zoom in or out using these tools. More…</td>
</tr>
</tbody>
</table>

### Changing views in a file or whiteboard

You can switch views in the content viewer by clicking the viewing icons in the bottom left corner of the content viewer:

<table>
<thead>
<tr>
<th>Tool</th>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Standard View</strong></td>
<td><img src="icon" alt="Standard View" /></td>
<td>Clicking <strong>Standard View</strong> displays the shared content as you would normally view it.</td>
</tr>
<tr>
<td><strong>View Thumbnails</strong></td>
<td><img src="icon" alt="View Thumbnails" /></td>
<td>To display thumbnails, or miniatures, of shared pages, slides, or whiteboards to the side of the content, click <strong>View Thumbnails</strong>. This tool helps you locate a page or slide quickly.</td>
</tr>
<tr>
<td><strong>Full-Screen View</strong></td>
<td><img src="icon" alt="Full-Screen View" /></td>
<td>Displays shared content in a full-screen view. Helps you to ensure that participants can view all activity on your screen. Also helps to prevent participants from viewing or using other applications on their screens during a presentation.</td>
</tr>
</tbody>
</table>
Chapter 18: Sharing Presentations, Documents, and Whiteboards

<table>
<thead>
<tr>
<th>Tool</th>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rotate page</td>
<td></td>
<td>For documents in landscape orientation, you can rotate the pages to the left or right so they appear correctly in the content viewer.</td>
</tr>
<tr>
<td>Zoom In/Zoom Out</td>
<td></td>
<td>Lets you display shared content at various magnifications. Click this button, and then click the page, slide, or whiteboard to change its magnification. For more magnification options, click the downward-pointing arrow.</td>
</tr>
<tr>
<td>Synchronize Displays for All</td>
<td></td>
<td>For presenters, synchronizes all participants' displays with your display. Helps to ensure that all participants are viewing the same page or slide, at the same magnification, as in your display.</td>
</tr>
</tbody>
</table>

Using annotation tools...nested embedding

In an online event, you can use annotation tools on shared content to annotate, highlight, explain, or point to information:

![Basic annotation tools]

<table>
<thead>
<tr>
<th>Annotation Tool</th>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pointer</td>
<td></td>
<td>Lets you point out text and graphics on shared content. The pointer displays an arrow with your name and annotation color. To display the laser pointer, which lets you point out text and graphics on shared content using a red “laser beam,” click the downward-pointing arrow. Clicking this button again turns off the pointer tool.</td>
</tr>
<tr>
<td>Text</td>
<td></td>
<td>Lets you type text on shared content. Participants can view the text once you finish typing it and click your mouse in the content viewer, outside the text box.</td>
</tr>
<tr>
<td>Line</td>
<td></td>
<td>To change the font, on the Edit menu, choose Font. Clicking this button again turns off the text tool.</td>
</tr>
<tr>
<td>Rectangle</td>
<td></td>
<td>Lets you draw lines and arrows on shared content. For more options, click the downward-pointing arrow. Clicking this button closes the Rectangle tool.</td>
</tr>
</tbody>
</table>
### Annotation Tool Icon Description

<table>
<thead>
<tr>
<th>Annotation Tool</th>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Highlighter</td>
<td></td>
<td>Lets you highlight text and other elements in shared content. For more options, click the downward-pointing arrow. Clicking this button again closes the Highlighter tool.</td>
</tr>
<tr>
<td>Annotation Color</td>
<td></td>
<td>Displays the Annotation Color palette, on which you can select a color to annotate shared content. Clicking this button again closes the Annotation Color palette.</td>
</tr>
<tr>
<td>Eraser</td>
<td></td>
<td>Erases text and annotations or clears pointers on shared content. To erase a single annotation, click it in the viewer. For more options, click the downward-pointing arrow. Clicking this button again turns off the eraser tool.</td>
</tr>
</tbody>
</table>

### Sharing information

You can open a document, whiteboard, desktop, or application to share by clicking the sharing icons in the upper left corner:

![Sharing tools for Windows](image)

![Sharing tools for the Mac](image)

<table>
<thead>
<tr>
<th>Sharing Tool</th>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Share Document</td>
<td></td>
<td>Share a document or presentation that resides on your computer. Participants view the shared document or presentation in their content viewers.</td>
</tr>
<tr>
<td>Share Application</td>
<td></td>
<td>Share any application on your computer with event participants. Participants can view the shared application in a sharing window on participant screens.</td>
</tr>
<tr>
<td>Share Desktop</td>
<td></td>
<td>Share your computer desktop* with meeting participants, including any applications, windows, and file directories that are currently open. Participants can view the shared desktop in a sharing window on participant screens.</td>
</tr>
</tbody>
</table>
Sharing files

File sharing is ideal for presenting information that you do not need to edit during the event, such as a video or slide presentation. Participants can view shared files in their content viewers without the need for the application with which it was created.

view a media file, such as a video, without the need for special software or hardware.

view any animation and transition effects on shared Microsoft PowerPoint slides.

After an event starts, you can open a presentation or document to share. You do not need to select it or “load” it before the event.

While sharing a file, you can:

- Print it More
- Synchronize all participants’ displays with the display in your content viewer
  More (on page 238)
- Save it to a file More (on page 243)

At any time during a meeting, you can grant participants privileges that allow them to annotate, save, print, and display different views of shared content.

Sharing a file

You can share a file, such as a document, presentation, or video, that resides on your computer. Participants view the shared file in their content viewers.

To share a document or presentation:

Chapter 18: Sharing Presentations, Documents, and Whiteboards

The Share File dialog box appears.

2. Select the file that you want to share.

3. Click **Open**.

The shared file appears in the content viewer.

**Tip:** See Tips for sharing files for information that can help you to share files more effectively.

### Tips for sharing files

These tips can help you share files more effectively.

- To import slide presentations quickly:
  - Limit the number of animations and slide transitions.
  - Minimize the number of screen shots that you add to slides, especially bitmap graphics. Bitmaps do not compress well.
- To improve the speed at which shared pages or slides appear in participant content viewers, save the document or presentation as a `.ucf` (Universal Communications Format) file before the event starts. Then share the `.ucf` file instead of the document or presentation itself. More…
- You can annotate shared presentations or documents in the content viewer; however, you cannot edit them. If you want to edit shared information, you can use application sharing instead.

If you are sharing a PowerPoint presentation, you can open the PowerPoint Notes panel and view any notes you have added to the slide in the presentation.

- To save time during an event, begin sharing the document or presentation before the event's starting time. That way, after participants join the event, they can begin viewing your presentation.
Choosing an import mode for presentation sharing

For Windows users only

Before you share a presentation, you can choose one of the following import modes:

- **Universal Communications Format (UCF)**—The default mode. Lets you display animations and slide transitions in Microsoft PowerPoint presentations. In the UCF mode, Event Manager imports presentations more quickly than it does in the printer driver mode. However, pages or slides may not appear consistently in Event Manager across platforms.

- **Printer driver**—Displays shared presentations as they appear when you print them, providing a consistent appearance of pages and slides in Event Manager across platforms. However, this mode does not support animations or slide transitions. In this mode, the first page or slide may appear quickly, but the total import time for all pages or slides is usually longer than it is in the UCF mode.

**Note:** Changing the import mode does not affect any presentations that you are currently sharing. To apply a new import mode to a shared presentation, you must close it first, and then share it again.

To choose an import mode for shared presentations:

1. In the Event window, on the Event menu, choose Options.
   
   The Event Options dialog box appears, with the Options tab selected by default.
2. Click the Import Mode tab.

   ![](import_mode.png)

   The Import Mode tab options appear.

3. Select either **Universal Communications Format** or **Printer driver**.
Closing shared files

You can close any files that you are sharing in your content viewer.

To close a shared file:

1. In the content viewer, select the tab for the file that you want to close.
2. On the File menu, choose Close.

   If you have not yet saved any annotations that you made on the document or presentation, a message appears, allowing you to save it.

Sharing a whiteboard

Sharing a whiteboard allows you to draw objects and type text that all Participants can see in their content viewers. You can also use a pointer to emphasize text or graphics on a whiteboard.

- Other things you can do while sharing a whiteboard:
  - Display it at various magnifications, in miniature (thumbnails), and in a full-screen view.
  - Copy and paste images into it
  - Reorder its position in reference to any other whiteboards
  - Print it
  - Synchronize Participants' displays with the display in your content viewer
  - Save it

If you allow participants to annotate slides and pages, you and participants can draw and type on a whiteboard simultaneously. You can also allow participants to save, print, and display different views of shared whiteboards. For details, see Granting sharing privileges.

Starting whiteboard sharing

You can share a whiteboard on which you can draw and write. Participants can view a shared whiteboard in their content viewers.
To share a whiteboard:

On the Share menu, choose **Whiteboard**.
Chapter 18: Sharing Presentations, Documents, and Whiteboards

Closing a shared whiteboard

You can close any whiteboards that you are sharing in your content viewer.

To close a shared whiteboard:
1. In the content viewer, select the tab for the whiteboard you want to close.
2. On the File menu, choose Close.

If you have not yet saved any annotations that you made on the whiteboard, a message appears, allowing you to save it.

Navigating presentations, documents, or whiteboards

When sharing a document, presentation, or whiteboard, you can
- Navigate slides, pages, or whiteboards using the toolbar More (on page 229)
- Advance pages or slides automatically, at an interval of time that you specify More (on page 229)
- Perform animations and slide transitions in a presentation More (on page 230)
- Use keys on your computer's keyboard to navigate a presentation and display animations on the slides More (on page 232)

Navigating slides, pages, or whiteboards using the toolbar

You can navigate to different pages, slides, or whiteboard “pages” in the content viewer. Each document, presentation, or whiteboard being shared appears on a tab at the top of the content viewer.
To display pages or slides in the content viewer:

1. In the Event window, in the content viewer, select the tab for the document, presentation, or whiteboard that you want to display.

   If there are more tabs than can appear at one time, click the Next Tab button to cause the next tab to scroll into view.

2. On the toolbar, click a button to change the page or slide you are viewing.

   Click the drop-down arrow to select any page or slide
   • left arrow to see the previous page or slide
   • right arrow to see the next page or slide

   If Microsoft PowerPoint slides are being shared, the drop-down list also displays the title of each slide.

   **Note:**
   • Alternatively, you can navigate to different pages or slides in a shared document, presentation, or whiteboard by opening the thumbnail viewer. For details, see Viewing thumbnails of slides, pages, or whiteboards.
   • You can advance pages or slides automatically at a time interval that you specify. For details, see Advancing pages or slides automatically.
   • You can also use the keys on your computer's keyboard to display different pages or slides and perform animations and slide transitions. For details, see Using keyboard shortcuts to control a presentation.
   • If your presentation includes animations or slide transitions, you can use the toolbar or keyboard shortcuts to perform them. For details, see Animating and adding effects to shared slides.

**Advancing pages or slides automatically**

When sharing a document or presentation in the content viewer, you can automatically advance pages or slides at a specified interval. Once you start automatic page or slide advancement, you can stop it at any time.
Chapter 18: Sharing Presentations, Documents, and Whiteboards

To automatically advance pages or slides:

1. In the Event window, in the content viewer, select the tab for the document or presentation for which you want to advance pages or slides automatically.

2. On the View menu, choose Automatically Advance Pages.
   The Automatically Advance Pages dialog box appears.

3. To change the time interval for advancing pages, do one of these:
   - click the up or down buttons to increase or decrease the interval
   - type a specific time interval

   Optional: To restart page or slide advancement once all pages or slides are displayed, select the Return to beginning and continue advancing pages check box.

4. Click Start.

5. Optional. Close the Automatically Advance Pages dialog box by clicking the Close button in the upper-right corner of the dialog box.
   The pages or slides continue to advance at the specified interval.

To stop automatic page or slide advancement:

1. If you closed the Automatically Advance Pages dialog box, on the View menu, choose Automatically Advance Pages.
   The Automatically Advance Pages dialog box appears.

2. Click Stop.

Animating and adding effects to shared slides

When sharing a Microsoft PowerPoint slide presentation in the content viewer, you can animate text and slide transitions, just as you can when using the Slide Show option in PowerPoint.

**Note:** To show slide animations and transitions, you must share the presentation as a Universal Communications Format (UCF) file (.ucf). The UCF import mode automatically converts a PowerPoint file (.ppt) to a UCF file when you share it. More
Alternatively, use the keys on your computer keyboard to show animations and slide transitions in a PowerPoint slide presentation. For details, see Using keyboard shortcuts to control a presentation.

To show slide animations and transitions in a shared presentation:

1. Ensure that the content viewer has input focus by clicking in the viewer.

   The content viewer has input focus if a blue border appears around the outside of the slide in the viewer.

2. On the toolbar, click the appropriate arrows to move through your presentation.

   - Click the drop-down arrow to select any page or slide
   - Click the left arrow to see the previous page or slide
   - Click the right arrow to see the next page or slide

Using keyboard shortcuts to control a presentation

When sharing a document or presentation in the content viewer, you can use the keys on your keyboard to display pages or slides. If you are sharing a Microsoft PowerPoint slide presentation, you can also use keyboard keys to show animations on the slides and in slide transitions, just as you can when using the Slide Show option in PowerPoint.

**Note:** Before using keyboard shortcuts, click in the viewer to set the input focus in the content viewer. A blue border around the shared page or slide indicates that the viewer has input focus.

Sharing a Presentation

Use these keystrokes to move quickly through your presentation.

<table>
<thead>
<tr>
<th>To...</th>
<th>Press...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display the next slide or perform the next animation or slide transition</td>
<td>Space Bar, Page Down, Right Arrow, or Down Arrow</td>
</tr>
<tr>
<td>Display the previous slide or perform the previous animation or slide transition</td>
<td>Page Up, Left Arrow, or Up Arrow</td>
</tr>
</tbody>
</table>
Chapter 18: Sharing Presentations, Documents, and Whiteboards

To...          Press...
Display the first slide  Home
Display the last slide   End

Note: To show animations and slide transitions, you must share the presentation as a Universal Communications Format (UCF) file. The UCF import mode automatically converts a PowerPoint file to a UCF file when you share it. For information about choosing an import mode, see Choosing an import mode for presentation sharing.

Sharing a Document

Use these keystrokes to move quickly through your document.

To...          Press...
Display the next page  Space Bar, or Page Down, Right Arrow, or Down Arrow
Display the previous page  Page Up, Left Arrow, or Up Arrow
Display the first page   Home
Display the last page    End

Working with pages or slides

When sharing a document, presentation, or whiteboard, you can

- Add new, blank pages or slides for annotation More (on page 234)
- Paste images that you copy to your computer’s clipboard into a new page or slide in a shared document, presentation, or whiteboard More (on page 234)
Adding new pages to shared files or whiteboards

When sharing a file or whiteboard in the content viewer, you can add a new, blank page for annotation.

To add a new page or slide:

1. In the content viewer, select the tab for the document, presentation, or whiteboard to which you want to add a page or slide.

2. Select Add Page from the Edit menu.
   
   A new page appears in the content viewer at the end of the currently selected document, presentation, or whiteboard.

**Tip:** If you have added multiple pages to a shared file or whiteboard tab, you can view thumbnails to make it easy to view and navigate around your added pages.

Pasting images in slides, pages, or whiteboards

If you copy any bitmap image to your computer’s clipboard, you can paste the image into a new page, slide, or whiteboard in the content viewer.

For example, you can copy an image on a Web page or in an application, then quickly share that image by pasting it in the content viewer.

To paste an image in a page, slide, or whiteboard in the content viewer:

1. In the content viewer, select the tab for the document, presentation, or whiteboard in which you want to paste an image.

2. On the Edit menu, choose **Paste Page Image**.
   
   The image appears on a new page in the content viewer, at the end of the currently selected document, presentation, or whiteboard.

**Note:** You can paste any type of bitmap image, such as a GIF, JPEG, BMP, or TIF image in the content viewer. However, you cannot paste other types of images-such as EPS or Photoshop (PSD) images-in the content viewer.
Managing views of presentations, documents, or whiteboards

All shared presentations, documents, or whiteboards appear in the content viewer in the Event window. A tab at the top of the content viewer appears for each document, presentation, or whiteboard that is being shared.

Depending on your role and the privileges that you have, you can do the following when viewing shared content in the content viewer:

- **Magnify** (on page 235) slides, pages, or whiteboards.
- **View thumbnail** (on page 237) of slides, pages, or whiteboards.
- **Display a full-screen view** (on page 236) of a page, slide, or whiteboard.
- **Synchronize all participant views** (on page 238) of a page or slide with the view that appears in your content viewer.

**Zooming in or out**

Using the tools on the content viewer toolbar, you can:

- Zoom in to or out from on a page, slide, or whiteboard
- Adjust the size of a page, slide, or whiteboard to fit the content viewer
- Adjust the size of a page, slide, or whiteboard to fit it width in the content viewer
Chapter 19: Managing views of presentations, documents, or whiteboards

- Turn off the Zoom tool at any time

To zoom in to or out from on a page, slide, or whiteboard:

Do one of the following on the content viewer toolbar:

- To zoom in or out incrementally, click the downward pointing arrow to the left of the Zoom In/Zoom Out button, and then choose Zoom In or Zoom Out. To continuing zooming in or out, click the Zoom In/Zoom Out button.

![Click the down arrow to choose a viewing option](image)

- To zoom in to a specific area, click the downward-pointing arrow to the right of the Zoom In button, and then drag your mouse to the area. Release your mouse button.

- To zoom in or out to a preset percentage, click the downward-pointing arrow to the left of the Zoom In/Zoom Out button, and then choose the percentage.

To adjust the size of a page, slide, or whiteboard to fit the content viewer:

1. On the toolbar, click the downward-pointing arrow to the right of the Zoom In/Zoom Out button.

![Click the down arrow to choose a viewing option](image)

2. On the menu that appears, choose Fit to Viewer.

To adjust the size of a page, slide, or whiteboard to fit its width in the content viewer:

1. On the toolbar, click the downward-pointing arrow to the right of the Zoom In/Zoom Out button.

2. On the menu that appears, choose Fit to Width.

To turn off the zoom tool:

On the toolbar, click the Zoom In/Zoom Out button.

**Controlling full-screen view**

You can maximize the size of a page, slide, or whiteboard in the content viewer to fit your monitor's entire screen. A full-screen view replaces the normal Event window view. You can return to a normal view at any time.
Chapter 19: Managing views of presentations, documents, or whiteboards

**Note:** If an event presenter displays a full-screen view of a page, slide, or whiteboard, attendees' screens automatically display a full-screen view as well. However, attendees can control full-screen view independently in their Event windows.

To display a full-screen view:

On the content viewer toolbar, click the Full Screen View button.

To return to a normal view:

On the Event Controls Panel, click the stop icon to return to the main window.

**Viewing thumbnails**

You can view thumbnails of the shared pages, slides, and whiteboards that appear in the content viewer. Viewing thumbnails can help you to locate quickly a shared page or slide that you want to display in the content viewer.

To view thumbnails of slides, pages, or whiteboards:

1. In the content viewer, select the tab for the document, presentation, or whiteboard for which you want to view miniatures.
2. On the content viewer toolbar, click the View Thumbnails button.

Thumbnails of all pages or slides in the selected document, presentation, or whiteboard appear in the thumbnail viewer, in the left column.
Chapter 19: Managing views of presentations, documents, or whiteboards

3 Optional. To display any page or slide in the content viewer, double-click its miniature in the thumbnail viewer.

**Note:** Participants must have both the View thumbnails and View any page privileges to display a miniature of a page or slide at full size in the content viewer.

To close the thumbnail viewer:

On the content viewer toolbar, click the **Standard View** button.

---

**Synchronizing all participant views**

You can synchronize the display of a shared page, slide, or whiteboard in all attendees' content viewers with the display in your viewer. Once you synchronize displays, the page, slide, or whiteboard in attendees' content viewers appears at the same magnification as in your content viewer.
To synchronize participant views of slides, pages, or whiteboards:

On the View menu at the bottom of the window, select **Sync Display for All**.

**Clearing annotations**

You can clear any annotations made by you or another participant on a shared page, slide, or whiteboard in the content viewer. You can clear:

- All annotations at once
- Only specific annotations
- If you are the presenter or host, clear all annotations you have made

To clear all annotations on a shared page, slide, or whiteboard:

1. On the annotation toolbar, click the downward-pointing arrow to the right of the **Eraser Tool** icon.

2. Choose **Clear All Annotations**.

**Note**: Only annotations on the page or slide that currently appears in your content viewer are cleared. Annotations on other pages or slides are not cleared.

If you are the host or presenter, you can clear all the annotations you've made.

To clear all annotations you have added to a shared page, slide, or whiteboard:

1. On the annotation toolbar, click the downward-pointing arrow to the right of the **Eraser Tool** icon.
2 Choose **Clear My Annotations**.

To clear specific annotations on a shared page, slide, or whiteboard:

1 On the toolbar, click the **Eraser Tool** icon.

Your mouse pointer changes to an eraser.

2 Click the annotation you want to clear.

To turn off the eraser tool:

On the toolbar, click the **Eraser Tool** icon.

---

**Clearing pointers**

You can clear your own pointers on all shared slides, pages, or whiteboards in the content viewer. If you are a presenter, you can also clear all participant pointers.

To clear your own pointer on all shared slides, pages, or whiteboards:

1 On the toolbar, click the downward-pointing arrow to the right of the **Eraser Tool** icon.
Choose **Clear My Pointer**.

## Renaming tabs

As you are sharing an item, such as a presentation, in the content viewer, you can easily change its name on the tab. Later, when you end the event, you can save the document, presentation, or whiteboard with this new name.

To rename a tab in the content viewer:

1. Right click the tab name you want to change.
2. Enter the new name on the tab.
3. Press **Enter** or click outside the tab.

   The tab displays the new name.

**Tip:** You can also click the tab name to select it.

This feature is handy if participants have used the annotation tools to make comments and notes or highlight elements in your document. You can save your document with the annotations as a new document, separate from your original.

Of course, you can still use the **Save As** command on the **File** menu to save the document at the end of your event. Changing the name on the tab itself allows others to see the name you are giving the file. Also, you are making the change at the moment that action is meaningful, rather than at the end of the event.

## Reordering tabs

The tabs in the content viewer are arranged in the order you open them. That order may not be the most logical way to display them. You can easily move the tabs, so the most current and important items are visible.

To reorder the tabs in the content viewer:

1. Right-click any tab.
2. In the Reorder View Tabs dialog box, use the arrows change the order of the tabs.

   Moving a tab up in the order moves that tab to the left in the content viewer.
Use the up and down arrows to reorder the tabs.

Tip: To quickly move a tab to the left or right, select the tab and use a drag and drop operation to move it.
Event participants (hosts, presenters, and participants with privileges) can access and print documents, presentations, and whiteboards shared in an event. For example, you can:

- save a shared presentation
- open a saved document
- print a whiteboard

**Saving a presentation, document, or whiteboard**

You can save any shared document, presentation, or whiteboard that appears in the content viewer. A saved file contains all the pages or slides in the document, presentation, or whiteboard that is currently displayed in the content viewer, including any annotations and pointers that you or other attendees added to them.

Files that you save are in the Universal Communications Format (UCF), which have a `.ucf` extension. You can open a `.ucf` file either in another event or at any time outside of an event.

Once you save a new document, presentation, or whiteboard to a file, you can save it again to overwrite the file or save a copy to another file.
To save a new document, presentation, or whiteboard that appears in the content viewer:

1. On the **File** menu, choose **Save > Document**.
   
   The Save Document As dialog box appears.

2. Choose a location at which to save the file.

3. Type a name for the file in the **File name** box.

To save changes to a saved document, presentation, or whiteboard that appears in the content viewer:

On the **File** menu, choose **Save > Document**.

Event Manager saves the changes to the existing file.

To save a copy of a document, presentation, or whiteboard:

1. On the **File** menu, choose **Save As > Document**.
   
   The Save Document As dialog box appears.

2. Do **either** or **both** of the following:
   
   - Type a new name for the file.
   - Choose a new location at which to save the file.

### Opening a saved document, presentation, or whiteboard

If you saved a document, presentation, or whiteboard that appeared in the content viewer during an event, you can do **either** of the following:

- Open file in the content viewer during another event for sharing. Only a presenter or participants who have the **Share documents** privilege can open a saved file during an event.

- Open the file at any time on your computer's desktop. If you open a saved file on your desktop, it appears in the WebEx Document Manager, a standalone, or “offline,” version of the content viewer.

A saved document, presentation, or whiteboard is in the saved Universal Communications Format (UCF) and has a **.ucf** extension.
To open a saved document, presentation, or whiteboard file in the content viewer:

1. On the **File** menu, choose **Open and Share**.
   The Share Document dialog box appears.
2. Select the document, presentation, or whiteboard file that you want to open.
3. Click **Open**.

To open a saved document, presentation, or whiteboard on your computer's desktop:

Double-click the saved file.

The document, presentation, or whiteboard opens in the WebEx Document Viewer.

---

**Printing presentations, documents, or whiteboards**

You can print any shared presentations, documents, or whiteboards that appear in your content viewer. A printed copy of shared content includes all added annotations and pointers.

To print shared content:

1. In the content viewer, select the tab for the document, presentation, or whiteboard that you want to print.
2. On the **File** menu, choose **Print > Document**.
3. Select the printing options that you want to use, and then print the document.

**Note:** When printing shared content in the content viewer, Event Manager resizes it to fit on the printed page. However, for whiteboards, the Event Manager prints only the content that lies within the dashed lines on the whiteboard.
Event participant

If you are participating in an event, (and have not taken on another role, such as host or presenter), you can move around independently in shared documents and presentations, if the host has assigned these privileges to you. For shared documents, presentations, and whiteboards, you can:

- display any page
- synchronize your view with the host's view
- save shared documents
- open shared documents
- print shared documents

Displaying pages, slides, or whiteboards

*For attendees*

If you have been granted the necessary privileges, you can navigate to different pages, slides, or whiteboard “pages” in the content viewer. Each document, presentation, or whiteboard being shared appears on at the top of the content viewer.

To display pages or slides in the content viewer:

1. In the Event window, in the content viewer, select the tab for the document, presentation, or whiteboard that you want to display.
   
   If you have more tabs than can be displayed on the content viewer, click the down-arrow button at the end of the tabs to view the list of other tabs.
To return to the document or page the host is viewing, you can synchronize your view More…

2 On the toolbar, click a button to change the page or slide you are viewing:
3 To display the next page or slide, click the **Next** button.

- To move forward or back between pages, click the left or right arrows.
- To select any page or slide, select it in the Go To drop-down list.

**Synchronizing your view of pages, slides, or whiteboards**

During an event, you can synchronize the display of shared content in your content viewer with the display in the presenter's viewer. This option is useful, for example, if you are viewing a previous slide in a presentation and want to quickly return to the actual slide that the presenter is discussing. Synchronizing your display also resizes it to that in the presenter's content viewer.

**To synchronize your view of shared content in the presentation viewer:**

In the Event window, on the viewing toolbar, click the **Synchronize My Display** button.
Sharing a tool, like a software application, works differently from sharing a document or presentation. When you share software during an event, a sharing window opens automatically on all participant screens. You can show, in this special sharing window:

- **an application** (for example, you want to edit a document as a group or show your team how a tool works)
- **computer desktop** (for easily sharing several applications at once and for sharing file directories open on your computer)
- **web browser** (useful for sharing particular Web pages with participants or showing a private intranet)

### Sharing applications

You can use application sharing to show all event participants one or more applications on your computer. Application sharing is useful for demonstrating software or editing documents during an event.

Participants can view the shared application, including all mouse movements without having to run the application that you are sharing on their computers.

Here are just a few tasks you can perform:

- Start sharing an application **More...** (on page 251) and open more applications to share **More...** (on page 250)
- Control the appearance and viewing of shared software (pausing, changing to full-screen view, and so on) **More...** (on page 259)
Annotate and draw on a shared application More... (on page 263) and allow attendees to draw More... (on page 266)

- Learn about sharing application effectively More...
- Stop sharing an application More... (on page 251)

Sharing several applications at once

Host or Presenter only

If you are already sharing an application, you can share additional applications simultaneously. Each application that you share appears in the same sharing window on attendees’ screens.

To share an additional application:

Select the application you want to share:

- **If that application is currently running**: Click the Share button.

Each application you have open on your desktop has these buttons in the upper right corner.

<table>
<thead>
<tr>
<th>SHARE</th>
<th>Not Shared</th>
</tr>
</thead>
</table>

**Tip**: When you open any application that you have minimized, it opens with the sharing buttons in the upper-right corner.

- **If that application is not currently running**: Click the Select Content to Share button in the Event Controls Panel. You can also find it using File Explorer or other tool you use to locate applications on your computer. When you open it, it appears with the Share button.

Your application appears in a sharing window on attendees' screens.

Event Center tracks the number of applications you are currently sharing:

![Sharing applications with Event Center](image)

**Tip**: Alternatively, you can share multiple applications by sharing your computer's desktop. For details, see Sharing your desktop.
Stopping application sharing for all participants

*Host or Presenter only*

You can stop sharing an application at any time. Once you stop sharing an application, attendees can no longer view it.

If you are sharing multiple applications simultaneously, you can stop sharing either a specific application or all applications at once.

To stop sharing a specific application when sharing multiple applications:

On the title bar of the application that you no longer want to share, click the **Stop** button.

To stop all application sharing:

In the Event Controls box, click the **STOP** button.

Starting application sharing

*Host or Presenter only*

You can share any application on your computer with event attendees.

To share an application:

1. On the **Share** menu, choose **Application**.
The Application Share dialog box appears, showing a list of all applications currently running on your computer.

2 Do one of the following:

- If the application you want to share is currently running, select it in the list, and then click Share.

- If the application you want to share is not currently running, click Other Application. The New Application dialog box appears, showing a list of all applications on your computer. Select the application, and then click Share.

Your application appears in a sharing window on attendees’ screens.

For tips that can help you to share applications more effectively, see Tips for Sharing Software.
### Controlling views of shared software

<table>
<thead>
<tr>
<th>Role</th>
<th>Task description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Host or Presenter</td>
<td>• Pause or resume sharing <em>More…</em> (on page 254)</td>
</tr>
<tr>
<td></td>
<td>• Control full-screen view of shared software <em>More…</em> (on page 255)</td>
</tr>
<tr>
<td></td>
<td>• Synchronize views <em>More…</em> (on page 256)</td>
</tr>
</tbody>
</table>

- **Share**
  - My Desktop
  - File (Including Video)
  - Application
  - Whiteboard
  - Web Content
  - Web Browser
  - Multimedia
  - My Event Window

- **View**
  - Ctrl+Alt+D

- **Communicate**
Chapter 23: Controlling views of shared software

<table>
<thead>
<tr>
<th>Role</th>
<th>Task description:</th>
</tr>
</thead>
</table>
| Participant| ▪ Control your view of shared software  
More… (on page 259)  
▪ Close your sharing window  More… (on page 260) |

The presenter can control attendees' views of a shared desktop, remote computer (if available), application or Web browser.

Attendees can manipulate their individual displays of the shared software

**Pausing and resuming software sharing**

*Host or Presenter only*

While sharing software, you can temporarily pause sharing to freeze attendees' views.

If you want to return attendees to the Event window while sharing software, pausing shared software conserves resources on your computer and bandwidth for your Internet connection. This option is also useful if you do not want attendees to see certain actions that you take with shared software.

You can resume sharing to restore attendees' views of shared software at any time.

**To pause software sharing:**

Click the **Pause** button, located to the right of the **Stop** button.
The word "Paused" now appears in the panel.

To resume software sharing:

Click the **Pause** button again.

---

**Controlling full-screen view of shared software**

*Host or Presenter only*

You can switch attendees' views of a shared application, remote computer (if available), or Web browser between a standard window and a full-screen view.

A full-screen view of shared software fits attendees' entire screens and does not include a title bar or scroll bars.

Attendees can override your setting to control full-screen view or to zoom in or out on the shared software on their computers.

To display shared software in a full-screen view:

On the Event Controls Panel, click the down arrow (the last button on the panel) and then choose **View**. Then choose **Full screen for Participants**.

---

To see panel controls, click the blue down-arrow button (it is the last button).
To display shared software in a standard window:

1. Do either of the following:
   - On the title bar of the window you are sharing, click the Sharing menu. If you are sharing a remote computer, the Access Anywhere menu appears instead of the Sharing menu.
   - In the lower-right corner of your desktop, click the WebEx icon to display the Sharing menu.

2. On the menu that appears, choose Views > Restore View for Attendees.

Synchronizing views of shared software

Host or Presenter only

While sharing an application, desktop (if desktop sharing is available), or Web browser, you can synchronize all attendees' views of the software with your view. Synchronizing views of shared software ensures that the sharing window appears as the active window on attendees' screens. For example, if an attendee has minimized the sharing window, or moved another window on top of it, the sharing window becomes the active window when you synchronize views.

Note: Synchronizing views has no effect on the size in which the shared software appears on attendees' screens. Attendees can control the size of their views independently.

To synchronize your view with attendees:

On the Event Controls Panel, click the down arrow (the last button on the panel) and then choose View. Then choose Synchronize for All.
Selecting a monitor to share

To select a monitor to share:

1. Start sharing your desktop:
   - On the Quick Start page, select Share Desktop.
     If two or more monitors are detected on your system, a window appears and allows you to select one of the monitors.

   - On the Share menu, select Desktop.
     A submenu shows the available monitors.

2. Select the monitor you want to share.

   The Event Controls Panel indicates which monitor you are sharing. If you are sharing the same monitor where the Event Controls Panel is, it says, "You are sharing this monitor."
If you are sharing a monitor that is not the same monitor where the Event Controls Panel is, it says, "You are sharing monitor \textless number\textgreater." 

In addition, a green border appears around the monitor you are sharing.

To select a different monitor to share:

1. On the Meeting Control Panel, select the Select Content to Share button.

2. In the submenu that appears, select \textbf{Share Desktop}.

A submenu shows you the available monitors.
3 Select the monitor number you want to share.

The Event Controls Panel indicates which monitor you are sharing. In addition, a green border appears around the monitor you are sharing.

# Controlling your view as an attendee

*Attendee only*

When viewing or remotely controlling shared software, you can set these options, which determine how shared software appears on your screen:

- Display the shared software in a full-screen view or a standard window. A full-screen view of a shared application or desktop fits your entire screen and does not include a title bar or scroll bars.
- Scale, or resize, a shared desktop or application to fit the full-screen view or standard window in which it appears.

**To control your view of shared software:**

On the Event Controls Panel, click the down arrow (the last button on the panel) and then choose View. Then choose an option from the menu.
Closing your attendee sharing window

*Attendee only*

While viewing or remotely controlling shared software, you can close the sharing window in which the software appears at any time. Closing a sharing window returns you to the Event window. If you close a sharing window, you can reopen it at any time.

**To close a sharing window:**

1. On the Event Controls Panel, click the down arrow (the last button on the panel) and then choose **Options**. Then choose an option from the menu.

   ![](image)

2. On the menu that appears, choose the appropriate option:

   - Exit Application Sharing
   - Exit Web Browser Sharing
   - Exit Desktop Sharing
   - Exit Remote Application Sharing
   - Exit Remote Desktop Sharing

   The sharing window closes. The Event window then automatically opens.

**To return to the sharing window at any time:**

In the Event window, on the **Sharing** menu, click a sharing option (desktop, remote computer, application or Web browser).
Switching your attendee view

Attendee only

While a presenter is sharing software, you can return to the Event window at any time. The sharing window remains open on your computer, so you can return to viewing the shared software at any time.

To return to the Event window while the presenter is sharing software:

On the Event Controls Panel, click the Return icon.

The Event window then appears.

To return to a sharing window:

Do either of the following:

- In the Application Share dialog box, which appears in the Event window, click Return.

- In the Event window, on the Sharing menu, click the appropriate sharing option remote computer (if available), application, desktop, or Web Browser.
# Annotating shared software

<table>
<thead>
<tr>
<th>Role</th>
<th>Task description:</th>
</tr>
</thead>
</table>
| Host or Presenter  | - Start or stop annotation mode  
|                    | More… (on page 264)                                                             |
|                    | - Use annotation tools More… (on page 265)                                      |
|                    | - Let an attendee use annotation More… (on page 266)                            |
|                    | - Save annotations More… (on page 269)                                           |
| Participant        | - Ask for permission to use annotation More… (on page 267)                     |
|                    | - Use annotation tools More… (on page 265)                                      |
|                    | - Save annotations More… (on page 269)                                           |
|                    | - Give up annotations More… (on page 268)                                       |
Chapter 24: Annotating shared software

You can annotate a shared desktop, application or Web browser during an event, using the highlighter or other annotation tool.

Event participants can see annotations in their sharing windows.

Starting and stopping annotation

Host or Presenter only

When you are sharing a desktop, application or Web browser, you can make annotations on the software.

Attendees can see all your annotations.

To start annotating shared software:

1. On the Event Controls panel, click the Start Annotating button.

   ![Annotation button](image)
   
   The Annotation button has the image of a pencil on it.

   The Tools panel appears.

2. Select a tool for making annotations.

   For details about annotation tools, see Using annotation tools.

   ![Annotation tools](image)

   Note:

   - You can let one or more attendees annotate the shared software. For details, see Letting an attendee annotate shared software.
   - Once you or an attendee makes annotations, you can save an image of the software, including the annotations. For details, see Taking a screen capture of annotations on shared software.

   To stop making annotations on shared software and return your mouse to a normal pointer, you must stop annotation mode.
To stop annotation mode:

Click the **Stop Annotating** button in the **Tools** panel.

---

**Using annotation tools**

If, while sharing software, you are the presenter or the presenter allows you to annotate, you can use the Annotation Tools panel that appears to make annotations. The Annotation Tools panel provides a variety of tools for annotating a shared desktop or application.

<table>
<thead>
<tr>
<th>Annotation Tool</th>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pointer</td>
<td><img src="image" alt="Pointer Icon" /></td>
<td>Lets you point out text and graphics on shared content. The pointer displays an arrow with your name and annotation color. To display the laser pointer, which lets you point out text and graphics on shared content using a red “laser beam,” click the downward-pointing arrow. Clicking this button again turns off the pointer tool.</td>
</tr>
<tr>
<td>Text</td>
<td><img src="image" alt="Text Icon" /></td>
<td>Lets you type text on shared content. Participants can view the text once you finish typing it and click your mouse in the content viewer, outside the text box. To change the font, on the <strong>Edit</strong> menu, choose <strong>Font</strong>. Clicking this button again turns off the text tool.</td>
</tr>
</tbody>
</table>
## Chapter 24: Annotating shared software

### Annotation Tool

<table>
<thead>
<tr>
<th>Annotation Tool</th>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Line</td>
<td><img src="image1.png" alt="Image" /></td>
<td>Lets you draw lines and arrows on shared content. For more options, click the downward-pointing arrow. Clicking this button closes the Rectangle tool.</td>
</tr>
<tr>
<td>Rectangle</td>
<td><img src="image2.png" alt="Image" /></td>
<td>Lets you draw shapes, such as rectangles and ellipses on shared content. For more options, click the downward-pointing arrow. Clicking this button again closes the Rectangle tool.</td>
</tr>
<tr>
<td>Highlighter</td>
<td><img src="image3.png" alt="Image" /></td>
<td>Lets you highlight text and other elements in shared content. For more options, click the downward-pointing arrow. Clicking this button again closes the Highlighter tool.</td>
</tr>
<tr>
<td>Annotation Color</td>
<td><img src="image4.png" alt="Image" /></td>
<td>Displays the Annotation Color palette, on which you can select a color to annotate shared content. Clicking this button again closes the Annotation Color palette.</td>
</tr>
<tr>
<td>Eraser</td>
<td><img src="image5.png" alt="Image" /></td>
<td>Erases text and annotations or clears pointers on shared content. To erase a single annotation, click it in the viewer. For more options, click the downward-pointing arrow. Clicking this button again turns off the eraser tool.</td>
</tr>
</tbody>
</table>

### Letting an attendee annotate shared software

**Host or Presenter only**

You can let one or more event attendees annotate a shared **desktop** (if available), **application** or **Web browser**.

You can let several attendees annotate shared software at the same time.

**To let an attendee annotate shared software:**

1. On the Event Controls Panel, click the **Annotate** icon.

   The **Start Annotating** button is the ninth button from the left.

The tools panel appears.
2 Click the down arrow on the **Allow to Annotate** button.

3 On the menu that appears, choose which participants can annotate the shared software:

You can choose "All" or select someone from the list.

**Note:**
- To quickly allow a participant to start drawing, just click the **Access Controls** button on the Event Controls Panel. Choose **Allow to Draw** and then choose that person's name from the drop-down list.
- You can stop an attendee from annotating shared software at any time. For details, see Stopping an attendee from annotating shared software.

## Requesting annotation control of shared software

*Attendee only*

If a presenter is sharing a **desktop, Web browser or application**, you can ask the presenter to allow you to annotate the shared software.

After you have permission, you can:

- Make annotations by highlighting areas on the software, drawing lines and shapes, typing text, and using pointers.
- Clear annotations at any time.
- Change the color that you are using to make annotations.
- Save an image of your annotations on the shared software.

**To request annotation control of shared software:**

1 In the Event Controls Panel, click the **Ask to Annotate** button.
Chapter 24: Annotating shared software

A request message appears on the presenter's screen. After the presenter allows you to annotate, the Annotation Tools panel appears:

2 Select the tool you want to use.
3 Optional. Choose another annotation tool. For details, see Using annotation tools.

**Note:** If you are controlling shared software remotely, the presenter must take back control to turn on annotation mode. You and the presenter can then annotate the shared software simultaneously.

**Giving up annotation control**

*Participant only*

If the presenter has granted permission to you to annotate, you can stop annotating at any time.

**To stop annotating:**

In the Annotation Tools panel, select the **Stop Annotating** button.

**Stopping an attendee from annotating shared software**

*Host or Presenter only*
If an event attendee is drawing on shared software, you can turn off the annotation feature.

To stop an attendee from annotating shared software:

1. On the Event Controls Panel, click the Allow to Annotate Control button.

On the menu that appears, a check mark appears next to the name of those who can annotate the shared software.

2. Choose the name of the attendee from the list to stop the attendee from annotating shared software.

**Saving an image of annotations on shared software**

If you make annotations on shared software, you can save an image of the shared software, including all annotations and pointers, to a WebEx Universal Communications Format (.ucf) file. You can open a .ucf file on your computer desktop or in the content viewer in an event.

**Note:** Participants cannot use this option unless the Host or Presenter grants the Screen Capture privilege to them. As Host, if you are sharing proprietary software, you may want to ensure that this privilege is turned off.

To take a screen capture of annotations on shared software:

1. On the Tools panel, select the Screen Capture button.
Chapter 24: Annotating shared software

The Save As dialog box appears.

2 Choose a location at which to save the file, and then select Save.

Note: The file you save is an image of your entire desktop.

Sharing applications with detailed color (Windows)

For Windows users only

By default, Event Manager sends images of shared software using 16-bit color mode, which is the equivalent of your computer's “High Color” (16-bit) setting. This mode provides an accurate representation of color for most shared applications. However, if your shared application contains detailed color images-such as color gradients—the color may not appear accurately on participants' screens. For example, color gradients may appear and color “bands.”

If the accuracy and resolution of color in a shared application is important, you can turn on True Color mode in Event Manager. Using this mode, however, may affect the performance of application sharing.

When using True Color mode, you can select one of the following options:

- Better imaging (no image compression)
- Better performance (some image compression)

“Performance” refers to the “speed” at which images appear on participant screens, and “imaging” refers to the quality of the color in shared images.

Note: Before turning on True Color mode, ensure that your monitor display is set to True Color (either 24- or 32-bit color). For more information about setting options for your monitor, refer to Windows Help.
To turn on True Color mode:

1. If you are currently sharing an application, stop your sharing session.
2. On the Event menu, choose Event Options.
   The Event Options dialog box appears.
3. Select the True Color Mode tab.
4. Select Enable True Color mode.
5. Select one of the following options:
   - Better imaging
   - Better performance
6. Select OK or Apply.

Sharing your desktop or applications with detailed color (Mac)

For Mac users only

Before sharing an application or your desktop, you can choose one of the following display modes:

- **Better performance**: The default mode. Lets you display your content faster than you do using the better image quality mode.
- **Better image quality**: Lets you display your content with better image quality. In this mode, your shared content may take longer time to display than in the better performance mode.

**Note**: Changing the display mode does not affect presentation or document sharing.

To choose a display mode for your shared desktop or applications:

1. In the Event window, on the Event Center menu, choose Preferences.
   The Preferences dialog box appears.
2. Select Display.
Chapter 24: Annotating shared software

3 Select **Better performance** or **Better image quality**, as appropriate.

**Tips for sharing software**

The following tips can help you to share software more effectively:

- **Application sharing only**: To save time during an event, ensure that any applications you intend to share are open on your computer. At the appropriate time during the event, you can then quickly begin sharing an application, without waiting for the application to start.

- If attendees cannot see all of the shared software without scrolling their sharing windows, they can adjust their views of the shared software. They can reduce the size of the shared software in decrements, or scale it to fit inside their sharing windows.

- To improve the performance of software sharing, close all applications that you do not need to use or share on your computer. Doing so conserves processor usage and memory on your computer, thus helping to ensure that Event Manager can send images of shared software quickly during an event. Also, to ensure that a maximum amount of bandwidth is available for software sharing, close any applications that use bandwidth, such as instant messaging or chat programs, and programs that receive streaming audio or video from the Web.
If you are sharing an application for which the rendering of color on participants' screen is important, you can improve color quality by turning on True Color mode. For details, see *Sharing applications with detailed color* (on page 270).

Application and Web browser sharing only: Avoid covering a shared application or Web browser with another window on your computer's desktop. A crosshatched pattern appears in attendees' sharing windows where the other window is covering the shared application or browser.

Application and Web browser sharing only: If you want to switch your display between shared software and the Event window, you can pause software sharing before you return to the Event window, and then resume sharing once you return to the shared application. Pausing software sharing conserves processor usage and memory on your computer while you view the Event window. For details, see *Pausing and resuming software sharing* (on page 254).

Application and Web browser sharing only: If you have more than one monitor, when you share an application or web browser, the attendees can see it on whichever monitor you are displaying it. If you move the application or Web browser to another monitor, it is still visible to the attendees. If you are sharing more than one application, the attendees will see the best view if you make sure the applications are displaying on the same monitor.

Because software sharing requires additional bandwidth during an event, it is recommended that you use a dedicated, high-speed Internet connection when sharing software. However, if attendees are using dial-up Internet connections, they may notice a delay in viewing or controlling shared software. If you want to share a document, such as a Microsoft Word or Excel document, you can improve the event experience for these attendees by using document sharing instead of application sharing.
A presenter uses Web browser sharing to show all event attendees all Web pages that he or she accesses in a browser. Web browser sharing is useful for showing attendees Web pages on the Internet, or the presenter's private intranet or computer.

Attendees can view the presenters Web browser, including mouse movements, in a sharing window on their screens.

Tasks related to sharing a Web browser:

- Start sharing a web browser *More...* (on page 275)
- Manage how attendees view the shared Web browser *More...* (on page 253)
- Annotate and draw on a shared Web browser *More...* (on page 263) and let an attendee draw on a shared Web browser *More...* (on page 266)
- Learn how to share Web browsers effectively *More...* (on page 272)
- Stop sharing a Web browser *More...* (on page 276)

### Starting Web browser sharing

*Host or Presenter only*

You can share a Web browser with event participants.

**To share a Web browser:**

1. On the *Share* menu, choose *Web Browser*.
   
   Your default Web browser opens.

2. Go to a Web page in your browser.
Chapter 25: Sharing a Web browser

Note: Participants view all new Web browser windows that you open. You can show participants several Web pages simultaneously.

Stopping Web browser sharing

You can stop sharing a Web browser at any time.

To stop Web browser sharing:

On the title bar of the application that you no longer want to share, click the Stop button.

Tip: You can temporarily pause Web browser sharing, rather than stopping Web browser sharing. For details, see Pausing and resuming software sharing.
Sharing your desktop

The presenter uses desktop sharing to show all event attendees his or her entire computer desktop—including any applications, windows, and file directories that are currently open. The presenter can use desktop sharing to share several applications simultaneously or to share other areas of the computer, such as file directories.

Attendees can view the presenter's shared desktop, including all mouse movements, in a sharing window on their screens.

Tasks related to sharing your desktop:

- Start sharing your desktop More... (on page 250)
- Manage how attendees view your shared software (pausing, changing to full-screen view, and so on) More... (on page 253)
- Annotate and draw on your desktop More... (on page 263) and allow attendees to draw More... (on page 266)
- Read a few tips for sharing your desktop effectively More... (on page 272)
- Stop sharing your desktop More... (on page 278)

Starting desktop sharing

Host or Presenter only

You can share your computer's desktop with event participants.

To share your desktop:

1 On the Share menu, choose My Desktop.

   If you have more than one monitor, a submenu shows the available monitors.
2 Select the monitor to share.

Your desktop appears in a sharing window on participants' screens.

For ideas that can help you to share your desktop more effectively, see Tips for Sharing Software.

**Note:** If your desktop has any background images or patterns, or wallpaper, your Event Manager software may remove them from attendees' views to improve the performance of desktop sharing.

### Stopping desktop sharing

You can stop desktop sharing at any time.

**To stop sharing your desktop:**

In the Event Controls box, click the **Stop Sharing** button.
If you are an attendee, rather than the presenter, click the Return button to leave the sharing session.

You do not leave the event, just the sharing portion of it.
Sharing Web Content

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>get an overview of sharing Web content</td>
<td>About sharing Web content (on page 281)</td>
</tr>
<tr>
<td>share Web content with meeting participants</td>
<td>Sharing Web content (on page 282)</td>
</tr>
<tr>
<td>understand the differences between sharing a browser and sharing Web content</td>
<td>Differences between sharing Web content and sharing a Web browser (on page 282)</td>
</tr>
</tbody>
</table>

**About sharing Web content**

You can share Web content that resides on:

- The public Internet or Web
- Your company’s intranet
- Your computer or another computer on your private network

Web content includes:

- Web pages, including pages that contain embedded media files, such as Flash, audio, or video files
- Standalone media files, such as Flash, audio, or video files

The Web content that you share opens in the content viewer on each participant’s screen. If you share a Web page, participants view and interact independently with the content on the page. If the page contains links to other pages, they can also navigate independently to those pages.
If you use Web content sharing, then, participants can experience audio and video effects on a Web page. However, unlike Web browser sharing, this option does not allow you to guide participants to other Web pages. For more information, see *Differences between sharing Web content and sharing a Web browser* (on page 282).

**Important:** If you share content that requires a media player, participants can view and interact with the content only if the appropriate player is installed on their computers.

### Sharing Web content

You can share a Web page that contains multimedia effects. The page opens in the content viewer on each participant's screen.

**To share Web content:**

1. On the **Share** menu, choose **Web Content**.
   
   The Share Web Content dialog box appears.

2. In the **Address** box, enter the address, or URL, at which the content resides.
   
   Or, if you have previously shared the content, select it in the drop-down list.

3. In the **Type** box, select the type of Web content that you want to share.

4. Click **OK**.

**Tip:** You can copy a URL from any source, such as another browser window, and then paste it in the **Address** box.

### Differences between sharing Web content and sharing a Web browser

Event Center provides two options for sharing Web-based information. You can share Web content or share a Web browser with event participants. Choose the feature that better suits your needs.
### Chapter 27: Sharing Web Content

<table>
<thead>
<tr>
<th>Sharing option</th>
<th>Advantages</th>
<th>Disadvantages</th>
</tr>
</thead>
</table>
| Web browser sharing    | - Lets you guide participants to various Web pages and sites on the Web.  
                         | - Lets you grant attendees control of your Web browser.  
                         | - Lets you and other participants annotate Web pages.                                                   | - Does not display media effects or transmit sounds on Web pages.  
                         |                                                                                                                | - Does not let participants interact with Web pages independently.                                        |
| Web content sharing    | - Displays Web pages, and lets participants experience media effects on Web pages, including video and sound.  
                         | - Lets participants interact with Web pages independently in their content viewers.                        | - Does not let you guide participants to other Web pages.                                                |
Sharing Multimedia on the Media Viewer Panel

<table>
<thead>
<tr>
<th>If you want to ...</th>
<th>See ...</th>
</tr>
</thead>
<tbody>
<tr>
<td>get an overview of sharing multimedia on the Media Viewer panel</td>
<td>About sharing multimedia Web content on the Media Viewer panel (on page 285)</td>
</tr>
<tr>
<td>share or stop sharing multimedia on the Media Viewer panel</td>
<td>Sharing multimedia content in the media viewer (on page 286)</td>
</tr>
</tbody>
</table>

About sharing multimedia Web content on the Media Viewer panel

You can share multimedia content that resides at a Web address, or URL, on the Media Viewer panel. For details about working with the panels, see Working with panels (on page 133).

This option ensures that the multimedia content you are sharing remains visible or playing to event participants, regardless of the types of content you are presenting in the content viewer.

Note: The content viewer displays one or more documents, presentations, applications, and whiteboards that you share during an event. Document tabs at the top of the viewer allow you to switch among multiple shared documents, presentations, and whiteboards.
Chapter 28: Sharing Multimedia on the Media Viewer Panel

The multimedia content you can share include audio, video, Flash movies, graphics, and WebEx Recording Format files.

Sharing multimedia content in the media viewer

You can share multimedia content that resides at a Web address, or URL, in the dedicated media viewer on the Media Viewer panel. You can also stop sharing multimedia content at any time during an event.

To share multimedia content on the Media Viewer panel:
   The Share Multimedia dialog box appears.
2. In the Address box, type the URL that contains the multimedia content you want to share.
   The content appears in the media viewer on the Media Viewer panel.

To replace the currently displayed content with new content:
1. On the Media Viewer panel, right-click (Windows) or select ctrl and then click (Mac) the Media Viewer title bar.
2. On the menu that appears, choose Share Multimedia.

The Share Multimedia dialog box appears.
3. In the Address box, type the URL that contains the multimedia content you want to share.
   The content replaces the old content in the media viewer.

To stop sharing multimedia content in the media viewer:
1. On the Media Viewer panel, right-click the Media Viewer title bar.
2 On the menu that appears, choose **Stop Multimedia Sharing**.
Using Chat

Chat is useful during an event if you want to:
- send brief information to all participants
- send a private message to another participant
- ask a question but do not want to use the Q & A option, which provides a formal procedure for asking and answering questions

All chat messages that you send or receive appear on the Chat panel in the event window.

The Chat function allows you to perform these tasks:
- Send chat messages More... (on page 289)
- Print chat messages More... (on page 291)
- Save chat messages More... (on page 292)
- Open a chat file during an event More... (on page 293)

Sending chat messages

During an event, the presenter can specify chat privileges for participants. These privileges determine to whom participants can send chat messages.

To send a chat message:
1. Open the Chat panel.
2. In the Send to drop-down list, select the recipient of the message.
3. Enter your message in the chat text box.
Depending on the operating system you use, follow this step:

- Windows: Click **Send**.
- Mac: Select **enter** on your keyboard.

**Note:** If you join an event in progress, you can see only the chat messages that participants send after you join the event.

### Sending chat messages to an attendee

*Host and panelists only*

During an event, you can send chat messages to any particular attendee. If there is a large number of attendees in the event, you can search for an attendee's name.

**To send a chat message to an attendee:**

1. Open the Chat panel.
2. In the **Send to** drop-down list, select **Select an Attendee...**

   ![Select an Attendee dialog box]

3. In the **Select an Attendee** dialog box, select the attendee's name in the list, and then click **OK**.
To search for an attendee's name, enter all or a portion of the name and then click **Find**.

To refresh the attendee list, click **Refresh**.

4 Enter your message in the chat text box.

5 Depending on the operating system you use, follow one of these steps:
   - Windows: Click **Send**.
   - Mac: Select **enter** on your keyboard.

The attendee's name you selected are added to the **Send to** drop-down list. If you need to send a chat message to the same attendee again, you can do so more quickly.

### Printing chat messages

You can print all the chat messages that appear on the Chat panel.

**To print chat messages:**

1 In the Event window, on the **File** menu, choose **Print > Chat**.
   A print dialog box appears.

2 Optional. Specify printer options.

3 Print.
Chapter 29: Using Chat

Saving chat messages

You can save chat messages that appear on the Chat panel to a .txt file. You can then reopen the file for use in any event or view the file's content outside an event by opening the file in a text editor.

Once you save chat messages to a file, you can save changes to the messages or save a copy of them to another file.

For help in performing these tasks, click the "More" link:

- Save chat messages for the first time in an event More... (on page 292)
- Save change to a chat file More... (on page 293)
- Create a copy of a chat file More... (on page 293)

Note: Event Center also automatically saves chat messages every two minutes to the WebEx folder in the My Documents folder on the host and panelist computers.

Saving chat messages to a new file

You can save chat messages you have sent or received to a new chat file.

To save chat messages to a new file:

1. In the Event window, on the File menu, choose Save > Chat.
   
   The Save Chat As dialog box appears.

2. Choose a location at which you want to save the file.

3. Type a name for the file.

4. Click Save.

Event Manager saves the chat messages in a .txt file at the location you selected.
Saving changes to a chat file

If you make changes to the messages on your Chat panel, you can save them to an existing chat file.

To save changes to a chat file:
1. In the Event window, on the File menu, choose Save > Chat.
2. Event Manager saves the changes to the existing chat file.

Creating a copy of previously saved chat messages

If you have saved chat messages and want to create another copy of the messages, you can do so by saving the chat messages to a chat file with a different name.

To create a copy of chat messages that have been previously saved:
1. In the Event window, on the File menu, choose Save As > Chat.
   The Save Chat As dialog box appears.
2. Do either or both of the following:
   - Type a new name for the file.
   - Choose a new location at which you want to save the file.
3. Click Save.
Event Manager saves the file at the location you chose. The file name has a .txt extension.

Opening a chat file during an event

If you saved chat messages to a .txt file, you can display those chat messages on your Chat panel by opening the file.

To open a chat file in an event:
1. In the Event window, on the File menu, choose Open > Chat.
   The Open Chat dialog box appears.
2. Select the chat file that you want to open.
3 Click **Open**.

The chat messages appear on the Chat panel.

If there are already chat messages in your chat viewer, Event Manager appends the messages from the chat file to the existing messages.
Polling Attendees

During an event, you can poll attendees by presenting them with a questionnaire. Conducting a poll can be useful for gathering feedback from attendees, allowing attendees to vote on a proposal, testing attendees' knowledge of a topic, and so on. The host assigns the role of poll coordinator to a panelist in an event. More... (on page 296)

During the event, the poll coordinator is responsible for:
- Preparing a poll questionnaire More... (on page 296)
- Conducting a poll during the event More... (on page 304)

After closing a poll, the poll coordinator can:
- View poll results More.... (on page 306)
- Share poll results with participants More... (on page 307)
- Save poll results for viewing outside an event More... (on page 308)

Preparing a poll questionnaire

When preparing a poll questionnaire, you can:
- Create a questionnaire More... (on page 296)
- Edit a questionnaire More... (on page 301)
- Set a timer for polling More... (on page 303)
- Specify options for poll results More... (on page 303)
Designating the role of polling coordinator

*Host only*

In the beginning of an event, the host is the polling coordinator by default. You can assign the role of *polling coordinator* to a panelist.

The poll coordinator is responsible for preparing and conducting polls during the event.

To designate the role of the polling coordinator:

1. On the **Participants** panel and in the list of panelists, select the name of the panelist whom you want to designate as the polling coordinator.
2. On the **Participant** menu, choose **Change Role To > Polling Coordinator**.

The polling functions become available on the designated panelist's Polling panel.

Creating a poll questionnaire

*Polling coordinator only*

To conduct a poll, you must first create a poll questionnaire. You can create poll questionnaires by using one of these methods:

- **WebEx Poll Questionnaire Editor**—This standalone version of the WebEx Poll Questionnaire Editor allows you to create poll questionnaires outside an event, save them, and open them during an event.

  To download the Editor, go to the Downloads page by clicking **Support > Downloads** on the left navigation bar of your Event Center Web site.

- **Polling panel inside an event**—To save time in an event, you can start the event earlier than the scheduled time, create questionnaires on the Polling panel, save them, and then open them during the actual event.

To create a questionnaire (for Windows):

1. Open the WebEx Poll Questionnaire Editor or the Polling panel in an event.
   
   You can start the WebEx Poll Questionnaire Editor by going to **Start > Programs > WebEx** on your desktop.

2. In the **Question** section, select one of these question types:
- To create a multiple-answer question, select **Multiple choice**, and then select **Multiple Answers** in the drop-down list.
- To create a single-answer question, select **Multiple choice**, and then select **Single Answer** in the drop-down list.
- To create a text question, select **Short answer**.

3 Click **New**.

4 Type a question in the box that appears.

5 In the **Answer** section, click **Add**.

6 Type an answer in the box that appears.

7 To type another answer, click **Add** once you finish typing an answer.
   The question and answers appear in the Poll Questions area.

8 To add questions, repeat steps 2 to 7.

This figure shows an example of a poll questionnaire.

<table>
<thead>
<tr>
<th>Poll Questions:</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>1.</strong> What is your favorite color?</td>
</tr>
<tr>
<td>a. blue</td>
</tr>
<tr>
<td>b. red</td>
</tr>
<tr>
<td>c. green</td>
</tr>
<tr>
<td>d. black</td>
</tr>
<tr>
<td><strong>2.</strong> What do you enjoy doing at leisure?</td>
</tr>
<tr>
<td>a. reading</td>
</tr>
<tr>
<td>b. watching movies</td>
</tr>
<tr>
<td>c. travelling</td>
</tr>
<tr>
<td>d. sports</td>
</tr>
<tr>
<td><strong>3.</strong> Please give us feedback about this event.</td>
</tr>
</tbody>
</table>

To create a questionnaire (for the Mac):

1 Open the Polling panel in the event.

2 Add a question by clicking this button and then typing the question.

3 Add an answer by clicking this button and then typing the answer.
4 To add more answers, repeat step 3.
5 To add more questions, repeat step 2.
6 To change the question type for a question, click the text "Click here to change question type" that appears under the specific question and then do one of the following:
   - To create a multiple-answer question, select **Multiple Answers**.
   - To create a single-answer question, select **Single Answer**.
   - To create a question that requires a text answer, select **Short Answer**.

Displaying multiple poll questionnaires on Polling panel
When an event is in progress, you can:

- Display or create multiple poll questionnaires on your Polling panel.
  Each poll questionnaire displays on a tab.
- Click any of the poll tabs to edit or open the poll.

To display additional poll questionnaires on your Polling panel:

- If the poll questionnaire has not been created, click the icon **New**. For more information, see *Creating poll questionnaires* (on page 296).
If the poll questionnaire has been created, click the icon **Open** to open the poll questionnaire file. For more information, see *Opening a poll questionnaire file* (on page 311).

To close a poll tab:

Click this icon.
Renaming and reordering poll tabs

You can easily change a tab name or change the tab order on your Polling panel.

**To rename a tab on your Polling panel (Windows):**

1. Do one of the following:
   - Right-click the tab name and choose **Rename**.
   - Double-click the tab name.
2. Enter the new name on the tab.
3. Press **Enter** or click outside the tab.

This tab displays the new name.

**To rename a tab on your Polling panel (the Mac):**

Double-click the tab, type the new name, and then press **enter**.

**To reorder the tabs on your Polling panel:**

1. Right-click any tab and choose **Reorder Polling Tabs**.
2. In the Reorder Viewer Tabs dialog box, use the arrows to change the order of the tabs.
   - Moving a tab up in the order moves that tab to the left on the Polling panel.
3. Click **OK**.

**Tip:** To quickly move a tab to the left or right, select the tab and use a drag-and-drop operation to move it.

Editing a questionnaire

You can change the type of a question and edit, rearrange, or delete the questions and answers.
To change the type of a question:
1. Select the question by clicking it, and then select the new type of question in the Question section.
   For more information about the different types of questions, see *Creating poll questionnaires* (on page 296).
2. Click Change Type.

To edit any question or answer that you entered:
1. Select the question or answer by clicking it, and then click the Edit icon.
2. Make your changes.

To delete a question or an answer:
Select the question or answer by clicking it, and then click the Delete icon.

To rearrange questions or answers:
Select the question or answer by clicking it, and then click the Move Up or Move Down icon, as appropriate.

To delete an entire questionnaire:
Click Clear All.

If you have not saved the questionnaire, a message box appears, asking whether you want to save it or not.
Displaying a timer during polling

You can specify that a timer displays for participants and yourself when a poll is in progress.

To display a timer:

1. Open the Polling Options dialog box.
   - If you use Windows, click **Options** at the bottom of your Polling panel.
   - If you use the Mac, click this button on the lower-right portion of the Polling panel.

2. In the dialog box that appears, select **Display**, and then type the length of time in the **Alarm:** box.

3. Click **OK**.

Specifying options for poll results

Poll results may contain the number of responses for each answer and the percentage of participants who choose each answer. When preparing a poll questionnaire, you can choose to base the percentage for each answer on *either* of the following:

- the total number of attendees in the event, including those who do not respond to the poll
- the number of attendees who submit at least one answer to the poll

To specify options for poll results:

1. Open the Polling Options dialog box.
   - If you use Windows, click **Options** at the bottom of your Polling panel.
If you use the Mac, click this button on the lower-right portion of the Polling panel.

2 Select one or both of these options:

- **Include no answer**—Specifies that the poll results will include “non-respondents,” that is—attendees who do not respond to any of the answers in the poll.

- **Show number of responses**—Specifies that the poll results for each answer will show the number of respondents out of the total number of attendees in the poll.

**Note:** The total number of attendees in the poll can be all attendees in the event or only those who respond to the poll, depending on whether you select **Include no answer** in the Polling Options dialog box. If you do not select **Include no answer**, the percentage for each answer in your poll results will be based on only those who respond to the poll.

3 Click **OK**.

### Opening a poll

After you finish preparing a poll questionnaire, you can open the poll.

If you prepared your questionnaire in advance and saved it, you must first display it on the Polling panel. For details, see *Opening a poll questionnaire file* (on page 311).

**To open a poll:**

1 Display your poll questionnaire on the Polling panel, if you have not done so.

2 Click **Open Poll**.
The questionnaire appears on participants’ Polling panels. Participants can now answer the poll.

As participants answer the questions, you can watch the polling status on your Polling panel.

Windows:
To view each participant’s polling status, click one of these three buttons.

Mac:
To view each participant’s polling status, select the text “Click to see detailed status.”

3 Click Close Poll when the time is up.

If you specify a timer and the poll times out, the poll automatically closes.

Participants can no longer answer questions.

Once you close a poll, you can view the poll results and optionally share them with participants. For details, see Viewing and sharing poll results (on page 305).

### Viewing and sharing poll results

After closing a poll, you can:

- View the complete results of the poll. More... (on page 306)
- Share group results with participants. More... (on page 307)

The poll results you can share during an event are anonymous. However, Event Center records responses from each participant, in addition to group results, and allows you to save those individual and group results. For more information, see Saving results of a poll (on page 308).
Chapter 30: Polling Attendees

Viewing poll results

Poll results may contain the number of responses for each answer and the percentage of participants who choose each answer. If you did not specify to show the number of responses when preparing the questionnaire, you see only the percentage for each answer.

<table>
<thead>
<tr>
<th>Poll Questions:</th>
<th>Results</th>
<th>Bar Graph</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. What is your favorite color?</td>
<td></td>
<td></td>
</tr>
<tr>
<td>a. blue</td>
<td>2/4(50%)</td>
<td></td>
</tr>
<tr>
<td>b. red</td>
<td>1/4(25%)</td>
<td></td>
</tr>
<tr>
<td>c. green</td>
<td>0/4(0%)</td>
<td></td>
</tr>
<tr>
<td>d. black</td>
<td>0/4(0%)</td>
<td></td>
</tr>
<tr>
<td>No Answer</td>
<td>1/4(25%)</td>
<td></td>
</tr>
<tr>
<td>2. What do you enjoy doing at lei...</td>
<td></td>
<td></td>
</tr>
<tr>
<td>a. reading</td>
<td>3/4(75%)</td>
<td></td>
</tr>
<tr>
<td>b. watching movies</td>
<td>3/4(75%)</td>
<td></td>
</tr>
<tr>
<td>c. traveling</td>
<td>2/4(50%)</td>
<td></td>
</tr>
<tr>
<td>d. sports</td>
<td>1/4(25%)</td>
<td></td>
</tr>
<tr>
<td>No Answer</td>
<td>1/4(25%)</td>
<td></td>
</tr>
<tr>
<td>3. Please give us feedback abou...</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

The Results column indicates the percentage of attendees who chose each answer. The Bar Graph column provides a graphic representation of each percentage in the Results column.
Sharing poll results with participants

After you close a poll, you can share the poll results with participants.

The poll results you can share during an event are anonymous. However, Event Center records responses from each participant, in addition to group results, and allows you to save those individual and group results. For more information, see Saving results of a poll (on page 308).

To share the results of a poll:

In the Share with attendees section on your Polling panel, select Poll results, and then click Apply.

The results of the poll appear in the participants' Polling panels, just as they do on your Polling panel.

Saving and opening poll questionnaires and results

<table>
<thead>
<tr>
<th>Task description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>If you have prepared a poll questionnaire, you can:</strong></td>
</tr>
<tr>
<td>• Save the questionnaire More… (on page 308)</td>
</tr>
<tr>
<td>• Open the saved questionnaire for use in any event More… (on page 311)</td>
</tr>
<tr>
<td><strong>After you close a poll, you can:</strong></td>
</tr>
<tr>
<td>• Save group results to a .txt or .csv file More… (on page 308)</td>
</tr>
<tr>
<td>• Save responses from individual participants to a .txt or .csv file More… (on page 308)</td>
</tr>
</tbody>
</table>
Saving a poll questionnaire in an event

After you create a poll questionnaire in an event, you can save it as a .atp file. You can open the file for use in any event.

To save a poll questionnaire:
1. On the File menu, choose Save > Poll Questions.
   The Save Poll Questions As dialog box appears.
2. Choose a location at which to save the file.
3. Type a name for the file.
4. Click Save.
   Event Manager saves the poll questionnaire to a file at the location you specified. Poll questionnaire file names have a .atp extension.

Saving results of a poll

After closing a poll, you can save the responses in one of these ways:

- **Text File group result**—Saves the percentage of attendees who chose each answer in a .txt file
- **Text File individual attendees result**—Saves the responses from each attendee, in addition to the group results, in a .txt file
- **CSV group result**—Saves the percentage of attendees who chose each answer in a .csv file
- **CSV individual attendees result**—Saves the responses from each attendee, in addition to the group results, in a .csv file

When you are saving poll results, you can select a format in which you want to save the results.
To save results of a poll:

1. Close the poll if you have not done so.
2. On the File menu, choose Save > Poll Results.
   The Save Poll Results As dialog box appears.
3. Select a location at which to save the file.
4. In the "File name" drop-down list, enter a name for the file.
5. In the "Save as type" drop-down list, select the format in which you want to save the results.
6. Click Save.

You can now view poll results by opening the file.

Tip: Event Center automatically saves poll questionnaires and group and individual results every two minutes to the default folder C:\Documents and Settings\$USER$\My Documents\WebEx on your computer. If the folder does not exist and cannot be created when the event starts, the alternative folder is C:\My WebEx Documents. If you ever lose your poll questions or results, recover them in the designated folder or contact the WebEx Technical Support for more information.

Saving results of all polls in one file

After closing a poll, you can save the responses in one of these ways:

- **Text File group result**—Saves the percentage of attendees who chose each answer in a .txt file
- **Text File individual attendees result**—Saves the responses from each attendee, in addition to the group results, in a .txt file
- **CSV group result**—Saves the percentage of attendees who chose each answer in a .csv file
- **CSV individual attendees result**—Saves the responses from each attendee, in addition to the group results, in a .csv file
When you are saving poll results, you can select a format in which you want to save the results.

To save results of all polls in one file:

1. Close all the polls if you have not done so.
2. On the File menu, choose Save > All Poll Results.

The Save All Poll Results dialog box appears.

3. Select a location at which to save the file.
4. In the "File name" drop-down list, enter a name for the file.
5. In the "Save as type" drop-down list, select the format in which you want to save the results.
6. Click Save.

You can now view poll results by opening the file.

Tip: Event Center automatically saves poll questionnaires and group and individual results every two minutes to the default folder C:\Documents and Settings\<USER ROOTs>\My Documents\WebEx on your
Opening a poll questionnaire file

If you saved a poll questionnaire to a file, you can display the questionnaire on your Polling panel by opening the file.

**Note:** You can open a poll questionnaire file only during an event.

To open a poll questionnaire file:

1. Use one of these methods to browse to the file:
   - On the **File** menu, choose **Open Poll Questions**.
   - Click the **Open** icon on your Polling panel.

   ![Windows Open Poll Questions](image)
   ![Mac Open Poll Questions](image)

   The Open Poll Questions dialog box appears.

2. Select the poll questionnaire file that you want to open.
   A poll questionnaire file has a .atp extension.

3. Click **Open**.

   The poll questionnaire appears on your Polling panel. You can now open the poll to the participants.
Using Feedback

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>get an overview of using Feedback</td>
<td>About using Feedback (on page 313)</td>
</tr>
<tr>
<td>allow participants to use Feedback options</td>
<td>Allowing participants to provide feedback (on page 314)</td>
</tr>
<tr>
<td>view a running tally of responses</td>
<td>Viewing a running tally of responses (on page 314)</td>
</tr>
<tr>
<td>provide feedback</td>
<td>Providing feedback (on page 315)</td>
</tr>
<tr>
<td>remove responses from the Participants panel</td>
<td>Removing feedback (on page 316)</td>
</tr>
</tbody>
</table>

About using Feedback

Feedback is a feature that allows the presenter to pose a question at any time—either verbally during a teleconference or Internet phone conference, or in a chat message—and receive instant feedback from other participants.

As the host, you can:

- allow attendees to provide feedback
- respond to the presenter’s verbal request for feedback
- provide unsolicited feedback
- view the results on the Feedback palette

As the presenter, you can:

- pose a question and request feedback
Chapter 31: Using Feedback

- share the feedback results with all participants
- clear the feedback results
- view the results on the Feedback palette

As a participant, you can:
- click the **Raise Hand** button if the presenter asks for a show of hands in response to a question or if you have a question
- select **yes** or **no** in response to a question
- select **too slow** or **too fast** to indicate that the presenter’s pacing is too slow or too fast
- select **Applause** or **Laughter** to express your emotions

### Allowing participants to provide feedback

*Host only*

You can allow participants to use the Feedback options during an event.

**To allow participants to use the Feedback options:**

1. On the **Participants** panel, click the **Feedback** icon.

   ![Windows Feedback Icon](image.png)
   ![Mac Feedback Icon](image.png)

   The Feedback palette appears.

2. Check **Allow feedback**.

3. To close the palette, click the "close" button.

### Viewing a running tally of responses

You can view a running tally of responses from attendees during an event.

**To view a running tally of responses:**

On the **Participants** panel, click the **Feedback** icon.
The Feedback palette appears.

Your Feedback palette displays a running tally of responses. See the following figure for an example.

![Feedback Palette](image)

In your participants list, a response indicator appears to the right of the name of each participant who has responded to a presenter's question.

**Providing feedback**

You can provide feedback from the Participants panel.

The following table shows the types of feedback you can provide during an event:

<table>
<thead>
<tr>
<th>Windows</th>
<th>Mac</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Raise Hand" /></td>
<td></td>
</tr>
</tbody>
</table>

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Click the button if the presenter asks for a show of hands in response to a question or if you have a question.</td>
<td>Click the icon to provide feedback.</td>
</tr>
</tbody>
</table>
To provide feedback:

1. Click *either* the **Feedback** icon or the downward-pointing arrow to the right of the **Feedback** icon.
2. Select *one* of the following responses from the drop-down list.

   - **Yes or No** in response to a question
   - **Too Slow** or **Too Fast** to indicate that the presenter’s pacing is too fast or slow
   - **Applause** to applaud the presenter
   - **Laughter** to laugh at the presenter's remarks

3. Click **Send**.

   Your Feedback palette displays a running tally of responses. On the **Participants** panel, a response indicator appears to the right of the name of each participant who has responded to a presenter's question.

**Removing feedback**

You can remove all the feedback at any time during an event.

To remove feedback (erase all responses):

1. On the **Participants** panel, click the **Feedback** button on the toolbar.
2. Click **Clear**.
Publishing a Recorded Event

If you record an event using WebEx Recorder, you can publish and make available the recording on your event service Web site's Event Recordings page in one of the following ways:

- If the recording is made from the integrated or standalone WebEx Recorder, upload the recording file, with a .wrf extension, from your local computer to the My Event Recordings page and publish it from that page.

  For details about uploading a recording, see *Uploading a recording file* (on page 319).

- If the event was recorded on the server, the WebEx server automatically uploads the recording file to the My Event Recordings page. You can maintain and publish the recording from that page.

- Specify the Web address, or URL, at which the recording resides on a publicly accessible Web server, such as your organization's Web site. To use this option, you can ask your organization's Webmaster to store the recording on the server and provide you with the URL for the recording.

- Send an email to share the event recording. For details about sharing a recording with others, see *Sending an email to share an event recording* (on page 331).

- Send an email to vendors to share an event recording. For details about sharing a recording with vendors, see *Sending an email to vendors to share an event recording* (on page 332).

Before publishing a recorded event, you can:

- Specify that users provide registration information before viewing the recording and customize the registration form.

- Provide information about the recording, such as a description of the recording and the presenter, the duration, and so on.
Set an access password for viewing the recording.

Once you publish a recording, you can edit information about it at any time.

**Note:** For more information about using the different types of WebEx Recorder and WebEx Player, see the guide *WebEx Recorder and Player User's Guide* on the Support page of your Event Center Web site.

### Opening the My Event Recordings page

To upload or maintain event recordings, you must do so from the My Event Recordings page on your Event Center Web site.

**To open the My Event Recordings page:**

Do *either* of the following:

- Log in to your Event Center Web site, and then click **My WebEx**. From the left navigation bar, click **My Files > My Event Recordings**.
- Log in to your Event Center Web site. On the left navigation bar, click **My Event Recordings**.

The following figure shows an example of the page.
For details about the My Event Recordings page, see About the My Event Recordings page (on page 322).

### Uploading a recording file

If you recorded an event using the integrated or standalone WebEx Recorder, you can upload the recording file, with a .wrf extension, from your local computer to the My Event Recordings page and then publish it from that page.

For instructions on publishing a recording, see Publishing a recorded event (on page 319).

**Note:** If you recorded an event on the server, the WebEx server automatically uploads the recording file, with an .arf extension, to the My Event Recordings page once you stop the Recorder. You do not need to upload it yourself.

To upload a recording file:

1. Go to the My Event Recordings page. For details, see Opening the My Event Recordings page (on page 318).
2. Click Add Recording.
3. On the Add Event Recording page, enter information and specify options.
   
   For details about what you can do with each option on the page, see About the Add/Edit Event Recording page (on page 325).
4. Click Save.

### Publishing a recorded event

All event recordings are unlisted by default—that is, they appear only on the My Event Recordings page. You must log in to your Event Center Web site to view and maintain the recordings.

To publish a recording and make it available for all visitors to your site, you must specify to list the recording—that is, the recording appears on the Event Recordings page, which is accessible to each site visitor.
After a recording is added to the My Event Recordings page, your event service generates URLs for streaming and downloading the recording on the Recording Information page. You can copy and paste the URLs in an email message that you send to event participants.

To publish a recorded event:

1. Open the My Event Recordings page. For details, see Opening the My Event Recordings page (on page 318).

2. Upload your recording, if you have not yet done so. For details, see Uploading a recording file (on page 319).

3. Click the More icon for the recording that you want to edit:

   ![More icon]

4. Click Modify from the menu.

   ![Modify menu]

   The Edit Event Recording page appears.

5. In the Type drop-down list, select Listed.

   For details about what you can do with each option on the Edit Event Recording page, see About the My Event Recordings page (on page 322).

6. Click Save.

   The recording appears on the Event Recordings page. You can verify it by clicking Attend an Event (left navigation bar) > List of Events > View Event Recordings.
Optional. Send an email share an event recording. For details, see Sending an email to share an event recording (on page 331).

Optional. Send an email to vendors to share an event recording and track viewing. For details, see Sending an email to vendors and tracking viewing of recording (on page 332).

**Important:** If you require a password for playing or downloading a recording, ensure that you communicate it to the intended viewers, such as in an email message.

### Deleting a published recording

You can remove a published recording at any time.

**To delete a published recording:**

1. Go to the My Event Recordings page. For details, see Opening the My Event Recordings page (on page 318).
2. Click the More button next to the event recording to display additional options.
3. Click **Delete** from the menu.
4. Click **OK** to confirm.

Once you remove a recording from the My Event Recordings page, you also remove it from the Event Recordings page.
Editing information about a recorded event

Whether you publish a recording or not, you can edit information about it at any time. If you already published a recording, the changes you make to the recording information will appear on the Event Recordings page, which is accessible to all visitors to your Event Center Web site.

To edit information about a recorded event:

1. Go to the My Event Recordings page. For details, see *Opening the My Event Recordings page* (on page 318).
2. Click the More icon for the recording that you want to edit:

   ![More icon]

3. Click **Modify** from the menu.

4. The Edit Event Recording page appears.
5. Make your changes.
   
   For details about what you can do with each option on the Edit Event Recording page, see *About the Add/Edit Event Recording page* (on page 325).
6. Click **Save**.

About the My Event Recordings page

**How to access this page**

Do *either* of the following:
Log in to your Event Center Web site, and then click My WebEx. From the left navigation bar, click Manage My Stuff > My Recordings > Events.

Log in to your Event Center Web site. On the left navigation bar, click My Event Recordings.

**What you can do here**
Manage, upload, and maintain recording files of events you host.

**Options on this page**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Refreshes the information on the page.</td>
<td></td>
</tr>
<tr>
<td>Search</td>
<td>Allows you type text to search for within recording names. Click Search to start the search.</td>
</tr>
<tr>
<td>The name of the recording. If you record an event on the server, the WebEx server automatically uploads the recording to this page. In this case, the topic of the recording is the topic of the event. You can edit the topic at any time.</td>
<td></td>
</tr>
<tr>
<td>The percentage of available personal storage space on your WebEx Service Web site that is being used by your recordings.</td>
<td></td>
</tr>
<tr>
<td>The percentage of total available storage space on your WebEx Service Web site that is being used by all recordings on your site.</td>
<td></td>
</tr>
<tr>
<td>Information about the panelists in the event where the recording was made.</td>
<td></td>
</tr>
<tr>
<td>The publication status of the event recording:</td>
<td></td>
</tr>
<tr>
<td>Listed: The recording is published—that is, the recording appears on the Event Recordings page, which is accessible to all visitors to your Event Center Web site.</td>
<td></td>
</tr>
<tr>
<td>Unlisted: The recording is not published—that is, the recording appears only on the My Event Recordings page. You must log in to your Event Center Web site to view and maintain the recordings.</td>
<td></td>
</tr>
<tr>
<td>The size of the recording.</td>
<td></td>
</tr>
<tr>
<td>The date and time the recording was created.</td>
<td></td>
</tr>
<tr>
<td>The length of the recording.</td>
<td></td>
</tr>
</tbody>
</table>
Chapter 32: Publishing a Recorded Event

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Format</td>
<td>The format of the recording file. A recording file can be in WebEx Advanced Recording Format (ARF) or WebEx Recording Format (WRF). You can also store recording files that are in Windows Media Audio/Video (WMV) format. For Event Center and Training Center, you can also store Shockwave Flash Object (SWF) format files.</td>
</tr>
<tr>
<td></td>
<td>Lets you play the recording (available only for recording files with an .arf extension that were recorded by the Network-Based Recorder). If playback of the file requires a password, you must provide the password.</td>
</tr>
<tr>
<td></td>
<td>Lets you send an email to share this recording with others. Displays a menu with more options for your recording:</td>
</tr>
<tr>
<td></td>
<td>Download: Lets you download the recording to your local computer. If downloading the file requires a password, you must provide the password.</td>
</tr>
<tr>
<td></td>
<td>Modify: Lets you edit information of the recording. For details, see About the Add/Edit Event Recording page (on page 325).</td>
</tr>
<tr>
<td></td>
<td>Send to vendor: Lets you send an email to share this recording with a vendor.</td>
</tr>
<tr>
<td></td>
<td>Delete: Lets you delete the recording from this page.</td>
</tr>
<tr>
<td></td>
<td>Lets you upload a new recording. For details, see Uploading a recording file (on page 319) and About the Add/Edit Event Recording page (on page 325).</td>
</tr>
<tr>
<td></td>
<td>Indicates that a recording is password-protected.</td>
</tr>
<tr>
<td></td>
<td>Indicates that registration is required to view the recording.</td>
</tr>
</tbody>
</table>
About the Add/Edit Event Recording page

How to access this page

If you are adding a recording...
1. Do either of the following:
   - Log in to your Event Center Web site, and then click My WebEx. From the left navigation bar, click My Files > My Recordings > Events.
   - Log in to your Event Center Web site. On the left navigation bar, click My Event Recordings.
2. Click Add Recording.

If you are editing information of a recording...
1. Do either of the following:
   - Log in to your Event Center Web site, and then click My WebEx. From the left navigation bar, click My Files > My Recordings > Events.
   - Log in to your Event Center Web site. On the left navigation bar, click My Event Recordings.
2. Click the More icon for the recording that you want to edit:

3. Click Modify.
What you can do here

- Edit general information about an event recording, including the event topic and description.
- Specify whether to list an event recording—that is, the recording appears on your site's Event Recordings page, which is accessible to all site visitors.
- Require a password or registration to play or download the recording.

Options on this page

<table>
<thead>
<tr>
<th>Use this option…</th>
<th>To…</th>
</tr>
</thead>
<tbody>
<tr>
<td>Topic</td>
<td>Specify the topic of the recording.</td>
</tr>
<tr>
<td>Type</td>
<td>Specify the publication status of the event recording, which can be one of the following:</td>
</tr>
<tr>
<td></td>
<td>Listed: The recording is published—that is, the recording appears on the Event Recordings page, which is accessible to all visitors to your Event Center Web site.</td>
</tr>
<tr>
<td></td>
<td>Unlisted: The recording is not published—that is, the recording appears only on the My Event Recordings page. You must log in to your Event Center Web site to view and maintain the recordings.</td>
</tr>
<tr>
<td>Program</td>
<td>Assign the recording for a program. Select a program in the drop-down list.</td>
</tr>
<tr>
<td>Panelist information</td>
<td>Provide information about the panelists in this event.</td>
</tr>
<tr>
<td>Description</td>
<td>Provide a description of this recording.</td>
</tr>
<tr>
<td>Use this option....</td>
<td>To....</td>
</tr>
<tr>
<td>---------------------</td>
<td>--------</td>
</tr>
</tbody>
</table>
| **Recording file** | **I will provide URL**—Specify the Web address, or URL, at which the recording resides on a publicly accessible Web server, such as your organization's Web site. Enter a URL in the box. **Use the file on my local machine**—Select a recording file that resides on your local computer. Click **Browse** to select the file. **Use a file that is already on the WebEx network**—Specify a recording file that resides on the My Recordings page (in My WebEx), which lists the following types of recordings:  
  - all the network-based recordings (ARF format) that you made during an event  
  - other recordings (WRF format) that you upload to the page Click **Look Up** to browse and select a recording from the My Recordings page. If you cannot find a certain recording, it may have been removed or used on the My Training Recordings page, if your site includes the training service. |
| **Recording date** | Specify the date on which the recording was created. |
| **Recording start time** | Specify the time at which you started recording this event. |
| **Time zone** | Specify the time zone in which you recorded this event. |
| **Duration** | Specify the duration of this recording. |
| **Panel Display Options** | Determines which panels are displayed in the recording when it is played back. You can select any of the following panels to be included the recording playback:  
  - Chat  
  - Q & A  
  - Video  
  - Polling  
  - Notes  
  - File Transfer  
  - Participants  
  - Table of Contents Panel display options do not modify the panel display in the actual recording that is stored on the WebEx network. |
### Chapter 32: Publishing a Recorded Event

<table>
<thead>
<tr>
<th>Use this option...</th>
<th>To....</th>
</tr>
</thead>
</table>
| **Recording Playback Range** | Determines how much of the recording is actually played back. You can select either of the following:   
- **Full playback**: Plays back the full length of the recording. This option is selected by default.   
- **Partial playback**: Plays back only part of the recording based on your settings for the following options:   
  - **Start**: X min X sec of the recording; Specifies the time to start playback; for example, you can use this option if you would like to omit the "dead time" at the beginning of the recording, or if you would like to show only a portion of the recording.   
  - **End**: X min X sec of the recording; Specifies the time to end playback; for example, you can use this option if you would like to omit the "dead time" at the end of the recording. You can not specify an end time greater than the length of the actual recording.   
  The partial playback range you specify does not modify the actual recording that is stored on the server. |
| **Include NBR player controls** | Includes full Network Recording Player controls, such as stop, pause, resume, fast forward, and rewind. This option is selected by default. If you would like to prevent viewers from skipping portions of the recording, you can turn off this option to omit Network Recording Player controls from the playback. |
| **Registration required** | Require that users fill out a registration form before they can view the recording.  
To require registration, select **Yes**. |
| **Customize Registration form** | Customize the questions on the registration form.  
To customize the form, click **Customize**. |
| **Use password** | Set a password that users must provide to view the recording. |
| **Downloadable** | Specify that users can download the recording file to their local computers. |
| **Playable** | Specify that users can play the recording on their local computers. |
Chapter 32: Publishing a Recorded Event

<table>
<thead>
<tr>
<th>Use this option....</th>
<th>To....</th>
</tr>
</thead>
<tbody>
<tr>
<td>Post-recording survey</td>
<td>Allows you to create a survey for users to complete after playing the recording. You can select one of the following options:</td>
</tr>
<tr>
<td>▪</td>
<td>Do not display survey to attendees</td>
</tr>
<tr>
<td>▪</td>
<td>Display survey in pop-up window</td>
</tr>
<tr>
<td>▪</td>
<td>Display survey in main browser window (instead of destination URL)</td>
</tr>
<tr>
<td>You can click Create Post-Recording Survey to open the Create Survey page, which allows you to specify survey information and questions.</td>
<td></td>
</tr>
<tr>
<td>Allow direct access</td>
<td>If your site administrator has enabled hosts to expose a direct recording access URL, this option generates a direct recording access link. If the recording is not password-protected, clicking the direct recording access link plays the recording immediately, without requiring registration.</td>
</tr>
<tr>
<td>Display this URL at end of playback</td>
<td>Specify a Web page to display once a user stops the playback and closes WebEx Player.</td>
</tr>
</tbody>
</table>

About the Recording Information page

How to access this page

Open your event recordings list:

▪ Log in to your Event Center Web site, and then click My WebEx. From the left navigation bar, click My Files > My Recordings > Events.

▪ Log in to your Event Center Web site. On the left navigation bar, click My Event Recordings.

What you can do here

▪ View information about an event recording.

▪ Obtain URLs for playback or downloading of an event recording.

▪ Open the Edit Recording Information page, on which you can edit information about an event recording.

Options on this page
### Chapter 32: Publishing a Recorded Event

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Topic</strong></td>
<td>The name of the recording</td>
</tr>
<tr>
<td></td>
<td>If you record an event using the Network-Based Recorder, the WebEx server automatically uploads the recording to this page. In this case, the topic of the recording is the topic of the event. You can edit the topic at any time.</td>
</tr>
<tr>
<td><strong>Type</strong></td>
<td>The publication status of the event recording, which can be one of the following:</td>
</tr>
<tr>
<td></td>
<td>- <strong>Listed</strong>: The recording is published—that is, the recording appears on the Event Recordings page, which is accessible to all visitors to your Event Center Web site.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Unlisted</strong>: The recording is not published—that is, the recording appears only on the My Event Recordings page. You must log in to your Event Center Web site to view and maintain the recordings.</td>
</tr>
<tr>
<td><strong>Recording date</strong></td>
<td>The date and time at which the recording was made</td>
</tr>
<tr>
<td><strong>Panelist information</strong></td>
<td>Information about the panelists for the event where the recording was made</td>
</tr>
<tr>
<td><strong>Duration</strong></td>
<td>The length of the recording</td>
</tr>
<tr>
<td><strong>Description</strong></td>
<td>A description of the recording</td>
</tr>
<tr>
<td><strong>Number of viewers</strong></td>
<td>The number of people who viewed the recording</td>
</tr>
<tr>
<td><strong>Use password?</strong></td>
<td>Indicates whether a user must provide a password to view the recording</td>
</tr>
<tr>
<td><strong>Post-recording survey</strong></td>
<td>Indicates whether a survey displays after the recording has finished playing.</td>
</tr>
<tr>
<td><strong>Playback/Download link</strong></td>
<td>Clicking the link lets you playback the recording directly, bypassing registration. This option replaces the Download link option if the Add/Edit Event Recording page has Allow Direct Recording Access set to Yes.</td>
</tr>
<tr>
<td></td>
<td>Clicking the button lets you play the recording (available only for recording files with the .arf extension that were recorded by NBR). If you want to download the recording, you can also click the link for downloading under Play Recorded an event Now.</td>
</tr>
<tr>
<td></td>
<td>Clicking the button opens the Share My Recording window, which allows you to send an email message to selected recipients, inviting them to play your recording.</td>
</tr>
</tbody>
</table>
Chapter 32: Publishing a Recorded Event

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>If you want to send the email with your local email client instead, click the link for using the email client under Share My Recording.</td>
</tr>
<tr>
<td>Modify</td>
<td>Clicking the button opens the Edit Event Recording page. For details about the page, see About the Add/Edit Event Recording page (on page 325).</td>
</tr>
<tr>
<td>Send to Vendor</td>
<td>Allows you to send the recording to up to three vendors and use source IDs to track attendees who view the recording. For more information about using source IDs, see About tracking your attendees (on page 93).</td>
</tr>
<tr>
<td>Back to List</td>
<td>Clicking the button returns you to the My Event Recordings page.</td>
</tr>
</tbody>
</table>

Sending an email to share a recording

You can send an email one or more people to share your recording with them.

To send an email to share a recording with others:

1. Go to the My Event Recordings page. For details, see Opening the My Event Recordings page (on page 318).

2. Open the Share My Recording window:
   - Click the following icon for the recording that you want to share with others.
   - Click the linked name of the recording you want to share. On the Recording Information page, click Send Email.

The Share My Recording window appears.
Select recipients for your email:

- Click **Select Recipients** to select contacts from your Contacts list
- Type email addresses in the **Send to** list, separated by commas.

(Optional) Type a message in the **Your message** box.

Click **Send**.

Your email message will be sent to the selected recipients, and will include information about the recording and a link to play it.

**Sending an email to vendors and tracking viewing of recording**

You can send an email to up to three vendors and use source IDs to track from which sources attendees view the recording. For details about using source IDs, see *About tracking your attendees* (on page 93).

To send an email to share a recording with others:

1. Go to the My Event Recordings page. For details, see *Opening the My Event Recordings page* (on page 318).
2. Open the Send Recording to Vendor window:
On the My Event Recordings page, click the More button next to the recording you want to share to display additional options.

From the More menu, click the Send to Vendor link.

On the My Event Recordings page, click the name of the recording you want to share. On the Recording Information page, click Send to Vendor.

The Send Recording to Vendor window appears.

Specify up to three vendors for your email:
Chapter 32: Publishing a Recorded Event

- Type the vendor's email address in the **Email address #** boxes.
- Type the vendor's source ID in the **Source ID** box.

4. Click **Send**.

Your email message will be sent to the specified vendors, and will include information about the recording and a link to play it.
Sending and Receiving Video

If a video camera is installed on your computer, you can send video. Other participants can see you, or whatever you focus your webcam on. To see video, participants do not need to have a webcam installed on their computers.

WebEx Meeting Center supports high-definition (HD) video with up to 720p resolution. Other WebEx services, such as Training Center, Event Center, and Support Center, support high-quality video with up to 360p resolution. The Cisco technology automatically adjusts video to the highest quality for each participant according to the computer capabilities and network bandwidth.

Your administrator can set video options at the site level. A meeting host can set video options on the scheduler as well as in the meeting. If your site or meeting is not set up to use HD or high-quality video, standard video is used.

To start or stop sending video, select the video icon beside your name.

The icon turns green when you are sending video.

If you have a High Definition camera and you select the video icon, a one-time notification indicating **You are ready to send HD video to other participants** displays.
After you start sending video, you can perform the following tasks depending on your role.

<table>
<thead>
<tr>
<th>Role</th>
<th>Tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Host</strong></td>
<td>What you can do:</td>
</tr>
<tr>
<td></td>
<td>• Start or stop sending video at will.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Lock focus on one participant</strong> (on page 337).</td>
</tr>
<tr>
<td></td>
<td>• <strong>View everyone who is sending video</strong> (on page 340) on one big screen.</td>
</tr>
<tr>
<td></td>
<td>• <strong>List participants or show thumbnails</strong>. (on page 338)</td>
</tr>
<tr>
<td></td>
<td>• Set <strong>webcam options</strong> (on page 343).</td>
</tr>
<tr>
<td><strong>Participant</strong></td>
<td>What you can do:</td>
</tr>
<tr>
<td></td>
<td>• Start or stop sending video at will.</td>
</tr>
<tr>
<td></td>
<td>• <strong>View everyone who is sending video</strong> (on page 340) on one big screen.</td>
</tr>
<tr>
<td></td>
<td>• <strong>List participants or show thumbnails</strong>. (on page 338)</td>
</tr>
<tr>
<td></td>
<td>• Set <strong>webcam options</strong> (on page 343).</td>
</tr>
</tbody>
</table>

**Note:** If you are managing a meeting that includes TelePresence systems (Meeting Center only), the following WebEx features are unavailable:
Chapter 33: Sending and Receiving Video

- Recording
- Polling
- File Transfer
- Chat with TelePresence room participants

Minimum system requirements

To send or receive video with a resolution of 360p, ensure that your system meets the following minimum requirements:

<table>
<thead>
<tr>
<th>Action</th>
<th>What you need</th>
</tr>
</thead>
<tbody>
<tr>
<td>Send</td>
<td>• A webcam capable of producing high-quality video. WebEx supports most webcams of this type</td>
</tr>
<tr>
<td></td>
<td>• A computer with at least 1 GB of RAM and a dual-core processor</td>
</tr>
<tr>
<td></td>
<td>• A fast network connection</td>
</tr>
<tr>
<td>Receive</td>
<td>• A computer with at least 1 GB of RAM and a dual-core processor</td>
</tr>
<tr>
<td></td>
<td>• A fast network connection</td>
</tr>
</tbody>
</table>

To send or receive video with a resolution of 720p, ensure that your system meets the following minimum requirements:

<table>
<thead>
<tr>
<th>Action</th>
<th>What you need</th>
</tr>
</thead>
<tbody>
<tr>
<td>Send</td>
<td>• A webcam capable of producing HD video. WebEx supports most webcams of this type</td>
</tr>
<tr>
<td></td>
<td>• A computer with at least 2 GB of RAM and a quad-core processor</td>
</tr>
<tr>
<td></td>
<td>• A fast network connection</td>
</tr>
<tr>
<td>Receive</td>
<td>• A computer with at least 2 GB of RAM and a dual-core processor</td>
</tr>
<tr>
<td></td>
<td>• A fast network connection</td>
</tr>
</tbody>
</table>

Locking focus on one participant

If you are the host, you can select whose video you want everyone to see. Follow these steps:

1. Select the name on the video display.
2 In the dialog box, select one of the following:

- **The active speaker.** This is the default. The display focuses on the person currently speaking and switches as the loudest speaker changes.
- **A specific participant.** The display focuses on only the specific participant that you select. All participants see that person, regardless of who is speaking.

### Switching between a list or thumbnail view of participants

You can switch between the Participant List and participants' video thumbnails.
To view video thumbnails:
1) Select the list icon.
2) Select Thumbnails.

To view Participant List:
1) Select the thumbnail icon.
2) Select List.

In the thumbnails view, select the down or up arrow to view additional thumbnails.
Viewing everyone who is sending video

With one click, you can view live, high-quality video display across your entire screen. In the video view, you see all participants who are sending video, including:

- the active speaker or a specific participant whom the host chose to lock on
- five thumbnails on the bottom. To see more participants, use the arrow on either side.

To view all participants who are sending video:
Select the icon in the upper-right corner of the display.

To return to the Event window:
Select Exit Full-Screen Mode in the upper-right corner of the screen.

Understanding the large video view

When you are viewing everyone who is sending video, high-quality video displays across your entire screen.
Chapter 33: Sending and Receiving Video

One of the following is displayed here:

- The active speaker's video, which switches as the loudest speaker changes
- A specific participant's video that the host chose to lock on

Your self-view appears in this corner. You can

- Minimize or restore the display by selecting the icon in the upper-right corner of the self-view.
- Mute or unmute your audio by selecting **Mute Me** or **Unmute Me**.
- Stop or show your self-view by selecting **Stop My Video** or **Start My Video**.

Video thumbnails of five other participants appear here.

Use these controls to see additional participants.

If you are the host or presenter, you can choose to lock everyone's focus on the active speaker's video or a specific participant's video. Select the name to get started. More… (on page 337)

You can expand the active speaker's video display to full screen. More… (on page 342)
Expanding the active speaker’s video display

When you are viewing all participants who are sending video, you can expand the active speaker’s video display to full screen. With the full-screen display, you can continue sending or receiving HD video (applicable for Meeting Center only).

To see the active speaker (or the specific participant the host chose to lock on) in full-screen view, select this icon in the upper-right corner of the active speaker’s display.

To return to the view where you see everyone who is sending video, select this icon in the upper-right corner of your screen.

Floating Icon Tray in Video Full Screen Mode

Meeting participants have access to the Floating Icon Tray in full video mode making it easy to use all the common WebEx functions. The Floating Icon Tray automatically displays at the top of the video screen.
Setting webcam options

If you have a working webcam, you can set options that are available for that webcam directly from your event.

To set webcam options:

Windows:
At the top right of the Participants panel, select the options icon.

Mac:
At the bottom right of the Participants panel, select the options icon.

Typically, you can set options for general settings, such as contrast, sharpness, and brightness. But options can vary depending on your webcam.

Note: Screen save option is disabled in video and other full screen modes.
Managing video display during sharing

When you are sharing information or someone else is sharing information with you, a floating panel containing participant video and your self-view appears on the right-hand side of your screen.

What you can do on the floating panel:

- Stop or start your video. More... (on page 344)
- Minimize or restore your video. More... (on page 344)
- Move the panel by dragging it. More... (on page 345)
- Switch to view everyone who is sending video. More... (on page 345)
- Lock focus on another participant (for host and presenter only). More... (on page 337)

**Note:** If you are viewing everyone sending video and the presenter starts sharing, you will automatically exit the video view so that you can view what is being shared.

Controlling your self-view

During sharing, your self-view appears in the lower-right portion of the floating panel. You can manage your self-view in several ways.
To minimize self-view:
Select the icon in the upper-right portion of the self-view display.

To restore self-view:
Select the icon in the lower-right portion of the floating panel.

To stop or show self-view:
Select the video icon at the center of the self-view display.

Controlling video display

During sharing, you see the active speaker’s video or a specific participant’s video, if the host chose to lock on the participant, in a floating panel. You can manage this video display in several ways.

To minimize:
Select the downward arrow in the upper-left corner.

To resize:
Select the bottom right-corner and drag the edge.

To move:
Select and drag the display to another location on your screen.

To lock another participant’s video:
Select the name and then select the participant in the dialog box. For details, see Locking focus on one participant (on page 337).

To switch to view everyone:
Select the icon in the upper-right corner of the display.
Obtaining video and audio data during an event

Having video or audio problems in a meeting? If you contact technical support, the video and audio data you can obtain within the meeting comes in handy.

To obtain audio and video data while in the Event window:

Windows
Select **Meeting > Audio & Video Statistics...**

MAC
Select **Meeting > Audio & Video Statistics...**

To obtain audio and video data while viewing everyone sending video:

Right-click the active speaker's display and then select **Audio & Video Statistics...**
### Using My WebEx

<table>
<thead>
<tr>
<th>If you want to…</th>
<th>See…</th>
</tr>
</thead>
<tbody>
<tr>
<td>get an overview of My WebEx</td>
<td><em>About My WebEx</em> (on page 350)</td>
</tr>
<tr>
<td>set up a user account on your WebEx service Web site</td>
<td><em>Obtaining a user account</em> (on page 351)</td>
</tr>
<tr>
<td>log in to or out from My WebEx</td>
<td><em>Logging in to and out of the WebEx service site</em> (on page 352)</td>
</tr>
<tr>
<td>use your list of meetings</td>
<td><em>Using your list of meetings</em> (on page 352)</td>
</tr>
<tr>
<td>view or set options for your Personal Meeting Room page</td>
<td><em>Maintaining Your Personal Meeting Room Page</em> (on page 364)</td>
</tr>
<tr>
<td>set up or access remote computers, using Access Anywhere</td>
<td><em>Using Access Anywhere (My Computers)</em> (on page 368)</td>
</tr>
<tr>
<td>add, edit, or delete files in your personal storage space for files</td>
<td><em>Maintaining files in your personal folders</em> (on page 369)</td>
</tr>
<tr>
<td>publish recorded events on your event service Web site</td>
<td><em>Publishing a recorded event</em> (on page 319)</td>
</tr>
<tr>
<td>add, edit, or delete information about your contacts in your online address book</td>
<td><em>Maintaining contact information</em> (on page 391)</td>
</tr>
<tr>
<td>change information or settings in your user profile, including personal information and preferences</td>
<td><em>Maintaining your user profile</em> (on page 406)</td>
</tr>
<tr>
<td>manage the scheduling templates you saved</td>
<td><em>Managing scheduling templates</em> (on page 413)</td>
</tr>
<tr>
<td>generate reports about online sessions</td>
<td><em>Generating Reports</em> (on page 418)</td>
</tr>
</tbody>
</table>
About My WebEx

My WebEx is an area on your WebEx service Web site in which you can access your user account and personal productivity features. The following features are available, depending on the configuration of your site and user account:

- **Personal list of meetings**: Provides a list of all the online meetings that you are hosting and attending. You can view the meetings by day, week, or month, or you can view all meetings.

- **Productivity Tools Setup**: Optional feature. Lets you set up options for instant or scheduled meetings that you can start from applications on your desktop. If you install WebEx Productivity Tools, you can start or join meetings, sales meetings, training sessions, and support sessions instantly from One-Click or from other applications on your desktop, such as Microsoft Office, Web browsers, Microsoft Outlook, IBM Lotus Notes, and instant messengers. You can also schedule meetings, sales meetings, events, and training sessions using Microsoft Outlook or IBM Lotus Notes without going to your WebEx service site.

- **Personal Meeting Room**: Optional feature. A page on your WebEx service Web site on which visitors can view a list of meetings that you are hosting and join a meeting in progress. Visitors can also access and download files that you share.

- **Access Anywhere**: Optional feature. Lets you access and control a remote computer from anywhere in the world. For more information about Access Anywhere, refer to the guide Getting Started with Access Anywhere, which is available on your WebEx service Web site.

- **File storage**: Lets you store files in personal folders on your WebEx service Web site, where you can access them on any computer that has access to the Internet. Also lets you make specific files available on your Personal Meeting Room page, so visitors to your page can access them.

- **Recorded events management**: Lets you maintain recorded events files and publish them on your WebEx service Web site. For more information, see *Publishing a recorded event* (on page 319).

- **Address book**: Lets you keep information about your personal contacts on your WebEx service Web site. Using your address book, you can quickly access contacts when inviting them to a meeting.

- **User profile**: Lets you maintain your account information, such as your username, password, and contact information. Also lets you specify another user who can schedule meetings on your behalf, set options for your Personal Meeting Room page, and manage scheduling templates.
- **Web site preferences:** Lets you specify the home page for your WebEx service Web site—that is, the page that appears first whenever you access your site. If your site provides multiple languages, you can also choose a language and locale in which to display text on your site.

- **Usage reports:** Optional feature. Lets you obtain information about meetings that you hosted. If you use the Access Anywhere option, you can also obtain information about computers that you access remotely.

### Obtaining a user account

Once you obtain a user account, you can use My WebEx features and host s on the Web.

You can obtain a user account in one of two ways:

- The site administrator for your WebEx service Web site can create a user account for you. In this case, you need not sign up for an account on your site, and you can begin hosting sessions immediately.

- If your site administrator has made the self-registration feature available, you can sign up for an account on your WebEx service Web site at any time.

**To obtain a user account using the self-registration feature:**

1. Go to your WebEx service Web site.
2. On the navigation bar, click **Set Up > New Account**.
   - The Sign Up page appears.
3. Provide the required information.
4. Click **Sign Up Now**.
   - You receive an email message, confirming that you have signed up for a user account.
   - Once your site administrator approves your new user account, you receive another email message containing your username and password.

**Note:** Once you obtain a user account, you can edit your user profile to change your password and provide additional personal information. You can also specify site preferences, such as your default home page and time zone. For details, see *Maintaining your user profile* (on page 406).
Logging in to and out of the WebEx service site

To manage your online meetings and maintain your user account, you must log in to your WebEx service Web site. If you do not yet have a user account, see *Obtaining a user account* (on page 351).

To log in to your WebEx service site:

1. Go to your WebEx service Web site.
2. In the upper-right corner of the page, click **Log In**.
   
   The Log In page appears.
3. Enter your username and password.
   
   Passwords are case-sensitive, so you must type your password exactly as you specified it in your user profile.
4. Click **Log In**.

*Tip:* If you have forgotten your username or password, click **Forgot your password**. Provide your email address, type verification characters, and then click **Submit**. You will receive an email message containing your username and password.

To log out from your WebEx service site:

In the upper-right corner of the page, click **Log Out**.

Using your list of meetings

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>get an overview of your list of meetings</td>
<td><em>About your list of meetings</em> (on page 353)</td>
</tr>
<tr>
<td>open your list of meetings</td>
<td><em>Opening your meetings list</em> (on page 353)</td>
</tr>
<tr>
<td>maintain your list of meetings</td>
<td><em>Maintaining your scheduled meetings list</em> (on page 355)</td>
</tr>
</tbody>
</table>
About your list of meetings

On your WebEx service Web site, your My Meetings page in My WebEx includes:

- A list of all the online meetings that you have scheduled, including both listed and unlisted meetings.
- A list of meetings on your site to which you are invited.
- An option to start a One-Click meeting (not available for Event Center).
- Any Personal Conference meetings that you scheduled (if your site and account have the Personal Conferencing feature turned on).

**Tip:** You can specify that your My WebEx meetings page is the home page that appears once you log in to your WebEx service Web site. For details, see *Maintaining your user profile* (on page 406).

Opening your meetings list

You can open your personal list of scheduled meetings on your WebEx service Web site to:

- Start an event
- Modify an event
- Cancel an event

You can open your personal list of meetings to which you are invited:

- Obtain information about an event
- Join an event in progress

**To open your meetings list:**

1. Log in to your WebEx service Web site, and then click **My WebEx**.

   The My Meetings page appears, showing your list of scheduled meetings.
2 Click *one* of the tabs to navigate to different views of the My Meetings page:

You can choose **Daily, Weekly, Monthly, or All Meetings**.

3 Optional. Do *either* of the following:
   - To view the list of meetings to which you are invited, select **The meetings you are invited to** from the list.
   - To include meetings in the view that have already occurred, turn on **Show past meetings**.

4 (Optional) Select options to control the view:
   - To view the list of meetings to which you are invited, select **The meetings you are invited to** from the list.
   - To include meetings in the view that have already occurred, turn on **Show past meetings**.

**Tip:** You can specify that your My WebEx Meetings page is the home page that appears once you log in to your WebEx service Web site. For details, see *Maintaining your user profile* (on page 406).
Maintaining your scheduled meetings list

Once you schedule an event, it appears in your meetings list on your My Meetings page. For more information, see Opening your meetings list (on page 353).

An online event remains on your My Meetings page until you delete it. When scheduling an event, you can choose to automatically delete the event from your list of meetings once both of these conditions occur:

- You start and end the event.
- The scheduled time for the event has passed.

However, if you required registration for a scheduled event, the event remains in your list until you remove it. That way, you can still view information about attendees who registered for the event at any time after you host the event.

To remove an event from your list of meetings on your My Meetings page, you must cancel the event by deleting it on this page.

For details about the options on the My WebEx Meetings page, see About the My WebEx Meetings page (on page 355).

About the My WebEx Meetings page

How to access this tab

On your WebEx service Web site, click the My WebEx tab.

What you can do here

Access these features:

- A link to your personal meeting room
- A list of meetings you are hosting or are invited to for the specified day, week, or month
- A list of all meetings you are hosting or are invited to
Options on this page

<table>
<thead>
<tr>
<th>Use this option…</th>
<th>To…</th>
</tr>
</thead>
<tbody>
<tr>
<td>Go To My Personal Meeting Room</td>
<td>Go to your Personal Meeting Room page.</td>
</tr>
<tr>
<td></td>
<td>Your Personal Meeting Room page lists any events that you scheduled and any in-progress events that you are currently hosting.</td>
</tr>
<tr>
<td></td>
<td>Users to whom you provide your personal URL can use this page to join any event that you are hosting. They can also download files in any folders that you share.</td>
</tr>
<tr>
<td>Daily</td>
<td>View a list all of the meetings for the specified day. For details, see About the My WebEx Meetings - Daily tab (on page 356).</td>
</tr>
<tr>
<td>Weekly</td>
<td>View a list all of the meetings for the specified week. For details, see About the My WebEx Meetings - Weekly tab (on page 358).</td>
</tr>
<tr>
<td>Monthly</td>
<td>View a list all of the meetings for the specified month. For details, see About the My WebEx Meetings - Monthly tab (on page 361)</td>
</tr>
<tr>
<td>All Meetings</td>
<td>View a list all meetings, or search for meetings by date, host, topic, or words in the agenda. For details, see About the My WebEx Meetings - All Meetings tab (on page 362)</td>
</tr>
<tr>
<td>Refresh</td>
<td>Refresh the information in the meeting list.</td>
</tr>
</tbody>
</table>

About the My WebEx Meetings page - Daily tab

How to access this tab
On your WebEx service Web site, click My WebEx > My Meetings > Daily tab.

Options on this tab

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Refresh icon]</td>
<td>Click the Refresh icon at any time to display the most current list of events.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Language link</td>
<td>Click to open the Preferences page, where you can select the language setting for your WebEx service Web site.</td>
</tr>
<tr>
<td>Time zone link</td>
<td>Click to open the Preferences page, where you can select the time zone setting for your WebEx service Web site.</td>
</tr>
<tr>
<td>Date</td>
<td>The date for the daily list of events. The default is the current date.</td>
</tr>
<tr>
<td></td>
<td>Click the <strong>Previous Day</strong> icon to display a list of events for the previous day.</td>
</tr>
<tr>
<td></td>
<td>Click the <strong>Next Day</strong> icon to display a list of events for the next day.</td>
</tr>
<tr>
<td>The meetings you host</td>
<td>Shows a list all of the online events or Personal Conference meetings that you are hosting.</td>
</tr>
<tr>
<td>The meetings you are invited to</td>
<td>Shows a list all of the events or Personal Conference meetings to which you have been invited.</td>
</tr>
<tr>
<td>Show past meetings</td>
<td>Select to include concluded events in the list of meetings.</td>
</tr>
<tr>
<td></td>
<td>The <strong>Ascending Sort</strong> indicator appears next to a column heading, and the events are sorted by the column, in ascending order.</td>
</tr>
<tr>
<td></td>
<td>The <strong>Descending Sort</strong> indicator appears next to a column heading, and the events are sorted by the column, in descending order.</td>
</tr>
<tr>
<td>Time</td>
<td>The starting time for each scheduled event. Click the box next to a meeting start time to select that event. Click the box next to the <strong>Time</strong> column heading to select or clear all events in the list.</td>
</tr>
<tr>
<td>Topic</td>
<td>The topic for an event that you are hosting. Click the topic name to get information about that event.</td>
</tr>
<tr>
<td>Type</td>
<td>Indicates the type of online event that you are hosting. Available event types depend on the configuration of your WebEx service Web site.</td>
</tr>
<tr>
<td>Assist</td>
<td>If an Assist has been requested for this event, indicates the type of Assist:</td>
</tr>
<tr>
<td></td>
<td>- None</td>
</tr>
<tr>
<td></td>
<td>- Dry Run</td>
</tr>
<tr>
<td></td>
<td>- Consult</td>
</tr>
</tbody>
</table>
### Chapter 34: Using My WebEx

#### About the My WebEx Meetings page - Weekly tab

**How to access this tab**

On your WebEx service Web site, click **My WebEx > My Meetings > Weekly** tab.

**Options on this tab**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Refresh" /></td>
<td>Click the <strong>Refresh</strong> icon at any time to display the most current list of events.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Language link</td>
<td>Click to open the Preferences page, where you can select the language setting for your WebEx service Web site.</td>
</tr>
<tr>
<td>Time zone link</td>
<td>Click to open the Preferences page, where you can select the time zone setting for your WebEx service Web site.</td>
</tr>
<tr>
<td>Week link</td>
<td>The beginning and ending date for the weekly list of events.</td>
</tr>
<tr>
<td></td>
<td>Click the Previous Week icon to display a list of meetings for the previous week.</td>
</tr>
<tr>
<td></td>
<td>Click the Next Week icon to display a list of meetings for the next week.</td>
</tr>
<tr>
<td></td>
<td>Click the Calendar icon to open the Calendar window for the current month. Click on any date to open its schedule in the Daily view.</td>
</tr>
<tr>
<td>The meetings you host</td>
<td>Shows a list all of the online events or Personal Conference meetings that you are hosting.</td>
</tr>
<tr>
<td>The meetings you are</td>
<td>Shows a list all of the events or Personal Conference meetings to which you have been invited.</td>
</tr>
<tr>
<td>invited to</td>
<td></td>
</tr>
<tr>
<td>Show past meetings</td>
<td>Select to include concluded events in the list of meetings.</td>
</tr>
<tr>
<td>Day link</td>
<td>Opens the Daily view, which shows the scheduled events for the selected day.</td>
</tr>
<tr>
<td>Friday</td>
<td></td>
</tr>
<tr>
<td></td>
<td>The Ascending Sort indicator appears next to a column heading, and the events are sorted by the column, in ascending order.</td>
</tr>
<tr>
<td></td>
<td>The Descending Sort indicator appears next to a column heading, and the events are sorted by the column, in descending order.</td>
</tr>
<tr>
<td></td>
<td>The Expand button appears next to a Day link. Click this button to expand and display the list of events for that day.</td>
</tr>
<tr>
<td></td>
<td>The Collapse button appears next to a Day link. Click this button to collapse and hide the list of events for that day.</td>
</tr>
<tr>
<td>Time</td>
<td>The starting time for each scheduled event. Click the box next to a meeting start time to select that event. Click the box next to the Time column heading to select or clear all events in the list.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>--------</td>
<td>-------------</td>
</tr>
<tr>
<td><strong>Topic</strong></td>
<td>The topic for an event that you are hosting. Click the topic name to get information about that event.</td>
</tr>
<tr>
<td><strong>Type</strong></td>
<td>Indicates the type of online event that you are hosting. Available event types depend on the configuration of your WebEx service Web site.</td>
</tr>
</tbody>
</table>
| Assist | If an Assist has been requested for this event, indicates the type of Assist:  
- None  
- Dry Run  
- Consult  
- Live Event Support  
- Audio Streaming  
- Video |
| Status | The status of the event.  
- **Start:** You can start this event that you are hosting at any time by clicking the link.  
- **Join | End:** (for hosts) For a event in progress that you are hosting, you can join or end the event. Appears if you left a event, or you allowed participants to join the event before its starting time and participants have already joined the event.  
  - **Join:** Lets you join the event in progress.  
  - **End:** Ends the event.  
- **Join:** (for attendees) The event that you are invited to has started, and you can now join the event.  
- **Registration:** (for attendees) The event that you are invited to requires registration. To display a page on which you can register to attend the event, click the link. (Does not apply to sales meetings or support sessions.) |
| **Delete** | Cancels any events that are currently selected in the list. If you click this link, a message appears, allowing you to confirm that you want to cancel the event. Another message appears, allowing you to inform any invited attendees that you canceled the event. (Does not apply to support sessions.) |
### About the My WebEx Meetings page - Monthly tab

#### How to access this tab

On your WebEx service Web site, click **My WebEx > My Meetings > Monthly** tab.

#### Options on this tab

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Refresh icon</td>
<td>Click the <strong>Refresh</strong> icon at any time to display the most current list of events.</td>
</tr>
<tr>
<td>Language link</td>
<td>Click to open the Preferences page, where you can select the language setting for your WebEx service Web site.</td>
</tr>
<tr>
<td>Time zone link</td>
<td>Click to open the Preferences page, where you can select the time zone setting for your WebEx service Web site.</td>
</tr>
<tr>
<td>Month</td>
<td>The month for the monthly calendar of events. The default is the current month.</td>
</tr>
<tr>
<td>Previous Month icon</td>
<td>Click the <strong>Previous Month</strong> icon to display a list of events for the previous month.</td>
</tr>
<tr>
<td>Next Month icon</td>
<td>Click the <strong>Next Month</strong> icon to display a list of events for the next month.</td>
</tr>
<tr>
<td>Calendar icon</td>
<td>Click the <strong>Calendar</strong> icon to open the Calendar window for the current month. Click on any date to open its schedule in the Daily view.</td>
</tr>
<tr>
<td>Week Number link</td>
<td>Opens the Weekly view, which shows the scheduled events for each day of the selected week.</td>
</tr>
<tr>
<td>Day link</td>
<td>Opens the Daily view, which shows the scheduled events for the selected day.</td>
</tr>
<tr>
<td>The meetings you host</td>
<td>Shows a list all of the online events or Personal Conference meetings that you are hosting.</td>
</tr>
<tr>
<td>The meetings you are invited to</td>
<td>Shows a list all of the events or Personal Conference meetings to which you have been invited.</td>
</tr>
</tbody>
</table>
### About the My WebEx Meetings page - All Meetings tab

#### How to access this tab

On your WebEx service Web site, click **My WebEx > My Meetings > All Meetings** tab.

#### Options on this tab

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Show past meetings</strong></td>
<td>Select to include concluded events in the list of meetings.</td>
</tr>
<tr>
<td><strong>Topic</strong></td>
<td>The topic for an event that you are hosting. Click the topic name to get information about that event.</td>
</tr>
<tr>
<td><img src="image" alt="Live Event" /></td>
<td>Indicates that the live event is in process.</td>
</tr>
</tbody>
</table>

---

**Option** | **Description**
---|---
Click the **Refresh** icon at any time to display the most current list of events.

**Language link** | Click to open the Preferences page, where you can select the language setting for your WebEx service Web site.

**Time zone link** | Click to open the Preferences page, where you can select the time zone setting for your WebEx service Web site.

**Date** | The date for the daily list of events. The default is the current date.

Click the **Previous Day** icon to display a list of events for the previous day.

Click the **Next Day** icon to display a list of events for the next day.

**Search for meetings by date, host, topic, or words in the agenda** | Allows you type or select a date range to search for events, or allows you to type text to search in host names, topics, or agendas. Click **Search** to start the search.

Click the **Calendar** icon to open the Calendar window. Click on any date to select that date as part of your search criteria.
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>The meetings you host</strong></td>
<td>Shows a list all of the online events or Personal Conference meetings that you are hosting.</td>
</tr>
<tr>
<td><strong>The meetings you are invited to</strong></td>
<td>Shows a list all of the events or Personal Conference meetings to which you have been invited.</td>
</tr>
<tr>
<td><strong>Show past meetings</strong></td>
<td>Select to include concluded events in the list of meetings.</td>
</tr>
<tr>
<td><strong>Ascending Sort</strong></td>
<td>The <em>Ascending Sort</em> indicator appears next to a column heading, and the events are sorted by the column, in ascending order.</td>
</tr>
<tr>
<td><strong>Descending Sort</strong></td>
<td>The <em>Descending Sort</em> indicator appears next to a column heading, and the events are sorted by the column, in descending order.</td>
</tr>
<tr>
<td><strong>Time</strong></td>
<td>The starting time for each scheduled event. Click the box next to a meeting start time to select that event. Click the box next to the <strong>Time</strong> column heading to select or clear all events in the list.</td>
</tr>
<tr>
<td><strong>Topic</strong></td>
<td>The topic for an event that you are hosting. Click the topic name to get information about that event.</td>
</tr>
<tr>
<td><strong>Type</strong></td>
<td>Indicates the type of online event that you are hosting. Available event types depend on the configuration of your WebEx service Web site.</td>
</tr>
<tr>
<td><strong>Assist</strong></td>
<td>If an Assist has been requested for this event, indicates the type of Assist:</td>
</tr>
<tr>
<td></td>
<td>- None</td>
</tr>
<tr>
<td></td>
<td>- Dry Run</td>
</tr>
<tr>
<td></td>
<td>- Consult</td>
</tr>
<tr>
<td></td>
<td>- Live Event Support</td>
</tr>
<tr>
<td></td>
<td>- Audio Streaming</td>
</tr>
<tr>
<td></td>
<td>- Video</td>
</tr>
<tr>
<td><img src="image" alt="Live Event" /></td>
<td>Indicates that the live event is in process.</td>
</tr>
</tbody>
</table>
### Chapter 34: Using My WebEx

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Status</strong></td>
<td>The status of the event.</td>
</tr>
<tr>
<td>- <strong>Start</strong>: You can start this event that you are hosting at any time by clicking the link.</td>
<td></td>
</tr>
<tr>
<td>- **Join</td>
<td>End**: (for hosts) For a event in progress that you are hosting, you can join or end the event. Appears if you left a event, or you allowed participants to join the event before its starting time and participants have already joined the event.</td>
</tr>
<tr>
<td>- <strong>Join</strong>: Lets you join the event in progress.</td>
<td></td>
</tr>
<tr>
<td>- <strong>End</strong>: Ends the event.</td>
<td></td>
</tr>
<tr>
<td>- <strong>Join</strong>: (for attendees) The event that you are invited to has started, and you can now join the event.</td>
<td></td>
</tr>
<tr>
<td>- <strong>Registration</strong>: (for attendees) The event that you are invited to requires registration. To display a page on which you can register to attend the event, click the link. (Does not apply to sales meetings or support sessions.)</td>
<td></td>
</tr>
<tr>
<td><strong>Delete</strong></td>
<td>Cancels any eventsthat are currently selected in the list. If you click this link, a message appears, allowing you to confirm that you want to cancel the event. Another message appears, allowing you to inform any invited attendees that you canceled the event. (Does not apply to support sessions.)</td>
</tr>
</tbody>
</table>

---

### Maintaining Your Personal Meeting Room Page

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>get an overview of your Personal Meeting Room page</td>
<td>About your Personal Meeting Room (on page 365)</td>
</tr>
<tr>
<td>access your Personal Meeting Room page</td>
<td>Viewing your Personal Meeting Room (on page 365)</td>
</tr>
<tr>
<td>add images and text to your Personal Meeting Room page</td>
<td>Setting options for your Personal Meeting Room (on page 366)</td>
</tr>
<tr>
<td>share files on your Personal Meeting Room page</td>
<td>Sharing files on your Personal Meeting Room (on page 367)</td>
</tr>
</tbody>
</table>
About your Personal Meeting Room page

Your user account includes a Personal Event Room page on your WebEx service Web site. Users who visit your page can:

- View a list of online events that you are hosting, either scheduled or in progress.
- Join an event in progress.
- View your personal folders and upload or download files to or from your folders, depending on the settings you specify for your folders.

You can customize your Personal Meeting Room page by adding images and text to it.

To provide users with access to your Personal Meeting Room page, you must provide them with your Personal Meeting Room URL. For more information, see Viewing your Personal Meeting Room page (on page 365).

Tip: Add your Personal Meeting Room URL to your business cards, your email signature, and so on.

Viewing your Personal Meeting Room page

You can view your Personal Meeting Room page at any time, by going to the link for the page. The link for your Personal Meeting Room page is available on your:

- My WebEx Meetings page
- My WebEx Profile page

To view your Personal Meeting Room page:

1. Log in to your WebEx service Web site, and then click My WebEx.
   The My WebEx Meetings page appears.

2. Click the Go to My Personal Meeting Room link.
   Alternatively, in My WebEx, click My Profile, and then click the Personal Meeting Room URL link in the Personal Meeting Room section.
   Your Personal Meeting Room page appears. The following is an example of a Personal Meeting Room page.
Tip: Add your Personal Meeting Room URL to your business cards, your email signature, and so on.

Setting options for your Personal Meeting Room page

You can add the following to your Personal Meeting Room page:

- An image (for example, you can add a picture of yourself or your company's product).
- A custom banner image to the header area of your Personal Meeting Room page, if your user account has the “branding” option. For example, you can add your company's logo.
- A welcome message. For example, you can provide a greeting; instructions on joining an online session; information about yourself, your product, or your company.

At any time, you can replace or delete images and text that you add.

To add an image to your Personal Meeting Room page:

1. If you have not already done so, log in to your WebEx service Web site. For details, see Logging in to and out of the WebEx service site (on page 352).
2. On the navigation bar at the top of the page, click My WebEx.
3. Click My Profile.
   The My WebEx Profile page appears.
5. At the bottom of the My WebEx Profile page, click Update.
For details about the options for your Personal Meeting Room page, see *About your Personal Meeting Room page* (on page 365).

**Sharing files on your Personal Meeting Room page**

You can share folders on your My WebEx Files: Folders page so that they appear on the *Files* tab on your Personal Meeting Room page. For any folder that you share, you can specify whether users can download files from or upload files to the folder.

For more information about your Personal Meeting Room page, see *About your Personal Meeting Room page* (on page 365).

To share files on your Personal Meeting Room page:

1. Open the My WebEx Files page. For details, see *Opening your personal folders, documents, and files* (on page 371).
2. Under *Name*, locate the folder in which you want to share files.
3. If the file or folder is in a closed folder, click the folder to open it.
4. Click the *Properties* icon for the folder in which you want to share files.

The Edit Folder Properties window appears.
Specify sharing options for the folder.

Click Update.

For details about sharing options, see About the Edit Folder Properties page (on page 378).

Using Access Anywhere (My Computers)

For information about and instructions for using Access Anywhere to set up and access a remote computer, please refer to the guide Getting Started with WebEx Access Anywhere. This guide is available on the Support page on your WebEx service Web site.

About the My Computers page

How to access this page

On your WebEx service Web site, click My WebEx Files > My Computers.
What you can do here

Set up and access remote computers using Access Anywhere.

Options on this page

<table>
<thead>
<tr>
<th>Link or option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Computer</td>
<td>The name you have assigned to your remote computer.</td>
</tr>
<tr>
<td>Status</td>
<td>The status of your remote computer:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Available</strong>—the computer is available for remote access.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Offline</strong>—the computer is offline and is not available for remote access.</td>
</tr>
<tr>
<td>Application</td>
<td>The application on your remote computer that you have allowed to access, based on what you specified during set up. It may be <strong>Desktop</strong>, if you set up your desktop for access, or it may be a specific application name.</td>
</tr>
<tr>
<td>Status</td>
<td>If the computer is available for access, you can click the <strong>Connect</strong> link to connect to your remote computer.</td>
</tr>
<tr>
<td>Remove</td>
<td>Removes the selected computer from the list of remote computers.</td>
</tr>
<tr>
<td>Set Up Computer</td>
<td>Sets up the current computer for Access Anywhere and adds it to the list of remote computers.</td>
</tr>
<tr>
<td>Download manual installer</td>
<td>Downloads the manual installer for the Access Anywhere software.</td>
</tr>
</tbody>
</table>

Maintaining files in your personal folders

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>get an overview of your personal storage space for files</td>
<td><em>About maintaining files in your folders</em> (on page 370)</td>
</tr>
<tr>
<td>open your personal storage space for files</td>
<td><em>Opening your personal folders, documents, and files</em> (on page 371)</td>
</tr>
<tr>
<td>If you want to…</td>
<td>See…</td>
</tr>
<tr>
<td>-----------------------------------------------------</td>
<td>----------------------------------------------------------------------</td>
</tr>
<tr>
<td>create new folders to organize your files</td>
<td>Adding new folders to your personal folders (on page 372)</td>
</tr>
<tr>
<td>upload files to your personal folders</td>
<td>Uploading files to your personal folders (on page 372)</td>
</tr>
<tr>
<td>move or copy files or an entire folder to another folder</td>
<td>Moving or copying files or folders in your personal folders (on page 373)</td>
</tr>
<tr>
<td>change information about files or folders, including their names or descriptions</td>
<td>Editing information about files or folders in your personal folders (on page 374)</td>
</tr>
<tr>
<td>search for files or folders in your personal storage space for files</td>
<td>Searching for files or folders in your personal folders (on page 375)</td>
</tr>
<tr>
<td>download files in your personal storage space to your computer</td>
<td>Downloading files in your personal folders (on page 376)</td>
</tr>
<tr>
<td>share, or publish, files in your personal folders on your Personal Meeting Room, so others can access them</td>
<td>Sharing files on your Personal Meeting Room page (on page 367)</td>
</tr>
<tr>
<td>remove files or folders from your personal folders</td>
<td>Deleting files or folders in your personal folders (on page 376)</td>
</tr>
</tbody>
</table>

### About maintaining files in your folders

Your user account includes personal storage space for files on your WebEx service Web site.

In your personal storage space, you can:

- Create folders to organize your files.
- Edit information about any file or folder in your personal folders.
- Move or copy a file or folder to a different folder.
- Share a folder so it appears on your Personal Meeting Room page.

**Tip:**

- You can use this storage space to access important information when you are away from the office. For example, if you are on a business trip and want to share a file during an online session, you can download the file in your personal folders to a computer, and then share the file with attendees.
- If you share a folder, visitors to your Personal Meeting Room page can upload files to or download them from the folder. For example, you can use your personal folders to exchange...
Opening your personal folders, documents, and files

To store files on your WebEx service Web site, or to access files that you stored, you must open your personal folders.

To open your personal folders:

1. Log in to your WebEx service Web site, and then click My WebEx.
2. Click My Files.

The My WebEx Files page appears, showing your personal folders and files. Depending on the settings for your WebEx Service Web site, you may see different categories of folders and files, and you can click on the heading links to see each category:

- My Documents
- My Recordings
- My Event Recordings (available only in Event Center)
- My Training Recordings (available only in Training Center)

For details about the My WebEx Files page, see About the My WebEx Files > My Documents page (on page 376) and About the My WebEx Files > My Recordings page (on page 387).
Adding new folders to your personal folders

To organize your files on your WebEx service Web site, you can create folders in your personal storage space for files.

To create a new folder:

1. Open the My Documents page. For details, see Opening your personal folders, documents, and files (on page 371).
2. Under Action, click the Create Folder button for the folder in which you want a new folder.

   ![Create Folder button]

   The Create Folder window appears.

3. In the Folder Name box, type a name for the folder.
4. Optional. In the Description box, type a description to help you to identify the folder's contents.
5. Click OK.

Uploading files to your personal folders

To store files in your personal folders on your WebEx service Web site, you must upload them from your computer or a local server.

You can upload up to three files at once. There is no limit to the size of the files, as long as you have available storage space. The amount of space available for storing files is determined by your site administrator. If you require more disk space, contact your site administrator.

To upload files to your personal folders:

1. Open the My Documents page. For details, see Opening your personal folders, documents, and files (on page 371).
2. Locate the folder in which you want to store the file.
3. Under Action for the folder, click the Upload button for the folder in which you want to store the file.
The Upload File window appears.

4 Click **Browse**.

The Choose File dialog box appears.

5 Select the file that you want to upload to your folder.

6 Click **Open**.

The file appears in the **File name** box.

7 Optional. In the **Description** box, type a description to help you to identify the file.

8 Optional. Select up to two additional files to upload.

9 Click **Upload**.

The files are uploaded to the folder that you selected.

10 Once you are finished uploading files, click **Finish**.

**Moving or copying files or folders in your personal folders**

You can move one or more files or folders to another folder on your WebEx service Web site.

To move or copy a file or folder:

1 Open the My Documents page. For details, see *Opening your personal folders, documents, and files* (on page 371).

2 Locate the file or folder that you want to move.

3 Select the check box for the file or folder that you want move.

    You can select multiple files or folders.

4 Click **Move** or **Copy**.

    The Move/Copy File or Folder window appears, showing a list of your folders.

5 Select the option button for the folder in which you want to move or copy the file or folder.

6 Click **OK**.
Editing information about files or folders in your personal folders

You can edit the following information about a file or folder in your personal folders on your WebEx service Web site:

- Name
- Description

You can also specify sharing options for folders that appear on your Personal Event Room page. For more information, see *Sharing files on your Personal Event Room page* (on page 367).

To edit information about a file or folder:

1. Open the My Documents page. For details, see *Opening your personal folders, documents, and files* (on page 371).
2. Locate the file or folder for which you want to edit information.
3. Click the **Properties** icon for the file or folder for which you want to edit information.

The Edit File Properties or Edit Folder Properties window appears.
In the Description box, type a new name for the file or folder.
In the Name box, type a new name for the file or folder.
4 Click Update.

Searching for files or folders in your personal folders

In your personal folders on your WebEx service Web site, you can quickly locate a file or folder by searching for it. You can search for a file or folder by text that appears in either its name or description.

To search for a file or folder:
1 Open the My Documents page. For details, see Opening your personal folders, documents, and files (on page 371).
2 In the Search For box type all or part of the file's name or description.
3 Click Search.
   A list of any files or folders that contain the search text appears.
Downloading files in your personal folders

In your personal folders on your WebEx service Web site, you can download any files to your computer or a local server.

1. Open the My Documents page. For details, see Opening your personal folders, documents, and files (on page 371).
2. Locate the file that you want to download.
3. Under Action, click the Download button for the file that you want to download.

The File Download dialog box appears.

4. Follow any instructions that your Web browser or operating system provides to download the file.

Deleting files or folders in your personal folders

You can delete files or folders in your personal folders on your WebEx service Web site.

To delete a file or folder:

1. Open the My Documents page. For details, see Opening your personal folders, documents, and files (on page 371).
2. Under Name, locate the file or folder that you want to delete.
3. Select the check box for the file or folder that you want delete.
   You can select multiple files or folders.
4. Click Delete.

About the My WebEx Files > My Documents page

How to access this page

On your WebEx service Web site, click My WebEx Files > My Documents.
What you can do here

- Store files that you use in your online sessions or that you want to access when away from your office.
- Specify in which folders that visitors to your Personal Meeting Room can download or upload files.

Options on this page

<table>
<thead>
<tr>
<th>Link or option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Capacity</td>
<td>The storage space available for your files, in megabytes (MB).</td>
</tr>
<tr>
<td>Used</td>
<td>The amount of storage space that your files occupy, in megabytes (MB). Once this value exceeds your capacity, you can no longer store files until you remove existing files from your folders.</td>
</tr>
<tr>
<td>Search for</td>
<td>Lets you locate a file or folder by searching for it. You can search for a file or folder by text that appears in either its name or description. To search for a file or folder, type all or part of its name or description in the box, and then click Search.</td>
</tr>
<tr>
<td>Name</td>
<td>The name of the folder or file. Click a folder or file name to open the Folder Information page or File Information page. From the Information page, you can access the properties of a folder or file.</td>
</tr>
<tr>
<td>Path</td>
<td>The folder hierarchy for the folder or file. The Root folder is the top-most folder in which all other folders and files reside.</td>
</tr>
<tr>
<td>Size</td>
<td>The size of the folder or file, in kilobytes (KB).</td>
</tr>
<tr>
<td>Actions</td>
<td>Click the icons to perform an action on the folder or file that is associated with it.</td>
</tr>
</tbody>
</table>

- Upload file: Available only for files. Click this icon to open the File Upload page, on which you can select up to three files at a time to upload to a specified folder.
- Download file: Available only for files. Click this icon to download the file associated with it.
**Chapter 34: Using My WebEx**

<table>
<thead>
<tr>
<th>Link or option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Edit File Properties or Edit Folder Properties icon" /></td>
<td><strong>Edit File Properties or Edit Folder Properties</strong>: Click this icon to open the Edit File Properties page or Edit Folder Properties page, on which you can edit information about the file or folder, respectively.</td>
</tr>
<tr>
<td><img src="image" alt="Create Folder icon" /></td>
<td><strong>Create Folder</strong>: Available for folders only. Click this icon to open the Create Folder page on which you can create a new folder in your personal storage space.</td>
</tr>
<tr>
<td><img src="image" alt="Shared icon" /></td>
<td>Specifies the sharing settings for a folder; that is, how others who visit your Personal Meetings Room can access your folder and its files.</td>
</tr>
<tr>
<td><img src="image" alt="Read only icon" /></td>
<td><strong>Read only</strong>: Visitors to your Personal Meeting Room can view the list of files in the folder and download the files.</td>
</tr>
<tr>
<td><img src="image" alt="Write only icon" /></td>
<td><strong>Write only</strong>: Visitors to your Personal Meeting Room can upload files to the folder, but they cannot view the files in it.</td>
</tr>
<tr>
<td><img src="image" alt="Read and write icon" /></td>
<td><strong>Read and write</strong>: Users can view files in the folder, download files from the folder, and upload files to the folder.</td>
</tr>
<tr>
<td><img src="image" alt="Password Protected icon" /></td>
<td><strong>Password Protected</strong>: Indicates that the folder is password protected. Visitors to your Personal Meeting Room must provide the password you specify to access the folder.</td>
</tr>
<tr>
<td><img src="image" alt="Select All icon" /></td>
<td>Selects the check boxes for all the folders and files that are visible in the list. You can then click the <strong>Copy</strong> or <strong>Move</strong> button or click the <strong>Delete</strong> link to perform an action on the selected folders or files.</td>
</tr>
<tr>
<td><img src="image" alt="Clear All icon" /></td>
<td>Clears the check boxes for all the folders and files that are selected in the list.</td>
</tr>
<tr>
<td><img src="image" alt="Delete icon" /></td>
<td>Deletes the selected folders and files from the list.</td>
</tr>
<tr>
<td><img src="image" alt="Copy icon" /></td>
<td>Opens a page on which you can copy the selected folder or file to another folder.</td>
</tr>
<tr>
<td><img src="image" alt="Move icon" /></td>
<td>Opens a page on which you can move the selected folder or file to another folder.</td>
</tr>
</tbody>
</table>

**About the Edit Folder Properties page**

**How to access this page**

On your WebEx service Web site, click **My WebEx > My Files > Properties** icon for folder.
What you can do here

Specify a name, a description, and sharing options for a folder that you created in your personal folders.

Options on this page

<table>
<thead>
<tr>
<th>Use this option...</th>
<th>To...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter the name of the folder.</td>
</tr>
<tr>
<td>Description</td>
<td>Enter the description of the folder.</td>
</tr>
<tr>
<td>Share</td>
<td>Specify who can access this folder.</td>
</tr>
<tr>
<td></td>
<td>- Do not share this folder: This folder does not appear on your Personal Meeting Room page. Thus, visitors to your page cannot view the folder or access any files in it.</td>
</tr>
<tr>
<td></td>
<td>- Share this folder: This folder appears on your Personal Meeting Room. The drop-down list specifies which users can access the folder, as follows:</td>
</tr>
<tr>
<td></td>
<td>- With all: All visitors to your Personal Meeting Room can access this folder.</td>
</tr>
<tr>
<td></td>
<td>- With users with host or attendee accounts: Only visitors to your Personal Meeting Room who have either a host account or an attendee account on your WebEx service Web site can access this folder.</td>
</tr>
<tr>
<td></td>
<td>- With users with host accounts only: Only visitors to your Personal Meeting Room who have a host account on your WebEx service Web site can access this folder.</td>
</tr>
</tbody>
</table>

| Share as          | Enter the name for the folder that will appear on your Personal Meeting Room page. |
| Read              | Let visitors to your Personal Meeting Room view the list of files in the folder and download the files. |
| Write             | Let visitors to your Personal Meeting Room upload files to the folder but does not allow them to view the files in it. |
| Read & write      | Let users view files in the folder, download files from the folder, and upload files to the folder. |
| Allow files to be overwritten | Let users upload a file with the same name as an existing file in the folder and replace the existing file. If this option is not selected, users cannot overwrite any files in the folder. |
Chapter 34: Using My WebEx

<table>
<thead>
<tr>
<th>Use this option…</th>
<th>To…</th>
</tr>
</thead>
</table>
| Password protected     | Let only visitors to your Personal Meeting Room who know the password view the list of files in the folder, download files from the folder, or upload files to the folder, depending on the read/write settings for the folder.  
  **Password:** The password that visitors to your Personal Meeting Room must provide to access the folder.  
  **Confirm:** If you specified a password, type it again to verify that you typed it correctly. |
| Update                 | Save any changes that you made to folder’s properties, and then closes the Edit Folder Properties window. |
| Cancel                 | Close the Edit Folder Properties window, without saving any of the changes that you made. |

**Opening the My Recordings Page**

To upload or maintain recordings, you must do so from the My Recordings page on your WebEx service Web site.

To open the My Recordings page:

1. Log in to your WebEx service Web site, and then click **My WebEx**.
2. Click **My Files > My Recordings**.

   The My Recordings page appears, showing your recording files.

For details about the My Recordings page, see *About the My WebEx Files > My Recordings page* (on page 387).

**Uploading a recording file**

If you recorded an event using the integrated or standalone WebEx Recorder, you can upload the recording file, with a .wrf extension, from your local computer to the My Recordings page.

For instructions on editing a recording, see *Editing information about a recording* (on page 381).
Note: If you recorded an event using the WebEx Network-Based Recorder (NBR), the WebEx server automatically uploads the recording file, with an .arf extension, to the appropriate tab on the My Recordings page once you stop the Recorder. You do not need to upload it yourself.

To upload a recording file:

1. Go to the My Recordings page. For details, see Opening the My Recordings page (on page 380).
2. Click Add Recording.
3. On the Add Recording page, enter information and specify options.
   For details about what you can do with each option on the Add/Edit Recordings page, see About the My WebEx Files > My Recordings page (on page 387).
4. Click Save.

Editing information about a recording

You can edit information about a recording at any time.

To edit information about a recording:

1. Go to the My Recordings page. For details, see Opening the My Recordings page (on page 380).
2. Click the following icon for the recording that you want to edit.

   ![Icon]

   The Edit Recording page appears.
3. Make your changes.
   For details about what you can do with each option on the Edit Recording page, see About the My WebEx Files > My Recordings page (on page 387).
4. Click Save.

Sending an email to share a recording

You can send an email one or more people to share your recording with them.
To send an email to share a recording with others:

1. Go to the My Recordings page. For details, see *Opening the My Recordings page* (on page 380).

2. Click the appropriate link for your recording type:
   - Meetings
   - Events
   - Sales Meetings
   - Training Sessions
   - Miscellaneous

3. Open the Share My Recording window:
   - Click the following icon for the recording that you want to share with others.
   - Click the linked name of the recording you want to share. On the Recording Information page, click **Send Email**.

The Share My Recording window appears.
4 Select recipients for your email:
   - Click Select Recipients to select contacts from your Contacts list
   - Type email addresses in the Send to list, separated by commas.
5 (Optional) Type a message in the Your message box.
6 Click Send.

Your email message will be sent to the selected recipients, and will include information about the recording and a link to play it.

About the Add/Edit Recording page

How to access this page

If you are adding a recording...
1 On your WebEx service Web site, click My WebEx > My Files > My Recordings.
2 Click Add Recording.

If you are editing information about a recording...
1 On your WebEx service Web site, click My WebEx > My Files > My Recordings.
2 Click the More button in the row of the recording that you want to edit.
   ![Operations Menu]
3 Click Modify.

What you can do here
   - Edit general information about a recording, including the topic and description.
• Require a password to play or download the recording.

Options on this page

<table>
<thead>
<tr>
<th>Use this option....</th>
<th>To....</th>
</tr>
</thead>
<tbody>
<tr>
<td>Topic</td>
<td>Specify the topic of the recording.</td>
</tr>
<tr>
<td>Description</td>
<td>Provide a description of this recording.</td>
</tr>
<tr>
<td>Recording file</td>
<td>Click <strong>Browse</strong> to select the recording file that resides on your local computer.</td>
</tr>
<tr>
<td>Duration</td>
<td>Specify the duration of the recording.</td>
</tr>
<tr>
<td>File size</td>
<td>Displays the size of the recording file. (Available only when editing recording information.)</td>
</tr>
<tr>
<td>Set password</td>
<td>Set an optional password that users must provide to view the recording.</td>
</tr>
<tr>
<td>Confirm password</td>
<td>Confirm the password that users must provide to view the recording.</td>
</tr>
</tbody>
</table>

Playback control options

<table>
<thead>
<tr>
<th>Use this option....</th>
<th>To....</th>
</tr>
</thead>
</table>
| Panel Display Options | Determines which panels are displayed in the recording when it is played back. You can select any of the following panels to be included the recording playback:  
• Chat  
• Q & A  
• Video  
• Polling  
• Notes  
• File Transfer  
• Participants  
• Table of Contents  
Panel display options do not modify the panel display in the actual recording that is stored on the WebEx network. |
### Use this option....

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Recording Playback Range</strong></td>
<td>Determines how much of the recording is actually played back. You can select <em>either</em> of the following:</td>
</tr>
<tr>
<td><strong>Full playback</strong></td>
<td>Plays back the full length of the recording. This option is selected by default.</td>
</tr>
<tr>
<td><strong>Partial playback</strong></td>
<td>Plays back only part of the recording based on your settings for the following options:</td>
</tr>
<tr>
<td><strong>Start: X min X sec of the recording</strong></td>
<td>Specifies the time to start playback; for example, you can use this option if you would like to omit the &quot;dead time&quot; at the beginning of the recording, or if you would like to show only a portion of the recording.</td>
</tr>
<tr>
<td><strong>End: X min X sec of the recording</strong></td>
<td>Specifies the time to end playback; for example, you can use this option if you would like to omit the &quot;dead time&quot; at the end of the recording. You can not specify an end time greater than the length of the actual recording. The partial playback range you specify does not modify the actual recording that is stored on the server.</td>
</tr>
<tr>
<td><strong>Include NBR player controls</strong></td>
<td>Includes full Network Recording Player controls, such as stop, pause, resume, fast forward, and rewind. This option is selected by default. If you would like to prevent viewers from skipping portions of the recording, you can turn off this option to omit Network Recording Player controls from the playback.</td>
</tr>
</tbody>
</table>

## About the Recording Information page

**How to access this page**

On your WebEx service Web site, click **My WebEx > My Files > My Recordings > [recording type] > [topic of a recording]**.

**What you can do here**

- View information about the recording.
- Play back the recording.
Chapter 34: Using My WebEx

- Send an email to share the recording with others.
- Download the recording.
- Enable or disable the recording
- Open the Edit Recording page on which you can edit information about a recording.

### Options on this page

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Topic</td>
<td>The name of the recording. You can edit the topic at any time.</td>
</tr>
<tr>
<td>Create time</td>
<td>The time and date the recording was created.</td>
</tr>
<tr>
<td>Duration</td>
<td>The length of the recording.</td>
</tr>
<tr>
<td>Description</td>
<td>A description of the recording.</td>
</tr>
<tr>
<td>File size</td>
<td>The file size of the recording.</td>
</tr>
<tr>
<td>Create time</td>
<td>The date and time at which the recording was created.</td>
</tr>
<tr>
<td>Status</td>
<td>The status of the recording. The possible options are Enable or Disable.</td>
</tr>
<tr>
<td>Password</td>
<td>Indicates whether a user must provide a password to view the recording.</td>
</tr>
<tr>
<td>Stream recording link</td>
<td>Clicking the link lets you play the recording (available only for recording files with the .arf extension that were recorded by NBR).</td>
</tr>
<tr>
<td>Download recording link</td>
<td>Clicking the link lets you download the recording.</td>
</tr>
</tbody>
</table>

**Play Now**

Clicking the button lets you play the recording (available only for recording files with the .arf extension that were recorded by NBR).

If you want to download the recording, you can also click the link for downloading under Play Recorded an event Now.

**Send Email**

Clicking the button opens the Share My Recording window, which allows you to send an email message to selected recipients, inviting them to play your recording.

If you want to send the email with your local email client instead, click the link for using the email client under Share My Recording.
### About the My WebEx Files > My Recordings page

**How to access this page**

Log in to your WebEx service Web site, and then click **My WebEx**. From the left navigation bar, click **My Files > My Recordings**.

**What you can do here**

Manage, upload, and maintain your recording files.

**Options on this page**

View different categories of recordings:
- Meetings
- Events
- Sales Meetings
- Training Sessions
- Miscellaneous
About the My WebEx Files > My Recordings > Events page

**How to access this page**

Log in to your WebEx service Web site, and then click My WebEx. From the left navigation bar, click My Files > My Recordings > Events.

**What you can do here**

Manage, upload, and maintain recording files of events you host.

**Options on this page**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Refreshes the information on the page.</td>
</tr>
<tr>
<td>Search</td>
<td>Allows you type text to search for within recording names. Click Search to start the search.</td>
</tr>
<tr>
<td>Capacity: n MB</td>
<td>The percentage of available personal storage space on your WebEx Service Web site that is being used by your recordings.</td>
</tr>
<tr>
<td>Used: n MB</td>
<td>The percentage of total available storage space on your WebEx Service Web site that is being used by all recordings on your site.</td>
</tr>
<tr>
<td>Topic</td>
<td>The name of the recording. If you record an event on the server, the WebEx server automatically uploads the recording to this page. In this case, the topic of the recording is the topic of the event. You can edit the topic at any time.</td>
</tr>
<tr>
<td>Panelist</td>
<td>Information about the panelists in the event where the recording was made.</td>
</tr>
<tr>
<td>Type</td>
<td>The publication status of the event recording:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Listed:</strong> The recording is published—that is, the recording appears on the Event Recordings page, which is accessible to all visitors to your Event Center Web site.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Unlisted:</strong> The recording is not published—that is, the recording appears only on the My Event Recordings page. You must log in to your Event Center Web site to view and maintain the recordings.</td>
</tr>
<tr>
<td>Size</td>
<td>The size of the recording.</td>
</tr>
</tbody>
</table>
### Option | Description
--- | ---
Create Time/Date | The date and time the recording was created.
Duration | The length of the recording.
Format | The format of the recording file.
- A recording file can be in WebEx Advanced Recording Format (ARF) or WebEx Recording Format (WRF). You can also store recording files that are in Windows Media Audio/Video (WMV) format. For Event Center and Training Center, you can also store Shockwave Flash Object (SWF) format files.
Play Recording | Lets you play the recording (available only for recording files with an .arf extension that were recorded by the Network-Based Recorder).
- If playback of the file requires a password, you must provide the password.
Send Recording | Lets you send an email to share this recording with others.
- Displays a menu with more options for your recording:
  - **Download:** Lets you download the recording to your local computer.
  - If downloading the file requires a password, you must provide the password.
  - **Modify:** Lets you edit information of the recording. For details, see *About the Add/Edit Event Recording page* (on page 325).
  - **Send to vendor:** Lets you send an email to share this recording with a vendor.
  - **Delete:** Lets you delete the recording from this page.
Add Recording | Lets you upload a new recording.
- For details, see *Uploading a recording file* (on page 319) and *About the Add/Edit Event Recording page* (on page 325).
Password | Indicates that a recording is password-protected.
Registration Required | Indicates that registration is required to view the recording.
About the My WebEx Files > My Recordings > Miscellaneous page

How to access this page
Log in to your WebEx service Web site, and then click My WebEx. From the left navigation bar, click My Files > My Recordings > Miscellaneous.

What you can do here
Manage, upload, and maintain recording files of events you host.

Options on this page

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="refresh.png" alt="Refresh" /></td>
<td>Refreshes the information on the page.</td>
</tr>
<tr>
<td><img src="search.png" alt="Search" /></td>
<td>Allows you type text to search for within recording names. Click Search to start the search.</td>
</tr>
<tr>
<td><img src="disabled.png" alt="Disabled" /></td>
<td>Indicates a disabled recording.</td>
</tr>
<tr>
<td><strong>Topic</strong></td>
<td>The name of the recording. If you record an event on the server, the WebEx server automatically uploads the recording to this page. In this case, the topic of the recording is the topic of the event. You can edit the topic at any time.</td>
</tr>
<tr>
<td><strong>Size</strong></td>
<td>The size of the recording.</td>
</tr>
<tr>
<td><strong>Create Time/Date</strong></td>
<td>The date and time the recording was created.</td>
</tr>
<tr>
<td><strong>Duration</strong></td>
<td>The length of the recording.</td>
</tr>
<tr>
<td><strong>Format</strong></td>
<td>The format of the recording file.</td>
</tr>
<tr>
<td></td>
<td>A recording file can be in WebEx Advanced Recording Format (ARF) or WebEx Recording Format (WRF). You can also store recording files that are in Windows Media Audio/Video (WMV) format. For Event Center and Training Center, you can also store Shockwave Flash Object (SWF) format files.</td>
</tr>
</tbody>
</table>
### Chapter 34: Using My WebEx

#### Option Description

- **Lets you play the recording (available only for recording files with an `.arf` extension that were recorded by the Network-Based Recorder).**
  
  If playback of the file requires a password, you must provide the password.

- **Lets you send an email to share this recording with others.**

- **Displays a menu with more options for your recording:**
  - **Download:** Lets you download the recording to your local computer.
    
    If downloading the file requires a password, you must provide the password.
  - **Modify:** Lets you edit information of the recording. For details, see *About the Add/Edit Recordings page* (on page 383).
  - **Disable:** Lets you disable the recording in all locations.
  - **Delete:** Lets you delete the recording from this page.

- **Indicates that a recording is password-protected.**

#### Maintaining contact information

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>get an overview of your personal address book</td>
<td><em>About maintaining contact information</em> (on page 392)</td>
</tr>
<tr>
<td>open your personal address book</td>
<td><em>Opening your address book</em> (on page 392)</td>
</tr>
<tr>
<td>add a new contact to your personal address book</td>
<td><em>Adding a contact to your address book</em> (on page 393)</td>
</tr>
<tr>
<td>add multiple contacts to your address book at once</td>
<td><em>Importing contact information in a file to your address book</em> (on page 396)</td>
</tr>
<tr>
<td>add contacts in Microsoft Outlook to your personal address book</td>
<td><em>Importing contact information from Outlook to your address book</em> (on page 399)</td>
</tr>
<tr>
<td>view or change information about contacts in your personal address book</td>
<td><em>Viewing and editing contact information in your address book</em> (on page 400)</td>
</tr>
</tbody>
</table>
Chapter 34: Using My WebEx

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>find a contact in your personal address book</td>
<td><em>Finding a contact in your personal address book</em> (on page 400)</td>
</tr>
<tr>
<td>combine multiple contacts into a single distribution list</td>
<td><em>Creating a distribution list in your address book</em> (on page 401)</td>
</tr>
<tr>
<td>edit information about a distribution list</td>
<td><em>Editing a distribution list in your address book</em> (on page 403)</td>
</tr>
<tr>
<td>delete a contact or distribution list</td>
<td><em>Deleting contact information in your address book</em> (on page 405)</td>
</tr>
</tbody>
</table>

**About maintaining contact information**

You can maintain a personal online address book, in which you can add information about contacts and create distribution lists. When scheduling a meeting or starting an instant meeting, you can quickly invite any contacts or distribution lists in your personal address book. You can also invite contacts in the Company Address Book for your WebEx service Web site, if one is available.

You can add contacts to your personal address book in any of the following ways:

- Specify information about contacts one at a time.
- Import contact information from your Microsoft Outlook contacts.
- Import contact information from a comma-separated/comma-delimited values (CSV) file.

You can also edit or delete the information about any contact or distribution list in your personal address book.

**Opening your address book**

You can open your personal address book on your WebEx service Web site, to view or maintain information about your contacts.

To open your address book:

1. Log in to your WebEx service Web site. For details, see *Logging in to and out of the WebEx service site* (on page 352).
2. On the navigation bar at the top of the page, click *My WebEx*.
3. Click *My Contacts*.
The My WebEx Contacts page appears.

### My WebEx Contacts

**View:** Personal Contacts

**Import From:** Microsoft Outlook

**Search for:**

**Note:** Search queries contact name and email address fields only

<table>
<thead>
<tr>
<th>Name</th>
<th>Email Address</th>
<th>Phone Number</th>
<th>Language</th>
</tr>
</thead>
<tbody>
<tr>
<td>Planning Committee</td>
<td></td>
<td></td>
<td>English</td>
</tr>
<tr>
<td>Sales Department</td>
<td></td>
<td></td>
<td>English</td>
</tr>
<tr>
<td>Christine Hullette</td>
<td><a href="mailto:christine@xx.com">christine@xx.com</a></td>
<td>1-543-456-7890</td>
<td>English</td>
</tr>
<tr>
<td>John Martin</td>
<td><a href="mailto:jm@xx.com">jm@xx.com</a></td>
<td>1-456-789-0123</td>
<td>English</td>
</tr>
<tr>
<td>Lisa Graham</td>
<td><a href="mailto:lisa@xx.com">lisa@xx.com</a></td>
<td>1-567-890-1234</td>
<td>English</td>
</tr>
<tr>
<td>Lisa Walsh</td>
<td><a href="mailto:lisa@xx.com">lisa@xx.com</a></td>
<td>1-678-901-2345</td>
<td>English</td>
</tr>
<tr>
<td>Mabel Tillman</td>
<td><a href="mailto:mtillman@xx.com">mtillman@xx.com</a></td>
<td>1-456-789-0123</td>
<td>English</td>
</tr>
<tr>
<td>Sally Chen</td>
<td><a href="mailto:sally@xx.com">sally@xx.com</a></td>
<td>1-567-890-1234</td>
<td>English</td>
</tr>
</tbody>
</table>

4. In the **View** drop-down list, select one of the following contact lists:
   - **Personal Contacts:** Includes any individual contacts or distribution lists that you added to your personal address book. If you have a Microsoft Outlook address book or contacts folder, you can import its contacts to this list of contacts.
   - **Company Address Book:** Your organization's address book, which includes any contacts that your site administrator has added to it. If your organization uses a Microsoft Exchange Global Address List, your site administrator can import its contacts to this address book.

### Adding a contact to your address book

You can add contacts to your personal address book, one at a time.

**To add a contact to your personal address book:**

1. Open your personal address book. For details, see *Opening your address book* (on page 392).

2. In the **View** drop-down list, select **Personal Contacts**.
A list of contacts in your Personal Contacts list appears.

3 Click **Add Contact**.

The Add Contact page appears.

### My WebEx Contacts

<table>
<thead>
<tr>
<th>Field</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Full name</td>
<td></td>
</tr>
<tr>
<td>Email address</td>
<td></td>
</tr>
<tr>
<td>Company</td>
<td></td>
</tr>
<tr>
<td>Job title</td>
<td></td>
</tr>
<tr>
<td>URL</td>
<td>(if known)</td>
</tr>
<tr>
<td>Phone number</td>
<td>[Country/Region]</td>
</tr>
<tr>
<td>Phone number for mobile device</td>
<td>[Country/Region]</td>
</tr>
<tr>
<td>Fax number</td>
<td>[Country/Region]</td>
</tr>
<tr>
<td>Address 1</td>
<td></td>
</tr>
<tr>
<td>Address 2</td>
<td></td>
</tr>
<tr>
<td>City</td>
<td></td>
</tr>
<tr>
<td>State/Province</td>
<td></td>
</tr>
<tr>
<td>ZIP/Postal code</td>
<td></td>
</tr>
<tr>
<td>Country/Region</td>
<td></td>
</tr>
<tr>
<td>User name</td>
<td>(if known)</td>
</tr>
<tr>
<td>Notes</td>
<td></td>
</tr>
</tbody>
</table>

4 Provide information about the contact.

5 Click **Add**.

For descriptions of the information and options on the New Contact page, see *About the New/Edit Contact page* (on page 395).

**Note:**
- You cannot add contacts to your Company Address Book.
- If you want to add multiple contacts, you can them all at once, instead of adding one contact
Chapter 34: Using My WebEx

About the New/Edit Contact page

How to access this page

On your WebEx service Web site, click My WebEx > My Contacts > Add Contact or [check box for contact] > Edit.

What you can do here

Enter information about a new or existing contact for your personal address book.

Options on this page

<table>
<thead>
<tr>
<th>Use this option...</th>
<th>To...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Full name</td>
<td>Enter the contact's first and last name.</td>
</tr>
<tr>
<td>Email address</td>
<td>Enter the contact's email address.</td>
</tr>
<tr>
<td>Language</td>
<td>Set the language in which any email messages that you send to the contact using your WebEx service site appear. Available only if your WebEx service Web site can be displayed in two or more languages.</td>
</tr>
<tr>
<td>Company</td>
<td>Enter the company or organization for which the contact works.</td>
</tr>
<tr>
<td>Job title</td>
<td>Enter the contact's position in a company or organization.</td>
</tr>
<tr>
<td>URL</td>
<td>Enter the URL, or Web address, for the contact's company or organization.</td>
</tr>
<tr>
<td>Phone number/Phone number for mobile device/Fax number</td>
<td>Enter the contact's phone numbers. For each number, you can specify the following:</td>
</tr>
<tr>
<td>Country Code</td>
<td>Specify the number that you must dial if the contact resides in another country. To select a different country code, click the link to display the Country Code window. From the drop-down list, select the country in which the contact resides.</td>
</tr>
<tr>
<td>Area or city code</td>
<td>Enter the area or city code for the contact's phone number.</td>
</tr>
<tr>
<td>Number</td>
<td>Enter the phone number.</td>
</tr>
</tbody>
</table>
### Importing contact information in a file to your address book

You can add information about multiple contacts simultaneously to your personal address book, by importing a comma-separated values (CSV) file. A CSV file has the .csv file extension; you can export information from many spreadsheet and email programs in CSV format.

To create a CSV file:

1. Open your address book. For details, see *Opening your address book* (on page 392).
2. In the View drop-down list, ensure that Personal Address Book is selected.
3. Click Export.
4. Save the .csv file to your computer.
5. Open the .csv file that you saved in a spreadsheet program, such as Microsoft Excel.
6. Optional. If contact information exists in the file, you can delete it.
7. Specify information about the new contacts in the .csv file.

**Important:** If you add a new contact, ensure that the UID field is blank. For information about the fields in the .csv file, see *About the Contact Information CSV template* (on page 397).

8. Save the .csv file. Ensure that you save it as a .csv file.
To import a CSV file containing new contact information:

1. Open your address book. For details, see *Opening your address book* (on page 392).

2. In the View drop-down list, ensure that Personal Contacts is selected.

3. In the Import From drop-down list, select Comma Delimited Files.

4. Click Import.

5. Select the .csv file in which you added new contact information.

6. Click Open.

7. Click Upload File.

   The View Personal Contacts page appears, allowing you to review the contact information you are importing.

8. Click Submit.

   A confirmation message appears.

9. Click Yes.

   **Note:** If an error exists in any new or updated contact information, a message appears, informing you that no contact information was imported.

---

**About the Contact Information CSV template**

**How to access this template**

On your WebEx service Web site, click My WebEx > My Contacts > View > Personal Address Book > Export.

**What you can do here**

Specify information about multiple contacts, which you can then import to your personal address book.
## Fields in this template

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>UUID</td>
<td>A number that your WebEx service site creates to identify the contact. If you add a new contact to the CSV file, you must leave this field blank.</td>
</tr>
<tr>
<td>Name</td>
<td>Required. The contact's first and last name.</td>
</tr>
<tr>
<td>Email</td>
<td>Required. The contact's email address. The email address must be in the following format: <a href="mailto:name@company.com">name@company.com</a></td>
</tr>
<tr>
<td>Company</td>
<td>The company or organization for which the contact works.</td>
</tr>
<tr>
<td>JobTitle</td>
<td>The contact's position in a company or organization.</td>
</tr>
<tr>
<td>URL</td>
<td>The URL, or Web address, for the contact's company or organization.</td>
</tr>
<tr>
<td>OffCntry</td>
<td>The country code for the contact's office phone—that is, the number that you must dial if the contact resides in another country.</td>
</tr>
<tr>
<td>OffArea</td>
<td>The area or city code for the contact's office phone number.</td>
</tr>
<tr>
<td>OffLoc</td>
<td>The contact's office phone number.</td>
</tr>
<tr>
<td>OffExt</td>
<td>The extension for the contact's office phone number, if any.</td>
</tr>
<tr>
<td>CellCntry</td>
<td>The country code for the contact's cellular or mobile phone—that is, the number that you must dial if the contact resides in another country.</td>
</tr>
<tr>
<td>CellArea</td>
<td>The area or city code for the contact's cellular or mobile phone number.</td>
</tr>
<tr>
<td>CellLoc</td>
<td>The contact's cellular or mobile phone number.</td>
</tr>
<tr>
<td>CellExt</td>
<td>The extension for the contact's cellular or mobile phone number, if any.</td>
</tr>
<tr>
<td>FaxCntry</td>
<td>The country code for the contact's fax number—that is, the number that you must dial if the contact resides in another country.</td>
</tr>
<tr>
<td>FaxArea</td>
<td>The area or city code for the contact's fax number.</td>
</tr>
<tr>
<td>FaxLoc</td>
<td>The contact's fax number.</td>
</tr>
<tr>
<td>FaxExt</td>
<td>The extension for the contact's fax machine, if any.</td>
</tr>
<tr>
<td>Address 1</td>
<td>The contact's street address.</td>
</tr>
<tr>
<td>Address 2</td>
<td>The additional address information, if necessary.</td>
</tr>
<tr>
<td>State/Province</td>
<td>The contact's state or province.</td>
</tr>
</tbody>
</table>
### Chapter 34: Using My WebEx

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ZIP/Postal</td>
<td>The contact's ZIP or postal code.</td>
</tr>
<tr>
<td>Country</td>
<td>The country in which the contact resides.</td>
</tr>
<tr>
<td>Username</td>
<td>The user name with which the user logs in to your WebEx service Web site, if the contact has a user account.</td>
</tr>
<tr>
<td>Notes</td>
<td>Any additional information about the contact.</td>
</tr>
</tbody>
</table>

#### Importing contact information from Outlook to your address book

If you use Microsoft Outlook, you can import the contacts that you maintain in your Microsoft Outlook address book or folder to your personal address book on your WebEx service Web site.

To import contacts from Outlook to your personal address book:

1. Open your address book. For details, see *Opening your address book* (on page 392).
2. In the View drop-down list, select *Personal Contacts*.
3. In the Import from drop-down list, select *Microsoft Outlook*.
4. Click *Import*.
   The Choose Profile dialog box appears.
5. In the Profile Name drop-down list, select the Outlook user profile that includes the contact information that you want to import.
6. Click *OK*.

**Note:**
- When you import contacts in Outlook, your WebEx service Web site retrieves contact information from the Outlook address book or folder in which you have chosen to keep personal addresses. For information about keeping personal addresses in Outlook, refer to Microsoft Outlook Help.
- If your personal address book already includes a contact who is also in your Outlook contacts list, the contact is not imported. However, if you change the contact's email address in your personal address book, importing the contact from Outlook creates a new contact in your personal address book.
Viewing and editing contact information in your address book

In your personal address book, you can view and edit information about individual contacts in your Personal Contacts list. You can view, but not edit, information about contacts in your Company Address Book.

To view or edit contact information:

1. Open your address book. For details, see Opening your address book (on page 392).
2. In the View drop-down list, select one of the following:
   - Personal Contacts
   - Company Address Book
   A list of contacts appears.
3. Locate the contact whose information you want to view or edit. For details about locating a contact, see Finding a contact in your personal address book (on page 400).
4. Under Name, select the contact whose information you want to view or edit.
5. Do one of the following:
   - If the contact is in your Personal Contacts list, click Edit.
   - If the contact is in your Company Address Book, click View Info.
   Information about the contact appears.
6. Optional. If the contact is in your Personal Contacts list, edit the information that you want to change on the Edit Contact's Information page.
   For descriptions of the information and options of the Edit Contact's Information page, see About the New/Edit Contact page (on page 395).
7. Click OK.

Finding a contact in your personal address book

You can quickly locate a contact in your personal address book, using one of several methods.
To search for a contact in your address book:

1. Open your address book. For details, see *Opening your address book* (on page 392).
2. In the View drop-down list, select a contacts list.
3. Do any of the following:
   - In the Index, click a letter of the alphabet to display a list of contacts whose names begin with that letter. For example, the name Susan Jones appears under S.
   - To search for a contact in the list you are currently viewing, type text that appears in either the contact's name or email address in the Search for box, and then click Search.
   - If the entire list of contacts does not fit on a single page, view another page by clicking the links for the page numbers.
   - Sort your personal contacts or company address book by name, email address, or phone number by clicking the column headings.

Creating a distribution list in your address book

You can create distribution lists for your personal address book. A distribution list includes two or more contacts for which you provide a common name and appears in your Personal Contacts list. For example, you can create a distribution list named Sales Department, which includes contacts who are members of your Sales Department. If you want to invite members of the department to an event, you can select the group rather than each member individually.

To create a distribution list:

1. Open your address book. For details, see *Opening your address book* (on page 392).
2. Click Add Distribution List.
   The Add Distribution List page appears.
3 In the **Name** box, type the name of the group.

4 Optional. In the **Description** box, type descriptive information about the group.

5 Under **Members**, locate the contacts that you want to add to the distribution list, by doing any of the following:
   - Search for a contact, by typing all or part of the contact's first or last name in the **Search** box.
   - Click the letter that corresponds to the first letter of the contact's first name.
   - Click **All** to list all contacts in your Personal Contacts list.

6 Optional. To add a new contact to your Personal Contacts list, under **Members**, click **Add Contact**.

7 In the box on the left, select the contacts that you want to add to the distribution list.

8 Click **Add** to move contacts you selected to the box on the right.

9 After you finish adding contacts to the distribution list, click **Add** to create the list.

   In your Personal Contacts list, the **Distribution List** indicator appears to the left of the new distribution list:
For descriptions of the information and options on the Add Distribution List page, see About the Add/Edit Distribution List page (on page 404).

## Editing a distribution list in your address book

You can add or remove contacts from any distribution list that you have created for your personal address book. You can also change a group's name or descriptive information.

**To edit a distribution list:**

1. Open your address book. For details, see Opening your address book (on page 392).
2. In the View drop-down list, select Personal Contacts.

   A list of the contacts in your Personal Contacts list appears, including any distribution lists that you have created. The **Distribution List** indicator appears to the left of a distribution list:

   Under **Name**, select the name of the distribution list. The Edit Distribution List page appears.
3 Edit information about the distribution list.

4 Click Update.

For descriptions of the information and options on the Edit Distribution List page, see About the Add/Edit Distribution List (on page 404).

About the Add/Edit Distribution List page

How to access this page

On your WebEx service Web site, click My WebEx > My Contacts > Add Distribution List. Or, select distribution list in Personal Contacts list.
What you can do here
Add contacts to your distribution list or remove contacts from your distribution list.

Options on this page

<table>
<thead>
<tr>
<th>Use this option...</th>
<th>To...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter the name of the distribution list. For example, if you want to add a distribution list that includes members of your company’s sales department, you might name the list Sales Department.</td>
</tr>
<tr>
<td>Description</td>
<td>Optionally enter descriptive information about the distribution list, to help you identify it later.</td>
</tr>
<tr>
<td>Search</td>
<td>Find a contact, by typing all or part of the contact's first or last name.</td>
</tr>
<tr>
<td>Index</td>
<td>Find a contact, by clicking the letter that corresponds to the first letter of the contact's first name. To list contacts for which you identified with a number, click #. To list all contacts in your Personal Contacts list, click All.</td>
</tr>
<tr>
<td>Add&gt;</td>
<td>Add a one or more selected contacts to your distribution list.</td>
</tr>
<tr>
<td>&lt;Remove</td>
<td>Remove one or more selected contacts from your distribution list.</td>
</tr>
<tr>
<td>Add Contact</td>
<td>Add a new contact to your Personal Contacts list and add the contact to your distribution list.</td>
</tr>
<tr>
<td>Add</td>
<td>Add a new distribution list to your Personal Contacts list.</td>
</tr>
<tr>
<td>Update</td>
<td>Update an existing distribution list that you have edited.</td>
</tr>
</tbody>
</table>

Deleting contact information in your address book
You can delete any contact or distribution lists that you have added to your personal address book.

To delete a contact or contact group:

1. Open your address book. For details, see Opening your address book (on page 392).
2. In the View drop-down list, select Personal Contacts.
Chapter 34: Using My WebEx

3 In the list that appears, select the check box for the contact or distribution list that you want to delete.

4 Click Delete.
   A message appears, asking you to confirm the deletion.

5 Click OK.

Maintaining your user profile

<table>
<thead>
<tr>
<th>If you want to…</th>
<th>See…</th>
</tr>
</thead>
<tbody>
<tr>
<td>get an overview of maintaining your user profile</td>
<td>About maintaining your user profile (on page 406)</td>
</tr>
<tr>
<td>edit your user profile</td>
<td>Editing your user profile (on page 413)</td>
</tr>
</tbody>
</table>

About maintaining your user profile

Once you obtain a user account, you can edit your user profile at any time to do the following:

- Maintain personal information, including your
  - Full name
  - Username (if your site administrator provides this option)
  - Password
  - Contact information (including your street address, email address, and phone numbers)
  - Tracking codes that your organization uses to keep records of your events (such as project, department, and division numbers)

- Specify whether to display links to your company's partner sites in the My WebEx navigation bar, if your site administrator set up partner links

- Manage any scheduling templates that you saved

- Set options for your Personal Event Room options, including the images and welcome message that appear on the page

- Set default options for your online sessions, including
Chapter 34: Using My WebEx

- The default session type that you want to use, if your account includes multiple session types
- Whether your scheduled events are automatically removed from your list of events once the event ends
- Whether the Quick Start page appears in the content viewer once you start an event
- The users who can schedule events on your behalf

Set Web site preferences, including:
- The home page that appears when you access your WebEx service Web site
- The time zone in which event times appear
- The language in which your Web site displays text, if your site includes multiple languages
- The locale (the format in which your Web site displays dates, times, currency values, and numbers)

About the My WebEx Profile page

How to access this template
On your WebEx service Web site, click My WebEx > My Profile.

What you can do here
Manage the following:
- Account information
- Personal information
- Partner integration options
- Scheduling templates (does not apply to Support Center)
- Personal Meeting Room information
- Event options
- Web page preferences, including your home page and language
- Support Center CSR Dashboard options (Support Center only)
## Personal Information options

<table>
<thead>
<tr>
<th>Use this option...</th>
<th>To...</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Username</strong></td>
<td>Specify the username for your account. You can change this name only if the administrator for your WebEx service Web site provides this option.</td>
</tr>
<tr>
<td></td>
<td><strong>Tip:</strong> If you need to change your username, but cannot edit it on this page, ask your site administrator to change your username or create a new account for you.</td>
</tr>
<tr>
<td><strong>Change Password</strong></td>
<td>▪ <strong>Old password</strong>: Type the old password for your account.</td>
</tr>
<tr>
<td></td>
<td>▪ <strong>New password</strong>: Specify the new password for your account. A password:</td>
</tr>
<tr>
<td></td>
<td>□ Must contain at least four characters</td>
</tr>
<tr>
<td></td>
<td>□ Can consist of a maximum of 32 characters</td>
</tr>
<tr>
<td></td>
<td>□ Can include any letters, numbers, or special characters, but not spaces</td>
</tr>
<tr>
<td></td>
<td>□ Is case sensitive</td>
</tr>
<tr>
<td></td>
<td>▪ <strong>Retype New password</strong>: Verify that you typed your password correctly in the <strong>New password</strong> box.</td>
</tr>
<tr>
<td><strong>Call-in authentication</strong></td>
<td>If enabled by your site administrator, allows you to be authenticated and placed into the correct teleconference without needing to enter a meeting number whenever you dial into any CLI (caller line identification) or ANI (automatic number identification) enabled teleconference. Selecting this option for a phone number in your user profile maps your email address to that phone number. Caller authentication is available only if you have been invited to a CLI/ANI enabled teleconference by email during the meeting scheduling process. Caller authentication is not available if you are dialing in to a CLI/ANI enabled teleconference.</td>
</tr>
<tr>
<td><strong>Call-back</strong></td>
<td>When selected for a phone number in your user profile, allows you to receive a call from the teleconferencing service if it is using an integrated call-back feature. If your site includes the international call-back option, participants in other countries receive a call back. For more information about this option, ask your site administrator.</td>
</tr>
<tr>
<td><strong>PIN</strong></td>
<td>If enabled by your site administrator, allows you to specify a call-in authentication PIN to prevent “spoofers” from using your number to dial into a teleconference. If your site administrator sets the authentication PIN as mandatory for all accounts using call-in authentication on your site, you must specify a PIN number or caller authentication will be disabled for your account. This option is available only if you have selected the <strong>Call-in authentication option</strong> for at least one of the phone...</td>
</tr>
</tbody>
</table>
numbers in your profile. The PIN can also be used to provide a secondary level of authentication for calls where the host is using the phone and may need to invite additional attendees.

Other personal information options
Enter any personal information that you want to maintain in your profile.

Partner integration options
Your site administrator can set up custom links to the Web sites of your company's partners, and then display the links on the My WebEx navigation bar. For example, if your company uses another company's Web site to provide a service, your site administrator can provide a link to that company's site in your My WebEx navigation bar. You can then show or hide that link.

Display partner links in My WebEx
Shows or hides partner site links in the My WebEx navigation bar.

Calendar Work Hours options
Use these options to specify working hours to use with scheduling calendars.

Start time
Select the start time for your daily work calendar.

End time
Select the end time for your daily work calendar.

Scheduling template options
Use these options to manage scheduling templates that you set up using the scheduling options on your site.

Get Info
Shows the settings you set for the selected template.
**Chapter 34: Using My WebEx**

### Use this option... | To...
--- | ---
**Edit** | Opens the scheduling options on your site for the selected template.
**Delete** | Removes the selected template from your profile.
**Select All** | Selects all the scheduling templates, allowing you to delete them all at once.

### Personal Meeting Room options

| Use this option... | To... |
--- | ---|
**Personal Meeting Room URL** | Go to your Personal Meeting Room page. You can click the URL from the My Profile page to preview your current Personal Meeting Room page. Your Personal Meeting Room page shows online sessions that you scheduled and any in-progress sessions that you are currently hosting. Users to whom you provide your personal URL can use this page to join any meeting that you are hosting. They can also download files in any folders that you share. |
**Welcome Message** | Enter the message that appears on your Personal Meeting Room page. A message can be a maximum of 128 characters, including spaces and punctuation. To specify a message, type it in the box, and then click **Update**. |
**Upload Image** | Upload an image file from your computer or another computer on your network to your Personal Meeting Room page. For example, you can upload a picture of yourself, your company's logo, or a picture of your company's product. Visitors to your page can see the image that you upload. The image can be an maximum of 160 pixels wide. If you upload a larger image, its width is automatically reduced to 160 pixels. However, the image's aspect ratio is maintained. **Browse:** Lets you locate an image. **Upload:** Uploads the image that you selected. **Current Image:** Displays the image that currently appears on your Personal Meeting Room page. **Delete:** Removes the current image from your Personal Meeting Room page. This button is available only if you have uploaded an image for the page. |
**Customize branding of** | Upload a banner image to the non-scrolling header area for your Personal Meeting Room page. For example, you can... |
### Chapter 34: Using My WebEx

<table>
<thead>
<tr>
<th><strong>Use this option...</strong></th>
<th><strong>To...</strong></th>
</tr>
</thead>
</table>
| **header area**         | upload your company's logo or an advertisement. Visitors to your page can see the image that you upload. Available only if your site administrator has turned on this option for your account.  
The image can be an maximum of 75 pixels high. If you upload a larger image, its height is automatically reduced to 75 pixels. However, the image's aspect ratio is maintained.  
**Browse:** Lets you locate a banner image.  
**Upload:** Uploads the banner image that you selected.  
**Current Image:** Displays the banner image that currently appears on your Personal Meeting Room page.  
**Delete:** Removes the current banner image from your Personal Meeting Room page. This button is available only if you have uploaded an image for the page. |

### Productivity Tools Options

<table>
<thead>
<tr>
<th><strong>Use this option....</strong></th>
<th><strong>To....</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Automatically download Productivity Tools when logging in to the WebEx service site</strong></td>
<td>Specify that WebEx Productivity Tools should be downloaded automatically when you log in to the WebEx service site. If this option is turned off, you can still download Productivity Tools manually.</td>
</tr>
</tbody>
</table>

### Session Options

<table>
<thead>
<tr>
<th><strong>Use this option...</strong></th>
<th><strong>To...</strong></th>
</tr>
</thead>
</table>
| **Default session type** | Specify the default session type that you host, if your user account lets you host different types of online sessions.  
For more information about session types, ask the site administrator for your WebEx service.  
You can change this default setting when scheduling a meeting. |
### Quick Start

Specify whether the Quick Start page appears in the content viewer once you start a meeting. The Quick Start lets you start sharing activities quickly, as an alternative to starting them from a menu or toolbar.

- **Show Quick Start to host and presenter:** The Quick Start appears in the content viewer for the host and presenter.
- **Show Quick Start to attendees:** The Quick Start appears in the content viewer for attendees. Select this option only if you intend to let attendees share information during your meetings.

You can change this default setting when scheduling a meeting.

### Web page preferences options

<table>
<thead>
<tr>
<th>Use this option...</th>
<th>To...</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Home page</strong></td>
<td>Set the first page that appears when you access your WebEx service Web site.</td>
</tr>
</tbody>
</table>
| **Time zone**     | Set the time zone in which you reside.  
If you select a time zone for which daylight saving time (DST) is in effect, your WebEx service Web site automatically adjusts its clock for daylight saving time  
**Note:** The selected time zone appears:  
- Only on your view of your WebEx service Web site, not other users’ views  
- In all meeting invitations that you send using your WebEx service Web site |
| **Language**      | Set the language in which your WebEx service Web site displays text.  
**Note:** The languages that appear in this list are limited to the languages that have been set up for your Web site. |
| **Locale**        | Set the format in which your Web site displays dates, times, currency values, and numbers. |
Editing your user profile

Once you obtain a user account, you can edit your user profile at any time to change account login information, contact information, and other options available for your account.

To edit your user profile:

1. Log in to your WebEx service Web site. For details, see Logging in to and out of the WebEx service site (on page 352).
2. On the navigation bar, click My WebEx.
3. Click My Profile.
4. Edit the information on the page.
5. When you are finished editing your user profile, click Update.

For descriptions of the information and options on the My Profile page, see About the My WebEx Profile page (on page 407).

Managing scheduling templates

<table>
<thead>
<tr>
<th>If you want to…</th>
<th>See…</th>
</tr>
</thead>
<tbody>
<tr>
<td>get an overview of managing your scheduling templates</td>
<td>About managing scheduling templates (on page 413)</td>
</tr>
<tr>
<td>view, edit, or delete a scheduling template</td>
<td>Managing scheduling templates (on page 414)</td>
</tr>
</tbody>
</table>

About managing scheduling templates

Scheduling templates let you save the options you set for an event for later use. Once you save a scheduling template, you can use it to quickly schedule another event, instead of setting the same options again. If you saved a scheduling template using the Save As Template option when scheduling an event, you can manage the template, as follows:

- View the options you set in the template.
- Edit the options you set in the template.
Delete the template.

Managing scheduling templates

You can view, edit, or delete any scheduling templates that you saved.

To manage scheduling templates:

1. Log in to your WebEx service Web site. For details, see Logging in to and out of the WebEx service site (on page 352).

2. On the navigation bar, click My WebEx.

3. Click My Profile.

   The My Profile page appears.

4. Under Scheduling Templates, select a template in the list.

5. Click one of the following buttons to perform an action on the template:
   - **Get Info**: Shows the options you set in the template.
   - **Edit**: Opens the scheduling options on your site.
   - **Delete**: Removes the template from your profile.
Maintaining your Cisco Unified MeetingPlace Audio Conferencing accounts

<table>
<thead>
<tr>
<th>If you want to…</th>
<th>See…</th>
</tr>
</thead>
<tbody>
<tr>
<td>get an overview of maintaining Cisco Unified MeetingPlace audio conferencing account numbers</td>
<td><em>About maintaining Cisco Unified MeetingPlace audio conferencing account numbers</em> (on page 415)</td>
</tr>
<tr>
<td>reset the password for your Cisco Unified MeetingPlace audio conferencing account</td>
<td><em>Resetting the password for your Cisco Unified MeetingPlace audio conferencing account number</em> (on page 415)</td>
</tr>
</tbody>
</table>

About maintaining Cisco Unified MeetingPlace audio conferencing account numbers

If your site includes support for Cisco Unified MeetingPlace audio conferencing, you should already have a Cisco Unified MeetingPlace audio conferencing account assigned to you. With your account, you can use Cisco Unified MeetingPlace audio in your meetings and in MeetingPlace Personal Conference meetings.

Your account number includes a toll number to call as well as a Cisco Unified MeetingPlace profile number. For additional security, you can specify or reset a profile PIN that can be used to authenticate your account. You can also synchronize your account settings for your WebEx and Cisco Unified MeetingPlace accounts.

Resetting the profile PIN for your Cisco Unified MeetingPlace audio conferencing account number

If your site includes support for Cisco Unified MeetingPlace audio conferencing, you should already have a Cisco Unified MeetingPlace audio conferencing account assigned to you. You can change the personal identification number (PIN) for your Cisco Unified MeetingPlace audio conferencing account.

To add or edit a Personal Conference number account:

1. Log in to your WebEx service Web website, and then select **My WebEx**.
2. Select **Personal Conferencing**.
Chapter 34: Using My WebEx

The Personal Conferencing page appears.

3 Under **Change Profile PIN**, in the **New profile PIN** and **Confirm profile PIN** boxes, type a new personal password that contains only numbers and is between 5 and 24 digits in length.

4 To synchronize your account settings for your WebEx and Cisco Unified MeetingPlace accounts, select **Sync**.

**About the Personal Conferencing page**

**How to access this page**

On your WebEx service Web site, click **My WebEx > Personal Conferencing**.

**What you can do here**

- Add, edit, or delete a Personal Conference number account.
- View information about your existing Personal Conference number accounts.
- If you are a MeetingPlace user, view information about your Cisco Unified MeetingPlace Audio Conferencing account and change your profile PIN.
### Options on this page for Personal Conference number accounts only

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Personal Conference number</strong></td>
<td>Shows the numbers for your Personal Conference number accounts. With a Personal Conference number account, you can use the same conference numbers for all your meetings, including Personal Conference meetings that you schedule on your WebEx service Web site or that you start instantly from a phone. A Personal Conference number account also lets you specify the access codes that you want to use to start the audio portion of the Personal Conference meeting, and the access codes that you want attendees to use to join the audio portion. For details about the information in a Personal Conference number account, see About the Add/Edit Personal Conference Number page.</td>
</tr>
<tr>
<td><strong>Account [x]</strong></td>
<td>Allows you to add a new Personal Conference number accounts or view and edit information about each of your Personal Conference number accounts. <strong>Add account:</strong> Opens the Create Personal Conference Number page, on which you can obtain a Personal Conference number (PCN) account. Appears only if you have not yet added the maximum of three accounts. <strong>Default account:</strong> Indicates that the PCN account is the default account that is selected when you schedule a Personal Conference meeting. <strong>Set as default:</strong> If you set up more than one PCN account, you can click this link to specify which account is your default account.</td>
</tr>
<tr>
<td><strong>Edit</strong></td>
<td>Opens the Edit Personal Conference Number page, on which you can change the access codes for your PCN account. For details about the information in a PCN account, see About the Create/Edit Personal Conference Number.</td>
</tr>
<tr>
<td><strong>Delete</strong></td>
<td>Deletes the Personal Conference number (PCN) account from your user profile. <strong>Important:</strong> If you delete a PCN account that you have already selected for a scheduled a meeting, you must edit the meeting to select another PCN account or voice-conferencing option.</td>
</tr>
</tbody>
</table>
Chapter 34: Using My WebEx

Options on this page for MeetingPlace users only

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Toll Number</td>
<td>Shows the toll telephone number for your Cisco Unified MeetingPlace audio conferencing account.</td>
</tr>
<tr>
<td>Cisco Unified MeetingPlace profile number</td>
<td>Shows your Cisco Unified MeetingPlace audio conferencing account profile number.</td>
</tr>
<tr>
<td>New profile PIN</td>
<td>Allows you to reset your Cisco Unified MeetingPlace audio conferencing account profile personal identification number (PIN) in order to provide an additional level of security to your audio account.</td>
</tr>
</tbody>
</table>

Generating Reports

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>get an overview of what reports you can generate from your WebEx service Web site</td>
<td>About generating reports (on page 418)</td>
</tr>
<tr>
<td>generate usage reports that provide information about each session that you have hosted on your site</td>
<td>Generating reports (on page 420)</td>
</tr>
</tbody>
</table>

About generating reports

If your user account includes the reports option, you can view the following reports:

Note:
- For some reports, if you click on the report link within 15 minutes after the event ends, you will see a preliminary version of that report. The preliminary report provides quick access to data before the final, more accurate data is available. The preliminary report contains only a subset of the information that is available in the final report.
- When the final, more accurate data is available, which is usually 24 hours after the event ends, the preliminary report is replaced by the final report.
- You can download both preliminary reports and final reports as comma-separated values (CSV) files.
General Event Usage reports

These reports contain information about each online session that you host. You can view the following reports:

- **Summary Usage report**: Contains summary information about each event including topic, date, start and end time, duration, number of attendees you invited, number of invited attendees who attended, and type of voice conference you used.

  **Note**: Initially, this report appears as a Preliminary Usage Summary Report, but after the final, more accurate usage data is available, it is replaced by the Final Usage Summary Report.

- **Summary Usage report CSV (comma-separated values) file**: Contains additional details about each event, including the minutes that all participants were connected to the event and tracking codes.

- **Session Detail report**: Contains detailed information about each participant in an event, including the time the participant joined and left the event, the attentiveness during the event, and any information that the attendee provided.

  **Note**: Initially, this report appears as a Preliminary Session Detail Report, but after the final, more accurate session detail data is available, it is replaced by the Final Session Detail Report.

Access Anywhere usage report

This report shows information about the computers that you access remotely, including the date and start and end times for each session.

Event Center reports

These reports contain detailed information about the events that you host. You can view the following types of Event Center reports:

- **Registration Report**: Contains registration information for an event that you hosted, including the name, date, and time of the event, and the numbers of participants who were invited, who registered, who attended, or who were absent. It also allows you to send reminder emails before the event.

- **Attendance Report**: Contains detailed information about attendees and absentees for an event that you hosted. The report includes the event ID, key, name, start and end time, duration, number of attendees, the host name, and the minutes that all attendees spent in the event. The report also includes each attendee’s username, email address, IP address, the time the attendee joined, and the time the
attendee left the event, and the attendee attentiveness during the event. You can also use the attendance report to send follow-up emails after the event.

**Note:** Initially, this report appears as a Preliminary Attendance Report, but after the final, more accurate attendance data is available, it is replaced by the Final Attendance Report.

- **In-Event Activity Report:** Contains the event name, date, and time, information about the number of attendees, the number of questions asked and the response rate for the questions, and the number of polls and the response rate for the polls.

**Note:** This report is available only for events recorded on the server.

- **Attendee History Report:** Contains a list of all events that an attendee has joined on your Event Center Web site.
- **Event Recording Report:** Contains access and registration information about people who have downloaded a recording for a specific event from your Event Center Web site.

### Generating reports

You can generate usage reports that provide information about each online event that you have hosted on your site.

You can export or download the data to a comma-separated values (CSV) file which you can then open in a spreadsheet program such as Microsoft Excel. You can also print reports in a printer-friendly format.

**To generate a report:**

1. Log in to your WebEx service Web site, and then click **My WebEx**.
2. Click **My Reports**.
   - The My Reports page appears.
3. Choose the type of report you want to generate.
4. Specify your search criteria, such as a date range for which you want to view report data.
5. Click **Display Report**.
6 To change the order in which report data is sorted, click the column headings.

The report data is sorted by the column that has an arrow next to the column heading. To reverse the sort order, click the column heading. To sort using another column, click that column’s heading.

7 Do one of the following, as appropriate:

- If you are viewing a general event usage report and want to display the report in a format that is suitable for printing, click Printer-Friendly Format.

- If you are viewing the usage report for an event and want to view the content in the report, click the link for the event name.

- If you are viewing an WebEx Service Registration Report, you can click the number in the Registered column to send an email reminder to the registered attendees for that event. An email editor opens and allows you to edit the default email template.

- If you are viewing an WebEx Service Registration Report or an Event Center Attendance Report, you can click the event name in the Event Name column to view a detailed report of the registered users for that event, which provides additional options for sending email reminders to registered attendees.

- If you are viewing an WebEx Service Attendance Report, you can click the number in the Attended column to send an email message to the attendees for that event, or you can also click the number in the Absent column to send an email message to the absentee(s) for that event. An email editor opens and allows you to edit the default email template; for example, you could add a link to the edited event recording.

- If you are viewing an Event Center Attendance Report, you can click the event name in the Event Name column to view a detailed report of the attendees for that event, which provides additional options for sending email messages to attendees for the event.

8 To export the report data in comma-separated values (CSV) format, click Export Report or Export.

9 If available, click links on the report to display more details.
### Viewing Recorded Events

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>get an overview of viewing a recorded event</td>
<td>About viewing a recorded event (on page 423)</td>
</tr>
<tr>
<td>view a recorded event</td>
<td>Viewing a recorded event (on page 423)</td>
</tr>
</tbody>
</table>

### About viewing a recorded event

If an event host publishes a recorded event on your Event Center Web site, you can view the recording. A host may require that you do *one or both* of the following to view a recorded event:

- **Register to view a recorded event.** In this case, you must provide your name, email address, and any other information that the host requires.
- **Provide a password.** In this case, you must obtain the password from the host.

To view a recorded event, you must use WebEx Player. Your Event Center Web site automatically downloads WebEx Player to your computer the first time you view a recorded event.

If you have a user account, you can also download WebEx Player from the Support page on your Event Center Web site.

### Viewing a recorded event

You can stream or download a recording file, depending on which option the host specifies.
When you play a recording for the first time, your WebEx site automatically downloads WebEx Player to your computer.

To play or download a recorded event:

1. If the host requires that you have a user account to view a recording, sign in to your WebEx site.
2. On the left navigation bar, select **Attend an Event > Event Recordings**.
3. Do one of the following, as appropriate:
   - Click for the recording you want to play.
   - Click for the recording you want to download.
4. If playing or downloading the recording requires a password, type the password that the host gave to you in the **Password** box.
5. Select **Playback** or **Download**, as appropriate.
6. If viewing the recording requires registration, provide the required information on the form that appears, and then select **Submit**.
Index

.atp files • 299, 302
  attendees to event in progress • 156, 157, 159
  by email • 156
  by instant messaging (IM) • 159, 163
  by phone • 156
  by WebEx AIM Pro • 157, 162
  Cisco Unified MeetingPlace
    audio conferencing accounts • 404, 405
    MeetingPlace Personal Conference • 72, 73, 74, 75,
    76, 406
  contact group • 393
  creating for attendees • 160
  creating message for • 160
  event templates • 46
    creating greeting for • 160
  email messages, overview • 28
  overview • 156
  to enrollees • 101
  to host • 54
  events • 67
  files, overview • 362
  from My WebEx • 67, 68
  host role • 169
  in address book • 393
  in personal folders, overview • 362
  information about • 372
  information about files • 365
  information about in personal folders • 365
  information about recorded events • 314
  obtaining during event • 152
  on Event Information page • 112
  options for panels • 135
  overview • 67
  panelists to join event in progress • 163
reclaiming • 169
recorded events, overview • 309
scheduling events • 46
specifying during scheduling • 59
using to reclaim host role • 169
viewing information about • 99
.txt files • 300
  for chat messages • 284

A

Access Anywhere
  using • 360
Access Anywhere Usage report
description • 408
access to events • 170
  by phone • 156
  restricting • 170
  setting options • 135
accessing • 5
account, user
  obtaining • 343
adding
  contacts to address book • 384
  new personal folders for file storage • 363
  post-event surveys • 60
adding existing contacts • 23
  accessing, viewing • 64
adding new contacts • 21
adding to event descriptions • 55
adding to invitation list • 21
address book
  adding contacts • 384
  creating contact group • 392
  importing contacts from file • 387
  importing contacts from Outlook • 390
  opening • 383
  searching for contacts • 391
  using, overview • 383
  viewing or editing contact information • 390
address books • 23
approval rules • 10
for event registration • 10
asking to speak in teleconference • 199
attendees
  allowing to join before starting time • 53
  muting and unmuting microphones in Integrated VoIP • 211
  preventing from joining event • 170
audio broadcast • 147
  automatically granting teleconferencing privilege • 147
audio files
  sharing a Web content • 276
Audio Setup Wizard, using • 212
audio, for Integrated VoIP muting and unmuting • 211

B

becoming host • 169
browsers, Web
  sharing • 276

C

call-back teleconference
  joining • 194
call-in numbers, global • 194
call-in teleconference
  joining • 194
canceling
  Personal Conference meetings • 76
  scheduled events • 69
changing time zone
  from List of Events page • 122
changing type of, editing, rearranging, deleting poll question • 293
chat messages
  printing • 283
  saving • 284, 285
  sending • 281
Chat panel • 135
  setting options • 135
checking system for UCF compatibility • 3
choosing
  panelists for event • 168
  presenter in event • 167
clearing
  feedback • 308
computer, setting up
  Meeting Manager • 2
contact group
  creating in address book • 392
contact information
  adding to address book • 384
  creating contact group • 392
  importing to address book from file • 387
  importing to address book from Outlook • 390
  maintaining, overview • 383
  searching for in address book • 391
  viewing or editing in address book • 390
creating
  poll questionnaires • 288
  post-event surveys • 60
creating event templates • 46
  scheduling events • 46
  creating for attendees • 20

dele
downloading
  event materials • 111
  files • 367
  from personal folders • 367
  materials for events • 56

E

Edit Recording Information page
  options • 317
  editing
    contact group in address book • 393
    contact information in address book • 390
    information about files in personal folders • 365
    information about recordings • 372
    Personal Conference meetings • 74
  email • 156
    reminding panelists to join event in progress • 161
  email messages
    customizing for a specific event • 33
    customizing for future events • 34
    variables • 35
  ending
    event • 172
  event information • 152
    obtaining • 120
    obtaining during event • 152
  Event Information page • 111
    accessing • 111
    adding images • 55
    adding materials to download • 56
    finding event description • 111
  Event Recordings page
    deleting recordings • 313
    event template • 46
      using • 46
    event URL • 116
      registering from • 116
    events • 170
      adding to program • 87
      assigning to programs • 47
      finding • 116
      finding date • 120
      finding description • 120
      finding presenters • 120
      finding time • 120
  finding topic • 120
  grouping together • 81
  obtaining information • 120
  providing descriptions • 55
  providing materials to download • 56
  restricting access • 170
  scheduling • 65
  selecting tracking codes • 48
  setting approval rules for registration • 10
  specifying destination URL at end • 58
  specifying duration • 50
  specifying time zones • 50
  starting, overview • 66
  events, recorded
    deleting published • 313
    editing information about • 314
    opening your list • 310
    publishing • 311
    publishing, overview • 309
    uploading • 311
  existing contacts • 23
    adding to invitation list • 23
  expelling
    participants from event • 170
  explanation of roles • 168

F

feedback
  allowing participants to use • 306
  clearing • 308
  overview of • 305
  viewing • 306
files
  .atp • 299, 302
  .txt • 300
  for chat • 284
  for poll questionnaire • 299
  for poll questionnaires • 302
  for poll results • 300
  from personal folders • 367
  in personal folders • 365, 367
  in your personal folders, overview • 362
  moving or copying in personal folders • 365
  searching in personal folders • 366
  sharing on Personal Meeting Room page • 359

427
to personal folders • 364
uploaded by panelists • 64
finding • 152
event number • 152
event topic • 152
events • 116
URL for Event Center Web site • 152
Flash files
sharing as Web content • 276
folders, personal
adding new for file storage • 363
moving files • 365
opening • 362
overview • 362
searching for files • 366
for future events • 34
for specific audiences • 81
formatting • 55
event descriptions in HTML • 55
from email invitation • 110

iCalendar • 31
including in email messages • 31
images
adding to event descriptions • 55
adding to Personal Meeting Room page • 358
formats allowed in event descriptions • 55
replacing in event descriptions • 55
size limits in event descriptions • 55
importing
contacts to address book from file • 387
contacts to address book from Outlook • 390
distribution lists to invitation list • 24
including • 295
individual results, for poll
saving • 300
installing
Meeting Manager • 2
instructions
teleconference • 194
Integrated VoIP conference
about • 207
muting and unmuting microphones • 210
muting and unmuting participant’s m • 211
muting and unmuting your microphone • 211
setting options • 212
Integrated VoIP conferences • 40
setting up • 40
invitation list • 24
creating for panelists • 25
importing distribution lists • 24
inviting
attendees to event in progress • 156, 157, 159
attendees to teleconference in progress • 156
contacts from • 23
panelists to event • 25
to event • 20, 25

header, custom
adding to Personal Meeting Room page • 358
hiding • 59
attendee list • 59
home page for site
setting • 402

joining
teleconference • 194
joining events • 111
from URL • 111
language and locale for site
setting • 402
learning • 120
about upcoming events • 120
leaving
   event without ending it • 171
teleconference • 194
List of Events page • 116
accessing • 116
by date • 116
by program • 116
switching between views • 116
viewing by date • 116
viewing recordings • 116
list of meetings, personal
maintaining • 347
overview • 345
locking
   access to event • 170
logging in to and out from site • 344

maintaining
   contact information, overview • 383
   personal list of meetings • 347
   Personal Meeting Room page, overview • 357
manual installer
   Meeting Manager • 2
media players for UCF media files
   checking if installed on com • 3
media viewer • 280
   sharing content • 280
Meeting Manager
   setting up • 2
   system requirements • 2
meeting service
   system requirements • 2
message
   adding to Personal Meeting Room page • 358
   creating for attendees • 160
microphone
   muting and unmuting a specific microphone • 197
   muting and unmuting all • 198
muting and unmuting for participant in Integrated
   V • 211
muting and unmuting participants automatically • 196
muting and unmuting your own in Integrated
   VoIP con • 211
muting and unmuting your own in teleconference • 199
multimedia
   sharing as Web content • 276
multimedia content • 280
   sharing in media viewer • 280
muting
   a specific microphone • 197
   all in teleconference • 198
   in integrated VoIP conference • 210
   participant's microphone in integrated VoIP
   conference • 211
   your microphone in integrated VoIP conference • 211
   your microphone in teleconference • 199
My Computers
   using • 360
My Contacts
   adding contacts • 384
   creating contact group • 392
   importing contacts from file • 387
   importing contacts from Outlook • 390
   opening • 383
   searching for contacts • 391
   using, overview • 383
   viewing or editing contact information • 390
My Files
   adding folders • 363
   maintaining, overview • 362
   moving or copying files or folders • 365
   opening • 362
   searching for files • 366
My Meetings
   maintaining • 347
   overview • 345
My Profile
   editing • 402
opening
  address book • 383
  chat file • 285
  file for • 285, 302
  list of your recorded events • 310
  list of your recordings • 371
  personal folders • 362
  poll questionnaire file • 302
  poll questionnaires • 296
  saved chat files • 285
  user profile • 402
  your list • 371
options
  for integrated VoIP conference • 212
overview • 109, 111, 116, 279, 413

Panelist Entrance page • 110
  required information • 110
panelists • 170
panelists to join event in progress • 161
panels
  media viewer • 279
  resetting • 134
  returning to default settings • 134
participants
  muting and unmuting microphones in Integrated
  VoIP • 211
Participants panel • 135
  setting options • 135
passing to panelist • 169
password
  for Panelist Entrance page • 110
passwords • 47
  setting for events • 47
PCNow
  see Access Anywhere • 360
pending registration requests • 99
  viewing • 99
Personal Conference meetings
  adding to calendar • 73
  canceling • 76
  editing • 74
  setting up • 72
personal folders
  adding new for file storage • 363
  moving or copying files • 365
  opening • 362
  searching for files or folders • 366
Personal Meeting Room page
  add images and text • 358
  overview • 357
  setting options • 358
  sharing files • 359
  viewing • 357
phone • 156
playing when participants leave teleconference • 41
poll questionnaires
  creating • 288
  deleting • 293
  opening • 296
  saving • 299
poll questions or answers
  changing type of, editing, rearranging • 293
poll results
  saving • 300
  sharing with participants • 298
  specifying options for, including • 295
  specifying options for, overview • 295
  viewing after closing poll • 297
polling coordinator
  designating • 288
preferences
  setting for site • 402
presenter
  designating in event • 167
printing
  chat messages • 283
privileges
  granting to attendees during event • 146
  granting to panelists during event • 148
  overview • 145
privileges (attendees) • 147
  annotating documents • 147
  chatting with all attendees • 147
  chatting with host only • 147
  chatting with panelists • 147
  chatting with presenter only • 147
  joining teleconference during audio broadcast • 147
  printing documents • 147
  saving documents • 147
viewing any document • 147  
viewing any page • 147  
viewing attendee list • 147  
viewing number of attendees • 147  
viewing thumbnails • 147  

privileges (panelists) • 149  
annotating documents • 149  
chatting with all attendees • 149  
chatting with host only • 149  
chatting with panelists • 149  
chatting with presenter only • 149  
printing documents • 149  
saving documents • 149  
sharing documents • 149  
viewing any document • 149  
viewing any page • 149  
viewing thumbnails • 149  

privileges in events • 168  
profile, user  
editing • 402  
program URLs • 118  
for registering in events • 118  
programs • 81  
deleting • 88  
editing • 88  
for specific products • 81  
for specific projects • 81  
obtaining information about • 88  
overview • 117  
registering for events from URL • 118  
registering for multiple events • 117  
registering from Event Center Web site • 118  
viewing • 88  

publishing  
recorded event URLs • 311  
recorded events • 311  
recorded events, overview • 309  

R  
recorded event URLs  
publishing • 311  
recorded events • 413  
deleting published • 313  
editing information about • 314  
opening your list • 310  
publishing, overview • 309  
uploading • 311  
viewing • 413  
Recorded Events page • 116  
options • 314  
recording  
events • 147, 149  
Recording Information page  
options • 321  
recordings  
uploading • 371  
registering  
for multiple events • 117  
from event URL • 116  
registering for events • 118  
registrants • 63  
allowing to invite friends to event • 63  
registration form • 10  
customizing • 10  
question types • 10  
saving • 10  
registration ID • 9  
requiring • 9  
registration options • 10  
registration requests  
overview • 99  
rejected registration requests • 99  
viewing • 99  
rejoining  
teleconference • 194  
reminders • 54  
reminding • 162  
panelists to join event in progress • 162  
remote computer sharing  
overview • 4  
removing  
attendees from event • 170  
from event • 170  
panelists from event • 170  
participants from • 170  
participants from event • 170  
recorded event from Event Recordings page • 313  
replacing current content • 280  
replacing in event descriptions • 55  
reports  
generating • 410  
generating, overview • 408  
types of • 408
requesting • 8
requesting attendees • 59
  verifying rich media players • 59
resetting
  panels • 134
restricting
  access to event • 170
results, for poll
  saving • 300
reviewing • 99
  details about registrants • 99
  information about registrants • 99
saving
  chat messages • 284
  copy of chat messages • 285
  poll questionnaires • 299
  poll results • 300
scheduling events • 6
  creating event templates • 46
  include iCalendar attachments in email messages • 31
  make unlisted • 6
  providing security • 6
  requiring password • 6
  requiring registration IDs • 6
  restricting access • 6
  using event template • 46
scheduling templates
  about managing • 403
scoring • 17
  surveys, registration forms • 17
searching
  for contacts in address book • 391
  for events • 119
  for files in personal folders • 366
selecting
  panelists for event • 168
  presenter in event • 167
sending
  chat messages • 281
  email reminders for events • 101
Session Detail report
  description • 408
setting for events • 50
setting maximum for event • 63
setting options • 135
  for panels • 135
setting up
  approval rules • 10
  for Access Anywhere • 360
  for events • 39, 40
  for remote access • 360
  for Windows • 2
  Integrated VoIP conferences • 40
  Meeting Manager • 2
  Personal Conference meetings • 72
  teleconferences • 39
sharing
  Flash files, as Web content • 276
  poll results with participants • 298
  streaming audio, as Web content • 276
  streaming video, as Web content • 276
  Web browsers • 276
  Web content, overview • 275
showing number of responses
  in poll results • 295
speaker, in teleconference
determining • 199
specifying • 44
specifying for post-registration • 19
specifying in enrollment form • 14
specifying options
  for poll results • 295
  for poll results, overview • 295
specifying URLs • 135
specifying who can view • 59
streaming audio
  sharing as Web content • 276
streaming video
  sharing as Web content • 276
Summary Usage report
description • 408
Summary Usage report CSV file
description • 408
surveys, creating • 60
  post-event • 60
system requirements
  Meeting Manager • 2
teleconference
  asking to speak • 199
determining who is speaking • 199
displaying instructions for • 194
joining • 194
leaving • 194
muting and unmuting a specific microphone • 197
muting and unmuting all • 198
muting and unmuting participants automatically • 196
muting and unmuting your microphone • 199
rejoining • 194